
1.5 Line
Put one-and-a-half line spaces between lines.



2nd Y Axis & Grids
Update the selected chart's second Y axis and grid properties. This command is only available when the chart 
contains a second Y axis.



About Approach
Display the Approach release number and copyright.



Active Windows
Switch to the active window. All active windows appear in the list.



Add Column
Add a calculated field to the worksheet.



Add Field
Add a field from the current or related database to the view.



Add Footer
Insert a footer that appears at the bottom of each page of the report.



Add Header
Insert a header that appears at the top of each page of the report.



Add Page
Add a page to the current view.



Add Title Page
Insert a title page at the beginning of the report.



Align
Align selected objects to each other or to the grid.



Apply
Apply a named chart style to the selected chart.



Approach File Properties
Display or update information about the current Approach file.



Approach Preferences
Set default options for display, order, navigation, passwords, and other options.



Ascending
Sort the data in a selected field in ascending order.



Average
Calculate the average value in the selected column. Display the average at the end of the column if no summary 
bands exist, or in all summary bands.



Bold
Bold selected text.



Bring Forward
Bring the selected object(s) one layer forward.



Bring to Front
Place the selected object(s) in front of other objects.



Browse menu
The Browse menu appears when you are in Browse, and viewing a form.

Find>
• Find 
• Find Assistant 
• Find Again 
• Find All 

Sort>
• Ascending 
• Descending 
• Define 

New Record 

Duplicate Record 

Hide Record 

Delete Record 

Delete Found Set 

Dial 

Fill Field 

Insert>
• Today's Date 
• Current Time 
• Previous Value 

Refresh Data 



Browse & Data Entry
Change to Browse to enter, review, find, and sort data. A context-sensitive menu item appears depending on the view
or object you select.



Button
When in Design, draw a button. This is the same as selecting the Button tool in the Tools palette.



Cascade
Arrange active windows diagonally, leaving the title bars visible.



Cells Only
Select only the cells in a highlighted column.



Center
Align selected text to the center.



Chart
Create a new chart using the Chart Assistant.



Chart
When in Design, draw a chart. This is the same as selecting the Chart tool in the Tools palette.



Chart menu
The Chart menu appears when you are in Design and select a chart.

Chart Type 

Chart Style>
• Apply 
• Create 
• Set Default Chart 

Chart Properties 

Title 

Legend 

Axes & Grids>
• X Axis & Grids 
• Y Axis & Grids 
• 2nd Y Axis & Grids 
• Z Axis 

Series 

Series Labels 

Plot 

Note 

Table 

Drill Down to Data 



Chart Properties
Open the InfoBox to modify the properties of the selected chart.



Chart this Crosstab
Create a chart from the crosstab data.



Chart Type
Change the selected chart type and layout.



Check Box
When in Design, draw a check box. This is the same as selecting the Check box tool in the Tools palette.



Check Spelling
Find and correct misspelled and duplicate words.



Clean Screen
Hide SmartIcons, status bar, action bar, and view tabs.    Clean the screen to get the maximum work area.



Clear
Delete the selection. The original is removed from the file.



Close
Close the current file or active window.



Close & Return
Close the current file or active window, and return to the original application.



Column menu
The Column menu appears when you are in Design and select a column in a report.

Column Properties

Report Properties 

Find>
• Find    
• Find Assistant 

Sort>
• Ascending 
• Descending 

Arrange>
• Bring to Front 
• Send to Back 
• Bring Forward 
• Send Backward 

Align 

Group 

Ungroup 

Delete Report 

Duplicate Report 

Delete Page 

Duplicate Page 

Add Field 

Add Header 

Add Footer 

Add Title Page 

Insert>
• Today's Date 
• Current Time 
• Page Number 

Groups & Totals> 
• Sum 
• Average 
• Count 
• Minimum 
• Maximum 
• Standard Deviation 
• Variance 



• Leading Summary 
• Trailing Summary 

Show Title Page 

Turn on Columns 

Edit OLE Object 

Named Style 

Fast Format 



Column Properties
Open the InfoBox to modify the properties of the selected column.



Copy
Copy the selection to the Clipboard. The original remains in the file.



Copy View
Copy the current view to the Clipboard.



Count
Calculate the number of items in the selected column. Display the count at the end of the column if no summary 
bands exist, or in all summary bands.



Create
Define named chart styles to apply to other charts.



Create menu

Form 

Report 

Worksheet 

Crosstab 

Chart 

Form Letter 

Mailing Label 

Envelope 

Repeating Panel 

Summary 

Drawing>
• Text 
• Line 
• Ellipse 
• Rectangle 
• Rounded Rectangle 

Control>
• Field Box 
• Radio Button 
• Check Box 
• PicturePlus Field 
• Chart  
• Button 
• Custom Control 

Custom Menu 

Named Find/Sort 

Join 

Field Definition

Object 
 



Crosstab
Create a new crosstab using the Crosstab Assistant.



Crosstab menu
The Crosstab menu appears when you are viewing a crosstab.

Crosstab Properties

Find>
• Find 
• Find Assistant 
• Find Again 
• Find All 

Delete Crosstab 

Duplicate Crosstab 

Add Field 

Select>
• Header Only 
• Cells Only 

Edit Column Label 

Summarize Rows 

Summarize Columns 

Chart this Crosstab 

Drill Down to Data 

Refresh Data 

Named Style 

Fast Format 



Crosstab Properties
Update the crosstab name, printing information, and attached macros. 



Current Time
Insert the current time in the selected field.



Custom Control
Insert a custom designed control. Custom controls are OLE objects with .OCX extensions. Add custom controls to the
Tools palette for easy access.



Custom Menu
Create and modify menus for using in Browse.



Cut
Cut the selection to the Clipboard. The original is removed from the file.



Define
Define a sort order.



Delete Approach File
Delete an Approach file or database.



Delete Found Set
Delete all the records in the found set.



Delete Page
Delete the current page.



Delete Record
Delete the selected record(s).



Delete [View]
Delete the current view (form, report, worksheet, etc.).



Descending
Sort data in a selected field in descending order.



Design
Change to Design to edit and layout views. You can edit forms, reports, form letters, and mailing labels. A context-
sensitive menu item appears depending on the view or object you select.



Dial
Dial the phone number in the selected field, or dial a number manually. 



Double Line
Put double line spacing between lines.



Drill Down to Data
Display records from the selected region of the crosstab on the designated drill-down view.



Duplicate Page
Duplicate the current page.



Duplicate Record
Duplicate the selected record(s).



Duplicate [View]
Duplicate the current view (form, report, worksheet, etc.).



Edit Column Label
Edit the label of the selected column.



Edit menu

Undo 

Cut 

Copy 

Copy View 

Paste 

Clear 

Select All 

Paste Special 

Picture>
• Import 
• Export 

Find & Replace Text 

Check Spelling 

Manage Links 

Record Transcript 

Show Script Editor 

Macros 

Run Macro 



Edit OLE Object
Edit the selected OLE object. 



Edit Route
Edit the route of a message sent to you, so it goes to the next recipient in the list.



Ellipse
When in Design, draw a circle or an ellipse. Hold down SHIFT to draw a circle. This is the same as selecting the 
Ellipse tool in the Tools palette.



Envelope
Create a new envelope using the Envelope Assistant. 



Envelope menu
The Envelope menu appears when you are in Design and select an envelope.

Envelope Properties

Add Field 

Delete Envelope

Duplicate Envelope 

Delete Page 

Duplicate Page 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 



Envelope Properties
Open the InfoBox to modify the properties of the selected envelope.



Exit Approach
End the Approach session. Approach prompts you to save all unsaved files.



Exit & Return
End the Approach session and return to the originating application.



Export
Copy the selected graphic to a file.



Export Data
Export data to other data formats. You can export selected or all records from selected or all fields.



Fast Format
Pick up and apply attributes of one object to another.



Field Box
When in Design, draw a field box. This is the same as selecting the Field Box tool in the Tools palette.



Field Definition
Create new fields, and define field types and options.



Field Value
Insert special symbols to display field data.



File menu

New Database 

Open 

Open/Edit SQL 

Close 

Close & Return 

Save Approach File 

Save As 

Save View As 

Delete Approach File 

Import Approach File 

Import Data 

Export Data 

Approach File Properties 

TeamMail>
• Send New Message 
• Send to Next Stop 
• Edit Route 

TeamSecurity 

Internet>
• Publish as Web Pages(s) 
• Open from Internet 
• Save to Internet 
• FTP Connection Setup 

Print 

Print Preview 

Page Setup 

User Setup>
• Approach Preferences 
• SmartIcons Setup 

Exit Approach 

Exit & Return 

Recent files list 



Fill Field
Fill the selected field in every record in the found set, with a predefined value.



Find Again
Display the previous find conditions so you can narrow the search.



Find All
Display all the records in the database. This is the same as clicking Find All on the action bar.



Find Assistant
Search for records using the Find Assistant.



Find
Search for records based on selected criteria. This is the same as clicking Find on the action bar.



Find & Replace Text
Find specified text and optionally change it.



Form
Create a new form using the Form Assistant.



Form Letter
Create a new form letter using the Form Letter Assistant.



Letter menu
The Letter menu appears when you are in Design and select a form letter.

Form Letter Properties 

Add Field 

Delete Form Letter 

Duplicate Form Letter 

Delete Page 

Duplicate Page 

Insert>
• Today's Date 
• Current Time 
• Field Value 



Form Letter Properties
Open the InfoBox to modify the    of the selected form letter.



Form menu
The Form menu appears when you are in Design, and viewing a form with nothing selected.

Form Properties 

Delete Form 

Duplicate Form 

Delete Page 

Duplicate Page 

Add Page 

Add Field 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 



Form Properties
Update the form name, margin, border, and fill information, and attached macros.



FTP Connection Setup
Configure Internet connection options.



Full Justify
Align selected text flush with the left and right sides of text block.



Group
Group selected objects.



Header Only
Select only the header in a highlighted column.



Help menu

Help Topics 

Lotus Internet Support>
• Lotus Home Page 
• Lotus Customer Support 
• Lotus FTP Site 

Year 2000

About Approach 



Help Topics
Display a list of Help Topic categories, or the Help index.



Hide Record
Hide the selected record(s).



Import Approach File
When in Design, insert an existing Approach file.



Import
Insert a graphic or OLE object from a file. You can link the picture to the original, so if the original changes, Approach 
updates the picture in the file.



Import Data
Add or merge data from different data formats.



Italic
Italicize selected text.



Join
Join databases together to create relationships. You can use fields from joined databases in a view.



Leading Summary
Group the selected column; create a summary band at the beginning of the group. 



Left
Align selected text to the left.



Legend
Update the selected chart's legend. Changes the font and frame style and color, and position in relation to the chart.



Line
When in Design, draw a line. Hold down SHIFT to draw a vertical, horizontal or45 degree diagonal line. This is the 
same as selecting the Line tool in the Tools palette.



Lotus FTP Site
Connect to the Internet and access the Lotus FTP site.



Lotus Home Page
Connect to the Internet and view the Lotus Home Page.



Lotus Customer Support
Connect to the Internet and view the Lotus Customer Support page.



Macros
Edit, create, copy, delete, or run macros to automate tasks.



Mailing Label
Create a new mailing label using the Mailing Label Assistant.



Mailing Label menu
The Mailing Label menu appears when you are in Design and select a label.

Mailing Label Properties

Find>
• Find    
• Find Assistant 

Sort>
• Ascending 
• Descending 
• Define 

Delete Mailing Label

Duplicate Mailing Label

Delete Page 

Duplicate Page    

Add Field 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 



Mailing Label Properties
Open the InfoBox to modify the properties of the selected mailing label.



Manage Links
Edit, delete, or update links to data in other Windows applications. You can choose to create automatic or manual 
links to the original file.



Maximum
Display the maximum value in the selected column if no summary bands exist, or in all summary bands.



Minimum
Display the minimum value in the selected column if no summary bands exist, or in all summary bands.



Named Find/Sort
Create a named find/sort.



Named Style
Define, edit, and apply named styles to objects.



New Database
Create a new database and Approach file.



New Record
Create a new record. This is the same as clicking New Record on the action bar.



Normal
Remove style and formatting from selected text.



Note
Update the selected chart's note properties. You can change the font and frame style and color, and the position of 
the note in relation to the chart.



Object
When in Design, insert an OLE object into the current view.



Context Object menu
The Object menu appears when you are in Design and select a field, button, line, rectangle, ellipse or rounded 
rectangle. One other Properties command, for the view, also appears.
The Context Object menu appears when you are in Design and select a field, button, line, rectangle, ellipse or 
rounded rectangle. 
If you select an OLE object, the menu name reflects the type of object, for example Bitmap Image, and the Edit 
command appears for the object. 
A Properties command for the type of object appears in the menu. One other Properties command, for the view, also 
appears. 

Context Object Properties 

Form Properties 

Report Properties

Worksheet Properties 

Crosstab Properties 

Chart Properties 

Form Letter Properties 

Mailing Label Properties 

Envelope Properties 

Arrange>
• Bring to Front 
• Send to Back 
• Bring Forward 
• Send Backward 

Align 

Group 

Ungroup 

Delete [View] 

Duplicate [View] 

Delete Page 

Duplicate Page 

Add Field 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 

Edit OLE Object 



Named Style 

Fast Format 



Object Properties
Open the InfoBox to modify the properties of the selected object.



Open
Open an existing Approach file or database.



Open/Edit SQL
Open an SQL file.



Open from Internet
Download a read-only .APT file containing Approach views and data from an Internet server, or a read-only .HTM file 
from the Internet.



Page Number
Insert a special symbol to display the current page. The page number appears in Design, Print Preview, or when you 
print the report.



Page Setup
Change the page settings.



Paste
Insert the Clipboard contents at the cursor or last placed clicked.



Paste Special
Insert the Clipboard contents as a linked object, embedded object or other special format.



PicturePlus Field
When in Design, draw a PicturePlus field. This is the same as selecting the PicturePlus tool in the Tools palette.



Plot
Update the selected chart's plot properties. 



Previous Value
Insert the contents of the field in the previous record in the selected field.



Print
Print the current view.



Print Preview
Preview the current view.



Publish as Web Page(s)
Save the current view as an .HTM file, and upload the file to your preferred Web server in a single step.



Radio Button
When in Design, draw a radio button. This is the same as selecting the Radio Button tool in the Tools palette.



Recent files list
Open a recently accessed file.



Record Transcript
Record a transcript of the actions you perform in Approach.



Rectangle
When in Design, draw a square or rectangle. Hold down SHIFT to draw a square. This is the same as selecting the 
Rectangle tool in the Tools palette.



Refresh Data
Update the data to display changes made by others working in the same file.



Repeating Panel
When in Design, add a panel to list records from a related database.



Report
Create a new report using the Report Assistant.



Report menu
The Report menu appears when you are in Design and select a report.

Report Properties 

Find>
• Find    
• Find Assistant 

Sort>
• Ascending 
• Descending 
• Define 

Delete Report 

Duplicate Report 

Delete Page 

Duplicate Page 

Add Field 

Add Header 

Add Footer 

Add Title Page 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 

Show Title Page 

Turn on Columns 

Named Style 

Fast Format 



Report Properties
Open the InfoBox to modify the report's properties. You can change the report name, view options, and associated 
macros.



Right
Align selected text to the right.



Rounded Rectangle
When in Design, draw a square or rectangle with rounded corners. Hold down SHIFT to draw a rounded square. This 
is the same as selecting the Rounded Rectangle tool in the Tools palette.



Run Macro
Run the selected macro. Macros only appear in this menu if you chose Show in Menu when you created or edited it.



Save Approach File
Save the current Approach file.



Save As
Save a copy of the current Approach file and database. You can save the copy with or without data and password 
protection.



Save Copy as File
Save a copy of the current Approach file and database.



Save to Internet
Save views and data as an .APT file and upload it to an Internet server directory.



Save View As
Save form, worksheet, crosstab or report views in .HTM, .TXT, or .RTF file format.



Select All
In Design, select all objects in the current view. 
In Browse, select the contents of the current field box.



Send Backward
Send the selected object(s) one layer backward.



Send New Message
Send or route a message through your E-Mail system, including the current or all views in the current database.



Send to Back
Place the selected object(s) behind other objects.



Send to Next Stop
Send a message to the next recipient.



Series
Update the selected chart's series properties. You can change the color and type of each series in the chart.



Series Labels
Update the selected chart's series labels properties. 



Set Default Chart
Set a default chart type and style. Approach creates new charts using this default type.



Shortcut menus

 Are you in Design?
When you click the right mouse button on a view or object, a shortcut menu appears. 
The shortcut menu lists the most frequently used commands for the selected view or object. 



Show Action Bar
Show or hide the action bar. Hide the action bar to enlarge your work area.



Show Data
When in Design, display actual data instead of field names.



Show Grid
When in Design, show or hide the grid lines.



Show Internet Tools
Show or hide the Internet Tools palette.



Show Panel Labels
When in Design, show or hide the report panel labels.



Show Rulers
When in Design, show or hide the ruler.



Show Script Editor
Open the LotusScript Editor window.



Show SmartIcons
Show or hide the SmartIcons. Hide SmartIcons to enlarge your work area.



Show Status Bar
Show or hide the status bar. Hide the status bar to enlarge your work area.



Show Tab Order
When in Design, change or review the tab order.



Show Title Page
Show or hide the report title page.



Show Tools Palette
When in Design, show or hide the Tools palette.



Show View Tabs
Show or hide the tabs at the top of each view. Hide view tabs to enlarge your work area.



Single Line
Put a single-line space between lines.



SmartIcons Setup
Modify and save sets of SmartIcons.



Snap to Grid
When in Design, snap objects to the grid.



Standard Deviation
Calculate the standard deviation of the values in the selected column. Display the calculation at the end of the column
if no summary bands exist, or in all summary bands.



Strikethrough
Strike a line through selected text.



Summarize Columns
Add crosstab columns to summarize the data.



Summarize Rows
Add crosstab rows to summarize the data.



Summary
When in Design, add a panel that groups data in a report.



Sum
Sum the values in the selected column. Display the total at the end of the column.



Table
Update the selected chart's table properties. 



TeamSecurity
Define privileges and passwords for Approach files, databases, and views.



Text
When in Design, draw a text box. This is the same as selecting the Text tool in the Tools palette. 



Text menu
The Text menu appears when you are in Design and select a text block in a view. One other Properties commands, 
for the view, also appears.

Text Properties 

Form Properties 

Report Properties 

Form Letter Properties 

Envelope Properties 

Mailing Label Properties 

Normal 

Attributes>
• Bold 
• Italic 
• Underline 
• Strikethrough 

Alignment>
• Left 
• Center 
• Right 
• Full Justify 

Line Spacing>
• Single Line 
• 1.5 Line 
• Double Line 

Delete [View] 

Duplicate [View] 

Delete Page 

Duplicate Page 

Insert>
• Today's Date 
• Current Time 
• Page Number 
• Field Value 



Text Properties
Open the InfoBox so you can change the style and properties of the selected text block.



Tile Left-Right
Arrange active windows side by side.



Tile Top-Bottom
Arrange active windows horizontally.



Title
Update the selected chart's title. Changes the font and frame style and color, and position of the title in relation to the 
chart.



Today's Date
Insert the current date in the selected field.



Trailing Summary
Group the selected column, create a summary band at the bottom of the group.



Turn on Columns
Keep heading and column together as you move them.



Underline
Underline selected text.



Undo
Reverse the last command or action.



Ungroup
Ungroup selected grouped objects.



Variance
Calculate the variance of the values in the selected column. Display the variance at the end of the column if no 
summary bands exist, or in all summary bands.



View menu

Browse & Data Entry 

Design 

Zoom In 

Zoom Out 

Zoom To>
• 25% 
• 50%
• 75%
• 85%
• 100%
• 200%

Show Data 

Show Grid 

Snap to Grid 

Show Rulers 

Show Tools Palette 

Show Panel Labels 

Show Tab Order 

Show SmartIcons 

Show Internet Tools 

Show Status Bar 

Show Action Bar 

Show View Tabs 

Clean Screen 



Window menu

Tile Left-Right 

Tile Top-Bottom 

Cascade 

Active Windows 



Worksheet
Create a new worksheet using the Worksheet Assistant.



Worksheet menu
The Worksheet menu appears when viewing a worksheet.

Worksheet Properties 

Find>
• Find 
• Find Assistant 
• Find Again 
• Find All 

Sort>
• Ascending 
• Descending 
• Define 

Delete [View] 

Duplicate [View] 

Records>
• New 
• Duplicate 
• Hide 

Delete>
• Selected Records 
• Found Set 

Add Field 

Add Column 

Fill Field 

Dial 

Insert>
• Today's Date 
• Current Time 
• Previous Value 

Select>
• Header Only 
• Cells Only 

Edit Column Label 

Refresh Data 

Named Style 

Fast Format 



Worksheet Properties
Update the worksheet name, printing information and attached macros. 



X Axis & Grids
Update the selected chart's X axis and grid properties.



Y Axis & Grids
Update the selected chart's Y axis and grid properties.



Zoom In
When in Design or Print Preview, enlarge the current view. In Print Preview, the cursor changes to a mouse. Click the 
right and left mouse buttons to enlarge or reduce the view respectively.



Zoom Out
When in Design or Print Preview, reduce the current view.



Zoom to 100%
When in Design or Print Preview, change the view to actual size.



Zoom to 200%
When in Design or Print Preview, change the view to twice the actual size.



Zoom to 25%
When in Design or Print Preview, change the view to 25% of the actual size.



Zoom to 50%
When in Design or Print Preview, change the view to 50% of the actual size.



Zoom to 75%
When in Design or Print Preview, change the view to 75% of the actual size.



Zoom to 85%
When in Design or Print Preview, change the view to 85% of the actual size.



Z Axis
Update the selected chart's Z axis and grid properties. This command is only available when the chart is a 3D chart.



Abs
Abs(number) returns the absolute value of number. 
The absolute value is the positive equivalent of a number.

Examples
• Abs(6.8) returns 6.8
• Abs(-6.8) returns 6.8
• Abs(0) returns 0
• Abs(Total) returns 10, where the Total field contains -10



Acos
Acos(number) returns the arc cosine of number, where number is between -1 and 1.
The arc cosine is expressed in radians in the range 0 to pi.
Use Degree to convert radians to degrees.

Examples
• Acos(0.75) returns 0.7227342478134
• Degree(Acos(Result)) returns 90, where the Result field contains the value 0.00



Asc
Asc('character') returns the ASCII value of character.
If you give more than one character as a parameter, Asc returns a value for the first character only.
See also Chr.

Examples
• Asc('a') returns 97, the ASCII value of a
• Asc('Aqua') returns 65, the ASCII value of A



Asin
Asin(number) returns the arc sine of number, where number is between -1 and 1. 
The arc sine is expressed in radians in the range -pi/2 to pi/2.
Use Degree to convert radians to degrees.

Examples
• Asin(0.5) returns 0.5235987755983
• Degree(Asin(Result)) returns 30, where the Result field contains the value 0.5



Atan2
Atan2(number1,number2) returns the arc tangent of number1 divided by number2. 
The arc tangent is expressed in radians in the range -pi to pi.
Use Degree to convert radians to degrees.

Example
Atan2(0.75,-1.25) returns 2.6011731533192



Atan
Atan(number) returns the arc tangent of number. 
The arc tangent is expressed in radians in the range -pi/2 to pi/2.
Use Degree to convert radians to degrees.

Example
• Atan(-1.25) returns -0.8960553845713
• Degree(Atan(Result)) returns -45, where Result field contains the value -1.00



Avg
Avg(number1, number2, ... numberN) calculates the average of the listed values within the same record. 
If any fields in number list are blank, those fields are not included in the average. To consider a zero value in the 
average, enter a zero (0) in the field. Any number of fields can be in the list.
The fields must all be in the same record. 
To average values over a range of records, use SAverage.

Examples
• Avg(2.8,-5.6,14,5.9) returns 4.275
• Avg(Score1,Score2,Score3) returns 4, where the Score1 field contains 3, Score2 contains 8, and Score3 contains

1
• Avg(Score1,Score2,Score3) returns 5.5, where the Score1 field contains 3, Score2 contains 8, and Score3 is 

blank
• Avg(Score1, Score2, Score3) returns 3.7, where the Score1 field contains 3, Score2 contains 8, and Score3 

contains 0.



Blank
Blank(field,value) returns value if field is blank; otherwise, Blank returns the value in field.
Value can be any type (text, numeric, date, time, or Boolean) but should match the type of field.

Examples
• Blank(Cost,2.75) returns 3.95, where the Cost field contains 3.95
• Blank(Cost,Minimum) returns 2.5, where the Cost field is blank and Minimum contains 2.5



Chr
Chr(number) returns the ASCII character for number.
See also Asc.

Examples
• Chr(97) returns a
• Chr(65) returns A



Combine
Combine(list) concatenates all text strings in list to form one text string.

Examples
Combine('Monthly ','Expenses') returns Monthly Expenses. Because these parameters are text strings, the space is 
included inside the quotation marks (after Monthly).
Combine("First Name",' ',"Last Name") returns Mary Jones, where the First Name field contains Mary and Last Name 
contains Jones. The second parameter is a space. Because the other parameters are field names, the space could 
not be included with them.
Combine(City,', ',State,' ',Zip) returns San Francisco, California 94504, where the City field contains San Francisco, 
State contains California, and Zip contains 94504.
Combine(Company,Chr(10),Chr(13)) returns Blue Moon followed by a return and a new line, where the Company 
field contains Blue Moon, 10 is ASCII value for a return, and 13 is the ASCII value for a new line.



Cos
Cos(number) returns the cosine of number, where number is expressed in radians. 
The result is always between -1 and 1.
Use Radian to convert degrees to radians.

Examples
• Cos(1.243) returns 0.330465108
• Cos(Radian(Result)) returns 0.5, where the Result field contains 60



CurrTime
CurrTime() returns the current time on the system clock. 
CurrTime does not use any parameters.

Example
CurrTime() returns 1:15:00, where the system-clock time is 1:15:00



DateToText
DateToText(date,'format') converts date to a text string.
Use DateToText in formulas involving text or text-oriented functions, or for display or export. For information about 
specifying format, see Formatting dates.

Example
• DateToText(Date,'MMM DD, YYYY') returns Jan 11, 1994, where the Date field contains the date 1/11/94

Use the following formula to convert a date to the quarter when it occurs:
• DateToText(ORDERS.Date,'YY 4Q') returns 91 1Q where the Date field contains January 12, 1991



Date and time constants
Date and time constants require the order and separator specified by the operating system settings. Generally, date 
constants require slashes (/) and time constants require colons (:).
Approach gives the results of time calculations as numbers represented in hundredths of a second. Format these 
results using the Time function.

Unit In hundredths of a second
second 100
minute 6,000
hour 360,000
day 8,640,000

{button ,AL(`H_INSERTING_DATES_OR_TIMES_STEPS;H_OPERATORS_OVER;',0)} See related topics



Date
Date(month,day,year) returns a date corresponding to numbers in month, day, and year. 

Examples
• Date(10,31,1993) returns October 31, 1993
• Today() - Date(1,1,1996) returns the number of days between today and the beginning of 1996.



DayName
DayName(number) returns the name of the day corresponding to number.
number must be from 1 to 7, with 1 being Sunday, or a date enclosed in single quotation marks.

Examples
• DayName(5) returns Thursday
• DayName('1/1/94') returns Saturday
• DayName(Date) returns Sunday, where the Date field contains the date 1/2/94



DayOfWeek
DayOfWeek(date) returns a number representing the day of the week in date.
Sunday = 1, Monday = 2, and so on.

Examples
• DayOfWeek('1/1/94') returns 7
• DayOfWeek(Date) returns 7, where the Date field contains the date 1/1/94
• "Start date" - DayOfWeek("Start date") + 1 returns a number representing the first day of the week (Sunday) in 

which the date falls.



DayOfYear
DayOfYear(date) returns a number representing the number of days since January 1 of the year in date.

Example
DayOfYear('2/1/94') returns 32



Day
Day(date) returns a number from 1 to 31, representing the day of the month for date.

Examples
• Day('10/31/93') returns 31
• Day(Date) returns 25, where the Date field contains the date 3/25/94



Degree
Degree(radians) converts radians from radians to degrees. 
All Approach trigonometric functions return radians. 

Examples
• Degree(2) returns 114.5915590261646
• Degree(Acos(Result)) returns 90, where the Result field contains the value 0.00



Exact
Exact(text1,text2) compares text1 and text2. 
If the two strings match exactly, including case, Exact returns Yes; if they do not match, Exact returns No.
See also Like.

Examples
• Exact('receipts','receipts') returns Yes
• Exact ('ORDER','Order') returns No
• Exact (STATE, 'California') returns No when the text in the field STATE is CalAfornia



Exp
Exp(number) calculates the constant e to the power of number. 
The constant e is the base of the natural logarithm, equal to 2.718281828545904.

Example
Exp(5) returns 148.413159102657660



Factorial
Factorial(number) returns the factorial of number.
If number has decimals, Factorial truncates the decimals.

Example
Factorial(4) returns 24 (that is, 4*3*2*1)



Fill
Fill(text,number) returns text repeated number times. 

Example
Fill('Baden',2) returns BadenBaden



Formulas
Follow the guidelines given here to create a formula. For a list of tasks that might need a formula, see the section 
called "When might I need to write a formula?" at the end of this topic.

Double-click items to ensure accuracy
Type as little of the formula as possible; instead, select items for your formula by double-clicking them.
When you double-click items from the "Fields," "Operators," and "Functions" drop-down boxes, Approach enters them
correctly in the "Formula" box. 
For example, if you select a field name instead of entering it, Approach automatically surrounds it with quotation 
marks if it contains spaces or special characters.

How to get rid of the X on the flag
When you generate a formula that works (that is, Approach can calculate a value using the formula), the checkered 
flag is no longer crossed out:

Approach evaluates the formula and enters the result in the field or completes the find.

Components of a formula
Use these components to write a formula:

• Functions 
• Operators 
• Constants 
• Field references 

Unexpected field types in formulas
If the field type of a field used in a formula does not match what Approach expects to use in the formula, Approach 
converts the data to the type it expects.
For example, suppose a field called Amount_Due is defined as a text field, even though it would work better as a 
numeric field. Approach can still use the numbers in Amount_Due in a formula that multiplies each number by 0.05, to
find the commission due on the sale.

Null values in fields
If a field that is used in a formula is blank (it has a null value or no value), Approach cannot use it in a calculation. If 
you want Approach to use the field even when users have not entered anything in it, define a default value for the 
field.

Order of precedence
Approach evaluates a formula from left to right, performing multiplication and division first and then addition and 
subtraction. To change the order that the formula is calculated, use parentheses to enclose the expressions you want 
evaluated first. For example:

• 4 + 8 * 3 equals 28
• (4 + 8) * 3 equals 36

When might I need to write a formula?
You must write a formula when you define a calculated field. 
You might also write a formula when doing any of the following tasks:

Adding formula columns to worksheets 
Entering data automatically in a field
Entering the same data into many records
Summarizing data of records in reports 
Summarizing data of records in repeating panels
Using the Run macro command 
Using the Set macro command    



Verifying the accuracy of entered data

Writing a formula to use in a find
You can use a formula to find field values. The Formula dialog box, however, is not available during a find.
Tip If you want to use the Formula dialog box to write    an accurate formula for a find, do the following:
1. Go to Browse.
2. From the Browse menu, choose Fill Field.
3. Click Formula.

The Formula dialog box appears.
4. Write the formula.
5. In the "Formula" box, highlight the entire formula and press CTRL+C to copy the formula to the Clipboard.
6. Click Find in action bar.
7. In the blank view, select the field you want to use in the find.
8. Press CTRL+V to paste the formula into the field.
9. Click OK.

{button ,AL(`H_FUNCTIONS_ALPHA_REF;H_FUNCTIONS_OVER;H_CREATING_FIND_REQUESTS_STEPS',0)} 
See related topics



Functions

Click a function name for information about it.

A

Abs 
Acos 
Asc 
Asin 
Atan 
Atan2 
Avg 

B

Blank

C

Chr 
Combine 
Cos 
CurrTime 

D

Date 
DateToText 
Day 
DayName 
DayOfWeek 
DayOfYear 



Degree 

E

Exact 
Exp 

F

Factorial 
Fill 
FV 

G

(None)

H

Hour 
Hundredth 

I

If 
IsBlank 
IsLastRecord 

J

(None)

K

(None)

L

Left 
Length 
Like 
Ln 
Log 
Lower 

M

Middle 
Minute
Mod 
Month 
MonthName 

N

NPeriods 
NumToText 



NumToWord 

O

(None)

P

Pi 
PMT 
Position 
Pow 
Prefix 
Proper 
PV 

Q

(None)

R

Radian 
Random 
Replace 
Right 
Round 

S

SAverage 
SCount 
Second 
Sign 
Sin 
SLN 
SMax 
SMin 
SNPV 
SoundsLike 
Span 
SpanUntil 
Sqrt 
SSTD 
SSum 
STD 
Svar 

T

Tan 
TextToBool 
TextToDate 
TextToTime 
Time 
Today 
Translate 
Trim 



Trunc 

U

Upper

V

Var

W

WeekOfYear

X

(None)

Y

Year

Z

(None)



Functions are built-in formulas
Functions are built-in formulas that perform a specialized calculation automatically, often by using values that you 
supply.
Some functions perform simple calculations. For example, the functon Abs returns the absolute value of a number.
Many functions, however, can save you time by performing complex calculations. For example, the function SNPV 
calculates the net present value of an investment based on a series of periodic cash flows and a discount rate.

Where are the functions in Approach?
Wherever you might need to write a formula, Approach gives you access to the Formula dialog box. Approach 
displays the list of functions in that dialog box. You can use functions alone or inside a larger formula.

Parts of a function: name, parentheses, parameters
A function consists of a name and a pair of parentheses, for example, CurrTime(). 
Often, Approach requires you to supply more information in the function. Put this information, called a parameter, 
inside the parentheses.

• Parameters can be constants, field references, expressions, or other functions. 
• You must use the same number of parameters given in the syntax and match the order shown for them. 
• You must separate multiple parameters with commas or another separator specified in your operating system 

settings. If you double-click a function to add it to the "Formula" box, Approach supplies the separators 
automatically.

Example: Supplying the parameters of a function
Suppose you double-click the function DateToText. Approach enters the function in the "Formula" box this way:
DateToText( , )
Below the "Formula" box, a description of the function shows you the parameters you must supply:
DateToText(date, format)
When you fill in the parameters for the function, it might look like this:
DateToText(5/5/95,'MMM DD,YYYY')
Note When you write a formula, type only what you have to. The more components you select from the "Fields," 
"Operators," and "Functions" boxes, the more you ensure the accuracy of the formula.

Functions in finds and If statements
• When you use a function in a find, precede the function name with @ (at sign). 
• When you use a function in an If statement, do not use the @.

{button ,AL(`H_FORMULAS_OVER;H_FUNCTIONS_ALPHA_REF;H_OPERATORS_OVER;',0)} See related topics



FV
FV(payment,rate,periods) calculates the future value of an investment given payment, periodic interest rate, and 
number of periods.
The formula used is
(payment * ((rate + 1)^periods - 1))/i
where periods is an exponent and i is the square root of -1.
Note The period used to calculate rate must be the same period used for periods. For example, if you are calculating
a monthly payment, enter the rate and periods in monthly increments. Usually, this means you must divide the 
interest rate by 12 and multiply the number of years in periods by 12.

Example
To calculate the value of an investment in which you pay $50 per month for five years at 11% annual interest, the 
formula is as follows:
FV(50,.11/12,5*12) returns 3975.90 
The second parameter specifies the rate as 11% over 12 months.



Hour
Hour(time) returns a number representing the hours in time.

Examples
• Hour('10:12:19') returns 10
• Hour(Time) returns 9, where the Time field contains the time 9:12:19.14



Hundredth
Hundredth(time) returns a number representing the hundredths of a second in time.

Examples
• Hundredth('12:15:23.34') returns 34
• Hundredth(Time) returns 14, where the Time field contains the time 8:15:30.14



If
If(condition,true value,false value) evaluates condition as true or false and returns true value if true and false value if 
false.
You can nest an If function inside another If function.

Examples
• If(State='CA','Yes','No') returns No, where the State field contains the text AZ
• If(Total>=1000,50,0) returns 50, where the Total field contains the value 1234
• If(Amount<1000,0,If(Amount<2000,50,100)) returns

• 0, where the Amount field contains a value less than 1000
• 50, where the Amount field contains a value greater than 1000 and less than 2000
• 100, where the Amount field contains a value greater than 2000

• If(Amount>1000 AND Type='B',200,100) returns
• 200, where the Amount field contains a value greater than 1000 and the Type field contains B
• 100, where the Amount field contains a value less than 1000 or the Type field does not contain B



IsBlank
IsBlank(field) returns Yes if field is blank; otherwise, IsBlank returns No.

Examples
• IsBlank(Customer) returns No, where the Customer field contains a value
• If(IsBlank(Quantity),100,Quantity) returns

• 100, where the Quantity field is blank 
• Value of Quantity, where the Quantity field contains a value



IsLastRecord
IsLastRecord() returns Yes if the current record is the last record in the sort order of the found set; otherwise, 
IsLastRecord returns No.

Example
This example uses IsLastRecord to update a variable field, Current State.
If(IsLastRecord(),'CA',"Current State") returns

• CA if the current record is the last record
• NM if the current record is not the last record, where Current State contains NM

.



Left
Left(text,number) returns the specified number of characters in text, counting from the left.

Examples
• Left('Mississippi',2) returns Mi
• Left(State,2) returns Ca, where the State field contains California
• Combine(Alpha1,Left(Alpha2,3)) returns ABCDEF, where the Alpha1 field contains ABC and the Alpha2 field 

contains DEFG



Length
Length(text) returns the number of characters in text, including all spaces, numbers, and special characters.

Examples
• Length('Customer No.') returns 12
• Length(SalesRep) returns 5, where the SalesRep field contains Jerry
• Length(Combine(Item1,Item2)) returns 11, where the Item1 field contains Orange and the Item2 field contains 

Lemon



Like
Like(text1,text2) compares text1 and text2. 
If the two strings match (without considering case), Like returns Yes; if they do not match, Like returns No.
You can use these wildcards in text2:

Wildcard Represents
* Any number of characters 

including zero or no 
characters

? One character
See also Exact.

Examples
• Like('Cola','cola') returns Yes
• Like ('their','th*r') returns Yes
• Like('their','th?r') returns No
• Like(Color1,Color2) returns Yes, where the Color1 field contains red and Color2 contains R?D
• Like(SalesRep,Combine('*',Contact,'*')) returns

• Yes, where the SalesRep field contains Jerry Jones and Contact contains Jerry
• No, where the SalesRep field contains Jerry Jones and Contact contains Paul

• If(Like(SalesRep,Contact),'Match','No Match') returns
• Match, where the SalesRep field contains Jerry and Contact contains Jerry
• No Match, where the SalesRep field contains Jerry and Contact contains Chris



Ln
Ln(number) returns the natural logarithm of number, where number must be positive.
This is the logarithm to the base e.

Example
Ln(10) returns 2.3025851



Log
Log(number) calculates the logarithm of number to the base 10 (decimal logarithm). 
The value returned is the power to which 10 is raised to produce number.

Example
Log(1000) returns 3



Lower
Lower(text) converts all letters in text to lowercase.

Examples
• Lower('Gourmet Emporium') returns gourmet emporium
• Lower(Country) returns usa, where the Country field contains USA



Middle
Middle(text,start,size) extracts the number of characters specified by size from text, beginning at start.

Examples
• Middle('Germany',4,3) returns man
• Middle(Product,7,8) returns Approach, where the Product field contains Lotus Approach 96



Minute
Minute(time) returns a number representing the minutes in time.

Examples
• Minute('12:10:05') returns 10
• Minute(Time) returns 11, where the Time field contains the time 12:11:05



Mod
Mod(number1,number2) divides number1 by number2 and returns the remainder. 
The result is the modulus.

Examples
• Mod(12,5) returns 2.
• Mod(Month("Start Date"),12)+1 returns the number of the next month, where the Mod function corrects for the 

change from December to January.
• Mod(Product_number,100) returns the number 05 from the last digits of a product code number, where 

Product_number contains 1010497105. Useful if the last two digits always indicate a feature of the product, like 
the product color.

Use the following time formula to convert the result into a time:
• Time(Hund_diff/360000, Mod(Hund_diff/6000,60),Mod(Hund_diff/100,60),0) returns the time duration between 

two times, where Hund_diff is the end time minus the start time. The Mod function corrects for the roll-over at the 
minute and hour. 
Note When times are used in calculations, the result (Hund_diff) is a number of hundredths of a second.



MonthName
MonthName(number) returns the name of the month corresponding to number. 
number must be from 1 to 12, with 1 being January, or a date enclosed in single quotation marks.

Examples
• MonthName(9) returns September
• MonthName('10/20/93') returns October
• MonthName(Date) returns March, where the Date field contains the date 3/29/94
• Combine('Sales for ',MonthName(Date),' ',Year(Date)) returns Sales for July 1994, where the Date field contains 

the date 7/6/94



Month
Month(date) returns a number representing the month in date.

Examples
• Month('10/20/93') returns 10
• Month(Date) returns 12, where the Date field contains the date 12/5/1995

 



NPeriods
NPeriods(rate,principal,payment) calculates the number of periods necessary to pay off principal with a periodic 
payment at a periodic interest rate specified by rate.
The formula used is
(log (payment / payment - (principal * rate))) / log (1 + rate)
Note The period used to calculate rate must be the same period used for periods. For example, if you are calculating
a monthly payment, enter the rate and periods in monthly increments. Usually, this means you must divide the 
interest rate by 12 and multiply the number of years in periods by 12.

Example
To calculate the number of $100 monthly payments required to pay off a $1000 loan with a monthly interest rate of 1 
percent, or yearly rate of 12 percent, the formula is as follows:
NPeriods(.01,1000,100) returns 11



NumToText
NumToText(number,format) converts number to a text string formatted with format. 
Use the result of NumToText with formulas involving text or text-oriented functions, or for display or export. 
See Formatting numbers.

Examples
• NumToText(200,'##0.00') returns the text string 200.00
• NumToText(5694.08,'$##,##0.00') returns the text string $5,694.08



NumToWord
NumToWord(number, number_of_decimals) converts number to words, where number_of_decimals describes how 
many decimal digits should be included in the final words.
If number contains more decimals than specified in number_of_decimals, the remaining decimals are truncated. If 
number contains fewer decimals than number_of_decimals, trailing zeros are added.
Use the result of NumToWord in printing amounts on checks.

Example
• NumToWord(25.13,0) returns Twenty five
• NumToWord(25.13,1) returns Twenty five and one tenths
• NumToWord(25.13,2) returns Twenty five and thirteen hundredths
• NumToWord(25.13,3) returns Twenty five and one hundred thirty thousandths
• Combine(NumToWord("Amount Due"),'_dollars') returns One hundred fifty two and twenty three hundredths 

dollars, when Amount Due contains 152.23



Overview: Field references, constants, and operators

Field references in formulas
A field reference instructs Approach to use the value of the field in the current record.
For example, in the formula
Quantity * 8.95
the name Quantity is a reference to the value in the Quantity field. In one record, this formula might calculate 48 * 
8.95; in another, 31 * 8.95.
When you write a formula, double-click the field name to enter a field reference in the formula. 
If you enter a field reference by typing in the formula, you must enclose the field name with double quotation marks if 
it contains spaces, periods, commas, or any of the following characters: / * + - < > ( ). For example:
"Quarterly Results"    "Results(Quarter)"      "Start/End"

References to fields in joined databases
Include the name of the database in a field reference to a joined database, and separate the database name and field
name with a period. In Approach, the database reference appears in all caps:
ORDERS.Quantity
Make sure you select a field from the correct database. For example, two databases may contain fields with the same
name:
CUSTOMERS.FirstName
SUPPLIERS.FirstName

Constants
A constant is a value that is used exactly as you type it; it does not change from one record to another. Constants can
be numbers, dates, text, times, spaces, or Boolean values. Text, spaces, dates, and times must be enclosed in single
quotation marks, like this:
'Price'
'1/1/94' + 15
'11:30:00'
"FirstName",' ',"LastName"
Enter constants directly in the formula box.

Operators
Operators are symbols that specify an arithmetic, comparison, or logical expression. 

Arithmetic operators: +    -    *    /
Values on both sides of an arithmetic operator must be numbers, dates, or times.

Comparison operators:    <    <=    =    <>    >    >=
Values on both sides of a comparison operator must be numbers, text, dates, times, or Boolean values. The 
calculation returns Yes or No.
For example, the expression Price >= 4 returns Yes if the value in the field Price is greater than or equal to 4.
Use these operators to build conditions for If functions.

Logical operators: AND, OR, NOT
Both sides of AND and OR operators must evaluate to Yes or No. The NOT operator requires one expression that 
evaluates to Yes or No.
The logical expression itself returns Yes or No.
For example, suppose the Orders field contains 462 and the ShipDate field contains the date 1/15/94:

• Orders >= 500 AND ShipDate >= '1/1/94'    returns No
• Orders >= 500 OR ShipDate >= '1/1/94' returns Yes
• NOT (Orders >= 500) returns Yes



{button ,AL(`H_FORMULAS_OVER;H_FUNCTIONS_ALPHA_REF;H_FUNCTIONS_OVER;',0)} See related topics



Pi
Pi() returns the constant 3.14159. 
This function does not use any parameters.

Example
Pi()*15 returns 47.124



PMT
PMT(principal,rate,periods) calculates the payment required to pay off a loan given principal, periodic interest rate, 
and periods.
The formula used is
(principal * rate * (1 + rate)^periods) / (1 + rate)^(periods - 1)
where periods and (periods - 1) are exponents.
Note The period used to calculate rate must be the same period used for periods. For example, if you are calculating
a monthly payment, enter the rate and periods in monthly increments. Usually, this means you must divide the 
interest rate by 12 and multiply the number of years in periods by 12.

Example
To finance $92,000 toward the purchase of office equipment at an annual interest rate of 6.9% over 48 monthly 
payments, the formula is as follows:
PMT(92000,.069/12,48) returns $2198.79 (The second parameter specifies the rate as 6.9% over 12 months.)



Position
Position(text,string,start) begins at start to scan text for the first occurrence of string, and returns a number indicating 
where the string was found in text. 
If text does not contain the search string, the result is zero.

Examples
• Position('California','if',1) returns 4.
• Position(City,' ',1) returns 7, where the City field contains Mexico City. The space is the search string.
• Left(Region,Position(Region,' ',1)-1) returns West, where the Region field contains West Central.



Pow
Pow(number1,number2) returns the value of number1 raised to the power of number2.

Examples
• Pow(2,3) returns 8
• Pow(30,8) returns 656,100,000,000



Prefix
Prefix(text1,text2) returns Yes if all the characters in text1 match the same number of characters at the start of text2; 
otherwise, Prefix returns No.

Example
• Prefix('quo','quantity') returns No
• Prefix(Item1,Item2) returns Yes, where the Item1 field contains Aqua and the Item2 field contains Aqua Spring 

Water



Proper
Proper(text) converts the first letter of each word in text to uppercase and all other letters to lowercase.

Examples
• Proper('SOS') returns Sos
• Proper('europe') returns Europe
• Proper(Region) returns Pacific Northwest, where the Region field contains Pacific northwest



PV
PV(payment,rate,periods) calculates the present value of an ordinary annuity given payment, periodic interest rate, 
and number of periods. 
An ordinary annuity is a series of payments to be made at equally spaced intervals. The present value is the value in 
today's dollars of the payments to be made or received later.
The formula used is
(payment * (((1 + rate)^periods) - 1)) / (rate * (1 + rate)^periods)
where periods is an exponent.
Note The period used to calculate rate must be the same period used for periods; for example, if you are calculating 
a monthly payment, enter the rate and periods in monthly increments. Usually, this means you must divide the 
interest rate by 12 and multiply the number of years in periods by 12.

Example
If an annuity returns $250.50 per year for 5 years and the discount rate is 12%, the formula is as follows:
PV(250.5,0.12,5) returns 902.996438
This means that the present value of the annuity is $903.



Radian
Radian(degrees) converts degrees to radians.
All Approach trigonometric functions require angles expressed in radians.

Examples
• Radian(90) returns 1.5708
• Radian(30) returns 0.5236
• Sin(Radian(60)) returns 0.866025404



Random
Random() returns a random number between 0 and 1. 
This function does not use any parameters.

Example
Trunc(Random()*10)+1 returns a random integer between 1 and 10



Replace
Replace(text1,start,size,text2) substitutes the series of characters in text1 (the original text) with those in text2 (the 
replacement text), beginning at start. 
Size specifies the number of characters to replace in original text. Replacement text can be longer or shorter than the
number specified in size, resulting in a new character string of a different length.

Example
Replace(Phone_number,1,3,'510') returns 5106330101 where Phone_number contains 4156330101. 
Be sure that you determine the size from the value in the database rather than the formatted value in an Approach 
view. In this case, Phone_number may be formatted to appear as (415) 633-0101; however, the value stored in 
Phone_number does not include the punctuation or spacing.



Right
Right(text,number) returns number of characters in text, counting from the right.

Examples
• Right('sideview',4) returns view.
• Right(Region,4) returns Asia, where the Region field contains Southeast Asia.
• Right(Name,Length(Name) - Position(Name,' ',1)) returns the text to the right of the space in Name, as specified 

by the Position function. So, this example would return the last name, where the Name field contains a first and 
last name.

• Combine(Alpha1,Right(Alpha2,3)) returns ABCGHI, where the Alpha1 field contains ABC and the Alpha2 field 
contains DEFGHI.



Round
Round(number,precision) rounds number to the number of decimal places specified by precision.
If precision is zero or not specified, Approach rounds number to the nearest integer.

Examples
• Round(23.509) returns 24
• Round(Amount,1) returns 23.8, where the Amount field contains 23.849



SAverage
SAverage(number field) returns the average of the values in number field for a summary range of records. 
If the field is blank in any of the records, those records are not included in the average.

Example
• SAverage(Amount) returns 3, where the Amount field contains 2, 3, 1, and 6 in a summary range of records
• SAverage(Amount) returns 1.25, where the Amount field contains 2, 3, 1 and 0 in a summary range of records.
• SAverage(Amount) returns 2, where the Amount field contains 2, 3, and 1 in three records and is blank in the 

fourth record in a summary range



SCount
SCount(field) returns the number of nonblank occurrences in field for a summary range of records.
Fields with blank values are not counted.

Example
• SCount(Paid) returns 5, where the Paid field contains a value in five records of the current database.
• SCount(Paid) returns 3, where the Paid field contains a value in three records of the current found set.



Second
Second(time) returns a number representing the number of seconds in time.

Examples
• Second('10:35:18') returns 18
• Second(Time) returns 20, where the Time field contains the time 8:45:20.14



Sign
Sign(number) returns -1, 0, or 1, representing whether number is negative, zero, or positive.

Examples
• Sign(21) returns 1
• Sign(-21) returns -1
• If(Sign(Profit)>=0,Profit,Combine('(',Abs(Profit),')')) returns the absolute value of Profit in parentheses if Profit is 

negative; otherwise it returns the value of Profit without parentheses.



Sin
Sin(angle) returns the trigonometric sine of angle, where angle is in radians.
The result is always between -1 and 1.
Use Radian  to convert degrees to radians.

Example
• Sin(1.243) returns 0.943818209
• Sin(Radian(60)) returns 0.866025404



SLN
SLN(cost,salvage,life) calculates the straight-line depreciation of an asset for a single period, given cost, salvage, and
life.
The formula used is
(cost - salvage) / life

Example
SLN(7500,3000,10) returns 450



SMax
SMax(field) returns the largest number or latest date or time in field for a summary range of records. 
The field can be a number, date, or time field, or a text field filled with numbers.

Examples
• SMax(Amount) returns 200, where Amount contains 25, 40, 200, and 75 in a summary range of records
• SMax("End date") returns 3/8/96, where End date contains 12/12/95, 1/13/95, and 3/8/96 in a summary range of 

records



SMin
SMin(field) returns the smallest number or earliest date or time in field for a summary range of records. 
The field can be a number, date, or time field, or a text field filled with numbers.

Examples
• SMin(Amount) returns 25, where the Amount field contains 25, 40, 200, and 75 in a summary range of records
• SMin("End date") returns 1/13/95, where End date contains 12/12/95, 1/13/95, and 3/8/96 in a summary range of 

records



SNPV
SNPV(value,discount) calculates the net present value of an investment based on a series of periodic cash flows 
(value) and discount rate. 
The net present value of an investment is today's value of a series of future payments (negative values) and income 
(positive values).

Example
Suppose that someone wanted to borrow $12,000 from you today, and would pay you an annual income of $1500, 
$4000, $3500, and $4100 in the four following years. Assuming an annual discount rate of 8 percent, the formula is 
as follows:
SNPV(Payment,.08) returns -1286.78, where the Payment field contains the values -12000, 1500, 4000, 3500, and 
4100.    SInce the number is negative, you would probably decide not to make the investment.



SoundsLike
SoundsLike(text1,text2) returns Yes if text1 sounds phonetically like text2.

Example
• SoundsLike('fill','Phil') returns Yes
• SoundsLike("Sales Rep",'Steven') returns Yes when the field Sales Rep contains Stephen or Steven



SpanUntil
SpanUntil(text1,text2) returns the number of characters in text1 that are not in text2 until it finds a match in text2.
See also Span.

Example
• SpanUntil('radio','eiu') returns 3

Use the following for finding whether a character exists in text1 at all:
• If(SpanUntil('ABCDE','F')>0, 'Yes', 'No') returns No



Span
Span(text1,text2) returns the number of characters in text1 that also exist in text2 until a character is found in text1 
that is not in text2. 
See also SpanUntil.

Examples
• Span('automobile','muato') returns 6
• Span(OrderNo,PartNo) returns 0, where the OrderNo field contains 23241 and the PartNo field contains 413
• Span(Product1,Product2), where Product1 and Product2 are codes containing digits for company, product type, 

product, and color, returns
• 1 if Product1 and Product2 are from the same company
• 2 if the products are from the same company and are the same product type
• 3 if the products are from the same company, are the same product type, and are the same product
• 4 if the products are from the same company, are the same product type, are the same product, and are the 

same color 



Sqrt
Sqrt(number) returns the square root of number.

Examples
• Sqrt(13.69) returns 3.7
• Sqrt(100) returns 10



SStd
SStd(field) calculates the standard deviation of a population given the entire population as a field within a summary 
range of records. 
The standard deviation is a measure of how widely values are dispersed from the average value (the mean). Field 
must be a numeric field or a text field filled with numbers.

Example
SStd(Score) returns 1.87, where the Score field contains 2, 3, 1, and 6 in a summary range of records



SSum
SSum(field) returns the sum of all the values in a number field for a summary range of records.
field must be a numeric field or a text field filled with numbers.

Examples
• SSum(Amount) returns 375, where the Amount field contains 100, 25, 50, and 200 in a summary range of records



Std
Std(number1,number2, ... numberN) calculates the standard deviation of a population given the entire population as 
parameters. 
The standard deviation is a measure of how widely values are dispersed from the average value (the mean).
If fields are used as parameters, they must all be in the same record. To calculate the standard deviation over a range
of records, use SStd .

Example
Std(4,5,9,2) returns 2.549510



SVar
SVar(field) calculates the variance of a population given the entire population as a summary range of records.
field must be a numeric field or a text field filled with numbers.

Example
SVar(Score) returns 3.5, where the Score field contains 2, 3, 1, and 6 in a summary range of records



Tan
Tan(angle) returns the tangent of angle, where angle is expressed in radians.
Use Radian  to convert degrees to radians.

Examples
• Tan(1) returns 1.557407725
• Tan(Radian("Height angle")) returns 1, where Height angle contains 45



TextToBool
TextToBool(text) returns No if text is N, n, No, no, or zero (0); otherwise, returns Yes.
Use TextToBool to convert text strings to values defined with the Boolean data type. You can then use these values 
as parameters in logical functions.

Examples
• TextToBool(No) returns No
• TextToBool(Answer) returns Yes



TextToDate
TextToDate(text) converts text to a date value.
Use TextToDate to convert dates imported or entered as text strings to values defined with the Date data type. You 
can then use these dates as parameters in date functions.
The date string must in the format MM/DD/YY or the date format is specified in the operating system settings for 
dates.

Example
TextToDate('1/11/94') + 30 returns 2/10/94



TextToTime
TextToTime(text) converts text to a time value.
Use TextToTime to convert times imported or entered as text strings to values defined with the time data type. You 
can then use these times as parameters in time functions.
The time string must be in the format HH:MM:SS.00 (the seconds are optional). You can also use AM or PM at the 
end of the time. 
Some countries use a different separator. Use whatever time separator is specified in the operating system settings 
for times.

Example
TextToTime('11:30PM') returns 23:30:0.0



Time
Time(hours,minutes,seconds,hundredths) returns a time corresponding to hours, minutes, seconds, and hundredths. 
See also Date and time constants.

Example
• Time(2,15,30,0) returns 2:15:30
• Hours(CurrTime() - Time (12,0,0)) returns the number of hours between the current time and 12:00 noon

Use the following to convert the result into a time:
• Time(Hund_diff/360000, Mod(Hund_diff/6000,60),Mod(Hund_diff/100,60),0) returns the difference between two 

times in the form of a time, where Hund_diff is the end time minus the start time. The Mod function corrects for the
roll-over at the minute and hour.
Note When times are used in calculations, the result (Hund_diff) is a number of hundredths of a second.



Today
Today() returns the current system date. 
This function does not use any parameters.

Example
Today() returns 2/14/96, where the system date is February 14,1996



Translate
Translate(text,character1,character2) replaces all occurrences of character1 with character2 in text.

Example
Translate('grey','e','a') returns gray
Translate('ABC CDE','C','D') returns ABD DDE



Trim
Trim(text) returns text without its leading and trailing spaces.

Examples
• Trim('New York      ') returns New York
• Trim(City) returns Paris, where the City field contains ' Paris '
• Combine(Trim("First Name"),' ',"Last Name") returns Mary Smith with correct spacing regardless of how many 

extra spaces exist in First Name



Trunc
Trunc(number,precision) truncates number to the number of decimal places specified by precision.
If precision is zero or not specified, Approach truncates the number to an integer.

Examples
• Trunc(13.1374,2) returns 13.13
• Trunc(13.1374) returns 13



Upper
Upper(text) converts all letters in text to uppercase.

Examples
• Upper('Ca') returns CA
• Upper(Country) returns KENYA, where the Country field contains Kenya



Var
Var(number1, number2, ..., numberN) returns the variance of a population given the entire population as parameters.
To calculate variance for a field over a range of records, use SVar .

Example
Var(1,4,7) returns 6



WeekOfYear
WeekOfYear(date) returns a number representing the number of weeks since January 1 of the year in date.

Example
WeekOfYear('11/15/1993') returns 47



Year
Year(date) returns a number representing the year within which date occurs. 

Examples
• Year('10/21/93') returns 1993
• Year(Date) returns 1994, where the Date field contains the date 1/1/94



action bar
A set of buttons located initially at the top of the Approach work area, below the SmartIcons. The set of buttons you 
see most often lets you

• Switch to the Browse or Design environment
• Create a new record
• Create a find request in the current view or the Find Assistant
• Execute a named find

To hide or move the bar, use the right mouse button to click the bar in a space between buttons; then choose a 
location from the menu. 
You can also drag the action bar to a new location, or let it float.



alias
A virtual copy of a database file, for use in special types of joins. An alias is not a physical duplicate of a database, 
but acts like it for the purposes of joining.
Use an alias to join a database to itself for advanced kinds of summaries and groupings, or to be able to join to a 
single database in multiple ways.



Approach file
The Approach file does not store data; instead, it stores the views you create. Through these views, you can look at 
and work with your data, which is stored in the database file(s) associated with the Approach file.

An Approach file can contain as many views (forms, reports, worksheets, and so on) as you need for your database 
application. The Approach file also stores calculated fields, variable fields, macros, and scripts.
When you create or open a database file, Approach automatically creates an Approach file for it.
Approach file extension: .APR



Approach file password
A sequence of characters you must enter before you can work in an Approach file. 

• Passwords can have up to 16 characters.
• They are not case-sensitive.

One file can have more than one password. Different passwords for the same file can give you different privileges in 
that file. 
For example, one password can give you complete access to edit and enter data in the associated databases as well 
as change the design of the views. Another password for the same file might let you do nothing except look at data. 
This is useful for files on networks; such files often must be available to many users, not all of whom should be able 
to change the file.
To define a password for an Approach file, choose File - TeamSecurity.
You can also define passwords for dBASE and FoxPro database files associated with the Approach file.



scrolling list
Three kinds of data-entry types for fields offer a predefined list of values, from which users select one value. When 
the predefined list is long enough, Approach adds a vertical scroll bar to the list. The following data-entry types are 
scrolling lists:

• Drop-down box 
• Field box and list 
• List box 



arithmetic expression
An expression that performs a basic calculation on numeric, date, or time values. For example:
ShipDate + 15    returns a date equal to 15 days from the date in the ShipDate field of the current record.
Operators used in arithmetic expressions:

+ Addition
- Subtraction
* Multiplication
/ Division



ascending order
The sort order that arranges records from

• A to Z, for text (usually case-insensitive)
• Smallest to largest, for numbers
• Earliest to latest, for dates and times



Boolean field
A field that stores a single value, either Yes or No. You can enter these values in a Boolean field:

For Yes  For No
Yes, yes No, no
Y, y N, n
1 0 

If you enter any other values (even, for example, False), Approach returns Yes.

A check box, which you define to have a checked and an unchecked value, is a good data-entry type to use with a 
Boolean field.
 



Browse
The environment in Approach for entering, editing, and viewing data in a database.
To go to Browse, do one of the following:

• Click the Browse button in the action bar.
• Click the Environment button in the status bar and select Browse.
• From the View menu, choose Browse & Data Entry.
• Press CTRL+B.

Any changes you make to records or any new records you create are saved automatically by Approach.



calculated field
A field that stores a formula using data from a record. 
Enter the formula as part of the field definition. Write the formula to calculate with data

• In one record at a time.
• Across a range of records, using a summary function. For example, SCount(Account_Name).

After you add the calculated field to a view, Approach displays the result of the formula for each record. If the formula 
uses a summary function, go to Print Preview or Design to see the result.
Calculated fields are stored in the Approach file (.APR), not the database. They appear at the bottom of the Field 
Definition list and, in italics, at the bottom of the Add Field list.



check box
A data-entry type for fields.    In Browse, to enter data in the field, you must select the check box or deselect it. 
Usually, a field is represented by only one check box.    A check box is especially useful as a data-entry type for a 
Boolean field, which accepts only Yes or No as values.
To make a field a check box: In Design, double-click the field to display the InfoBox. In the Basics tab, select Check 
boxes as the data-entry type. Define one checked value, one unchecked value, and a label for each check box.
When you first add a new field to a view and make it a check box, it appears to be deselected (no check mark). 
Actually, it has a null value--that is, the field has neither the checked value nor the unchecked value in it.    In the 
Default Value tab of the Field Definition dialog box, you can define the checked or unchecked value as default data. 
This is called initializing the check box.



client
• In network terminology, a computer used to gain access to files or applications on a network.
• In OLE terminology, an application that receives data from a server application.



column gutter
The area at the top of worksheets and crosstabs.
To add fields to a worksheet or crosstab, drag them to the column gutter.



comparison expression
An expression that compares two values and evaluates to Yes or No. For example:
Total <= 100 evaluates to Yes if the value in the Total field of the current record is less than or equal to 100; to No if 
the value is greater than 100.
Comparison expressions are useful when doing finds, creating calculated fields, and writing formulas used to validate
field data.
Operators used in comparison expressions:

< Less than
<= Less than or equal to
= Equal
<> Not equal
> Greater than
>= Greater than or equal to



compound document
A document that contains a linked or embedded OLE object. 
For example, if you have an OLE object from another application in an Approach file, the Approach file is a compound
document.



constant
A value in a formula that is used exactly as you type it; it does not change from one record to another.
Constants can be numbers, dates, text,    times, or Boolean values. Text, dates, and times must be enclosed in single 
quotation marks, like this:
'Price'
'1/1/95'
'11:30:00'



container application
An application that contains an OLE object. 
For example, if you have an OLE object from another application in an Approach file, Approach is the container 
application.



context menu
The context menu always appears between Create and Window on the menu bar.

The context menu changes depending on the selected object or view. It provides commands appropriate for the 
selected object or view.



crosstab
Also called a cross-tabulation worksheet: A view that categorizes and summarizes data from many records. For 
example, here's a worksheet in a sales database. Notice that some records repeat the same data in the same field:

A crosstab lets you collapse the five sales records into two summaries, one for each sales rep:



current record
The active record in a view. In Browse, you can enter and edit data in the current record.
In a form, the record showing is the current record.
In a worksheet, columnar report, or mailing label, the current record is the record you click. If no record is selected, 
the current record is the first record.
As you switch between views based on the same database, the current record stays the same.



database
A collection of data organized into fields and records.
An Approach file (.APR) is not itself a database, but it is associated with at least one database. When you choose File
- New Database, you create (1) a database, in which you store data (for example, names, addresses, and so on), and
(2) an Approach file, in which you create views that let you work with the data. 
When you enter data, Approach immediately saves the data in the database.
You can join databases so that more than one database is associated with a single Approach file.
Approach works with many database file types, but you can work in Approach without having another database 
product on your computer.
Other database products use the terms "table" or "data file" for a collection of data organized into fields and records; 
unlike Approach, they reserve the term "database" for a collection of tables.



database password
A sequence of characters you must enter before you can access the data in a database.
The password grants you read-only or read-write access to the database(s) associated with an Approach file.
To define a password for a dBASE or FoxPro database, use File - User Setup - Approach Preferences and click the 
Password tab.



data
The information entered in a field within a record and stored in a database. Typically, data is text, numbers, dates, or 
times.
Approach automatically saves data as you enter and edit records.



date field
A field that can hold a single date. You can perform finds, sorts, and calculations on dates in a date field.
To format a date, in Design, double-click the field and use the InfoBox.
Regardless of the format of the date field, in Browse, you must enter a date month first, then day, then year.



default style
A collection of style and layout information that Approach uses to create new views, unless you select a SmartMaster 
template or application.
To modify the default style, choose File - User Setup - Approach Preferences and choose Default Style in the Display 
tab.



delimited text file
A text file that uses separators such as commas, spaces, or tabs to break up the text into discrete units. One row in a 
delimited text file represents one record.
When you open a delimited text file as a database in Approach, the units of text become data in fields.



descending order
The sort order that arranges records from

• Z to A, for text (usually case-insensitive)
• Largest to smallest, for numbers
• Latest to earliest, for dates and times



Design
The environment in Approach for laying out and designing views. In Design, you do tasks such as adding fields to 
views, adding color, changing label text, changing fonts, and creating text blocks.
To go to Design, do one of the following:

• Click the Design button in the action bar.
• Click the Environment button in the status bar and select Design.
• From the View menu, choose Design.
• Press CTRL+D.

You must save the work you do in Design by choosing Save Approach File from the File menu.



detail database
When an Approach file is associated with joined databases, each view not only can display the data of its main 
database; it can also display supplementary information from the other databases, giving details about the records of 
the view's main database.
When a database provides supplementary information, it's called a detail database.
If the main and detail databases have a one-to-many relationship, a repeating panel    is a good way to display data 
from the detail database. The panel displays the "many" details of "one" record of the main database
A view can have only one main database, but it can have many detail databases.



drop-down box
A data-entry type for fields. In Browse, it offers a predefined list of values. Because it limits the values users can 
select and doesn't allow users to enter new values, this kind of field can help prevent the introduction of inaccurate 
data into your database.
To make a field a drop-down box: In Design, double-click the field to display the InfoBox. In the Basics tab, select 
Drop-down list as the data-entry type.



embed
To insert an OLE object in Approach. An embedded object gives you access to a server application when you are 
working inside Approach. When you embed an object

• You edit the embedded object by opening the server application from within Approach.
• The data is stored with the database associated with the Approach file, not in the server application.
• There is no link to the server application.

When you embed an object 
• In Browse, in a PicturePlus field, it becomes part of a record.
• In Design, it becomes part of the background of a view.



expression
A combination of operators, operands, and functions that yields a single result. In Approach, you can create 
arithmetic, comparison, and logical expressions.
A formula can consist of one or more expressions.



field box
A data-entry type for fields. In Browse, type in the field box to enter data in the field.
The field box is the default data-entry type, so when you add a field to a view, Approach adds it as a field box. To 
change to another data-entry type: In Design, double-click the field to display the InfoBox. In the Basics tab, select 
another data-entry type.



field box and list
A data-entry type for fields. In Browse, it offers a predefined list of values and a field box that lets users enter a new 
value. The new value becomes part of the list.
To make a field a field box and list:    In Design, double-click the field to display the InfoBox. In the Basics tab, select 
Field box & list as the data-entry type.



field
The smallest unit of data in a database. It's a good idea to break your information into as many meaningful fields as 
you can, especially if you plan to do finds on the data in the field. 
For example, in an address database, rather than have just two fields for name and address, break the information 
into at least six separate fields: first name, last name, street, city, state, and postal code. You can then do finds for all 
persons living in the same city, all persons with the same last name using the same postal code, and so on.

• To define a field for a database: From the Create menu, choose Field Definition.
• After you define a field, you can add it to a view: In Design, from the context menu, choose Add Field.



field definition
A set of attributes that includes the field name, the type of data the field can contain, a maximum field length for some
field types, and optional settings for controlling and validating data as it's entered in the field.
Every field in a database has a definition. Choose Create - Field Definition to define a field.



field mapping
Approach uses field mapping to ensure the accuracy of field definitions or the relationship between fields and data. 
You may need to map fields when you

• Open an Approach file in which previous changes to field definitions have not been saved in the Approach file.
• Import data from one database into another. Field mapping defines which fields should receive the data being 

imported.
• Import one Approach file (.APR) into another. Field mapping defines what kind of data, stored in fields that already

exist in the receiving file, should appear in the fields of the views being imported.



field name
A name for a field, stored in the database as part of the field definition.
Follow these guidelines when you name a field: Begin the name with a character; use only letters, numbers, and 
underscores; use no more than 10 characters; avoid spaces and characters like $, &, @, and so on.
A field name is different from the label that identifies a field in a view:

Approach uses the field name as the label when you add the field. You can, however, change the label    without 
changing the field name, and vice versa.



field reference
In formulas, a reference to a field. When calculating the formula, Approach uses the value in the referenced field from
the current record.
For example, the calculated field Commission contains the formula
INVOICE.Amount * 0.05
The name INVOICE.Amount is a reference to the value in the Amount field of the INVOICE database. In one record, 
Amount is 3500; in another, 2800; so the formula result varies according to the value in the referenced field.
You must add the name of the database to the field reference when the Approach file has joined databases. The 
name of the database must be all uppercase letters, separated by a period (no spaces) from the field name.



field type
Also called "data type," the specification for the type of data you can enter in a field. Assign a field type to a field in 
the Field Definition dialog box.
Possible field types: Boolean, calculated, date, memo, numeric, PicturePlus, text, time, variable.



file type
The specification for the way a program stores and organizes data in files. In Approach, you can use a variety of 
database file types.



find condition
An instruction you give to Approach to find records in a database. A find consists of one or more find conditions. 
A find condition can range from the simple, such as a single value you want to find, to the advanced, such as find 
conditions that use operators (=, <>,    >, <, and so on) or formulas or If statements. You can also combine find 
conditions in a single find when you link the conditions with AND or OR. 
The following is an example of a simple find condition expressed in English language format:
In database "Offices," find all records in field "City" that are exactly equal to "Tokyo"
When Approach finds records that match the find conditions, it displays only those records as the found set.



find
Also known as a search or query: To search for a set of records that satisfy one or more conditions you specify about 
data in one or more fields. For example, you might want to find all records in which the field Country contains France.
In Browse, click Find in the action bar to start a find.

Approach then gives you two ways to do a find:
• Find request. Use the blank view to enter your find conditions.
• Find Assistant. The assistant is especially useful for finding duplicate records, distinct records, and top or lowest 

values in a field.
The set of records that is the result of a find is called the found set. After a find, Approach keeps the found set as the 
only data you work with until you show all the records in the database or do another find.
If you know that you'll do the same find often, name the find so you can use it again.



Find (environment)
The environment in Approach in which you specify find conditions. In Browse, click Find in the action bar to go to the 
Find environment.

Then use the buttons that now appear in the action bar to create and execute the find.
When Approach finds records that match the find conditions, it returns you to Browse and displays only those records
as the found set.



find request
One of the two ways Approach gives you to do finds. (The other is the Find Assistant.)
A find request is a blank view that you use for entering find conditions.
To create a find request, in Browse, click Find in the action bar. Approach then displays the tools for doing a find using
a find request: a blank view in which to enter find conditions; buttons in the action bar to create, execute, and cancel 
the find; and a set of SmartIcons representing the operators    you can use in the find conditions.



fixed-length text file
A text file in which the text is broken into blocks of a specific length. If you open a fixed-length text file as a database 
in Approach, the blocks of text become data in fields.



form
A kind of view that focuses on a single record. You can use the same form to see every record in the database, but 
the form shows you only one record at a time.
Forms are useful for entering and editing data for a record.
Forms can have up to five pages. They can also be converted into dialog boxes for use in macros or scripts.
To create a form: From the Create menu, choose Form.



form letter
A view that combines text you type with names and addresses from a database record, so you can send copies of the
same letter addressed to many different people. You can also create envelopes printed with addresses for the form 
letters.
To create a form letter, choose Create - Form Letter.



found set
The group of records that match your find conditions.
After a find, Approach keeps the found set as the only data you work with until you show all the records in the 
database or do another find.



full record locking
A method of network data-sharing in which only one user at a time can edit a record, although more than one person 
can look at a record at the same time; the opposite of optimistic record locking.
To turn on full record locking, choose File - User Setup - Approach Preferences. In the General tab, deselect 
optimistic record locking.



function
A built-in formula that performs a specialized calculation automatically, often by using values that you supply. Such 
values are called parameters.
Some functions perform simple calculations. Many, however, simplify your work by performing complex calculations; 
for example, SNPV calculates the net present value of an investment based on a series of periodic cash flows and a 
discount rate.



grid
A non-printing matrix of dotted lines that you can show in Design. The grid provides a background to help you lay out 
objects in a view. 



handles
In Design, squares at the edges of a selected object. To resize the object, drag one of its handles.

If you are enlarging a field that is in a report panel or repeating panel, be sure the resized field stays completely 
inside the panel.



index
A file that contains a list of the values of a field, with pointers to the records in the database that contain those values.
Finds and sorts on a field go faster when the field is indexed.
Approach creates an index for a field (excluding memo fields) the first time you do a find or sort on that field. It 
maintains the index as you enter data.
Approach index files have the file extension .ADX. Each .APR can have only one .ADX file associated with it. 
Approach stores indexes for all the fields in the single .ADX file.
If you delete the .ADX file, Approach creates a new one with the next sort or find that you do. When you compress a 
file, Approach rebuilds the index file.



InfoBox
A window that shows the properties of the selected object, such as its name, color, borders, alignment, and so on.
The InfoBox can display the properties of every object in a view, including the view itself. To display the InfoBox so 
you can change those properties, go to Design and then do one of the following:

• Double-click the object whose properties you want to change. For a view, double-click the background, away from
any other object.

• From the context menu, choose the Properties command of the object.
• Select the object and click the InfoBox icon:

You can keep the InfoBox open as you work in Design.
The InfoBox displays the object's properties on one or more tabs. Click the tabs to see the properties.
Changes you make to a property happen either at once or as soon as you click elsewhere, so you can see the effects
of your changes immediately and decide whether you like the results.



join
To link two databases so that you can work with the data of all the databases from inside a single Approach file; show
relationships between the data of the joined databases; do finds; and so on.
You create a join by linking one or more fields that the databases have in common.
For example, the following illustration shows a diagram of two joined databases, one with data about authors, the 
other with data about publishers. They're joined on the Publisher and Name fields because those fields contain data 
that both databases have in common.
bmc join.bmp
Joined databases are a fundamental part of a relational database application like Approach. They reduce the amount 
of data entry you have to do and increase the power and ease with which you can manipulate your data.
To join databases: From the Create menu, choose Join.



join field
A field in one database linked to a field in another database, thus joining the databases. Join fields don't have to have
the same name, nor do they have to be defined as the same data type; but they must contain the same kind of data. 
Often, a join field is a numeric ID field created specifically for joining. In the following illustration, the employee 
database contains personal data, such as first and last names, address and phone number. The department 
database contains department information, such as manager, location, and cost center. The two databases are joined
on the Dept ID field because that is how the two databases are related: each employee is assigned to a department, 
and every department comprises employees.



key field
One or more fields that can identify each record in a database as unique, for example, an invoice number or an ID 
number. 
When exporting data from Approach or saving a database file to a different file format, you must specify one or more 
key fields. If you do not specify a key field that is unique, an error message displays indicating that you can't export or
save the file because a duplicate key exists. 



label
Text used to identify a field in a view, stored in the Approach file (.APR) as part of the design of a view.
Approach uses the field name as the label when you add the field to the view. You can, however, change the label 
without changing the field name, and vice versa.



link
To place a copy of an OLE object in Approach, with a connection to the original object in the server application. If the 
original object changes, the copy also changes in Approach.
When you link an object 

• In Browse, in a PicturePlus field, it becomes part of a record.
• In Design, it becomes part of the background of a view.



list box
A data-entry type for fields. In Browse, it offers a predefined list of values. Because it limits the values users can 
select and doesn't allow users to enter new values, this kind of field can help prevent the introduction of inaccurate 
data into your database.
Unlike a drop-down box or field box and list, however, you can size the list box to display as many of its values as you
like.
To make a field a list box:    In Design, double-click the field to display the InfoBox. In the Basics tab, select List box as
the data-entry type.



logical expression
An expression that evaluates one or more comparison expressions and returns a result of Yes or No.
For example, suppose the field Orders contains 462 and the field ShipDate contains the date 1/15/95:

• (Orders >= 500) AND (ShipDate >= '1/1/95') returns No
• NOT (Orders >= 500) returns Yes

Operators used in logical expressions:

AND Returns Yes if both expressions are true
OR Returns Yes if either or both are true
NOT Evaluates a comparison expression and 

returns Yes if it's false, No if it's true



lookup
An automatic display of data from a many-to-one or one-to-one relationship.



macro button
A control that you can add to a form, report, or other view. When you click the button, it executes an attached macro 
or script.
To create a button, choose Create - Control - Button. 
Attach a macro to the button in the Macros tab of the InfoBox for the button.



macro
A single command that executes a sequence of other commands. You define this sequence when you create the 
macro.
Use macros to automate Approach tasks.
To create a macro, choose Edit - Macros - New. 



mailing label
A view that displays database fields and text in a mailing address format. You can then print the addresses on 
standard or custom mailing labels.



main database
Every view in an Approach file represents a database. The database represented by the view is called its main 
database. The main database determines how many, and what kind of, records can be visible in the view.
When an Approach file is associated with joined databases, each view can have a different main database. A view 
must have one main database, and it can have many detail databases.
To find out what the main database of a view is, in Design, select the view and then look in the Basics tab of the 
InfoBox.
Example: Suppose a company has two joined databases, DEPT (departments) and EMP (employees). One view has 
DEPT as its main database. The company has five departments, so that view can show a maximum of five records.
The company has 100 employees. A view that has EMP as its main database can show a maximum of 100 records.



many-to-many
A relationship in which two or more records in one database can be related to two or more records in a joined 
database. For example, each order can include several products, and each product can appear on several orders.
In Approach, you can create a many-to-many relationship between databases, but it is better to design your 
databases so that you can create one-to-many or many-to-one relationships.



many-to-one
A relationship in which two or more records in one database can be related to only one record in a joined database. 
For example, several employees can be in the same department.



memo field
A field that can hold large amounts of text (maximum size: 64K). Define a field as memo instead of text if the field has
to store more than approximately 254 characters, for example, customer profiles or specifications of products.
Design your database so that you can avoid doing finds or sorts on memo fields.
Data of memo fields is not stored in the database file itself; rather, it is stored in a file with the extension .DBT (for 
dBASE), .DBQ (for Paradox 3.5), or .MB (for Paradox 4.0).
Another way to store a large document as part of a record: Define a PicturePlus field and embed the document in it 
as an OLE object.



named style
A set of layout and style properties, such as font and color, that you name and save as a group. You can then apply 
the set of properties again, as a group, rather than applying individual properties one at a time.
You can apply a named style to a particular object or to a view as a whole; Approach uses only the properties that 
pertain to the selected object.
To create or apply named styles, in Design, double-click the view or object and click the Named Style tab in the 
InfoBox.



numeric field
A field that can hold numbers and can be formatted with numeric symbols, such as a currency symbol. You can 
perform arithmetic calculations on data in a numeric field.
To format a number, in Design, double-click the field and use the InfoBox.



OLE object
An object you embed or link in Approach through OLE. The object can be

• Part of the layout of a view. In Design, choose Create - Object.
• Data in a PicturePlus field, if you define the field to accept an OLE object. In Browse, select the field to activate 

the OLE server application.
Double-click an OLE object to edit it using the tools from the server application without leaving Approach.
Approach also lets you use OLE in the other direction--that is, you can embed an Approach OLE object inside 
another application.



OLE (Object Linking & Embedding)
A method for data exchange, using links, and for the creation of compound documents, using embedded objects, that
lets you use one application from inside another.
For example, in Approach, you can use OLE to

• Add data to a record by embedding a Lotus WordPro document in a PicturePlus field.
• Use a SmartMaster background from Lotus Freelance Graphics as the background of an Approach view.

Approach also lets you use OLE in the other direction--that is, you can embed an Approach OLE object inside 
another application.



one-to-many
A relationship in which a record in one database can be related to two or more records in a joined database. For 
example, one department can have several employees. In a form, you use a repeating panel to represent the "many" 
data from a one-to-many relationship.



one-to-one
A relationship in which a record in one database is related to only one record in a joined database. For example, a 
vehicle number can be related to a license number for a single vehicle.



operand
A value in a formula, used in conjunction with one or more operators. Operands can be either constants (numbers, 
dates, text, or times) or field references. In the following formula, INVOICE.Amount (a field reference) and 0.05 are 
operands; * is the operator:
INVOICE.Amount * 0.05



operator
A symbol in a formula that defines the calculation or other evaluation to be performed. A plus sign (+) and a less-than 
sign (<) are examples of operators.



optimistic record locking
A method of network data-sharing in which two users can edit a record at the same time; the opposite of full (or 
pessimistic) record locking. 
When the second user tries to enter changes, Approach warns that the second user's changes will write over those of
the first user.
Approach uses optimistic record locking unless you deselect this option in File - User Setup - Approach Preferences, 
the General tab.
Approach runs faster with optimistic record locking on because it does not have to check whether to lock a record 
when a user tries to view it. Use this method when no more than one user at a time is likely to try to edit a record.
.



panel
A report component, visible in Design, that determines how field data appears in the report. 



parameter
A value to be operated on in a function. Parameters appear in parentheses after the function name and can be either 
constants or field references. For example, the function Fill(text,number) could take the parameters
Fill('Baden',2)
to return BadenBaden.



PicturePlus field
A field that can contain graphics or OLE objects.
To allow freehand drawing with the mouse on top of a graphic or OLE object in a PicturePlus field: go to Design, 
double-click the field to display its InfoBox, and then on the Basics tab, select Allow drawing.



PowerClick reporting
An Approach feature that allows you to modify an existing columnar report. Use PowerClick reporting to reorganize 
and summarize data.
In Design, be sure View - Show Data is turned on.

Select the field to use for grouping records. Then, from the Column menu, choose Groups & Totals. Then choose a 
leading or trailing summary option. You can also use these PowerClick icons:

 

Next, select the column to summarize. From the Column menu, choose Groups & Totals and choose a calculation 
option. You can also use these PowerClick icons:

Sum (grand total): Maximum: Standard deviation:

Count:

 

Minimum: Variance:

Average:



Print Preview
The environment in Approach that shows views on the screen as they appear when printed.



radio button
A data-entry type for a field that accepts only one of a small number of predefined values.
In Browse, to enter data in the field, you must select one of the values offered.
To make a field a set of radio buttons: In Design, double-click the field to display the InfoBox. In the Basics tab, select 
Radio buttons as the data-entry type. Define a clicked value and a label for each button.



read-only access
Permission to read data, but not to modify it.

• Make individual fields read-only. In Design, double-click the field to bring up the InfoBox and click the Basics tab. 
• Assign a database password to your files to grant read-only permission to users who know the password. Choose

File - User Setup - Approach Preferences and click the Password tab.



read-write access
Permission to read and modify data in a database. You can assign a database password to your files to grant read-
write permission to users who know the password.
Assign a database password to your files to grant read-write permission to users who know the password. Choose 
File - User Setup - Approach Preferences and click the Password tab.



record
One set of related information in a database. For example, in an employee database, the information on each 
employee (name, address, date of birth, and so on) is a record.



relational database application
A database application that lets you bring together data from more than one database in a single form, report, or 
other view. Approach is a relational database application.
The distribution of data among several databases, which you then join, is a basic concept of a relational database 
application such as Approach. If you create multiple databases and join them rather than try to put all your data into a 
single database, you save yourself work and increase the variety of ways you can view and manipulate your data. 
Plan your databases and store your information so as to take advantage of the power and efficiency of joined 
databases.



repeating panel
In an Approach file that has joined databases, a repeating panel is an object you add to a form to display the "many" 
side of a one-to-many relationship between the main database of the form and one of its detail databases.
The repeating panel shows data from multiple records in a detail database that are related to the current record of the
main database.
For example, a repeating panel in a department form might list all the employees in the department.
To create a repeating panel: In Design, from the Create menu, choose Repeating Panel.



report
A view used for organizing, summarizing, and presenting data from many records. A report shows all the records in 
the database or the current found set on one or more pages.



row gutter
The area at the left side of worksheets and crosstabs that holds row headers.
To convert a worksheet to a crosstab, drag a column header from a worksheet and drop it in the row gutter.



server application
An application used to create an OLE object.



server
One or more central computers that store files and applications to which users have access across a network.



SmartIcons
Buttons (icons) in the Approach window that let mouse users choose commonly used commands and macros.
To select SmartIcons, click them.
To see a short description of what an icon does, leave the mouse pointer on the icon for a few seconds.
To change the set of SmartIcons, choose File - User Setup - SmartIcons Setup.



SmartMaster application
An Approach file with one or more associated databases, designed to be a ready-to-use application for business or 
personal use.
To create an application based on a SmartMaster application, choose File - New and select a SmartMaster 
application.
To create a SmartMaster application, save an Approach file as an .MPR file to the SmartMaster directory. Define the 
directory in the General tab of the Approach Preferences dialog box.



SmartMaster template
A predefined set of field definitions for a single database file. Approach provides SmartMaster templates for many 
common business and personal uses, such as a customer database and an employee database.
To create a new database from a template rather than defining all of your fields from scratch, choose File - New and 
select a SmartMaster template.
To start from the basis of an even more fully developed sample business application, select a SmartMaster 
application.



sort
To organize records alphabetically, numerically, or chronologically by data in one or more fields. You also designate 
whether to organize the records in ascending (for example, A - Z) or descending order (Z - A).
You can sort an entire database or a found set.



sort field
A text, numeric, date, or time field used for sorting records in a database.
The first field you select is the primary sort field. Subsequent fields you select resolve conflicts in the sort order that 
arise when the same data appears in the primary sort field in different records.
For example, when sorting a database of names, select Last Name as the primary sort field and First Name as the 
second sort field so that Smith, John and Smith, Alice appear in correct alphabetical order.



status bar
The bar at the bottom of the Approach work area.
The information available from the status bar changes depending on the current environment. You can always, 
however, click the buttons on the far right to change to another view or environment.
In Browse, the status bar indicates whether you are working with all records of a database or a found set.



summary function
A function that applies to a group of records. For example, the SSum(Amount) summary function adds the values in 
the Amount field in a range of records you specify.



summary panel
An area in a report that may contain a calculated field that summarizes data.



summary report
A report that omits record-by-record detail and displays only summary information.



tab order
The order in which you move through the fields in a view when you press TAB. Also referred to as data-entry order.
To change the tab order, in Design, choose View - Show Tab Order and then change the numbers that appear. Use 
the buttons in the action bar to confirm your changes.
Calculated fields cannot be included in the tab order.



text field
A field that can hold any characters you can type, including letters, numbers, and symbols. The maximum length of a 
text field is approximately 250 characters. If you need to hold larger amounts of text in a field, define the field as 
memo.
You can search on a text field using any character in the field.



time field
A field that can hold a single time. You can perform finds, sorts, and calculations on times in a time field.
To format a time, in Design, double-click the field and use the InfoBox.



Tools palette
In Design, a set of buttons for drawing shapes and lines, creating text blocks, and adding fields.
To show the Tools palette, choose View - Show Tools palette.
To move the palette around in the work area, drag its title bar.



variable field
A field that temporarily stores a value, which can be text, a number, a date or time, or a Boolean value. When you 
define a variable field, set its data type and initial value. The value is the same for every record in your database 
application.
Use variable fields to store intermediate values in calculations and macros, and to pass values between Approach 
and Notes using Notes/FX.
Variable fields are stored in the Approach file (.APR). 



view
An interface that you create in an Approach file (.APR). Views let you look at and work with the data stored in the file's
associated database files. Views are stored in the Approach file.
When you create a new file, Approach provides a standard form and a worksheet. You can modify these views and 
add as many other views as you need. 
You can design each view. In Design, double-click the background and the objects to display the properties of 
objects, including the view itself, in the InfoBox. To save design work: From the File menu, choose Save Approach 
File.
Approach provides these kinds of views: form (for looking at one record at a time), report, form letter, mailing labels, 
worksheet, crosstab, chart, and envelope.



view tab
The folder tab that appears at the top of the window for each view in the Approach file.

Click the tab to go to that view.
Go to Design to

• Double-click the tab to change the name. (Maximum number of characters: 79.)
• Drag the tab to move the view to another position.



worksheet
A view that presents data from many records in a grid of columns and rows.    Each record occupies a single row in 
the worksheet.
A worksheet shows all the records in the database or the current found set.



zoom
To change the magnification of a view on the screen. You can zoom in for a closer look or zoom out for the big 
picture. Zooming does not affect the size of a view when you print it, only how it appears on the screen.



Details: Adding all groups to crosstabs
Approach supports two ways of presenting crosstab entries made up of zero values. Choose which method shows 
your data appropriately.

Showing all subgroup values in every group
Turning off "Show only related rows or columns" changes the crosstab behavior so that all subgroup entries appear 
for each group, even if the subgroup records do not match the header. 
For example, if a crosstab shows products sold by city and the cities are grouped into countries, every city in the 
database appears as a category for each country. So New York and San Francisco would appear under Germany, 
and Berlin and Munich would appear under USA. Probably not the desired result.
In other situations, however, showing all subgroup values can be useful. 
For example, if a crosstab shows the number of products sold by sales representative, you might want to show all 
products for each sales rep, even if the subgroup record does not match the header: in this example, that would 
mean that products the sales rep hadn't sold would show up as a subgroup under the rep's name.

Quantity
AG product1 100 

product2 200 
product3

JF product1 100 
product2
product3 150 

Showing only nonzero subgroup values in every group
The default behavior of a crosstab is to show only the headers with values relevant to the next larger group in the 
crosstab. For the country and city example above, accepting the default means the crosstab would display only the 
cities in the United States in the USA country grouping:

Product Sales
USA New York 200 

San Francisco 150 
Canada Toronto 250 

Vancouver 100 
Germany Berlin 175

Munich 225

{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_SUMMARIES_TO_CROSSTABS_STEPS;H_GROUPING_RECORDS_IN_NEW_REPORT

S_AND_CROSSTABS_REF;H_crosstabs_over;',0)} See related topics



Adding all groups to crosstabs
By default, a crosstab displays only subgroups with records related to the next larger group. 
For example, zero values, by default, do not appear under groups.
Follow these steps to display all subgroups even if no record values correspond to the group and subgroup 
combination.

 Are you in Design?
1. Click a crosstab body cell to select the crosstab.
2. Choose Crosstab - Crosstab Properties.

3. Click the Options tab in the InfoBox.

4. Deselect "Show only related rows or columns."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_DETAILS',1)} See details
{button ,AL(`H_ADDING_SUMMARIES_TO_CROSSTABS_STEPS;H_GROUPING_RECORDS_IN_NEW_REPORT

S_AND_CROSSTABS_REF;H_crosstabs_over;',0)} See related topics



Adding and deleting items in scrolling lists
You can add or remove items in a scrolling list field on a form.

 Are you in Design?
1. Double-click the field.
2. Click the Basics tab of the InfoBox.

3. Click Define List.
A dialog box appears.

4. To add an item to the list:
• Scroll through the list and click on the item you want to appear below the new item.
• Click Insert to create a blank line above the current item.
• Enter the new item.

5. To delete an item:
• Select the item in the list.
• Click Delete.

6. Click OK.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_FEWER_VALUES_IN_A_SCROLLING_LIST_STEPS;H_DISPLAYING_THE_CONTEN
TS_OF_DROPDOWN_BOXES_AUTOMATICALLY_STEPS;H_DISPLAYING_DESCRIPTIVE_VALUES_IN_A_SC
ROLLING_LIST_STEPS;',0)} See related topics



Aligning and distributing objects
Align objects along their tops, bottoms, sides, or centers to put them all in the same row or column. Distribute objects 
vertically or horizontally to place an equal amount of space between them.

 Are you in Design?
1. Select two or more objects.
2. Choose Multiple Objects - Align.

The Align tab of the InfoBox appears.

3. Select whether to align the objects to each other or to the grid under Align selections.
4. Under Object alignment: 

• To align the objects horizontally, click Left, Center, or Right.

• To align the objects vertically, click Bottom, Middle, or Top.

5. Under Spacing options, select whether to space objects horizontally or vertically.
6. To include field labels in the alignment calculation, select "Include field label."

Note This option is available only if one of the selected objects is a field. If you do not include field labels, fields 
are layered on top of each other and aligned.

7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SELECTING_OBJECTS_STEPS;H_ADDING_MULTIPLE_OBJECTS_TO_A_VIEW_STEPS;H_SETTI
NG_OBJECTS_AND_FIELDS_TO_SLIDE_WHEN_PRINTING_STEPS;',0)} See related topics



Alternating the color of records in a repeating panel

 Are you in Design?
1. Select the repeating panel.
2. From the Panel menu, choose Panel Properties.
3. Click the Lines & Colors tab in the InfoBox.

4. Select "Alternate fill color."
5. Under Fill color, select the alternate color.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_LINE_AND_COLOR_PROPERTIES_CS;',0)} See related topics



Applying found sets to crosstabs
By default, crosstabs reflect the results of any finds, but you can specify that a crosstab always include data from all 
records in all databases joined in the current Approach file.
Want the big picture?    See Overview: Crosstabs.

 Are you in Design?
1. Click a crosstab body cell to select the crosstab.
2. Choose Crosstab - Crosstab Properties.

3. Click the Options tab in the InfoBox.

4. Deselect "Apply found set to crosstab headers."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FINDING_RECORDS_THAT_MAKE_UP_CROSSTABS_STEPS;',0)} See related topics



Changing dialog boxes back to forms

 Are you in Design?
When you are in Design, a dialog box displays as a form with a tab.
1. Double-click the background of the form that represents the dialog, away from any object.
2. Click the Macros tab of the InfoBox.

3. Deselect "Show form as dialog."
When you switch to Browse, the form continues to display with a tab as it did in Design.

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_DIALOG_BOXES_FROM_FORMS_STEPS;H_CREATING_DIALOG_BOXES_FROM_F
ORMS_DETAILS;',0)} See related topics



Changing the color of objects and views

 Are you in Design?
1. Double-click the text block, the object, or the background of a view.
2. Click the Lines & Colors tab in the InfoBox.

3. Select the color you want
• For views, select "Fill color."
• For shadows, select "Shadow color."
• For lines around an object or view, under Border select "Color."

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_MAKING_OBJECTS_AND_VIEWS_TRANSPARENT_STEPS;',0)} See related topics



Displaying baselines in fields
A baseline is like the dashed or dotted line you often see on typical official forms, such as job applications.
Steps 1 through 3 of this task explain how to create dashed or dotted lines in fields. Steps 4 through 6 explain how to 
continue enhancing the style of the fields so that they look like those on official forms.

 Are you in Design?
1. Double-click the field.
2. Click the Lines & Colors tab in the InfoBox.

3. Under Border, select "Baseline."
4. Display the label to the left of the field.
5. Turn off field borders.
6. Make the field boxes transparent.
7. (Optional) To apply these styles to other fields, create a named style for the field.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_POSITION_OF_LABELS_STEPS;H_MAKING_OBJECTS_AND_VIEWS_TRANSP
ARENT_STEPS;H_CREATING_PARTIAL_BORDERS_STEPS;',0)} See related topics



Displaying field labels inside field boxes
When you display a label    within the borders of a field box, the label has the same background as the data in the 
field.
If you're trying to change the position of the label relative to the field, see Changing the position of labels.

 Are you in Design?
1. Double-click the field.
2. Click the Lines & Colors tab in the InfoBox.

3. Under Border, select "Enclose field label."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_POSITION_OF_LABELS_STEPS;',0)} See related topics



How do I get rid of the space between objects?
Oftentimes, when you place an object such as a field on a form, a report, an envelope, or a mailing label, the data 
that you enter in the field varies in length. So you may end up in some records with too much blank space between 
fields when you print.
In Approach, you can adjust the boundaries (the borders within which you enter data) of fields and slide the fields 
closer together when you are in Design, or when you preview or print. This gets rid of the unnecessary space 
between fields. 
Although you'll probably do this mostly with the space between fields, you can do this with all objects. For example, 
you may want to reduce the space between a field box and a text block.
Adjusting field boundaries and closing up the extra space between fields involves three steps:

• Adjusting the boundaries of a field
• Aligning fields to each other
• Sliding fields together

Note Approach automatically slides mailing label fields up and to the left to remove extra space. However, if you add 
a field to an existing mailing label, you must set the field to slide.

Step 1: Adjusting the boundaries of fields
Suppose you have a field called "First Name" on a view. In one record, the field contains the value "Anastasia,"    
which is nine characters long.    In another record    the field contains the value "Jon," which is only three characters 
long.
If you defined the field as having a size of 20 characters, it would contain 17 spaces.
In the Anastasia record, the value takes up more space in the field than in the Jon record, so there is less blank 
space. In both cases, however, there is still a substantial amount of blank space that remains to the right of the name.
This means that any data to the right of the First Name field, like Last Name, would print too far away from the data in
the First Name field.
The first step in getting rid of this space is to simply reduce the boundaries of the field. The boundaries actually shrink
so that they adjust according to the size of the data in the field.    
Now the field looks smaller. Its rightmost boundary is right after the last letter in "Anastasia." Notice, however, that 
there are also selection marks (which display only in Design) that go beyond the border. This indicates the defined 
length of the field (20 characters).
At print time, the field looks only as long as the value in it, in this case nine characters for the length of "Anastasia." 
The Jon record would print the field with a length of three characters. But at data entry time, when the record is being 
created or modified, the field displays with the length of its field definition, in this case, 20 characters.

Step 2: Aligning fields to prepare them for sliding
After you reduce the size of the field so that it doesn't print with a lot of blank spaces, you need to make it line up with
other fields in a way that lets users read them together easily. For example, the view that has a field called First 
Name also has a field called Last Name. 
First of all, Last Name, which is defined with a length of 30 characters, has a lot of blank spaces in it. So, you need to 
reduce the boundaries of Last Name. But notice also that Last Name appears quite a bit to the right of First Name. 
This is because First Name is defined as having 20 characters, but it really only displays as having the nine 
characters of the value "Anastasia." So, while the boundaries of First Name field have been reduced to nine 
characters, Approach still knows that First Name is really 20 characters long, and so Last Name starts in the place on
the view where you originally placed it, in this case directly after the twentieth character of First Name.
How do you deal with this? Easily. You just slide Last Name over to the left toward First Name, to the    spot where the
value in First Name ends. This means that Last Name will start at a different spot for each record, depending on how 
long the value in First Name is for that record.
But before you can slide Last Name over to First Name, you need to align the two fields. Otherwise, the field on the 
right won't slide next to the one on the left. If you are working with more than two fields, select all the fields you want 
to align and slide together.

Step 3: Sliding fields together
Now that the fields are lined up, you can slide them together. Keep in mind that you are sliding fields to the left, so the
first field in the series, the one toward which you are sliding the other, remains stationary, that is, it doesn't actually 
slide. 



Notice that the selection marks around First name appear "behind" the Last Name field. This is because when you 
slid Last Name to the left, it overlapped the true right-hand boundary of First Name (which is defined as having 20 
characters), even though First Name has been visually reduced to the size of the value of "Anastasia." (nine 
characters).

Sliding fields up
You can also slide fields up. For example, if you design a form to have four lines of information, and a user only 
enters data in the first, third, and fourth lines, you can set fields to slide up, removing the unnecessary second blank 
line. 
Another situation in which sliding fields is useful occurs when the field on the top is a memo field that can have a 
variable amount of data in it, depending on the record. You must mark both fields, the memo field and the other field, 
to slide up.
To do this, align the fields. Then, with the fields still selected, click the Size tab in the InfoBox, and under "When 
printing, slide," select Up.



Details: Attaching macros
User actions
Fields, views, buttons,and objects have different types of user actions that determine when an attached macro is 
activated.
Note You can attach a macro to a group of radio buttons and check boxes, or to individual radio buttons and check 
boxes. To attach a macro to a single radio button or check box, first ungroup them, then attach the macro to the 
individual object.

Field user actions
This option Activates the macro when the user
On tab into Tabs into or clicks this field
On tab out of Tabs out of this field or clicks 

elsewhere
On data change Changes the data in this field

View (form) user actions
This option Activates the macro when the user
On switch to Displays this view
On switch out Changes from this view to another 

view

Object user actions
This option Activates the macro when the user
On tab into Tabs into or clicks this object
On tab out of Tabs out of this object or clicks 

elsewhere
On selected Selects this object

Macro button user actions
This option Activates the macro when the user
On tab into Tabs to this button
On tab out of Tabs away from this button
On clicked Clicks the button

{button ,AL(`H_ATTACHING_MACROS_STEPS',1)} Go to procedure



Attaching macros
Attach a macro to a button or object, view, or field. The macro runs when you click the button or object, switch to or 
out of the view, or tab into or out of the field.

 Are you in Design?
1. Double-click the object.
2. Click the Macros tab of the InfoBox.

3. (Optional) Click Define Macro to create a new macro.
4. Select a user action that activates the macro.
5. Select a macro from the list.
6. To attach additional macros, repeat steps 4 and 5.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ATTACHING_MACROS_DETAILS',1)} See details



Basic properties of objects and fields

Choose a task
Preventing objects and fields from printing 
Naming views and objects
Putting objects and fields in the tab order
Removing objects and fields from the tab order
Displaying fields as check boxes
Displaying fields as radio buttons
Displaying fields as scrolling lists

For fields displayed as scrolling lists
Displaying fewer values in a scrolling list
Displaying descriptive values in a scrolling list 
Adding and deleting items in scrolling lists 

For PicturePlus fields
Drawing in PicturePlus fields 

For repeating panels
Setting a default sort order for a repeating panel 
Modifying repeating panels

{button ,AL(`H_BASIC_PROPERTIES_OF_VIEWS_CS;',0)} See related topics



Basic properties of views

Choose a task
Changing the color of objects and views
Naming views and objects
Selecting a main database for a view
Changing the menu for a view
Hiding views
Showing more of the view by hiding its margins
Changing dialog boxes back to forms
Creating dialog boxes from forms 

For reports
Choosing which records go into a summary
Changing the number of columns in reports
Paginating reports
Reducing or expanding sections of reports when printing 

For crosstabs
Selecting drill-down views

For charts
Drilling down to data for charts

For mailing labels
Changing or deleting custom mailing label types

{button ,AL(`H_LINE_AND_COLOR_PROPERTIES_CS;',0)} See related topics



Changing display options for a PicturePlus field

 Are you in Design?
1. Double-click the PicturePlus field.
2. Click the Options tab of the InfoBox.

3. Drag the graphic where you want it to appear in the field.
4. Select the method for resizing the graphic, if it is too large or too small for the field.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_OLE_OPTIONS_FOR_PICTUREPLUS_FIELDS_STEPS;',0)} See related topics



Changing or deleting custom mailing label types
If you want a different arrangement of labels on the page once you have created the label, create a new mailing label 
view.

 Are you in Design?

Changing mailing label types
1. Choose Mailing Label - Mailing Label Properties.

2. Click Edit Label Options in the Basics tab.

The Mailing Label Options box appears.
3. Select the label layout you want to change in the "Custom label" box.
4. Change the settings for the custom label.
5. Click Change to apply your changes to the current label definition.
6. Click Done to close the Mailing Labels Options box.
7. (Optional) Move, collapse, or close the InfoBox.

Deleting custom mailing label types
1. Select the layout in the "Custom Label" box.
2. Click Delete.
3. Click Done.

{button ,AL(`H_ADDING_TEXT_TO_MAILING_LABELS_STEPS;H_CREATING_CUSTOM_MAILING_LABEL_TYPE
S_STEPS;H_CREATING_MAILING_LABELS_STEPS;H_MOVING_OR_RESIZING_MAILING_LABEL_FIELDS_S
TEPS;H_SETTING_FIELDS_TO_SLIDE_STEPS;',0)} See related topics



Changing properties of text in text blocks
In a text block

• Selecting the entire text block changes the properties for all text in the text block.
• Selecting only some of the text changes the properties for only that text. 

1. Double-click the text block.
2. Click the Font tab in the InfoBox.

3. Select options to change text attributes.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_CUTTING_OR_COPYING_O
BJECTS_OR_TEXT_STEPS;',0)} See related topics



Changing text attributes of labels or data

 Are you in Design?
1. Double-click the field.
2. Click the Font tab in the InfoBox.

3. Click Data    or Label    depending on what you want to change.

4. Select options to change text attributes.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_POSITION_OF_LABELS_STEPS;H_EDITING_LABELS_STEPS;H_HIDING_LAB
ELS_STEPS;',0)} See related topics



Changing the date format on form letters

 Are you in Design?
1. Click to enter the text block.

The insertion point appears when you click.
2. Double-click <<DATE>> to select it.
3. Choose Letter - Form Letter Properties. 

4. Click the Format tab in the InfoBox.

5. Change the format of the date.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ADDING_FIELDS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LET
TERS_STEPS;H_ENTERING_TEXT_IN_FORM_LETTERS_STEPS;H_MOVING_OR_DELETING_FORM_LETTE
R_FIELDS_STEPS;',0)} See related topics



Details: Changing the menu for a view
An attached menu is available when you go to the view in Browse. 
Approach lets you attach the default menu, the short menu, or a custom menu you create.
The short menu is a subset of the default menu. It does not include commands for modifying the file. For example, 
the short menu does not contain Create - Form.

{button ,AL(`H_CHANGING_THE_MENU_FOR_A_VIEW_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_A_CUSTOM_MENU_BAR_STEPS;H_HIDING_VIEWS_STEPS;H_NAMING_VIEWS_AN

D_OBJECTS_STEPS;H_SELECTING_A_MAIN_DATABASE_FOR_A_VIEW_STEPS;H_SHOWING_MORE_OF_
THE_VIEW_BY_HIDING_ITS_MARGINS_STEPS;',0)} See related topics



Changing the menu for a view
You can change the menu bar of the current view. The selected menu bar displays when you go to the view in 
Browse.

 Are you in Design?
1. Double-click the background of the view, away from any object.

For worksheets or crosstabs, choose Worksheet Properties or Crosstab Properties on the context menu.
2. Click the Basics tab of the InfoBox.

3. Select a menu from the "Attached menu bar" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_MENU_FOR_A_VIEW_DETAILS',1)} See details
{button ,AL(`H_CREATING_CUSTOM_MENUS_STEPS;H_HIDING_VIEWS_STEPS;H_NAMING_VIEWS_AND_OBJ

ECTS_STEPS;H_SELECTING_A_MAIN_DATABASE_FOR_A_VIEW_STEPS;H_SHOWING_MORE_OF_THE_VI
EW_BY_HIDING_ITS_MARGINS_STEPS;',0)} See related topics



Changing the number of columns in reports
If the fields on the report don't take up much room left to right but run onto many pages, increase the number of 
columns on the report to use fewer pages.

 Are you in Design?
1. Choose Report Properties on the context menu.
2. Click the Basics tab in the InfoBox.

3. Enter the number of columns in the "Number of columns" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_EDITING_COLUMN_HEADER_TEXT_STEPS;H_MOVING_AND_RESIZING_REPORT_COLUMNS_
STEPS;H_reports_over;',0)} See related topics



Changing the position of labels
If you're trying to make the label appear inside the border of the field with the field data, see Displaying field labels 
inside field boxes.

 Are you in Design?
1. Double-click the field.
2. Click the Font tab in the InfoBox.

3. Select "Label."
4. Select a position for the label in the "Label position" box.

Note To remove the label from the form, select No label.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_EDITING_LABELS_STEPS;
H_HIDING_LABELS_STEPS;H_APP_DISPLAYING_FIELD_LABELS_INSIDE_FIELD_BOXES_STEPS;',0)} See 
related topics



Changing the width of lines or borders
If you're trying to modify reports, you change the width of the view border in individual panels.

 Are you in Design?
1. Double-click the object, or the background of a view.
2. Click the Lines & Colors tab in the InfoBox.

3. Under Style, select the first frame or line style.
4. Select a width.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_PARTIAL_BORDERS_STEPS;H_LINE_AND_COLOR_PROPERTIES_CS;',0)} See 
related topics



Selecting drill-down views
Select the view that records appear in when you use Drill Down to Data. If you don't choose a drill-down view, 
Approach creates a new worksheet for the drill-down results and sets this worksheet as the default drill-down view.
Want the big picture? See Overview: Drill down to data.
1. Click a body cell in the crosstab.
2. Choose Crosstab - Crosstab Properties.

3. Click the Basics tab in the InfoBox.

4. Select a view in the "Drill down view" box.
5. From the Crosstab menu, choose Drill Down to Data to obtain drill-down results.

For charts, see Drilling down to data for charts.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_drill_down_to_data_over;H_finding_records_that_make_up_crosstabs_steps;H_DRILL_DOWN_TO_
DATA_FOR_CHARTS_STEPS;',0)} See related topics



Choosing which records go into a summary
Summary panels appear on reports only.
Tip Do the following to make the report design clearer:

• Deselect View - Show Data. 
• Select View - Show Panel Labels

 Are you in Design?
1. Double-click the summary panel.

The title bar of the InfoBox should say "Properties for: Summary Panel."
Tip Don't click a field in the panel. Otherwise, you'll get the InfoBox for the field.

2. Click the Basics tab in the InfoBox.

3. Select an option from "Summarize."
You can summarize

• A fixed number of records, such as the number that fit on a page.
• All records.
• Records that correspond to the values used for grouping. Select a field from the "records grouped by" box.

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_MOVING_SUMMARIES_STEPS;H_reports_over;',0)} See related topics



Closing up extra space between objects
When you're in Design or when you want to print or preview, you can remove unwanted space between fields, or 
between fields and other kinds of objects, such as text blocks. To do this, perform these tasks:

• Adjust the boundaries of objects
• Align the objects to each other
• Slide the objects together

Want the big picture? See How do I get rid of the space between objects?

 Are you in Design?

Adjusting the boundaries of objects
1. Select the objects whose boundaries you want to adjust.
2. From the Multiple Objects menu, choose Object Properties.

3. Click the Size tab in the InfoBox.

4. Under When printing, select "Reduce boundaries."

Aligning objects
1. Select the objects that you want to slide together.
2. From the Multiple Objects menu, choose Object Properties.

3. Click the Align tab in the InfoBox.

4. Align the objects
• Along the bottom if you are sliding the objects left

• Along the left if you are sliding the objects up

Sliding objects
1. Select the object(s) that you want to slide left or up.

Note If you are sliding left, do not select the object that is farthest to the left. If you are sliding up, select all 
objects.

2. Click the Size tab in the InfoBox.

3. Under When printing, slide, select "Left" or "Up."
4. (Optional) Move, collapse, or close the InfoBox.
The objects you selected will slide together up or down in Design or when you print or preview the view.

{button ,AL(`H_CLOSING_EXTRA_SPACE_BETWEEN_FIELDS_DETAILS',1)} See details
{button ,AL(`H_moving_objects_steps;',0)} See related topics



Creating a shadow

 Are you in Design?
1. Double-click the text block, object, or repeating panel.
2. Click the Lines & Colors tab in the InfoBox.

3. Under "Shadow color," select a color.
Select T, for transparent, if you want to see through the shadow to objects underneath.

4. (Optional) Move, collapse, or close the InfoBox.
Note If a repeating panel has records of alternating colors, the records that are the same color as the form take on 
the color you select for the shadow.

{button ,AL(`H_LINE_AND_COLOR_PROPERTIES_CS;',0)} See related topics



Details: Creating custom formats for currency
Decoding number formats
Approach specifies currency formats with the following characters. Use them to create your own formats:

0 Required digit.
# Optional digit. Does not 

display zero.
. (period) Decimal point position. Your 

operating system may be set 
to use a different decimal 
indicator.

, (comma) Thousands separator, if used 
between digits. Your operating
system may be set to use a 
different thousands separator.

$ F DM Literal characters displayed as
they appear. These and other 
literal characters like spaces 
must be enclosed in double 
quotation marks (") in the 
format.

Entering currency in Browse
Select "Show data entry format" on the Format tab of the InfoBox to make the format visible when the field is selected
in Browse.

Storing currency in the database
Data in numeric fields are stored in the database without any formatting and in the order specified by your operating 
system.
Note When you format a text field for currency, "Show data entry format" stores the text in the database with the 
formatting.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_CURRENCY_STEPS',1)} Go to procedure



Creating custom formats for currency
To create a custom format for currency, modify an existing format. To restore the original format, you must change the
custom format back to the original. So take note of the original format.

 Are you in Design?
1. Double-click a currency field.
2. Click the Format tab in the InfoBox.

3. Make sure that Currency is selected in the "Format type" box.
4. Select the format you want to modify in the "Current format" box.
5. Click Edit Format.

The Edit Format dialog box appears.
6. In the "Format code" box, edit the codes for the new currency format.

Note Edit the format for both positive and negative values. The negative format is to the right of the separator (;).
7. Click OK to close the Edit Format dialog box.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_CURRENCY_DETAILS',1)} See details



Details: Creating custom formats for dates
Use the following tables to determine how to enter the format code.

Day, month, and year formats
Format Appears as Sample
D Date without leading zero  8
DD Date with leading zero  08
DDD 3-letter day  Thu
DDDD Day of the week in full  Thursday
M Month without leading zero  5
MM Month with leading zero  05
MMM 3-letter month  Sep
MMMM Month in full  September
Y Year in full  1997
YY Last two digits of year  97
YYY Year in full  1997
YYYY Year in full  1997

Numbers indicate periods
To indicate the year broken into different periods, use the following number codes:

4 Quarter
3 Third
2 Semiannual period
1 Entire year

Repeat the number in the format to specify how the period appears in the field: 

Format Appears as
3 1, 2, or 3
33 1st, 2nd, or 3rd
333 First, Second, or Third

A format can also include literal text (such as Quarter). If the literal text includes the character D, M, Y, 2, 3, 4, or 
includes a space, enclose the text in double quotation marks.

Examples
Format For the date 7/1/86
Q4 Q3
YYT3 86T2
22 Half YY 2nd Half 86
333 "Year" YYYY Third Year 1986

Your modifications to the date format appear in the field when you press ENTER or TAB or click the view. 

Storing dates
Dates are stored in the database in the order specified by your operating system without any formatting.

International and system dates
Date formats marked [ISO] are international date formats. Date formats marked with a computer icon are system 
dates, such as regional settings.

 
Approach reads these formats from the operating system. If you change system settings, they are automatically 
updated in the current Approach session. 
International and system date and time formats are not saved with the Approach document, as are other date and 
time formats.



System dates change according to the operating system you are using. If you do not want your date formats to 
change when you change operating systems, select a date format in the Format type box that is not marked with a 
computer icon. 
Note When you format a text field for dates or times, and you select "Show data entry format," Approach stores the 
text in the database with the date or time formatting.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_DATES_STEPS',1)} Go to procedure
{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_DETAILS;H_FORMATTING_DATES_AS_QUARTERS_THI

RDS_AND_SO_ON_STEPS;H_INSERTING_DATES_OR_TIMES_STEPS;',0)} See related topics



Creating custom formats for dates
To create a custom format for a date, modify an existing format. To restore the original format, you must change the 
custom format back to the original. So take note of the original format.

 Are you in Design?
1. Double-click a date field.
2. Click the Format tab in the InfoBox.

3. Make sure that Date is selected in the "Format type" box.
4. Select the format you want to modify in the "Current format" box.
5. Click Edit Format.

The Edit Format dialog box appears.
6. In the "Format code" box, edit the code for the new date format.
7. Click OK to close the Edit Format dialog box.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_DATES_DETAILS',1)} See details



Details: Creating custom formats for numbers

Decoding number formats
Approach specifies number formats with the following characters. Use them to create your own formats:

0 Required digit.
# Optional digit. Does not 

display zero.
. (period) Decimal point position. Your 

operating system may be set 
to use a different decimal 
indicator.

, (comma) Thousands separator, if used 
between digits. Your operating
system may be set to use a 
different thousands separator.

$ - + : ( ) Literal characters displayed as
they appear. Other literal 
characters like spaces must 
be enclosed in double 
quotation marks (") in the 
format.

% Percent operator. Displays the
field value as a percent.

; (semicolon) Separates positive and 
negative values. The part to 
the right is for negative 
numbers.

= < > Field values are formatted 
according to the number of 
digits in the value. See details 
below.

| (vertical bar) Separates alternative formats 
for the same value

e+ Field values are formatted in 
scientific notation.

Use equal (=), greater than (>), or less than (<) signs to control the format according to the number of digits entered. 
For example, suppose a field has this format:
=7 000-0000|<7 "x"0000

• If you enter 1234567, the data appears as 123-4567.
• If you enter 1234, the data appears as x1234. 

The vertical bar (|) separates the two conditional formats.

Verifying entered numbers
Number formats make it easier to enter correct and consistent data into a record. They do not guarantee correct 
information, however. See Verifying the accuracy of entered data.

Entering numbers in Browse
Select "Show data entry format" on the Format tab of the InfoBox to make the format visible when the field is selected
in Browse.

Storing numbers in the database
Data in numeric fields are stored in the database without any formatting and in the order specified by your operating 
system.
Note When you format a text field for numbers, "Show data entry format" stores the text in the database with the 
numeric formatting.



{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_NUMBERS_STEPS',1)} Go to procedure



Creating custom formats for numbers
To create a custom format for a number, modify an existing format. To restore the original format, you must change 
the custom format back to the original. So take note of the original format.

 Are you in Design?
1. Double-click a numeric field.
2. Click the Format tab in the InfoBox.

3. Make sure that Numeric is selected in the "Format type" box.
4. Select the format you want to modify in the "Current format" box.
5. Click Edit Format.

The Edit Format dialog box appears.
6. In the "Format code" box, enter the code for the new numeric format.
7. Click OK to close the Edit Format dialog box.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_NUMBERS_DETAILS',1)} See details



Details: Creating custom formats for times
Clock
You can set the clock for 12- or 24-hour time intervals.

• 12-hour time divides the hours of a day by AM and PM.
• 24-hour time displays the consecutive hours of a day from 0 (midnight) to 23:59:59.

Delimiter
Set the separator of hours from minutes. The default is a colon (:).

Suffixes
• For 12-hour time, set the suffixes for the first half and the second half of a day. The defaults are AM and PM.
• For 24-hour time, set the suffix for the hours. The default is h.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_TIMES_STEPS',1)} Go to procedure
{button ,AL(`H_ENTERING_VALUES_IN_NUMERIC_FIELDS_STEPS;H_FORMATTING_TIMES_STEPS;',0)} See 

related topics



Creating custom formats for times
To create a custom format for a time, modify an existing format. To restore the original format, you must change the 
custom format back to the original. So take note of the original format.

 Are you in Design?
1. Double-click a time field.
2. Click the Format tab in the InfoBox .

3. Select Time in the "Format type" box.
4. Select the format you want to modify in the "Current format" box.
5. Click Edit Format.

The Edit Format dialog box appears.
6. Select a 24-hour or 12-hour format.
7. (Optional) Enter a delimiter for separating hours, minutes, and seconds.
8. (Optional) Enter a suffix.

A sample of the selected format appears in the "Sample" box.
9. Click OK to close the Edit Format dialog box.
10. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FORMATTING_TIMES_STEPS;',0)} See related topics



Creating custom mailing label types
Approach accommodates dozens of standard label types, but you can also create your own mailing label type.

 Are you in Design?
1. Create the mailing label. 

• Don't select a label type.
• Don't click Done before completing the rest of these steps.

2. Click the Options tab.

3. Name the custom labels in the "Custom label" box.
4. Enter values for margin, label size, and gap dimensions.
5. Under Number of labels, enter the number of labels to appear across and down on the page.
6. Select a printing order in the "Arrange labels" box.
7. If you're using continuous feed labels, select "Tractor feed."

Choose Printer Setup to adjust printer settings for the correct paper size.
8. Click Add to save the custom label type.
9. Click Done.
Next time you create a label, the custom label type appears in the list of available label types.

{button ,AL(`H_ADDING_TEXT_TO_MAILING_LABELS_STEPS;H_CHANGING_OR_DELETING_CUSTOM_MAILIN
G_LABEL_TYPES_STEPS;H_CREATING_MAILING_LABELS_STEPS;H_MOVING_OR_RESIZING_MAILING_L
ABEL_FIELDS_STEPS;H_SETTING_OBJECTS_AND_FIELDS_TO_SLIDE_WHEN_PRINTING_STEPS;',0)} See 
related topics



Details: Creating dialog boxes from forms
You can create customized dialog boxes by designing and building a form containing fields, buttons, and objects. 
When you switch to this form with a macro or script, Approach displays the form as a dialog box. It crops the form to 
the right and bottom of all objects, and creates a title bar and close box for the dialog box.    Approach does not create
OK or Cancel buttons, so create macro buttons on the form to perform these functions, or use the Esc key to close 
the dialog box. 
When you create a macro to display the dialog box, use the View macro command and select the form.
When you are in Browse, Approach removes the form name from the list of available forms. However, you can still 
see it as a view in Design. You can also run a macro in Browse, from the Edit - Run Macros list, that switches to the 
form as a dialog box.

Tabbed dialog boxes
To create a dialog box with tabs, like an assistant, create forms containing multiple pages. When you display the form
as a dialog box, Approach converts each page into a tab of the dialog box. Tabs names correspond to the Page 
Name shown on the Basics tab for the form.

Example
Create a dialog box that contains more detailed information about the current form. Instead of displaying all the fields 
on the main form, such as a customer record, put the detail fields on the form displayed as a dialog. Add a macro 
button to the main form, called More Info, that displays the dialog form.

{button ,AL(`H_CREATING_DIALOG_BOXES_FROM_FORMS_STEPS',1)} Go to procedure



Creating dialog boxes from forms

 Are you in Design?
1. Double-click the background of the form, away from any object.
2. Click the Macros tab of the InfoBox.

3. Select "Show form as dialog."
4. (Optional) Move, collapse, or close the InfoBox.
Note Create macro buttons on other forms that switch to this form.

{button ,AL(`H_CREATING_DIALOG_BOXES_FROM_FORMS_DETAILS',1)} See details
{button ,AL(`H_ATTACHING_MACROS_STEPS',0)} See related topics



Creating partial borders

 Are you in Design?
1. Double-click the text block, object, or the background of a view.
2. Click the Lines & Colors tab in the InfoBox.

3. Under Border, deselect the parts of the border you want to eliminate.
4. (Optional) Move, collapse, or close the InfoBox.
Note If you apply a frame style in the Lines & Colors tab, all four borders are turned on automatically.

{button ,AL(`H_CHANGING_THE_WIDTH_OF_LINES_OR_BORDERS_STEPS;H_LINE_AND_COLOR_PROPERTI
ES_CS;',0)} See related topics



Crosstab options
Set which records crosstabs use to display calculated results.

 

Choose a task
Adding all groups to crosstabs 
Applying found sets to crosstabs

 



Define scrolling lists dialog box

Choose a task
Adding and deleting items in scrolling lists 
Displaying descriptive values in a scrolling list 
Displaying fewer values in a scrolling list 



Displaying descriptive values in a scrolling list
Entering hard-to-remember codes and identifiers is simplified if users can select from values that are more 
descriptive. 
For example, instead of making users select an ID number to identify a product, you can have users select the 
product name, while Approach enters the ID number in the database.

 Are you in Design?
1. Double-click the scrolling list field.
2. Click the Basics tab in the InfoBox.

3. Click Define List.
A dialog box appears.

4. Click Options.
5. Select "Show description field."
6. Select the field that contains the descriptive values for the list.

For example, for the field ProductID, simplify the selection of unfamiliar product codes by displaying the values in 
the ProductName field as the description field.

7. Click OK.
8. (Optional) Move, collapse, or close the InfoBox.
The field displays the values from the description field, but stores the corresponding value from the original field in the
database.

{button ,AL(`H_DISPLAYING_FEWER_VALUES_IN_A_SCROLLING_LIST_STEPS;H_DISPLAYING_THE_CONTEN
TS_OF_DROPDOWN_BOXES_AUTOMATICALLY_STEPS;H_ADDING_AND_DELETING_ITEMS_IN_SCROLLI
NG_LISTS_STEPS;',0)} See related topics



Displaying fewer values in a scrolling list
Set a condition that preselects or filters values for a field displayed as a drop-down box, field box and list, or a list 
box.

 Are you in Design?
1. Double-click the field.
2. Click the Basics tab in the InfoBox.

3. Click Define List.
A dialog box appears.

4. Click Options.
5. Select "Filter the list based on another field."

The Define Filter dialog box appears.
6. Select the field(s) to control the list.

For example, to filter a list of city names by state, select the State field as the filter. The City field then lists only 
the cities that have the same state as the state in the current record. 

7. Click OK to close the Define Filter dialog box.
8. Click OK.
9. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_DESCRIPTIVE_VALUES_IN_A_SCROLLING_LIST_STEPS;H_DISPLAYING_THE_C
ONTENTS_OF_DROPDOWN_BOXES_AUTOMATICALLY_STEPS;H_SELECTING_FROM_A_DROPDOWN_BO
X_STEPS;H_ADDING_AND_DELETING_ITEMS_IN_SCROLLING_LISTS_STEPS;',0)} See related topics



Details: Displaying fields as check boxes
A check box can quickly show the distinction between two data values of a field. Often, one value is the opposite of 
the other. For example:

(x) On (    ) Yes, I'll attend (x) Tax included
(    ) Off (x) No, I can't attend

In examples such as these, where the field has two values, each check box has a checked and unchecked value. By 
selecting a check box, you insert the checked value of that check box into the field. By deselecting it, you insert the 
unchecked value of that check box. In some cases, you don't have to define an unchecked value of a check box.

Setting an initial value for a check box
If you never select a check box, the field contains neither the checked value nor the unchecked value. It has no value 
(also called "null value").

• To enter the unchecked value in the database, you must first select the check box (check it) and then deselect it 
(uncheck it). 

• To ensure that the field contains either the checked or unchecked value, define one of them as the default value 
for the field. See Entering data automatically.

The label describes the checked and unchecked values
Use the label to clarify what it means to select the check box. In Browse, the label is the only indication of what value 
is placed in the field.
To show a group name for a field displayed as multiple check boxes, create a text block  that displays a group name 
for the check boxes.

More than one check box
You can define a field as more than one check box, such as in the on/off example shown above. When you have 
more than one check box like this, only one of the check boxes can be selected at a time.    When you select a check 
box, any box already selected in the set is deselected. 
You can deselect all of the check boxes. When you do this, the field value becomes the unchecked value of the last 
check box that you deselected.    For example, if you deselect On

(x) On
(    ) Off

and you defined the unchecked value for On as Off, then this happens: 
• On displays as unchecked
• Approach automatically selects Off
• The field value becomes Off

( ) On
(x) Off

If, however, On has no unchecked value and you deselect it, the field value becomes null, and both check boxes 
display as unchecked:

( ) On
( ) Off

Multiple-choice check boxes
Sometimes you may want users to be able to check more than one box in a set. (Such a set of choices often appears
with the instruction, "Check all that apply.")
For example, to find out what experience employees have with different operating systems, you could create the 
following set of check boxes:

(x) Windows95 (    ) Macintosh (x) OS/2
(    ) UNIX (    )Windows NT (    ) NeXT

To do this, you must define a field for each choice. Then define each field as a check box. To make them easier to 



move, group them together first. 

Radio buttons instead
Multiple check boxes allow you to have none of the choices in the set selected. Radio buttons require you to have 
one choice always selected. Use radio buttons if you want one, but no more than one, of the choices in the set 
selected at all times.

{button ,AL(`H_DISPLAYING_FIELDS_AS_CHECK_BOXES_STEPS',1)} Go to procedure
{button ,AL(`H_Displaying_fields_as_radio_buttons_STEPS;H_ENTERING_DATA_AUTOMATICALLY_STEPS;H_FIN

DING_RADIO_BUTTON_AND_CHECK_BOX_SETTINGS_STEPS;H_REARRANGING_A_SET_OF_RADIO_BUT
TONS_OR_CHECK_BOXES_STEPS;',0)} See related topics



Displaying fields as check boxes
A check box is most effective when you want a field to give users a choice between two mutually exclusive values. 
For example:

You can, however, use check boxes to display as many selections as you like.
In either case, the user can select just one value.

 Are you in Design?
1. Double-click the field.
2. Click the Basics tab in the InfoBox.

3. Select Check boxes in the "Data entry type" box.
The Define Check Box dialog box appears.

4. Define one or more check boxes for the field. 
Each row in the Define Check Box dialog box represents a check box.

• To create a single check box, enter a checked value, an unchecked value, and a label that explains what it 
means to select the check box.

• To create two or more check boxes, enter a checked value and a label for each check box. Entering an 
unchecked value is not necessary.

• If the field you're using already has data in it, and you want that data to appear as the possible selections, 
click "Create Check Boxes from Field Data."

5. Click OK to close the Define Check Box dialog box.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_FIELDS_AS_CHECK_BOXES_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_FIELDS_AS_RADIO_BUTTONS_STEPS;H_DISPLAYING_FIELDS_AS_SCROLLING_

LISTS_STEPS;H_FINDING_RADIO_BUTTON_AND_CHECK_BOX_SETTINGS_STEPS;H_REARRANGING_A_
SET_OF_RADIO_BUTTONS_OR_CHECK_BOXES_STEPS;',0)} See related topics



Details: Displaying fields as radio buttons
Radio buttons make choices clear among a small, predefined set of possible answers. For example:

Payment: Level:
( ) Credit ( ) Freshman
( ) Check ( ) Sophomore
( ) Cash ( ) Junior

( ) Senior

Setting an initial value for radio buttons
If you never select a radio button, the field has no value (also called "null value").
To ensure that the field contains a clicked value, define one of them as the default value for the field. See Entering 
data automatically.

Labeling the radio buttons
To show a group name for a field displayed as radio buttons, create a text block  that displays a group name for the 
radio buttons.

Entering a value with a radio button
A radio button has only one value, so you should normally use a set of two or more radio buttons for a single field, to 
allow for choices. Click a radio button to enter that value in the field. 
In a set of radio buttons, only one button can be selected at a time. When you select a radio button, any button that is
currently selected in the set is deselected.

Turning off radio buttons
If you want to be able to deselect all values in the set, use check boxes instead of radio buttons. You can also create 
a radio button for the "off" choice. For example, the last clicked value and label could be "None."

{button ,AL(`H_DISPLAYING_FIELDS_AS_RADIO_BUTTONS_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_A_TEXT_BLOCK_STEPS;H_ENTERING_DATA_AUTOMATICALLY_STEPS;H_FINDING_

RADIO_BUTTON_AND_CHECK_BOX_SETTINGS_STEPS;',0)} See related topics



Displaying fields as radio buttons
Use radio buttons when the field has a limited number of acceptable responses, and you want no more than one 
response at a time.

 Are you in Design?
1. Double-click the field.
2. Click the Basics tab in the InfoBox.

3. Select Radio buttons in the "Data entry type" box.
The Define Radio Buttons dialog box appears.

4. Set the values that the radio buttons represent.
• To use new values, enter clicked values and labels.
• To use values from the field, click Create Radio Buttons from Field Data.

5. Click OK to close the Define Radio Buttons dialog box.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_FIELDS_AS_RADIO_BUTTONS_DETAILS',1)} See details
{button ,AL(`H_FINDING_RADIO_BUTTON_AND_CHECK_BOX_SETTINGS_steps;H_REARRANGING_A_SET_OF

_RADIO_BUTTONS_OR_CHECK_BOXES_steps;H_displaying_fields_as_check_boxes_steps;H_displaying_field
s_as_scrolling_lists_steps;',0)} See related topics



Displaying fields as scrolling lists
A field in a view can show a predefined list of choices.
Note Users can select only one value from a scrolling list. If you want users to be able to make more than one 
selection from a group of related choices (for example, a group headed "Check all that apply"), create a check box  
for each choice.

 Are you in Design?
1. Double-click the field.
2. Click the Basics tab of the InfoBox.

3. In the "Data entry type" box, select one of the following:
• Drop-down list 
• Field box & list 
• List box 

4. If necessary, click Define List to define values for the field.
5. Select the values to display in the list. 

• To use new values, click the list and enter the values.
• To use existing values from this or another field, select "Create list automatically from field data."

6. (Optional) To include an arrow on drop-down boxes and fields boxes and lists, select "Show drop-down arrow."
7. Click OK to close the dialog box.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_DESCRIPTIVE_VALUES_IN_A_SCROLLING_LIST_STEPS;H_DISPLAYING_FEWER
_VALUES_IN_A_SCROLLING_LIST_STEPS;H_displaying_fields_as_check_boxes_steps;H_displaying_fields_as
_radio_buttons_steps;H_ADDING_AND_DELETING_ITEMS_IN_SCROLLING_LISTS_STEPS;',0)} See related 
topics



Details: Editing crosstab summaries
Calculating from crosstab or record values
For each crosstab summary, you can control which values are used in calculating the crosstab summary values. This 
distinction matters when your summary calculations involve averages, standard deviations, counts, minimum values, 
maximum values or variances.
For example, suppose you have the following records for how many of one product were sold by two sales 
representatives:

Sales rep Product Quantity
AG product1 100 
AG product1 200 
JF product1 300 

If you create a crosstab showing the average number of each product sold, you get different values for the average 
summary, depending on whether you consider each record separately (Summarize record values - 
(100+200+300)/3=200) or the groupings that appear on the crosstab (Summarize crosstab values - 
(300+300)/2=300):

Both of the calculations are correct; you need to determine which calculation is appropriate for what you are showing 
in your crosstab.

{button ,AL(`H_EDITING_CROSSTAB_SUMMARIES_STEPS',1)} Go to procedure
{button ,AL(`H_crosstabs_over;',0)} See related topics



Editing crosstab summaries
Control calculations for the following:

• Each summary row
• Each summary column
• Crosstab values

1. Click a row or column summary header.
To change the summary for the crosstab values, select any of the column headers closest to the body cells.

2. Choose Crosstab - Crosstab Properties.

3. Click the Formula tab in the InfoBox.

4. Select sum from the "Formula" box.
5. Select whether the formula should use the values visible in the crosstab or record values.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_EDITING_CROSSTAB_SUMMARIES_DETAILS',1)} See details
{button ,AL(`H_adding_summaries_to_crosstabs_steps;H_crosstabs_over;',0)} See related topics



Editing labels
These steps change only the label in the view. A change to a label does not affect the field name in the database.

 Are you in Design?
1. Double-click the field.
2. Click the Font tab in the InfoBox.

3. Select "Label."
4. Enter the new label in the "Label text" box.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_CHANGING_THE_POSITIO
N_OF_LABELS_STEPS;H_HIDING_LABELS_STEPS;',0)} See related topics



Formats for fields

Choose a task
Formatting data in text fields 
Formatting numbers
Formatting dates    
Formatting times 
Formatting currency
Formatting dates as quarters, thirds, and so on
Changing the date format on form letters

For custom formats
Creating custom formats for numbers
Creating custom formats for dates
Creating custom formats for times
Creating custom formats for currency

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_CURRENCY_DETAILS;H_CREATING_CUSTOM_FORMAT
S_FOR_DATES_DETAILS;H_CREATING_CUSTOM_FORMATS_FOR_TIMES_DETAILS;',0)} See related topics



Formatting currency
Currency formats are available for numeric and text fields.

 Are you in Design?
1. Double-click the field.
2. Click the Format tab in the InfoBox.

3. Select Currency in the "Format type" box.
4. Select a country from the "Current format" box.

A sample of the currency format appears in the lower right of the InfoBox.
5. (Optional) Click Edit Format to further modify the format.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_CUSTOM_FORMATS_FOR_CURRENCY_DETAILS;',0)} See related topics



Formatting dates as quarters, thirds, and so on

 Are you in Design?
1. Double-click the field.
2. Click the Format tab in the InfoBox.

3. Select Date in the "Format type" box.
4. Select one of the formats, such as 1st Quarter 58.
5. (Optional) Click Edit Format to change the format in the "Format code" box.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_STEPS;H_CREATING_CUSTOM_FORMATS_FOR_DATES
_STEPS;H_INSERTING_DATES_OR_TIMES_STEPS;',0)} See related topics



Details: Formatting dates
Entering dates in Browse
The format you select affects the way the date is displayed; it does not affect how you must enter the date. This is 
determined by the regional setting for dates of your computer's operating system.
So regardless of the date format you select for the field, enter a date in the order given by your regional setting, for 
example month first, then day, then year. 
If you select "Show data entry format" in the InfoBox, the entry format of the regional setting appears in the field when
it's selected in Browse. You do not need to enter any separators (for example, slashes). For example, you can enter 
050497, and Approach will interpret it correctly. 
If you do not select "Show data entry format" and you enter 050497 or 5497, an error message appears warning you 
that this is not a correct date. 
Approach replaces spaces left in dates as the current day, month, or year, depending on the position where the space
occurs. 
To enter dates in another order:

• Create separate fields for each date element and combine them in a calculated field.
• Change your operating system setting to the date order you prefer.

Overriding the Year 2000 setting
If you do not select "Show data entry format" in the InfoBox, you can enter the year in a four-digit format to override 
the millenium settings. 
For example, if you enter 5/14/02, Approach interprets it as May 14, 2002. To enter May 14, 1902, you must enter it 
as 5/14/1902.

Storing dates
Dates are stored in the database in the order specified by your operating system without any formatting.

International and system dates
Date formats marked [ISO] are international date formats. Date formats marked with a computer icon are system 
dates.

 
Approach reads these formats from the operating system. If you change system settings, they are automatically 
updated in the current Approach session. 
International and system date and time formats are not saved with the Approach document, as are other date and 
time formats.
System dates change according to the operating system you are using. If you do not want your date formats to 
change when you change operating systems, select a date format in the "Format type" box that is not marked with a 
computer icon. 
Note When you format a text field for dates or times, and you select "Show data entry format," Approach stores the 
text in the database with the date or time formatting.

{button ,AL(`H_FORMATTING_DATES_STEPS',1)} Go to procedure
{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_DETAILS;H_CREATING_CUSTOM_FORMATS_FOR_DATE

S_DETAILS;H_FORMATTING_DATES_AS_QUARTERS_THIRDS_AND_SO_ON_STEPS;H_INSERTING_DATE
S_OR_TIMES_STEPS;',0)} See related topics



Formatting dates
Dates entered as numbers can appear on a view in one of many formats. For example, format a field to display 
03/04/82 as Thursday, March 4, 1982.

 Are you in Design?
1. Double-click a field.
2. Click the Format tab in the InfoBox.

3. Select Date in the "Format type" box.
4. Select a date format in the "Current format" box.

A sample of the selected format appears in the lower right of the InfoBox.
5. (Optional) Click Edit Format to change which parts of the date appear or the separators that the date uses.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FORMATTING_DATES_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_STEPS;H_CREATING_CUSTOM_FORMATS_FOR_DATES

_STEPS;H_FORMATTING_DATES_AS_QUARTERS_THIRDS_AND_SO_ON_STEPS;H_INSERTING_DATES_
OR_TIMES_STEPS;',0)} See related topics



Formatting numbers
Number formats are available for numeric and text fields.

 Are you in Design?
1. Double-click the field.
2. Click the Format tab in the InfoBox.

3. Select Numeric in the "Format type" box.
4. Select a format from the "Current format" box.

A sample of the format appears in the lower right of the InfoBox.
5. (Optional) Click Edit Format to further modify the format.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ENTERING_VALUES_IN_NUMERIC_FIELDS_STEPS;H_CREATING_CUSTOM_FORMATS_FOR_N
UMBERS_DETAILS;',0)} See related topics



Formatting times
Time formats are available for time and text fields.

 Are you in Design?
1. Double-click the field.
2. Click the Format tab in the InfoBox.

3. Select Time in the "Format type" box.
4. Select a time format in the "Current format" box.

A sample of the format appears in the lower right of the InfoBox. 
5. (Optional) Click Edit Format to change the delimiter and whether the "AM" and "PM" suffixes appear.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ENTERING_TIMES_IN_TIME_FIELDS_STEPS;H_CREATING_CUSTOM_FORMATS_FOR_TIMES_
DETAILS;H_INSERTING_DATES_OR_TIMES_STEPS;',0)} See related topics



Formatting worksheets or crosstabs for printing
Add a title that appears on each page, and the date and page number, which appear in the footer of each page. 

 Are you in Design?
1. Choose Properties from the context menu.

2. Click the Printing tab.
3. To add a title, select "Print title" and enter a title.
4. To add a date, select "Print date."
5. To add a page number, select "Print page" number.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DOWNLOADING_DATA_BEFORE_PREVIEWING_STEPS;H_SPECIFYING_THE_PAPER_ORIENTA
TION_AND_MARGINS_STEPS;',0)} See related topics



Hiding labels in repeating panels

 Are you in Design?
1. Double-click the repeating panel.
2. Click the Basics tab in the InfoBox.

3. To hide labels in the panel, deselect "Show panel labels."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_EDITING_LABELS_STEPS;',
0)} See related topics



Hiding labels
When you hide a label, the data in the field remains visible.

 Are you in Design?
1. Double-click the field.
2. Click the Font tab in the InfoBox.

3. Select "Label."
4. Select No label in the "Label position" box.
5. (Optional) Move, collapse, or close the InfoBox.



Hiding views
Hidden views do not appear in the view tabs or in the status bar when you are in Browse.    Use hidden views when 
you do not want the user to see the data in those views.
In Design, hidden views appear in the status bar and can be displayed by users.

 Are you in Design?
1. Double-click the background of the view, away from any object.

For worksheets or crosstabs, choose Worksheet Properties or Crosstab Properties on the context menu.
2. Click the Basics tab of the InfoBox.

3. Under In Browse, select "Hide view."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NAMING_VIEWS_AND_OBJECTS_STEPS;H_SELECTING_A_MAIN_DATABASE_FOR_A_VIEW_S
TEPS;H_SHOWING_MORE_OF_THE_VIEW_BY_HIDING_ITS_MARGINS_STEPS;',0)} See related topics



Overview: InfoBox
Every object has a set of properties, such as size, text attributes, lines and fill colors, and attached macros. These 
object properties are available in the InfoBox. 

Opening the InfoBox in Design
• Click the InfoBox icon.

• Choose the Properties command of the object you want to work with from the context menu.
• Double-click an object or view.

Note If you click twice in a text block, Approach puts the insertion point in the object, it does not open the InfoBox.

InfoBox tabs
The InfoBox contains tabs that display the properties for the selected object. If no object is selected, the InfoBox tabs 
display the properties for the view. 
To see the properties for the object or view, click each tab in the InfoBox.

Working with the InfoBox
When you are working in Design, you can keep the InfoBox open as you work. Switch from working in the InfoBox to 
working in the view simply by clicking the view or an object. To switch back, click the word Properties in the InfoBox 
title bar.    
Approach displays the name of the selected object in the InfoBox title bar, so you can see which object is updated 
when you make a change. Most changes take effect as you make them, so you see the results immediately.

Moving, collapsing, or closing the InfoBox

Named styles
You can save a set of InfoBox properties as a named style and then apply the style to objects or to a view. You can 
apply these saved properties consistently, and all at once, without repeatedly applying them individually from the 
InfoBox.

{button ,AL(`H_BASIC_PROPERTIES_OF_OBJECTS_AND_FIELDS_CS;H_BASIC_PROPERTIES_OF_VIEWS_CS
;H_FORMATS_FOR_FIELDS_CS;H_LINE_AND_COLOR_PROPERTIES_CS;H_SIZE_OF_OBJECTS_CS;H_TE
XT_ATTRIBUTES_FOR_LABELS_AND_DATA_CS;',0)} See related topics



Line and color properties

Choose a task
Making objects and views transparent 
Changing the color of objects and views    
Creating partial borders 
Changing the width of lines or borders
Creating a shadow

For fields
Displaying baselines in fields
Displaying field labels inside field boxes 

For PicturePlus fields
Changing pen properties for drawing in fields 

For repeating panels
Alternating the color of records in a repeating panel 

{button ,AL(`H_APPLYING_PROPERTIES_FROM_ANOTHER_OBJECT_STEPS;',0)} See related topics



Macros tab

Choose a task
Attaching macros 
Creating dialog boxes from forms 



Making objects and views transparent
Whatever is beneath a transparent object shows through. This is useful, for example, for placing text inside a circle 
instead of a rectangle. 

 Are you in Design?
1. Double-click the text block, object, or the background of a view.
2. Click the Lines & Colors tab in the InfoBox.

3. Under "Fill color," select T (Transparent).

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_LINE_AND_COLOR_PROPERTIES_CS;H_PUTTING_OBJECTS_AND_FIELDS_IN_THE_TAB_ORD
ER_STEPS;',0)} See related topics



Moving, collapsing, or closing the InfoBox



Moving objects
The unit of measurement used in this procedure (grid units: inches or centimeters) is selected in the Display tab of 
the Approach Preferences dialog box. 

 Are you in Design?

Moving an object using exact measurements
1. Double-click the object.
2. Click the Size tab in the InfoBox.

3. Enter Top and Left measurements.
4. (Optional) Move, collapse, or close the InfoBox.

Moving an object using the mouse
Select the object and drag it.
The mouse pointer changes to a hand when the object can be moved.

Nudging an object 
Select the object and move it with the keyboard keys: , ¯, ®, or ¬. 
Nudging an object moves the object off the grid alignment.

{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_RESIZING_OBJECTS_
STEPS;H_SELECTING_OBJECTS_STEPS;',0)} See related topics



Moving summaries
Summary panels appear on reports only.
Tip Do the following to make the report design clearer:

• Deselect View - Show Data. 
• Select View - Show Panel Labels

 Are you in Design?
1. Double-click the summary panel.

The title bar of the InfoBox should say "Properties for: Summary Panel."
2. Click the Display tab in the InfoBox.

3. Select an alignment.
4. Select whether the summary should go above (leading) or below (trailing) the records it summarizes.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_reports_over;',0)} See related topics



Naming views and objects
• When you rename a view using the InfoBox, its name on the view tab and in the status bar also changes.
• Use the name of a drawn object to refer to it in a LotusScript script.    

 Are you in Design?
1. Double-click the object, or background of the view away from any object.

For worksheets or crosstabs, choose Worksheet Properties or Crosstab Properties on the context menu.
2. For views, click the Basics tab in the InfoBox.

For objects, click the Macros tab in the InfoBox.

3. Enter a name for the view or object.
4. (Optional) Move, collapse, or close the InfoBox.

• You can also rename a view by double-clicking the view tab and entering the name in the tab.
• To change the name in the text block at the top of a form, double-click it and enter the new name. This does 

not change the name of the view.

{button ,AL(`H_CHANGING_THE_MENU_FOR_A_VIEW_STEPS;H_EXTENDING_THE_BACKGROUND_TO_THE_
EDGE_OFTHE_WINDOW_STEPS;H_HIDING_VIEWS_STEPS;H_PREVENTING_OBJECTS_AND_FIELDS_FR
OM_PRINTING_STEPS;H_PUTTING_OBJECTS_AND_FIELDS_IN_THE_TAB_ORDER_STEPS;H_SELECTING
_A_MAIN_DATABASE_FOR_A_VIEW_STEPS;',0)} See related topics



Paginating reports

 Are you in Design?

Breaking pages before summaries
Prevents a page break within summaries so summary values appear with related records.
1. Double-click the summary panel.

The title bar of the InfoBox shows the type of panel.
2. Click the Basics tab in the InfoBox.

3. Under When printing, select "Insert page break."
4. (Optional) Move, collapse, or close the InfoBox.

Breaking pages at record boundaries
Keeps a record's fields on the same page when there is more than one line of fields in the record.
1. Choose Report Properties on the context menu.
2. Click the Basics tab in the InfoBox.

3. Select "Keep records together."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_report_panels_over;H_reports_over;',0)} See related topics



Preventing objects and fields from printing

 Are you in Design?
1. Double-click the object.
2. Click the Basics tab in the InfoBox.

3. Under Display, select "Nonprinting."
4. (Optional) To see a nonprinting object in Print Preview and in Design when View - Show Data is on, select "Show 

in Print Preview."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NAMING_VIEWS_AND_OBJECTS_STEPS;H_PUTTING_OBJECTS_AND_FIELDS_IN_THE_TAB_O
RDER_STEPS;',0)} See related topics



Reducing or expanding sections of reports when printing
Control report printing for each type of panel in the report.

 Are you in Design?
1. Double-click the panel.

The title bar of the InfoBox shows the type of panel you selected.
2. Click the Basics tab in the InfoBox.

3. Under "When printing," select one or more of the following:
• To decrease the panel size to fit smaller contents, select "Reduce boundaries."
• To increase the panel size to fit larger contents, select "Expand boundaries."
• To start a summary group on a new page, select "Insert page break."

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SELECT_PRINT_PREVIEW_TO_SEE_REPORT_SUMMARIES_REF;H_SPECIFYING_THE_PRINT
ER_PAPER_AND_ORIENTATION_STEPS;H_printing_approach_views_over;H_report_panels_over;',0)} See 
related topics



Putting objects and fields in the tab order
You can put all objects and fields, except calculated fields, in the tab order so users can press TAB to navigate to 
them.

 Are you in Design?
1. Double-click the object.
2. Click the Basics tab in the InfoBox.

3. Select "In tab order."
4. (Optional) Move, collapse, or close the InfoBox.
Note If you attach a macro to a drawn object, put the object in the tab order. Otherwise, you cannot use TAB to move 
into or out of that object, to activate the macro. You can click the object the macro is attached to if the macro was 
attached to the object using the "On selected" option in the InfoBox.

{button ,AL(`H_FIELDS_OVER;H_REMOVING_OBJECTS_AND_FIELDS_FROM_THE_TAB_ORDER_STEPS;H_AT
TACHING_MACROS_STEPS;H_CHANGING_THE_TAB_ORDER_ON_VIEWS_STEPS;',0)} See related topics



Redisplaying hidden views
When you redisplay hidden views, their names appear in the status bar in Browse and in the view tabs.

 Are you in Design?
1. Click the View button in the status bar.
2. Select the name of the hidden view.
3. Click the InfoBox icon.

4. Click the Basics tab of the InfoBox.

5. Under In Browse, deselect "Hide view."
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_HIDING_VIEWS_STEPS;',0)} See related topics



Removing objects and fields from the tab order

 Are you in Design?
1. Double-click the object.
2. Click the Basics tab in the InfoBox.

3. Deselect "In tab order."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FIELDS_OVER;H_PUTTING_OBJECTS_AND_FIELDS_IN_THE_TAB_ORDER_STEPS',0)} See 
related topics



Resizing objects
The unit of measurement used in this procedure (grid units) is selected in the Display tab of the Approach 
Preferences dialog box. 

 Are you in Design?

Resizing an object to exact measurements
1. Double-click the object.
2. Click the Size tab in the InfoBox.

3. Enter Width and Height measurements.
4. (Optional) Move, collapse, or close the InfoBox.

Resizing an object using the mouse
Select the object and drag one of its handles. 

{button ,AL(`H_DRAWING_GEOMETRIC_OBJECTS_STEPS;H_MOVING_OBJECTS_STEPS;H_SETTING_PREFE
RENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SELECTING_OBJECTS_STEPS;',0)} See related 
topics



Modifying repeating panels
You can increase both the height and width of a line in a repeating panel. Increasing the height lets you stack fields in
that line and makes the repeating panel look like a number of small forms.
If you're trying to add more lines to the panel, use the Basics tab of the InfoBox.

 Are you in Design?
1. Turn off View - Show Data.

Just the outline of the panel remains, and in its first line, the field names.
2. Select the repeating panel.

The repeating panel is selected when the first-record line has a double-line border around it.
3. When the mouse pointer changes to a    two-headed arrow, drag the border of the first line.
4. Drag fields to new locations. 

Make sure the fields remain within the panel.

{button ,AL(`H_RESIZING_OBJECTS_STEPS;',0)} See related topics



Selecting a main database for a view
If you have joined databases in the Approach file, one of the databases must be the main database  for the view. A 
view displays each record from its main database.

 Are you in Design?
1. Double-click the background of the view, away from any object.

For worksheets or crosstabs, choose Worksheet Properties or Crosstab Properties on the context menu.
2. Click the Basics tab of the InfoBox.

3. Select a database in the "Main database" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_MENU_FOR_A_VIEW_STEPS;H_HIDING_VIEWS_STEPS;H_JOINING_DATABA
SE_FILES_STEPS;H_NAMING_VIEWS_AND_OBJECTS_STEPS;H_SHOWING_MORE_OF_THE_VIEW_BY_HI
DING_ITS_MARGINS_STEPS;',0)} See related topics



Formatting data in text fields
Choose capitalization options for text.

 Are you in Design?
1. Double-click a field.
2. Click the Format tab in the InfoBox.

3. Select Text in the "Format type" box.
4. Select a format in the "Current format" box.
5. (Optional) Move, collapse, or close the InfoBox.
Note "Show data entry format" stores the text in the database with the formatting.

{button ,AL(`H_FORMATTING_DATES_STEPS;H_FORMATTING_NUMBERS_STEPS;H_FORMATTING_TIMES_S
TEPS;',0)} See related topics



Setting margins for views

 Are you in Design?
1. Double-click the background of the view, away from any object.
2. Click the Margins tab in the InfoBox.

3. Under Margins, enter measurements for the Left, Right, Top, and Bottom margins.
The unit of measurement is the same as that for the grid, specified in the Display tab of    Approach Preferences.

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SHOWING_MORE_OF_THE_VIEW_BY_HIDING_ITS_MARGINS_STEPS;H_SETTING_PREFEREN
CES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SNAPPING_OBJECTS_TO_THE_GRID_STEPS;',0)} See 
related topics



Showing records from other databases in a report
When you create a report with groups and totals using data from more than one database, the report shows all of the 
records from the main database, even if there are no corresponding records in the detail database. However, this 
report may show only one record from the detail database for each main database entry.
If you're trying to change your report to display all records from the main database, even if there are no related 
records in the detail database, either base the report on a different database (see Selecting a main database for a 
view), or create an outer join for the report. Choose the method that makes sense for your data.

Creating an outer join report
An outer join shows

• All detail database records appear for each main database record.
• Main database records without any detail entries also appear on the report.

 Are you in Design?
1. Choose Report Properties on the context menu.
2. Click the Options tab in the InfoBox.

3. To create an outer join, select "Enable outer join."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND
_ONE_TO_ONE_RELATIONSHIPS_OVER;H_REPORTS_OVER;H_SELECTING_A_MAIN_DATABASE_FOR_A
_VIEW_STEPS;',0)} See related topics



Showing more of the view by hiding its margins
You can hide the margins of forms and form letters only.

 Are you in Design?
1. Double-click the background of the view, away from any object.
2. Click the Basics tab of the InfoBox.

3. Under In Browse, select "Hide page margins."
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_MARGINS_STEPS;H_CHANGING_THE_MENU_FOR_A_VIEW_STEPS;H_HIDING_VIE
WS_STEPS;H_RENAMING_VIEWS_STEPS;H_SELECTING_A_MAIN_DATABASE_FOR_A_VIEW_STEPS;',0)} 
See related topics



Size of objects

You can change the size and shape of an object, including fields, by using the mouse in Design or by clicking the 
Size tab in the InfoBox. 
The Size tab also lets you move an object.

Choose a task
Resizing objects
Moving objects
Closing up extra space between objects

{button ,AL(`H_BASIC_PROPERTIES_OF_OBJECTS_AND_FIELDS_CS;H_LINE_AND_COLOR_PROPERTIES_C
S;H_SELECTING_OBJECTS_STEPS;H_APP_HOW_DO_I_GET_RID_OF_THE_SPACE_BETWEEN_OBJECTS
_OVER;',0)} See related topics



Setting a default sort order for a repeating panel

 Are you in Design?
1. Select the repeating panel.
2. From the Panel menu, choose Panel Properties.
3. Click the Basics tab in the InfoBox.

4. Click Define Sort.
The Sort dialog box appears.

5. Be sure the database containing the field you want is showing in the "Database" box.
6. Select a field in the "Fields" box.
7. Click Add.
8. Specify the sort order for that field by choosing either Ascending or Descending from the "Sort order" box.
9. To add additional fields, repeat steps 4 - 7.
10. Click OK to close the Sort dialog box.
11. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SPECIFYING_A_SORT_ORDER_STEPS;',0)} See related topics



Text attributes for labels, data, and text blocks

• Labels identify fields and are part of the design of the view. 
• Data is the information stored in a database.
• Text blocks are drawn objects containing text. They are part of the design of a view.

Choose a task
Changing text attributes of labels or data 
Changing properties of text in text blocks 
Editing labels 
Changing the position of labels 
Hiding labels 



Details: Adding an icon to a set of SmartIcons
Available icons (drag to add) 
The icons in this list are grouped according to the Approach menu organization; File, Edit, View, Create, Window, and
Help, followed by Browse, Design, Form, Report, Crosstab, Worksheet, etc.

Dragging an icon into a set 
When you drag and drop icons, Approach moves the other icons in the set either forward or backward one position to 
accommodate the change. The SmartIcons then appear in the new order in the dialog box. 
You can use the left and right arrows to see icons that scroll out of sight.

Saving a SmartIcons set
If you click... This is what happens...
Save Set Takes you to the Save As SmartIcons 

File dialog box where you can give the 
new icon set a name and save it in its 
own file. The new set name becomes 
part of the SmartIcons list. 
Click Browse to rename the .SMI file.
Click OK to return to the SmartIcons 
Setup dialog box. 
Click OK again.

Delete Set Takes you to the Delete Set dialog box 
where you can delete sets of SmartIcons 
you do not use. 
Click OK to return to the SmartIcons 
Setup dialog box. 
Click OK again.

OK Displays the new SmartIcons set. 
Approach displays the new arrangement 
every time you select this set. 

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_A_NEW_SMARTICONS_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H

_MOVING_AN_ICON_USING_THE_MOUSE_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTIC
ONS_STEPS;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTICONS_IN_A_SE
T_STEPS',0)} See related topics



Adding an icon to a set of SmartIcons
1. From the File menu, choose User Setup, and then choose SmartIcons Setup.
2. Under Bar to setup, select the name of the bar to which you want to add the icon.
3. To review all SmartIcons available in Approach, scroll the "Available icons (drag to add)" box.
4. Drag an icon from the list to the bar at the top of the dialog box. 
5. Do one of the following:

• To save your changes to the existing set, click OK.
• To save the bar with a different name, click Save Set. 

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NEW_SMARTICONS_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H

_MOVING_AN_ICON_USING_THE_MOUSE_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTIC
ONS_STEPS;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTICONS_IN_A_SE
T_STEPS',0)} See related topics



Details: Creating a new SmartIcons set
Working with SmartIcons

• Add icons by dragging icons from the "Available icons (drag to add)" box up into the new set. 
• Move and rearrange icons by dragging them (including spacers) within the new set. 
• Remove icons from the set by dragging them away from the displayed set.

Save Set 
Clicking Save Set opens the Save As SmartIcons File dialog box. There you can indicate you are changing the 
existing SmartIcons bar or creating a new one. If you click Save As New, name the new SmartIcons bar and its file 
name. 
Approach saves the new icon bar in an .SMI file, which is stored in the mainbar directory. The new name appears in 
the "Bar name" box.

Bar can be displayed when context is 
This option lets you define the context    in which you want the set of SmartIcons to be available: Always, Browse, 
Chart, Crosstab, Design, Find, and so on.

Bar is enabled to display during its context 
This option acts as an on/off display switch. If selected, Approach displays the named SmartIcons bar in its defined 
context. If deselected, Approach does not display the bar.

{button ,AL(`H_CREATING_A_NEW_SMARTICONS_SET_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_DELETING_A_SMARTICONS_SET

_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_PLACING_SMARTICONS_O
N_THE_WORKSPACE_OVER;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTI
CONS_IN_A_SET_STEPS',0)} See related topics



Creating a new SmartIcons set
1. From the File menu, choose User Setup, and then choose SmartIcons Setup.

2. Select a SmartIcons set to use as a base for the new set in the "Bar name" box.
3. Use drag and drop to add, move, group, and remove icons until the set is the way you want.    
4. Click Save Set.
5. Click Save As New.
6. Enter a name for the new set. 
7. If the file name is to be different from the bar name, enter a new file name for the set.
8. Click OK to return to the SmartIcons Setup dialog box.
9. To make the new bar available when you work in a specific part of the Approach file, select the context in "Bar can

be displayed when context is."
10. To display the new bar when the chosen context is active, select "Bar is enabled to display during its context." 
11. Click OK.

{button ,AL(`H_CREATING_A_NEW_SMARTICONS_SET_DETAILS',1)} See details
{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_DELETING_A_SMARTICONS_SET

_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_PLACING_SMARTICONS_O
N_THE_WORKSPACE_OVER;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTI
CONS_IN_A_SET_STEPS',0)} See related topics



Deleting a SmartIcons set
1. Choose File - User Setup -    SmartIcons Setup.

2. Click Delete Set.
3. Select the set you want to delete.
4. Click OK.
5. Approach asks you to confirm your selection.

Clicking Yes deletes the .SMI file and returns you to the SmartIcons Setup dialog box.
6. Click OK.

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_MOVING_AN_ICON_USING_THE_
MOUSE_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_SMARTICONS_SET
UP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTICONS_IN_A_SET_STEPS',0)} See related topics



Displaying or hiding SmartIcons bubble help
1. Choose File - User Setup - SmartIcons Setup.

2. Select "Show icon descriptions (bubble help)."
3. Click OK.

Place the mouse pointer on an icon and pause for a second. 
Approach displays a bubble describing what the icon does.

Hiding bubble help
Remove bubble help by deselecting "Show icon descriptions (bubble help)."

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORK
SPACE_OVER;H_USING_SMARTICONS_OVER;H_SELECTING_A_SMARTICONS_SET_USING_THE_BAR_B
UTTON_STEPS;H_SELECTING_AND_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS;H_SIZING_ICONS_IN_
A_SMARTICONS_SET_STEPS;H_USING_AN_ICON_STEPS',0)} See related topics



Displaying or hiding SmartIcons
• Choose View - Show SmartIcons.

A checkmark appears by the command when the SmartIcons are displayed. You can hide the SmartIcons by 
repeating these steps.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_HIDING_SMARTICONS_US
ING_THE_BAR_BUTTON_STEPS;H_PLACING_SMARTICONS_ON_THE_WORKSPACE_OVER;H_USING_SM
ARTICONS_OVER;H_SELECTING_A_SMARTICONS_SET_USING_THE_BAR_BUTTON_STEPS;H_SELECTIN
G_AND_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS',0)} See related topics



Hiding SmartIcons using the bar button 
1. Click the control box in the upper left corner of the icon bar. 
2. Choose Hide all SmartIcons or Hide this bar of SmartIcons.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_DISPLAYING_OR_HIDING_
SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORKSPACE_OVER;H_SMARTICONS_OVER;
H_USING_SMARTICONS_OVER;H_SELECTING_AND_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS;H_SIZI
NG_ICONS_IN_A_SMARTICONS_SET_STEPS',0)} See related topics



Moving an icon using the mouse
1. Press CTRL.
2. Drag an icon to a new location.

Dragging the icon off the SmartIcons bar places it at the end of the set. 

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_CREATING_A_NEW_SMARTICON
S_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_
SMARTICONS_STEPS;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTICONS
_IN_A_SET_STEPS',0)} See related topics



Placing a set of SmartIcons using the mouse
1. Place the mouse pointer over the area next to the bar button.

2. Click and drag the bar to the new location in the Approach workspace. 
As you drag it, the hand closes around an outline of the bar. 

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_DISPLAYING_OR_HIDING_
SMARTICONS_STEPS;H_HIDING_SMARTICONS_USING_THE_BAR_BUTTON_STEPS;H_PLACING_SMARTI
CONS_ON_THE_WORKSPACE_OVER;H_USING_SMARTICONS_OVER',0)} See related topics



Overview: Placing SmartIcons on the work area
You can display a set of SmartIcons at the sides of the Approach work area in a fixed position (left or right). If you 
drag a SmartIcons bar to an edge, it snaps to and stays with that edge, even when you move the work area window.
You can also display SmartIcons in a floating position. Dragging SmartIcons to a place other than an edge creates a 
floating palette. 

Context SmartIcons sets
You can display more than one set of SmartIcons for any context. Right-click anywhere in a SmartIcons bar to display
the shortcut menu of the SmartIcons options and the names of the available sets of SmartIcons. You can select a 
name to display or hide a set of SmartIcons.

Sharing the same location
You can define a group of SmartIcons sets that show up in the same location.
1. From the SmartIcons shortcut menu, choose SmartIcons Setup. 
2. In the "Bars that will appear in same location" box, select all of the SmartIcons sets you want to appear in the 

same location.
3. Click OK.
When you move one of those sets to a different location, Approach remembers that location for all sets of SmartIcons
defined in this group. 
For example, you include both the default Worksheet set of SmartIcons and the default Report set of SmartIcons in 
the group of context SmartIcons sets. 
While viewing a report, you drag the Default Report set of SmartIcons to the left side. 
When you switch to a worksheet, the Default Worksheet set of SmartIcons appears on the left side.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_HIDING_SMARTICONS_USING_THE_BAR_
BUTTON_STEPS;H_MOVING_AN_ICON_USING_THE_MOUSE_STEPS;H_USING_SMARTICONS_OVER;H_P
LACING_A_SET_OF_SMARTICONS_USING_THE_MOUSE_STEPS;H_SELECTING_AND_DISPLAYING_A_SP
ECIFIC_ICON_SET_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS',0)} See related topics



Removing an icon from a set of SmartIcons
1. Choose File - User Setup - SmartIcons Setup.

2. Select the set you want to modify under "Bar name."
3. Drag the icon you want to remove away from the displayed set.    
4. (Optional) To remove the icon for all sessions, click Save Set.
5. Click OK.

Approach displays the new arrangement every time you select this set.

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_CREATING_A_NEW_SMARTICON
S_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H_MOVING_AN_ICON_USING_THE_MOUSE_S
TEPS;H_SMARTICONS_SETUP_DIALOG_BOX_CS;H_SPACING_BETWEEN_SMARTICONS_IN_A_SET_STE
PS',0)} See related topics



Details: Selecting and displaying a specific icon set
Bar name
The name of the set of SmartIcons that you are defining.

Bar can be displayed when context is 
You can display a set of SmartIcons to correspond to various contexts: Always, Browse, Design, Crosstab, Find, etc.
For example, you have defined a custom set of SmartIcons you want to display when you are working with report 
columns. 

• First, select the custom set of SmartIcons under "Bar name." 
• Then select Report Column under "Bar can be displayed when context is."

Now the custom set of SmartIcons has the context of report columns and can display when you are working with 
report columns.

Bar is enabled to display during its context 
More than one set of SmartIcons can have the same context. You can display more than one set of SmartIcons at the
same time.
This option acts as an on/off display switch. If selected, the named set of SmartIcons displays when you're working in 
the specified context. Deselect this option to turn off the display. 
For example, to display the custom set of SmartIcons defined for report columns in the earlier example, you need to 
select "Bar is enabled to display during its context."

SmartIcons preferences
Options under SmartIcons preferences apply to all sets of SmartIcons. See the following topics:

• Sizing sets of SmartIcons 
• Placing SmartIcons on the work area 
• Displaying or hiding SmartIcons bubble help

{button ,AL(`H_SELECTING_AND_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS',1)} Go to procedure
{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORK

SPACE_OVER;H_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_SELECTING_A_SMARTICONS_S
ET_USING_THE_BAR_BUTTON_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS',0)} See related
topics



Selecting and displaying a specific icon set
1. Choose File - User Setup - SmartIcons Setup.

2. Select the set under "Bar name."
3. Select an option under "Bar can be displayed when context is." 
4. If you want to display the set at specific times (depending on your selections in steps 3 and 4), select "Bar is 

enabled to display during its context."
Note Typically, this setting should always be selected.

5. Click OK.
Tip You can use a shortcut to display available sets of SmartIcons by clicking the bar button on the icon bar and 
making your selection.

{button ,AL(`H_SELECTING_AND_DISPLAYING_A_SPECIFIC_ICON_SET_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORK

SPACE_OVER;H_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_SELECTING_A_SMARTICONS_S
ET_USING_THE_BAR_BUTTON_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS',0)} See related
topics



Selecting a SmartIcons set using the bar button
1. Click the bar button on the icon bar. 

2. Make your selection from the menu.
The menu contents depend on the available selection when you click the bar button.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_DISPLAYING_OR_HIDING_
SMARTICONS_STEPS;H_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_SELECTING_AND_DISP
LAYING_A_SPECIFIC_ICON_SET_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS;H_USING_A
N_ICON_STEPS',0)} See related topics



Sizing icons in a SmartIcons set 
1. Choose File - User Setup - SmartIcons Setup.

2. In the "Icon size" box, select Regular or Large. 
3. Click OK. 

{button ,AL(`H_PLACING_SMARTICONS_ON_THE_WORKSPACE_OVER;H_USING_SMARTICONS_OVER;H_PL
ACING_A_SET_OF_SMARTICONS_USING_THE_MOUSE_STEPS;H_SELECTING_A_SMARTICONS_SET_US
ING_THE_BAR_BUTTON_STEPS;H_SELECTING_AND_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS',0)} 
See related topics



Overview: SmartIcons
SmartIcons are icons that represent mouse shortcuts for Approach actions and commands. At least two SmartIcons 
sets appear at the top of the page when you first start Approach. 
You can modify SmartIcons for use as a custom set. 
When you use SmartIcons, you can:

• Check to see what each icon represents.
• Place sets of SmartIcons at the side of or floating on the Approach workspace. 
• Specify their size.
• Display different SmartIcons sets while you're working in specific parts of an Approach file.
• Customize one or more specific sets.
• Add, move, group, and remove icons from a set.
• Delete them, either individually or as a set.
• Specify the location for a bar or several bars.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORK
SPACE_OVER;H_USING_SMARTICONS_OVER;H_PLACING_A_SET_OF_SMARTICONS_USING_THE_MOUS
E_STEPS;H_SELECTING_A_SMARTICONS_SET_USING_THE_BAR_BUTTON_STEPS;H_SELECTING_AND_
DISPLAYING_A_SPECIFIC_ICON_SET_STEPS;',0)} See related topics



SmartIcons Setup dialog box
You can review all sets of SmartIcons in this dialog box by selecting an icon set from the SmartIcons Bar name list. 
When you do this, the specific icon set appears at the top of the box.
Using a SmartIcons set in this dialog box, you can add, move, group, and remove the icons in a set. 
Tip You can also open the SmartIcons Setup dialog box by clicking the bar button on the SmartIcons bar and 
choosing SmartIcons setup.

Choose a task
Selecting and displaying a specific icon set
Sizing icons in a SmartIcons set
Spacing between SmartIcons in a set
Adding an icon to a set of SmartIcons
Removing an icon from a set of SmartIcons
Creating a new SmartIcons set
Deleting a SmartIcons set

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_STEPS;H_SMARTICONS_OVER;H_USING_SMARTIC
ONS_OVER;H_PLACING_SMARTICONS_ON_THE_WORKSPACE_OVER;H_SELECTING_AND_DISPLAYING_
A_SPECIFIC_ICON_SET_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS;H_DISPLAYING_OR_
HIDING_SMARTICONS_BUBBLE_HELP_STEPS',0)} See related topics



Details: Spacing between SmartIcons in a set
When you drag and drop icons, Approach moves the other icons in the set forward or backward one position to 
accommodate the change. The SmartIcons then appear in the new order in the dialog box.    
You can use the left and right arrows to see icons that scroll out of sight.
Save the .SMI file for the change to take effect across all sessions.

{button ,AL(`H_SPACING_BETWEEN_SMARTICONS_IN_A_SET_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_CREATING_A_NEW_SMARTICON

S_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H_MOVING_AN_ICON_USING_THE_MOUSE_S
TEPS;H_SMARTICONS_OVER;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_SMA
RTICONS_SETUP_DIALOG_BOX_CS',0)} See related topics



Spacing between SmartIcons in a set 

1. Choose File - User Setup - SmartIcons Setup.

2. Under "Bar name," select the SmartIcon set you want to work with. 
3. Drag a spacer to separate the icons within the displayed set. 

4. Click OK.

{button ,AL(`H_SPACING_BETWEEN_SMARTICONS_IN_A_SET_DETAILS',1)} See details
{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_CREATING_A_NEW_SMARTICON

S_SET_STEPS;H_DELETING_A_SMARTICONS_SET_STEPS;H_MOVING_AN_ICON_USING_THE_MOUSE_S
TEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_SMARTICONS_SETUP_DIALO
G_BOX_CS',0)} See related topics



Using an icon
Place the mouse pointer over the desired icon and click.
Certain icons depress after you use them.
You can click a depressed icon to undo its state. For example, Show/Hide rulers, Show/Hide tools palette, Show/HIde
panel labels.

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_DISPLAYING_OR_HIDING_
SMARTICONS_STEPS;H_SMARTICONS_OVER;H_PLACING_A_SET_OF_SMARTICONS_USING_THE_MOU
SE_STEPS;H_SELECTING_A_SMARTICONS_SET_USING_THE_BAR_BUTTON_STEPS;H_SELECTING_AND
_DISPLAYING_A_SPECIFIC_ICON_SET_STEPS;H_SIZING_ICONS_IN_A_SMARTICONS_SET_STEPS',0)} 
See related topics



Overview: Using SmartIcons
When you first start Approach, at least two default sets of SmartIcons display. You can easily display one or more 
different sets. 
Certain SmartIcons depress after you use them. For example, if you click the SmartIcons Browse, Design, or 
Preview, they appear depressed on the icon bar.
If you place SmartIcons at the sides of or floating in the Approach window, their position is used by other SmartIcons 
sets that subsequently display. For example, if you place worksheet SmartIcons in a floating position in the Approach 
window and then view a report, the report SmartIcons appear in the same floating location.
Sets of SmartIcons save as .SMI files. 

{button ,AL(`H_DISPLAYING_OR_HIDING_SMARTICONS_BUBBLE_HELP_STEPS;H_DISPLAYING_OR_HIDING_
SMARTICONS_STEPS;H_PLACING_SMARTICONS_ON_THE_WORKSPACE_OVER;H_SMARTICONS_OVER;
H_SELECTING_A_SMARTICONS_SET_USING_THE_BAR_BUTTON_STEPS;H_SELECTING_AND_DISPLAYI
NG_A_SPECIFIC_ICON_SET_STEPS;H_USING_AN_ICON_STEPS',0)} See related topics



Adding a repeating panel to existing forms
You can add a repeating panel to a form if you have joined databases associated with the Approach file.
Want the big picture? See Overview: Repeating Panels.

 Show me a QuickDemo 

 Are you in Design?
1. Click where you want to place the top left corner of the repeating panel.
2. From the Create menu, choose Repeating Panel.
3. Be sure the database containing the fields you want is showing in the "Database" box.

The database cannot be the main database of the form.
4. Select a field in the "Fields" box.
5. Click Add.
6. To add additional fields, repeat steps 4 and 5.
7. (Optional) To alternate the color of the records, select "Alternate color with" and select a color.
8. (Optional) Enter the number of records to display in the panel at once in the "Number of lines" box.

Maximum: 30. The repeating panel must fit on one page of the form. If the number of records exceeds the limit 
you set, a scroll bar appears on the panel.

9. (Optional) To set a sort order for the records in the panel, click Define Sort.
The Sort dialog box appears.

10. (Optional) Specify the sort order and click OK.
11. Click OK.

{button ,AL(`H_ADDING_A_REPEATING_PANEL_TO_NEW_FORMS_STEPS;H_BASIC_PROPERTIES_OF_OBJE
CTS_AND_FIELDS_CS;H_FORMS_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_ONE_RELATI
ONSHIPS_OVER;H_REPEATING_PANELS_OVER;H_REPORT_PANELS_OVER;H_MAIN_AND_DETAIL_DATA
BASES_IN_A_VIEW_OVER;',0)} See related topics



Creating new forms that include a repeating panel
Add    a repeating panel to show data from joined databases.    The form on which the repeating panel appears 
represents the "one" side of the one-to-many    relationship between the two databases, while the repeating panel 
represents the "many" side.
Want the big picture? See Overview: Repeating Panels.
Command: Create - Form

1. On the Layout tab of the Form Assistant, select Standard with Repeating Panel.
2. On the Fields tab, be sure the database containing the fields you want is showing in the "Database" box. This will 

become the main database of the form. 
3. Select fields in the "Fields" box and click Add.
4. On the Panel tab, select the database that contains the fields for the repeating panel. This will become the detail 

database of your form.
The database cannot be the same one you selected on the Fields tab because that is the main database of the 
form.

5. Select fields in the "Fields" box and click Add.
6. Click Done.

{button ,AL(`H_ADDING_A_REPEATING_PANEL_TO_EXISTING_FORMS_STEPS;H_BASIC_PROPERTIES_OF_O
BJECTS_AND_FIELDS_CS;H_JOINING_A_DATABASE_TO_ITSELF_STEPS;H_ONE_TO_MANY_MANY_TO_O
NE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;H_REPEATING_PANELS_OVER;H_DECIDING_WHAT_NE
W_FORMS_LOOK_LIKE_REF;H_REARRANGING_FIELDS_IN_REPEATING_PANELS_STEPS;',0)} See related 
topics



Adding fields to new forms
Command: Create - Form

Tab: Fields
1. Be sure the database containing the fields you want is showing in the "Database" box.

If you are creating a form with a repeating panel, the database you select in this step is the main database    of the
form. You are creating the "one" side of the one-to-many    relationship between the two databases.

2. Select a field in the "Fields" box.
3. Click Add.
4. To add additional fields, repeat steps 1 -    3.
5. Click Next or Done.

{button ,AL(`H_CREATING_NEW_FORMS_THAT_INCLUDE_A_REPEATING_PANEL_STEPS;H_DECIDING_WHAT
_NEW_FORMS_LOOK_LIKE_REF;H_FORMS_OVER;H_REMOVING_OR_REORDERING_FIELDS_WHILE_CR
EATING_NEW_VIEWS_STEPS;H_MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_ONE_TO_MANY_
MANY_TO_ONE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;',0)} See related topics



Adding fields to repeating panels

 Are you in Design?
1. Select the repeating panel .
2. Choose Panel - Add Field.
3. Be sure the database containing the fields you want is showing.
4. Drag a field from the Add Field dialog box to the top line of the repeating panel.
5. If necessary, move and resize the new field or repeating panel.

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_ADDING_REPEATING_FIELDS_TO_NEW_REPE
ATING_PANEL_REPORTS_STEPS;H_DELETING_FIELDS_FROM_A_DATABASE_STEPS;H_EDITING_A_FIEL
D_STEPS;H_EDITING_FIELDS_OF_A_DATABASE_STEPS;H_REARRANGING_FIELDS_IN_REPEATING_PAN
ELS_STEPS;H_REPEATING_PANELS_OVER;H_RESIZING_REPEATING_PANELS_STEPS;',0)} See related 
topics



Adding pages to forms
A    form can use more than one page (up to five per form) to show all the fields associated with a record. Regardless 
of the number of pages in a form, however, the form still displays data from only one record at a time.

 Are you in Design?
Choose Form - Add Page.
Approach adds the page and displays it onscreen.

Naming pages
Use the Basics tab of the InfoBox to name a page. Then, if you create a tabbed dialog box based on the multi-page 
form, the page name becomes the name of a tab.

{button ,AL(`H_CREATING_TITLE_PAGES_FOR_REPORTS_STEPS;H_MOVING_FROM_PAGE_TO_PAGE_IN_F
ORMS_STEPS;H_MOVING_OBJECTS_TO_ANOTHER_PAGE_IN_FORMS_STEPS;H_OVERVIEW_FORMS_O
VER;H_PAGINATING_REPORTS_STEPS;H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS_TO_REPORTS_
STEPS;H_CREATING_DIALOG_BOXES_FROM_FORMS_STEPS;',0)} See related topics



Go hog wild!    Creative and fun designs for repeating panels

Default design
Much of the default design for a repeating panel is based on the default style Approach uses to create views. So if 
you change the default style for views, you also change the default style for repeating panels. You can change some 
default settings when you create a repeating panel, such as the number of display rows. You can also make other 
changes in the InfoBox after you have created the repeating panel, such as line thickness and color.

Border and color designs
You can change the borders and colors to make the display more attractive and easy-to-read. To make changes to 
the border and fill colors, double-click the repeating panel to display the InfoBox.
For example, in the InfoBox, turn off the left and right borders, change the line width to hairline and the color to dark 
blue.

For another design, turn on the alternate fill color and changed it to a pale blue. Also, set the style to None.

Field data and label styles
You can also change the appearance of field data and labels to make the panel more readable. Select the field 
whose attributes you want to change, then in the Font tab of the InfoBox choose whether you want to update the field 
data or field label. Once you have made the change to a field, you can then create a style using the updated field as a
base.
To select a single field, click on the field in the first row of the panel. If you click outside the first row, you select the 
panel instead of the field. To select multiple fields, hold the CTRL key then click on each field in the first row of the 
panel. It is easier to select the fields if you zoom to 200%.



Deciding what new forms look like
Approach provides a number of layouts and styles; select one of each to determine the basic appearance of the form.
The sample form previews each combination.
Command: Create - Form

Tab: Layout

View name & title
The name you enter appears in the title bar on the form and in the view tab. Each view in your application must have 
a unique name.

Layout
Layouts arrange the fields on the form.

• For Approach files with joined databases, you can create a form with a repeating panel.
• If you select Blank, go to Design and choose Form - Add Field to add fields to the form.

Style
Styles set properties such as background color for the form and text attributes for data and field labels.
Note You can change any element of the layout or style after you create the form.

{button ,AL(`H_CREATING_NEW_FORMS_THAT_INCLUDE_A_REPEATING_PANEL_STEPS;H_ADDING_FIELDS
_TO_NEW_FORMS_STEPS;H_FORMS_OVER;H_JOINED_DATABASES_OVER;H_REMOVING_OR_REORDE
RING_FIELDS_WHILE_CREATING_NEW_VIEWS_STEPS;H_REPEATING_PANELS_OVER;H_ADDING_PAGE
S_TO_FORMS_STEPS;',0)} See related topics



Overview: Forms
Command: Create - Form

What is a form?
A form is a type of view that focuses on a single record. You can use the same form to see every record in a 
database, but the form shows you only one record at a time.
Forms are useful for entering and editing data for a record.
When you create a file, Approach creates one form and a worksheet for you. You can change that form; you can also 
create additional forms.

Example: Why use forms?
You might use a form to maintain data about customers. In the following illustration, the Customer form is currently 
displaying data from the first customer record. When you press PG DN, the form shows you the same kind of data 
from the second customer record, and so on, through a found set of records or all records in the database.

Forms and records aren't the same
Like any other view in an Approach file, the form is a way to look at data from records in a database. A record, on the 
other hand, is a storage unit in a database.
This split between forms and records is useful. When you create a form, you can select only the fields from the 
database that store the data you want to show on the form.
For example, you can have one form to show customer billing information and another to show the orders placed. 
Both forms, however, use information stored in the same record.
So in the preceding example, the customer records in the database have a field for an alternate contact, but the 
creator of the form chose not to include that field on this form.

Multi-page forms
A form can have up to five pages. To add a page, go to Design and choose Form - Add Page.
Regardless of the number of pages a form has, however, it still shows data from only one record at a time.

The main database for a form
If you have joined databases in an Approach file, Approach identifies a main database for each form in the file. The 
number of records you can see using the form depends on the number of records in the main database.
The other joined databases become the detail databases of the form. You can add fields from the detail databases to 
the form.
To show data from a joined database in a form, add one or more of its fields to the form using the Add Field dialog 
box.
If the records of the main database are in a one-to-many relationship with records from a detail database, you can 
add a repeating panel to the form. The repeating panel shows the many records from the detail database that are 
related to each record in the main database of the form.

Example: Choosing a main database
As mentioned above, the number of records you can see using the form depends on the number of records in the 
main database.
In the preceding example, the Approach file that contains the Customer form has two joined databases: one for 
customers, containing 40 records; the other for customer purchases, containing 200 records. The main database for 
the Customer form is the customer database, and so 40 main records are visible through that form.
The file contains another form, however, that shows all the purchases. When the user created this form, she chose 



the Purchases database as the main database so she could see all 200 records. If she had chosen the Customer 
database as the main database for the Purchases form, she would have been able to see only 40 records. These 40 
records would show one purchase for each customer.

{button ,AL(`H_ADDING_FIELDS_TO_A_VIEW_STEPS;H_ADDING_FIELDS_TO_NEW_FORMS_STEPS;H_ADDIN
G_PAGES_TO_FORMS_STEPS;H_JOINED_DATABASES_OVER;H_JOINING_DATABASE_FILES_STEPS;H_O
NE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;H_REPEATING_PANELS_OV
ER;H_APP_DO_YOU_REALLY_NEED_THAT_APR_OVER;',0)} See related topics



Moving from page to page in forms
1. Click the Page selector button in the status bar.
2. Select the page you want to go to.

{button ,AL(`H_ADDING_PAGES_TO_FORMS_STEPS;H_FORMS_OVER;H_MOVING_OBJECTS_TO_ANOTHER_
PAGE_IN_FORMS_STEPS;H_MOVING_ONE_RECORD_AT_A_TIME_STEPS;H_MOVING_BETWEEN_FIELDS
_REF;',0)} See related topics



Moving objects to another page in forms

 Are you in Design?
1. Select the object.
2. Choose Edit - Cut or Copy.
3. Go to the page you want to add the object to.
4. Click where you want the object to appear on the page.
5. Choose Edit Paste.

{button ,AL(`H_ADDING_PAGES_TO_FORMS_STEPS;H_FORMS_OVER;H_MOVING_OBJECTS_STEPS;H_ADDI
NG_MULTIPLE_OBJECTS_TO_A_VIEW_STEPS;H_GROUPING_AND_UNGROUPING_OBJECTS_STEPS;H_N
AMING_VIEWS_AND_OBJECTS_STEPS;',0)} See related topics



Removing or reordering fields while creating new views
The steps for removing or reordering fields are generally the same when you create any type of view.

Removing fields
1. In the dialog box for creating the view, select the field in the "Fields to place on view" box.

CTRL+click to select multiple fields.
2. Click Remove.

Reordering fields
To move a field from one location on the list to another, you must remove the fields that separate it from its new 
location.
For example, if you want to move a field that is fifth on the list to first place, you must remove the first four fields. Then
use Add to add the four removed fields.

{button ,AL(`H_DELETING_ELEMENTS_OF_A_VIEW_STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROSSTAB
S_STEPS;H_MOVING_OR_DELETING_FORM_LETTER_FIELDS_STEPS;H_REMOVING_FIELDS_FROM_WO
RKSHEETS_OR_CROSSTABS_STEPS;',0)} See related topics



Overview: Repeating panels
A repeating panel lets you display information from another joined database in your form or report. It is useful in a 
one-to-many relationship between joined databases. The repeating panel shows the many records from a detail 
database that are related to the one record displayed on the form.

Example
A department and employees have a one-to-many relationship: One department can have many employees. To list 
the employees for each department, join a department database to an employee database on a department ID field.
Then set up a form that has the department database as its main database. Give the form a repeating panel for the 
employees. The panel lists all the employees that have the same department ID as the current department.
The employees in this repeating panel each have 332 in their department ID field, the same ID the department has.

Main and detail databases
Like a form with joined data, a repeating panel must have a main database that provides the framework of records. 
The main database of the repeating panel must be one of the detail databases of the form.
Each line in a repeating panel displays a record from its main database. The panel in the preceding example uses the
employee database as its main database.
A repeating panel can also have fields from other joined databases for additional, related information.

{button ,AL(`H_ADDING_A_REPEATING_PANEL_TO_EXISTING_FORMS_STEPS;H_ADDING_A_REPEATING_PA
NEL_TO_NEW_FORMS_STEPS;H_BASIC_PROPERTIES_OF_OBJECTS_AND_FIELDS_CS;H_FORMS_OVER
;H_ONE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;H_JOINED_DATABASE
S_OVER;',0)} See related topics



Selecting repeating panels

 Are you in Design?

If you You select
Click below the first-record 
line

The entire repeating panel

Click the first-record line Only the column that you click
Double-click below the first 
record line

The entire repeating panel and
simultaneously display the 
InfoBox

CTRL+click the first-record 
line

The entire repeating panel

CTRL+click below the first-
record line

The entire repeating panel and
simultaneously move it down 
to where you click

The panel is selected when the first-record line has a double-line border around it.
If you want to drag the panel to another location on the form, the mouse pointer must look like a hand.
If you want to resize the panel, the mouse pointer must look like a two-headed arrow.

{button ,AL(`H_CHANGING_THE_WIDTH_OF_LINES_OR_BORDERS_STEPS;H_CREATING_A_SHADOW_STEP
S;H_CREATING_PARTIAL_BORDERS_STEPS;H_LINE_AND_COLOR_PROPERTIES_CS;H_REARRANGING_
FIELDS_IN_REPEATING_PANELS_STEPS;H_RESIZING_REPEATING_PANELS_STEPS;H_SELECTING_OBJ
ECTS_STEPS;H_REPEATING_PANELS_OVER;',0)} See related topics



Summarizing data of records in repeating panels
You can add a calculated field to a form that summarizes data in a repeating panel on the form.
1. Choose Create - Field Definition.
2. Scroll to the blank line at the bottom of the list and click it.
3. Name the field and select Calculated as its data type.

The dialog box expands to show the Define Formula and Define Summary tabs.
4. On the Define formula tab, write a formula using a summary function that refers to a field in the repeating panel.

To see just a list of summary functions, select Summary in the "Functions" box.
5. Click the Define Summary tab, and then select "Summary of all records in database"    in the "Summarize on" box,

where database is the name of the database for the repeating panel.
6. Click OK.

Approach switches to Design    and the Add Field dialog box appears.
7. From the Add Field dialog box, drag the calculated field to the form and place it outside the panel.
8. Switch to Browse    to see the calculation results.

{button ,AL(`H_GROUPING_RECORDS_IN_REPORTS_STEPS;H_ADDING_SUMMARIES_TO_CROSSTABS_STE
PS;',0)} See related topics



Adding blank columns to worksheets
Add blank columns to enhance the layout of the worksheet.
The blank column only displays in the worksheet and does not create a new field. 
1. Select a cell in the column to the left of where you want to add the column.
2. Choose Worksheet - Add Column.

A blank column and the Formula dialog box appear.
3. Click Cancel in the Formula dialog box.
4. To enter a title for the new column, triple-click in the column header and enter the text.
Note To save the new column as part of the worksheet, choose File - Save Approach File.

{button ,AL(`H_ADDING_FORMULA_COLUMNS_TO_WORKSHEETS_STEPS;H_MOVING_COLUMNS_IN_WORK
SHEETS_OR_CROSSTABS_STEPS;',0)} See related topics



Adding formula columns to worksheets
To display the results of a formula without making it a part of the database file, add a formula column to the 
worksheet.
The formula column only displays in the worksheet and does not create a new field. 
If you are tyring to create a calculated field available for other views, define the field , and then add the field  to the 
worksheet.
1. Select a cell in the column to the left of where you want to add the column.
2. Choose Worksheet - Add Column.

A blank column and the Formula dialog box appear.
3. Write the formula.
4. Click OK.

The formula appears in every row of the selected column in the worksheet.
5. To enter a title for the new column, triple-click the column header and enter the text.
Note To save the formula column, choose File - Save Approach File.

{button ,AL(`H_ADDING_BLANK_COLUMNS_TO_WORKSHEETS_STEPS;H_MOVING_COLUMNS_IN_WORKSHE
ETS_OR_CROSSTABS_STEPS;H_USING_FUNCTIONS_AND_FORMULAS_OVER;',0)} See related topics



Editing formula columns in worksheets
1. Double-click a cell in the column whose formula you want to modify.

The Formula dialog box appears.
2. Edit the formula.
3. Click OK.
4. To edit the column title, triple-click the column header and enter the text.
Note To save the changes, choose File - Save Approach File.

{button ,AL(`H_FUNCTIONS_OVER;H_FORMULAS_OVER;',0)} See related topics



Details: Copying selections to the Clipboard
When you copy an entire worksheet or crosstab, you can paste it from the Clipboard in any of the following forms:

• An object that you can embed (which can be reports, forms, graphics, charts, sounds, or text)
• A Windows Metafile (.WMF) picture that you can paste as a graphic
• Tab-delimited text (for example, to paste into a spreadsheet)

When you copy a range of cells in a worksheet or crosstab, you can paste it from the Clipboard in any of the following
forms:

• A Windows Metafile (.WMF) picture
• Tab-delimited text

{button ,AL(`H_COPYING_SELECTIONS_TO_THE_CLIPBOARD_STEPS',1)} Go to procedure
{button ,AL(`H_CUTTING_OR_COPYING_OBJECTS_OR_TEXT_STEPS;',0)} See related topics



Copying selections to the Clipboard
After you select all or part of a worksheet or crosstab, you can copy the selection to the Clipboard for pasting, linking, 
or embedding in a document created by another application. 
1. Select the portion of the worksheet or crosstab you want to copy.
2. Choose Edit - Copy.

{button ,AL(`H_COPYING_SELECTIONS_TO_THE_CLIPBOARD_DETAILS',1)} See details
{button ,AL(`H_CUTTING_OR_COPYING_OBJECTS_OR_TEXT_STEPS;H_SELECTING_IN_WORKSHEETS_OR_

CROSSTABS_REF;',0)} See related topics



Creating new worksheets
1. Choose Create - Worksheet.

2. Be sure the database containing the field you want is showing in the "Database" box.
3. Select a field in the "Fields" box.
4. Click Add.
5. To add additional fields, repeat steps 2 - 4.
6. Click Done.

{button ,AL(`H_ADDING_BLANK_COLUMNS_TO_WORKSHEETS_STEPS;H_ADDING_FIELDS_TO_A_VIEW_STE
PS;H_ADDING_FORMULA_COLUMNS_TO_WORKSHEETS_STEPS;H_DELETING_FIELDS_FROM_A_DATAB
ASE_STEPS;H_EDITING_FIELDS_OF_A_DATABASE_DETAILS;H_REMOVING_OR_REORDERING_FIELDS_
WHILE_CREATING_NEW_VIEWS_STEPS;H_SELECTING_IN_WORKSHEETS_OR_CROSSTABS_REF',0)} 
See related topics



Dividing worksheets and crosstabs into panes
If a worksheet or crosstab doesn't fit on the screen, you can divide it horizontally or vertically into independently 
scrolling panes. Then you can view data from different areas of the worksheet or crosstab at the same time. 

Dividing worksheets or crosstabs into panes
Drag the divider boxes (thick black lines in the top right and lower left corners) to the location you want.

Adjusting the position of the pane divider bars
Drag the divider bars to a new position. 
To adjust both divider bars at the same time, position the mouse pointer on the intersection of the dividers. When the 
mouse pointer changes to a hand, drag the divider bars to another location.

Removing panes
Drag the divider bar back to its original position or off the screen.

{button ,AL(`H_RESIZING_COLUMNS_AND_ROWS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_MOVING_
COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_REMOVING_FIELDS_FROM_WORKSHEETS_O
R_CROSSTABS_STEPS;H_RESIZING_COLUMNS_AND_ROWS_IN_WORKSHEETS_OR_CROSSTABS_STEP
S',0)} See related topics



Editing column header text
Approach uses field names as column headers in worksheets and crosstabs by default.
You can change the column header text to be anything you want. This does not change the field name.
1. Select the column.
2. Choose Edit Column Label from the context menu.
3. Edit the text.
4. Press ENTER.

{button ,AL(`H_SELECTING_ROWS_AND_COLUMNS_IN_CROSSTABS_STEPS;',0)} See related topics



Moving columns in worksheets or crosstabs
Moving one or more columns to another location doesn't affect the data.
1. Select one or more columns.
2. Drag the columns to the position you want.

A vertical guide and bubble help saying, "Move field here," show where the column will be placed when you 
release it.

{button ,AL(`H_RESIZING_COLUMNS_AND_ROWS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_SELECTIN
G_IN_WORKSHEETS_OR_CROSSTABS_REF;',0)} See related topics



Removing fields from worksheets or crosstabs
1. Click the column header to select the column.
2. When the hand appears, drag the header toward the slider controls until the trash symbol appears.

Note  This procedure only removes the column from the worksheet; it does not delete the data.

{button ,AL(`H_ADDING_FIELDS_TO_WORKSHEETS_OR_CROSSTABS_STEPS;H_ADDING_FORMULA_COLUM
NS_TO_WORKSHEETS_STEPS',0)} See related topics



Resizing columns and rows in worksheets or crosstabs 
If you select more than one column or row, Approach makes all the selected columns and rows the same size.

Resizing columns
1. Select one or more columns.
2. Place the pointer between column headers to the right of the column(s) you want to resize.

The mouse pointer changes shape:

3. Drag the column to the size you want.

Resizing rows
1. Select one or more rows.
2. Place the pointer in the row gutter at the bottom border of the row(s) you want to resize.

The mouse pointer becomes a row sizer: 

3. Drag the row to the size you want.

{button ,AL(`H_ADDING_FORMULA_COLUMNS_TO_WORKSHEETS_STEPS;H_MOVING_COLUMNS_IN_WORK
SHEETS_OR_CROSSTABS_STEPS;H_SELECTING_IN_WORKSHEETS_OR_CROSSTABS_REF;',0)} See 
related topics



Selecting in worksheets or crosstabs
To select Do this
A single cell Click the cell.
A single cell for editing Double-click the cell.
A range of cells Click a cell and drag in any 

direction.
A column Click the column header. 

Drag to select multiple 
columns.

Just the column header Select the column and click 
the Column Header icon.

The column header text 
for editing

Triple-click the column 
header.

Just the column cells (and
not the column header)

Click the column header to 
select the column and click 
the Column Data icon. 

A worksheet row Click to the left of the row.
A crosstab row Click the row header.
The entire worksheet or 
crosstab

Click the top left corner of 
the worksheet or crosstab.

All of the worksheet 
column headers and all 
rows (but not the data)

Click the top left corner of 
the worksheet to select the 
worksheet; then click the 
corner again.

{button ,AL(`H_CREATING_NEW_WORKSHEETS_STEPS;H_EDITING_COLUMN_HEADER_TEXT_STEPS;H_MO
VING_COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_SELECTING_FIELDS_STEPS;',0)} See 
related topics



Overview: Worksheets
A worksheet presents database records in a grid of columns and rows. The columns in a worksheet are database 
fields, and the rows are individual records:

Worksheets are often the most efficient and flexible type of view  for displaying data.
In worksheets, you can move columns from one position to another, add or remove fields, or add columns that 
perform calculations. You can also change the worksheet's appearance by resizing columns or rows, editing the 
column header text, or adding color to text or background.
You can perform all of the same data functions in a worksheet that you can in other Approach views, including finding 
and sorting records, duplicating them, and editing database field values.
You can also create crosstabs from worksheets. Crosstabs expand on the worksheet model, by categorizing and 
summarizing database records.

{button ,AL(`H_ADDING_FORMULA_COLUMNS_TO_WORKSHEETS_STEPS;H_CREATING_NEW_WORKSHEET
S_STEPS;H_MOVING_COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_RESIZING_COLUMNS_A
ND_ROWS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_SELECTING_IN_WORKSHEETS_OR_CROSSTA
BS_REF',0)} See related topics



Details: Adding columns to new crosstabs
Field order
Column fields are nested in the order you select them in the Crosstab Assistant. The first field is used as the broadest
or topmost level. For example, if you list Country first and then City, Approach groups the cities inside the countries.
If you don't like the placement you chose, move the headers after creating the crosstab. See Adding or moving fields 
in crosstabs.

How Approach groups values by default
Approach groups matching values from the field and creates a new column for each distinct value from the selected 
field. For example, in a crosstab with Order Date in a column header, each unique date would head a column in the 
crosstab. 

Grouping options
If you want to group the values, choose a grouping option. These groups are bins that collect values into ranges. The 
grouping options depend on the field type of the selected field.
In the Crosstab Assistant, the Order Date field can be set to group field data into months, quarters, or years. If you 
select Order Date as a crosstab column and group Order Date by quarter, the crosstab column headers show four 
columns for each year, ordered from first quarter to fourth quarter.
You can group times, numbers, and text. See Grouping records in new reports and crosstabs.

Totals fields
Approach adds a summary column to the side of the crosstab. You can

• Delete this column if it doesn't make sense for your data.
• Change the summary calculation.

{button ,AL(`H_ADDING_COLUMNS_TO_NEW_CROSSTABS_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROS

STABS_STEPS;H_ADDING_ROWS_TO_NEW_CROSSTABS_STEPS;H_ADDING_SUMMARIES_TO_CROSST
ABS_STEPS;H_ADDING_VALUES_TO_NEW_CROSSTABS_STEPS',0)} See related topics



Adding columns to new crosstabs
Approach groups matching values from the field and then creates columns from the grouped values.
Command: Create - Crosstab

Tab: Columns
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field from the "Fields" box.

The values in this field are the column headers.

3. Click Add.
A group icon appears next to the field.

4. (Optional) To select a grouping option for the values, click the group icon and select a grouping method.
5. (Optional) Select other fields from the "Fields" box.

These values appear as subheaders in each column.

{button ,AL(`H_ADDING_COLUMNS_TO_NEW_CROSSTABS_DETAILS',1)} See details
{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_STEPS;H_ADDING_ROWS_TO_NEW_CROSSTABS_

STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROSSTABS_STEPS;H_ADDING_SUMMARIES_TO_CROSST
ABS_STEPS;H_ADDING_VALUES_TO_NEW_CROSSTABS_STEPS',0)} See related topics



Adding or moving fields in crosstabs
Convert a worksheet into a crosstab, or a simple crosstab into a multiple-level one. Do this with fields already on the 
view or with fields you add to the view.
1. Click a row or column header, or select a field in the Add Field dialog box.
2. Drag the field to a position in the row gutter, column gutter, or crosstab body.

Approach highlights the possible positions as you drag the field over them.

Removing a row or column
1. Click a row or column header.
2. Drag the header off of the crosstab until the trash symbol appears.

{button ,AL(`H_ADDING_SUMMARIES_TO_CROSSTABS_STEPS;H_EDITING_CROSSTAB_SUMMARIES_STEPS
;H_MOVING_COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_SELECTING_IN_WORKSHEETS_
OR_CROSSTABS_REF;H_ADDING_FIELDS_TO_A_VIEW_STEPS;H_CROSSTABS_OVER',0)} See related 
topics



Details: Adding rows to new crosstabs
Field order
Row fields are nested in the order you select them in the Crosstab Assistant. The first field is used as the broadest or 
outermost level. For example, if you list Country first and then City, Approach groups the cities inside the countries.
If you don't like the placement you chose, rearrange the headers after creating the crosstab. See Adding or moving 
fields in crosstabs.

How Approach groups values by default
Approach groups matching values from the field and creates a new row for each distinct value from the selected field.
For example, in a crosstab with Order Date in a row header, each unique date would head a row in the crosstab. 

Grouping options
If you want to group the values, choose a grouping option. These groups are bins that collect values into ranges. The 
grouping options depend on the field type of the selected field.
In the Crosstab Assistant, the Order Date field can be set to group field data into months, quarters, or years. If you 
select Order Date as a crosstab row and group Order Date by quarter, the crosstab row headers show four rows for 
each year, ordered from first quarter to fourth quarter.
You can group times, numbers, and text. See Grouping records in new reports and crosstabs.

Totals fields
Approach adds a summary row to the bottom of the crosstab. You can

• Delete this row if it doesn't make sense for your data.
• Change the summary calculation.

{button ,AL(`H_ADDING_ROWS_TO_NEW_CROSSTABS_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_STEPS;H_ADDING_COLUMNS_TO_NEW_CROSSTA

BS_STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROSSTABS_STEPS;H_ADDING_SUMMARIES_TO_CRO
SSTABS_STEPS;H_ADDING_VALUES_TO_NEW_CROSSTABS_STEPS',0)} See related topics



Adding rows to new crosstabs
Approach groups matching values from the field and then creates rows from the grouped values.
Command: Create - Crosstab

Tab: Rows
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field from the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
The values in this field are the row headers.

3. Click Add.
A group icon appears next to the field.

4. (Optional) To select a grouping option for the values, click the group icon and select a grouping method.
5. (Optional) Select other fields from the "Fields" box.

These field values appear as subheaders in each row.

{button ,AL(`H_ADDING_ROWS_TO_NEW_CROSSTABS_DETAILS',1)} See details
{button ,AL(`H_ADDING_ALL_GROUPS_TO_CROSSTABS_STEPS;H_ADDING_COLUMNS_TO_NEW_CROSSTA

BS_STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROSSTABS_STEPS;H_ADDING_SUMMARIES_TO_CRO
SSTABS_STEPS;H_ADDING_VALUES_TO_NEW_CROSSTABS_STEPS',0)} See related topics



Details: Adding totals to crosstabs
You can also use the mouse to add totals to crosstabs.

Adding a total row or column using the mouse
1. Position the mouse pointer at the right edge of the column headers or the bottom edge of the row headers.
2. Click when the cursor turns into a wedge:

You can add a total column or row only to crosstabs with existing sub-groupings.

Deleting total rows or columns
1. Click a row or column header.
2. Drag the header off of the crosstab until the trash symbol appears.

{button ,AL(`H_ADDING_SUMMARIES_TO_CROSSTABS_STEPS',1)} Go to procedure
{button ,AL(`H_crosstabs_over;H_editing_crosstab_summaries_steps;H_summary_calculations_ref;',0)} See related 

topics



Adding totals to crosstabs
These actions create columns and rows titled Total.

Adding a Total row that summarizes data in each column
Choose Crosstab - Summarize Columns.

 

Adding a Total column that summarizes data in each row
Choose Crosstab - Summarize Rows.

{button ,AL(`H_ADDING_SUMMARIES_TO_CROSSTABS_DETAILS',1)} See details
{button ,AL(`H_crosstabs_over;H_editing_crosstab_summaries_steps;H_summary_calculations_ref;',0)} See related 

topics



Adding values to new crosstabs
Crosstabs use summary calculations. Select field(s) not already selected for the rows and columns of the crosstab.
Command: Create - Crosstab

Tab: Values
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select the field containing the values to be used in the calculation.
3. Select a calculation from the "Calculate the" box. 

Approach performs this calculation on the values in the field. If the field data type is not numeric, select Count.
4. To add additional fields, repeat steps 1 - 3.
5. Click Done.
The results of the calculation(s) form the body of the crosstab.

{button ,AL(`H_editing_crosstab_summaries_steps;H_summary_calculations_ref;',0)} See related topics



Overview: Crosstabs
A cross-tabulation worksheet, or crosstab, categorizes and summarizes database records. Where a worksheet has 
rows containing individual records, a crosstab shows cells that summarize underlying records grouped by any fields 
you select. 
A crosstab is a good tool for analyzing data with three or more variables. For example, use a crosstab to present 
products by type, by quantity sold, and by sales representative.
In a worksheet the information appears as follows:

A crosstab provides another look at the same data:

Creating a crosstab
The Crosstab Assistant makes it easy for you to create a crosstab:
1. Choose Create - Crosstab.
2. Select the row headers.
3. Select the column headers.
4. Select a field and calculation to create crosstab body values.
You can also create a crosstab from a worksheet by dragging column headers into position on the left side of the 
worksheet. See Adding or moving fields in crosstabs.

Grouping record values in crosstab headers
When you create a crosstab using the Crosstab Assistant, you can choose grouping options to categorize records. 
For example, if you are showing product sales by date, you can group the date field values by month, quarter, or year.
There are also grouping options for time, numbers, and text. These options are only available through the Crosstab 
Assistant.

{button ,AL(`H_MOVING_COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_adding_columns_to_new_c
rosstabs_steps;H_adding_or_moving_fields_in_crosstabs_steps;H_adding_rows_to_new_crosstabs_steps;H_add
ing_summaries_to_crosstabs_steps;H_adding_values_to_new_crosstabs_steps;H_editing_crosstab_summaries_
steps;H_grouping_records_in_new_reports_and_crosstabs_ref',0)} See related topics



Overview: Drill down to data
A drill down quickly reveals the records summarized in crosstab and chart entries. When you perform a drill down, the
records that contribute to the selected part of the crosstab or chart appear on a worksheet or other view that you 
specify.
For example, in this crosstab, a drill down for the Sport column finds all records with the product category Sport.

A drill down on the cell containing 1840 finds all records from the sales representative Harvey in the Sport product 
category. 

In this chart, a drill down for the first red bar finds the records with the sales representative Adams and the Product 
category Sport.

Returning from a drill-down view
In a drill-down view, press ESC to return to the original crosstab or chart. You can also move to other views from the 
drill-down view. Which view you move to affects which found set of records you see, however. 

Using drill-down to data with a found set
If you are looking at a crosstab with a found set and then drill-down from that crosstab, your drill-down view shows a 
new found set.



For example, if the found set on the crosstab is for Product Type = Sport and then you drill down using the sales 
representative Harvey, the drill-down view shows only those records for Product Type = Sport and Sales Rep = 
Harvey.
If you then go back to the crosstab, the found set returns to the original set from the crosstab: Product Type = Sport 
with all sales representatives.
However, if you go to another view, the found set for all views retains the drill-down set Product Type = Sport and 
Sales Rep = Harvey.

{button ,AL(`H_APPLYING_FOUND_SETS_TO_CROSSTABS_STEPS;H_CHOOSING_DRILLDOWN_VIEWS_STEP
S;H_CROSSTABS_ASSISTANT_OVER;H_CROSSTABS_OVER;H_FINDING_RECORDS_that_make_up_CROS
STABS_STEPS;H_SELECTING_ROWS_AND_COLUMNS_IN_CROSSTABS_STEPS;',0)} See related topics



Finding records that make up crosstabs (drill down to data)
In a crosstab, find all records that contribute to a summary calculation.
If a crosstab displays the results of a find, the drill down uses the data in the found set only.
1. Click a row header, column header, or cell.

Don't select summary headers: the drill down would show all records in the found set.
2. Choose Crosstab - Drill Down to Data.

A new view appears, showing the records that contribute to the row, column, or cell selected. Only the fields appear 
that were used on the original crosstab.
Press ESC to return to the original crosstab.

{button ,AL(`H_APPLYING_FOUND_SETS_TO_CROSSTABS_STEPS;H_Choosing_drilldown_views_steps;H_SELE
CTING_ROWS_AND_COLUMNS_IN_CROSSTABS_STEPS;H_drill_down_to_data_over;',0)} See related topics



Selecting rows and columns in crosstabs
Selecting a row or column
Click the row or column header.

Selecting a row or column header only
Do one of the following:

• Double-click the row or column header.
• Click the header and choose Crosstab - Select - Header Only.

{button ,AL(`H_MOVING_COLUMNS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_RESIZING_COLUMNS_AN
D_ROWS_IN_WORKSHEETS_OR_CROSSTABS_STEPS;H_crosstabs_over;',0)} See related topics



Adding Custom controls to the Tools palette
Only registered custom controls can be added to the Tools palette.
1. Choose File - User Setup - Approach Preferences.
2. Click the Display tab.
3. Click Custom Controls.
4. Select the custom controls you want to add to the Tools palette.
5. Click OK to close the Custom Controls dialog box.
6. Click OK.
Note If you do not see the custom control you want, you may have to register it first. See Registering Custom 
Controls.

{button ,AL(`H_CHANGING_PROPERTIES_OF_CUSTOM_CONTROLS_STEPS;H_INSERTING_CUSTOM_CONTR
OLS_IN_VIEWS_STEPS;H_OLE_CUSTOM_CONTROLS_OVER;',0)} See related topics



Changing properties of custom controls

 Are you in Design?
1. Double-click the custom control on the view.

The Properties dialog box appears.    Each custom control has its own Properties dialog box, which is supplied by 
the third-party custom control developer.

2. Modify size, fonts, color and/or other appropriate properties for this custom control by setting the options in the 
Properties dialog box.

3. Close the Properties dialog box.

{button ,AL(`H_ADDING_CUSTOM_CONTROLS_TO_THE_TOOLS_PALETTE_STEPS;H_INSERTING_CUSTOM_
CONTROLS_IN_VIEWS_STEPS;H_OLE_CUSTOM_CONTROLS_OVER;H_REGISTERING_CUSTOM_CONTR
OLS_STEPS;',0)} See related topics



Details: Creating Approach views in Lotus 1-2-3
Lotus 1-2-3 works with Approach to help you manage and analyze data contained in a 1-2-3 database table or an 
external database table. 1-2-3 and Approach are installed together when you install 1-2-3.
You can create an Approach view by choosing Create - Database - Query Table, Form, Report, Dynamic Crosstab, 
Mailing Label, or Form Letter from the 1-2-3 menu. 1-2-3 starts the appropriate Assistant to create the view you want. 
Approach views appear as embedded objects in the 1-2-3 sheet. When you activate the view, 1-2-3 loads a portion of
Approach into memory to give you access to Approach commands. For example, you can use the Browse commands
to find and sort records. When the view appears in a full Approach window, you can join database tables, create 
computed columns, and use Design to change the way the view looks. 
Note When you activate a query table, form, or crosstab, 1-2-3 gives you partial access to Approach commands by 
showing Approach commands in the 1-2-3 window. To have full access to Approach features in an Approach window, 
choose Edit - Open Into Full Window. 

Using Approach views to change 1-2-3 data
When you modify data in your Approach view, 1-2-3 automatically makes the changes to the source data in the 1-2-3 
range. However, you can't modify formulas or field definitions while working with data in the view, nor can you create 
a chart from an Approach crosstab. If you wish to chart data that appears in a crosstab, copy the data to cells in the 
1-2-3 sheet.

Refreshing an Approach view
To refresh an Approach view so that it reflects any changes that have been made to the source data in the 1-2-3 
range, choose Browse - Refresh data.

Working with query tables
When you create a query table in 1-2-3, you create an Approach worksheet view of the selected data. You work with 
a 1-2-3 query table in the same way that you work with an Approach worksheet.

Working with external database tables
You can create a query table from an external database table, but you cannot use 1-2-3 to create forms, reports, 
crosstabs, mailing labels, or form letters from external database tables.

Getting Help
This topic is part of Approach Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a form letter or when the 
form letter is activated, Approach Help topics appear. Approach Help contains more information about working 
with Approach views. 

• If you want to get Help about 1-2-3, click the 1-2-3 sheet, switch to the 1-2-3 window or choose File - Exit & 
Return to 1-2-3, and then choose Help - Help Topics or press F1.

{button ,AL(`H_CREATING_APPROACH_VIEWS_IN_LOTUS_123_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_DATABASES_FROM_SPREADSHEETS_STEPS;H_OPENING_NAMED_RANGES_FR

OM_LOTUS_123_SPREADSHEETS_STEPS;',0)} See related topics



Creating Approach views in Lotus 1-2-3
Lotus 1-2-3 lets you create Form, Report, Crosstab, Mailing Label, and Form Letter views in 1-2-3 to display selected 
workbook data. You can also create Query Tables, which are similar to Approach worksheets. You can modify the 
workbook data in your Approach view and any changes will appear in the Lotus 1-2-3 range. 
1. In 1-2-3, select the range of sheet cells you want to use in an Approach view. 

The range of cells must use column headers for field names and cannot exceed 100 columns or 65,536 rows.
2. From the 1-2-3 Create menu, choose Database, and then choose Query Table, Form, Report, Dynamic Crosstab, 

Mailing Labels, or Form Letter.
1-2-3 starts the appropriate Approach assistant. 

3. Use the Approach assistant to create the view.
1-2-3 embeds the Approach view as an embedded object in the sheet and activates the view. The view contains 
data from all the records in the 1-2-3 range.

• Activated query tables, forms, and crosstabs appear in the 1-2-3 window with Approach commands and 
buttons on the main menu and status bar, giving you access to Approach and the Approach Help system from 
within 1-2-3. 

• Activated reports, form letters, and mailing labels appear in an Approach window. 
4. To set criteria (conditions) for finding and displaying specific records in the view, choose Browse, and then choose

Find Assistant.
5. To return to 1-2-3, do one of the following:

• From an activated query table, form, or crosstab, click the sheet area. 1-2-3 displays the deactivated view and
its data as an embedded object in the 1-2-3 sheet.

• From an activated report, form letter, or mailing label view, choose File - Exit & Return to Lotus 1-2-3. These 
views appear as icons in the 1-2-3 sheet.

Note To connect to Approach and open the form again, double-click the embedded view object or icon. If you 
changed data in the corresponding 1-2-3 range, Approach updates the view.

{button ,AL(`H_CREATING_APPROACH_VIEWS_IN_LOTUS_123_DETAILS',1)} See details
{button ,AL(`H_CREATING_DATABASES_FROM_SPREADSHEETS_STEPS;H_OPENING_NAMED_RANGES_FR

OM_LOTUS_123_SPREADSHEETS_STEPS;',0)} See related topics



Details: Customizing Lotus Notes (PowerKey)
User Server List
A list of remote servers displays under User Server List. You can control which remote servers display in the Open 
dialog box with this option. 
Add a server by entering it in the edit box and clicking Add. Remove a server by selecting it in the list of servers and 
clicking Remove. 

Preferences
Preference Definition
Show Hidden Views Displays Notes Hidden views 

(in parentheses).
Leaving this option unchecked
hides the Notes Hidden views.

Never create views (indices) 
in .NSF

Approach does not create 
indices when joining 
databases of Notes data to 
other databases.
Leaving this option unchecked
means Approach creates 
indices to enhance 
performance.

 

{button ,AL(`H_CUSTOMIZING_LOTUS_NOTES_STEPS',1)} Go to procedure
{button ,AL(`H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_LOCAL_NOTES_DATABASE_STEPS;

H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_NOTES_WORKSPACE_ON_A_SERVER_STEP
S;H_REPLICATING_A_NOTES_DATABASE_STEPS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVE
R_STEPS;',0)} See related topics



Customizing Lotus Notes (PowerKey)
The Notes PowerKey driver gives you direct access to Lotus Notes data from Approach. Customize how you access 
Lotus Notes data by setting options in the Notes PowerKey Setup dialog box.
Tip Before you begin using Notes PowerKey, make sure Notes is in your path.
1. From the Approach File menu, choose Open.

2. Select Lotus Notes - Local, Server, or Workspace in the "Files of type" box to indicate the location of the Notes 
database you use.
Tip If you have any problem with this step, specify a directory that contains an .NSF file. For example, your Notes
directory on your hard drive contains .NSF files.

3. Click Setup.
The Notes PowerKey Setup dialog box appears.

4. Under User Server List, enter the name of a Notes server you want to add in the edit box and click Add.
To remove a server from the list of servers, select it and click Remove.

5. Under Preferences, select or deselect "Show Hidden Views" and "Never create views (indices) in .NSF." 
6. Click OK.

{button ,AL(`H_CUSTOMIZING_LOTUS_NOTES_DETAILS',1)} See details
{button ,AL(`H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_LOCAL_NOTES_DATABASE_STEPS;

H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_NOTES_WORKSPACE_ON_A_SERVER_STEP
S;H_REPLICATING_A_NOTES_DATABASE_STEPS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVE
R_STEPS;',0)} See related topics



Custom Controls dialog box
Insert OLE custom controls (.OCX) in a form, report, mailing label, or form letter.

Choose a task
Adding custom controls to the Tools palette
Registering custom controls
Overview: OLE Custom    Controls
Inserting custom controls in views
Changing properties of custom controls 

{button ,AL(`H_CHANGING_PROPERTIES_OF_CUSTOM_CONTROLS_STEPS;H_INSERTING_CUSTOM_CONTR
OLS_IN_VIEWS_STEPS;H_OLE_CUSTOM_CONTROLS_OVER;',0)} See related topics



Enabling variable fields for Notes/FX 
When an Approach variable field is enabled, Notes can write to the field and can read its contents without having to 
open an Approach view.
1. From the Approach File menu, choose Approach File Properties.

A list of variable field names appears in the "Variable Fields" box. 
2. Select a variable field to enable it for Notes/FX.
3. Click OK.
Note  Deselect the variable field if you do not want it to be enabled. The default for variable fields is deselected.

{button ,AL(`H_APPROACH_FILE_PROPERTIES_REF;H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FRO
M_A_LOCAL_NOTES_DATABASE_STEPS;H_OPENING_LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_NO
TES_DATABASE_ON_A_SERVER_STEPS;',0)} See related topics



Inserting custom controls in views
Only registered custom controls can be inserted in views.

 Are you in Design?
1. Choose Create - Control - Custom Control.

The Insert Custom Control dialog box appears.
2. Select the custom control you want to insert in the view.
3. Click Insert.

You can also insert custom controls by clicking them in the Tools palette.

{button ,AL(`H_ADDING_CUSTOM_CONTROLS_TO_THE_TOOLS_PALETTE_STEPS;H_CHANGING_PROPERTI
ES_OF_CUSTOM_CONTROLS_STEPS;H_OLE_CUSTOM_CONTROLS_OVER;H_REGISTERING_CUSTOM_C
ONTROLS_STEPS;',0)} See related topics



Overview: OLE Custom controls
OLE custom controls, also called custom controls, are objects that you can add to the background of a form, report, 
mailing label, or form letter.
Custom controls are applications designed with a specific purpose in mind. They accomplish a specific task or range 
of tasks, from tasks as simple as drawing a special type of rectangle on the view, to tasks as complex as reporting 
stock prices or updating a calendar. 
Custom controls usually have the file extension .OCX.
An example of a custom control is the Tool Palette component. When you install it in Approach, you can take 
advantage of additional diagramming and freehand drawing tools, so you have more flexibility in creating and editing 
graphics.

Installing custom controls
Approach is an OLE custom control container, so you can use custom controls created by third-party vendors in 
Approach. In order for Approach to use third-party custom controls, you must install and register them on your hard 
disk. They can go into any directory recommended by the install program of the ActiveX control. The install program 
for the control should register it on your hard disk. 
If you copy a group of custom controls from a diskette or network drive to your hard disk, you cannot use the custom 
control's install program. In these two instances, you must manually register the custom controls or else you will not 
be able to use them in Approach. Register custom controls using the Preferences dialog box.
Any .OCX files registered on your hard disk under another application will also be visible to Approach. 

Adding custom controls to a view
In Design, the Insert Custom Control dialog box displays all the OLE custom controls registered on your hard disk. 
When you insert a custom control, it appears in the top left corner of the view. Like other objects in Approach, you can
resize a custom control object and drag it to another location on the view. 

Adding custom controls to the Approach Tools palette
Add any custom control to the Approach Tools palette by selecting it in the Custom Controls dialog box (available 
from File - User Setup - Approach Preferences, on the Display tab).    An ActiveX control's icon functions like any 
other icon on the Tools palette.

Changing ActiveX control properties
In Design, change the properties of an OLE custom control as you would any design object. Select it, then double-
click the custom conttrol to display the Properties dialog box for that ActiveX control. Each ActiveX control has its own
Properties dialog box, in which you set its size, fonts, colors and so on. 

LotusScript
You can use ActiveX controls to start LotusScript programs. ActiveX controls, just like objects native to Approach, 
may have methods, properties, and events. When an event executes, LotusScript code may also be executed.

{button ,AL(`H_ADDING_CUSTOM_CONTROLS_TO_THE_TOOLS_PALETTE_STEPS;H_CHANGING_PROPERTI
ES_OF_CUSTOM_CONTROLS_STEPS;H_INSERTING_CUSTOM_CONTROLS_IN_VIEWS_STEPS;H_REGIST
ERING_CUSTOM_CONTROLS_STEPS;',0)} See related topics



Opening Lotus Notes views or forms from a local Notes database
You can open a Lotus Notes view or form from a Notes database stored on your local drive.
1. From the Approach File menu, choose Open.

2. Select Lotus Notes - Local in the "Files of type" box.
3. Specify a Notes database.

Notes databases have the file extension .NSF. If no Notes databases are listed, specify a directory that contains 
the .NSF file with the view or form you want to open.

4. Select the view or form you want to open.
5. Click "Open as read-only" if you want to display the Notes view or form as read-only.
6. Click OK.

If you... Then...
Chose to display the view or 
form as read-only

A message box appears. Click
OK to remove the message 
box.

Opened a view The data appears in a 
worksheet. Double-click on a 
row to go to the appropriate 
form, which is generated from 
the corresponding Notes form.

Opened a form The data appears laid out as 
fields on a standard Approach 
form.

{button ,AL(`H_APPROACH_FILE_PROPERTIES_REF;H_CUSTOMIZING_LOTUS_NOTES_STEPS;H_OPENING_
LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_NOTES_DATABASE_ON_A_SERVER_STEPS;H_OPENING_
LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_NOTES_WORKSPACE_ON_A_SERVER_STEPS;H_REPLICA
TING_A_NOTES_DATABASE_STEPS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_STEPS;',0)}
See related topics



Opening Lotus Notes views or forms from a Notes database on a server
You can open a Lotus Notes view or form from a database stored on a Notes file server. 
1. From the Approach File menu, choose Open.

2. Select Lotus Notes - Server in the "Files of type" box.
3. Specify a server.
4. Click Open.

The Lotus Notes password dialog box appears.
5. Enter your Notes password in the "Enter a password" box. 
6. Click OK. 
7. Specify a Notes database.

Notes databases have the file extension .NSF. If no Notes databases are listed, specify the directory that contains
the .NSF file with the view or form you want to open.

8. Select the view or form you want to open.
9. Click "Open as read-only" if you want to display the Notes view or form as read-only.
10. Click Open.

If you... Then...
Chose to display the view or 
form as read-only

A message box appears.    
Click OK to remove the 
message box.

Opened a view The data appears in a 
worksheet. Double-click on a 
row to go to the appropriate 
form, which is generated from 
the corresponding Notes form.

Opened a form The data appears laid out as 
fields on a standard Approach 
form.

{button ,AL(`H_APPROACH_FILE_PROPERTIES_REF;H_CUSTOMIZING_LOTUS_NOTES_STEPS;H_OPENING_
LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_LOCAL_NOTES_DATABASE_STEPS;H_OPENING_LOTUS_
NOTES_VIEWS_OR_FORMS_FROM_A_NOTES_WORKSPACE_ON_A_SERVER_STEPS;H_REPLICATING_A
_NOTES_DATABASE_STEPS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_STEPS;',0)} See 
related topics



Opening Lotus Notes views or forms from a Notes workspace on a server
You can open a Lotus Notes view or form from any Notes database that appears in your Notes workspace.
1. From the Approach File menu, choose open.

2. Select Lotus Notes - Workspace in the "Files of type" box.
3. Specify a Notes database in the Directories list.

Notes databases have the file extension. NSF. If no Notes databases are listed, specify a directory that contains 
the .NSF file with the view or form you want to open.
If the database is stored on a Notes server, you automatically connect to the appropriate server.

4. Select the view or form you want to open.
5. Click "Open as read-only" if you want to display the Notes view or form as read-only.
6. Click OK.

If you... Then...
Chose to display the view or 
form as read-only

A message box appears. Click
OK to remove the message 
box.

Opened a view The data appears in a 
worksheet. Double-click on a 
row to go to the appropriate 
form, generated from the 
corresponding Notes form.

Opened a form The data appears laid out as 
fields on a standard Approach 
form

{button ,AL(`H_APPROACH_FILE_PROPERTIES_REF;H_CUSTOMIZING_LOTUS_NOTES_STEPS;H_OPENING_
LOTUS_NOTES_VIEWS_OR_FORMS_FROM_A_LOCAL_NOTES_DATABASE_STEPS;H_REPLICATING_A_N
OTES_DATABASE_STEPS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_STEPS;',0)} See 
related topics



Opening 1-2-3 named ranges in Approach
Open a named range of a 1-2-3 worksheet to view or edit the range in an Approach form.

• 1-2-3 must be running, and the worksheet containing the range must be open.
• The first row of the named range must contain data formatted as text. Approach uses this data for field names.

1. From the Approach File menu,    choose Open. 

2. Select 1-2-3 Ranges in the "Files of type" box.
3. Specify the worksheet containing the range you want to open.
4. Specify the named range.
5. Click Open.
Note Opening the named range does not convert it to a database file. Any changes you make in Approach to data in 
the range are saved in the worksheet.

{button ,AL(`H_CREATING_APPROACH_VIEWS_IN_LOTUS_123_STEPS;H_CREATING_DATABASES_FROM_SP
READSHEETS_STEPS;',0)} See related topics



Registering custom controls
Only registered custom controls appear in the Insert Custom Control dialog box and on the Tools palette.
1. Choose File - User Setup - Approach Preferences.
2. Click the Display tab.
3. Click Custom Controls.
4. Click Register Control.

The Register Custom Control dialog box appears.
5. Specify the custom control file (which usually has an .OCX file extension) you want to register in the File name 

box.
6. Click Open.
7. Click OK.

{button ,AL(`H_ADDING_CUSTOM_CONTROLS_TO_THE_TOOLS_PALETTE_STEPS;H_CHANGING_PROPERTI
ES_OF_CUSTOM_CONTROLS_STEPS;H_INSERTING_CUSTOM_CONTROLS_IN_VIEWS_STEPS;H_OLE_C
USTOM_CONTROLS_OVER;',0)} See related topics



Replicating Notes databases
Creates a copy on your local hard disk of a Notes database on a server.
If you're trying to replicate a Notes database with a server to update your local replica and the replica on the server 
with changes made to either one, see Replicating Notes databases with a server.

 Are you in Design?
1. Create a custom menu containing the command Notes - New Notes Replica. 

Note The item action for the menu is "Create a New Notes Replica."
2. Attach the menu to a view.
3. Switch to Browse.
4. Choose Notes - New Notes Replica from the custom menu.

The New Notes Replica dialog box appears.
5. Select the server in the "Server" box.
6. Select the database to be copied from the list of database files.
7. Under New Local Replica, enter a name for the new replica in the "Filename" box.
8. (Optional) To replicate only those documents saved during a specific period of time, select "Only replicate 

documents saved in the last nn days," and enter the number of days.
9. Click New.

The Notes database replicated on your hard disk is a Notes database file (.NSF).

{button ,AL(`H_CUSTOM_MENU_DIALOG_BOX_CS;H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_
STEPS;',0)} See related topics



Details: Replicating Notes databases with a server
Select this option To
Exchange document read 
marks

Update both the local replica 
and the server replica with read
marks on documents. (Read 
marks tell whether a document 
has been read.)

Receive documents from 
server

Update the local replica with 
documents from the server 
replica.

Send documents to server Update the server replica with 
documents from the local 
replica.

Replicate database 
templates

Replicate database templates 
associated with the database.

{button ,AL(`H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_A_CUSTOM_MENU_BAR_STEPS;H_CUSTOM_MENU_DIALOG_BOX_CS;H_REPLIC

ATING_A_NOTES_DATABASE_STEPS;',0)} See related topics



Replicating Notes databases with a server
Replicating a Notes database with a server updates both your local replica and the replica on the server with changes
made to either one.
If you're trying to create a local replica of a database on a server, see Replicating Notes databases.

 Are you in Design?
1. Create a custom menu containing the command Notes - Notes Replicate with Server. 

Note The item action for the menu us "Replicate with Notes Server."
2. Attach the menu to a view.
3. Switch to Browse.
4. Choose Notes - Notes Replicate with Server from the custom menu.

The Replicate with Notes Server dialog box appears.
5. Enter the name of the local database replica in the "Filename" box.
6. Select the server that has the database to be replicated in the "Server" box.
7. Select the replication options you want.
8. Click OK.

Example
By replicating a Notes database to your hard drive, you can add new information and make any necessary changes 
to the database without being connected to a network. This is useful if you need to update a database while you are 
working at a remote field site, without access to a network. After returning from the field site, you can replicate the 
changes you made to your local replica to the Notes database on the server, and replicate the changes made to the 
server to your local replica. 

{button ,AL(`H_REPLICATING_NOTES_DATABASES_WITH_A_SERVER_DETAILS',1)} See details
{button ,AL(`H_CUSTOM_MENU_DIALOG_BOX_CS;H_REPLICATING_A_NOTES_DATABASE_STEPS;',0)} See 

related topics



Adding dates, times, or page numbers to reports
Add these values to report headers or footers.

 Are you in Design?
1. Select the panel.
2. Choose Panel - Insert - Date, Time, or Page#.
3. Drag the new text block into position.

{button ,AL(`H_FORMATTING_DATES_AS_QUARTERS_THIRDS_AND_SO_ON_STEPS;H_FORMATTING_DATES
_STEPS;H_FORMATTING_TIMES_STEPS;H_adding_text_blocks_steps;H_report_panels_over;',0)} See related 
topics



Adding fields to new reports
Command: Create - Report

Tab: Fields
1. Be sure the database containing the field you want is showing in the Database box.
2. Select a field in the Fields box.

Use SHIFT+click or CTRL+click to select more than one field.
3. Click Add.
4. To add additional fields, repeat steps 1 - 3.
5. Click Next or Done.
The fields appear from left to right on the report in the order you select them here.

{button ,AL(`H_ADDING_FIELDS_TO_REPORTS_STEPS;H_ADDING_REPEATING_FIELDS_TO_NEW_REPEATIN
G_PANEL_REPORTS_STEPS;H_ADDING_SUMMARIES_TO_REPORTS_STEPS;H_DECIDING_WHAT_NEW_
REPORTS_LOOK_LIKE_REF;H_removing_or_reordering_fields_while_creating_new_views_steps;H_reports_ov
er',0)} See related topics



Adding fields to reports

 Are you in Design?
1. Choose Add Field on the context menu.
2. Drag the field from the Add Field dialog box into the appropriate panel.

Approach highlights the places on the report where you can place a new column. Be sure to position the field 
completely within the boundaries of the panel.

Tip To see labels on each type of panel, choose View - Panel Labels.

{button ,AL(`H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS_TO_REPORTS_steps;H_adding_summaries_to_r
eports_steps;H_report_panels_over;H_reports_over;h_grouping_records_in_reports_steps;',0)} See related topics



Adding repeating fields to new repeating panel reports
The fields you select on this tab should be from a different database than the Group fields you selected on the 
Groups tab.
Command: Create - Report

Tab: Repeating fields
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
3. Click Add.
4. To add additional fields, repeat steps 1 - 3.

The fields appear from left to right on the report in the order you select them here.
5. Click Next.

{button ,AL(`H_ADDING_FIELDS_TO_REPEATING_PANELS_STEPS;H_BASIC_PROPERTIES_OF_REPEATING_
PANELS_CS;H_MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_ONE_TO_MANY_MANY_TO_ONE_A
ND_ONE_TO_ONE_RELATIONSHIPS_OVER;H_REMOVING_EMPTY_GROUPS_FROM_REPEATING_PANEL_
REPORTS_STEPS;H_REPEATING_PANELS_OVER;H_removing_or_reordering_fields_while_creating_new_vie
ws_steps',0)} See related topics



Adding summaries to new reports
Command: Create - Report

Tab: Totals
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
3. Click Add.
4. Click the icon to the left of the summary field, and then select the summary calculation.
5. To add additional summaries, repeat steps 1 - 4.
6. Click Done.

{button ,AL(`H_ADDING_SUMMARIES_TO_REPORTS_STEPS;H_GROUPING_RECORDS_IN_REPORTS_STEPS
;H_POWERCLICK_REPORTING_DEF;H_removing_or_reordering_fields_while_creating_new_views_steps;H_su
mmary_calculations_ref',0)} See related topics



Adding summaries to reports
Follow these steps to add summary calculations to summary panels in an existing report using PowerClick reporting.

 Are you in Design?
1. From the View menu, choose Show Data.

2. If necessary, to create summary panels, group the records in the report.
3. Select the column you want to summarize.
4. From the Column menu, choose Groups & Totals, and then choose a calculation; or click an icon:

 Sum

 Average

 Count

 Maximum

 Minimum

 Standard Deviation

 Variance
Approach adds the summary calculation to the summariy panels in the report.

{button ,AL(`H_POWERCLICK_REPORTING_DEF;H_choosing_report_layouts_and_looks_steps;H_grouping_record
s_in_reports_steps;H_reports_over;H_select_print_preview_to_see_report_summaries_ref',0)} See related topics



Summarizing data of records in reports
You can add a calculated field to a report to summarize data in the records.
1. If necessary, from the Create menu, choose Summary, and then define a summary panel for the calculated field.
2. From the Create menu, choose Field Definition.
3. Scroll to the blank line at the bottom of the list of fields, and click it.
4. Name the field and select Calculated as its data type.

The dialog box expands to show the Define Formula and Define Summary tabs.
5. On the Define formula tab, to see just a list of summary functions, select Summary in the "Functions" box.
6. Double-click a summary function to select it.

The function appears in the "Formula" box. Until the formula definition is completed as required, a red "X" appears
over the flag. The "Function description" box describes the field requirements of the function.

7. To insert the required fields in the formula, double-click the field(s) required by the function.
8. Click the Define Summary tab, and then select "Summary panels where this field is placed"    in the "Summarize 

on" box.
9. Click OK.

Approach switches to Design and the Add Field dialog box appears.
10. From the Add Field dialog box, drag the calculated field to the summary panel.

It may be easier to do this with View - Show Data deselected.
11. To see the calculated fields on the report, choose View - Show Data, or choose File - Print Preview. 



Details: Creating title pages for reports
The title page of a report may contain data just like all other report pages, but allows you to use a different header 
and footer.
If your report is one page, it may consist of the title page alone.
When you have a title page for your report, be sure you make changes to the header and footer on the correct report 
page. The title page header and footer do not show up on the rest of the report pages.    If your header and footer 
does not print, check to see that "Show Title Page" is unchecked and that there is text in the header and footer.

Viewing the title page
Choose Report - Show Title Page. A check mark appears next to this menu option.

Returning to the report page
Choose Report - Show Title Page to remove the check mark.

Removing a title page
Choose Report - Add Title Page. The menu item should no longer have a check mark next to it.

{button ,AL(`H_CREATING_TITLE_PAGES_FOR_REPORTS_STEPS',1)} Go to procedure
{button ,AL(`H_PAGINATING_REPORTS_STEPS;H_adding_dates_times_or_page_numbers_to_reports_steps;H_ad

ding_text_blocks_steps;H_drawing_geometric_objects_steps;H_pasting_pictures_in_views_steps;',0)} See related
topics



Creating title pages for reports
The first page of a report - the title page - can have a different header and footer than the rest of the report.

 Are you in Design?
1. Choose Report - Add Title Page.
2. (Optional) Resize the header or footer panels.
3. Add objects such as text boxes or pictures to the panel.

{button ,AL(`H_CREATING_TITLE_PAGES_FOR_REPORTS_DETAILS',1)} See details
{button ,AL(`H_PAGINATING_REPORTS_STEPS;H_adding_dates_times_or_page_numbers_to_reports_steps;H_ad

ding_text_blocks_steps;H_drawing_geometric_objects_steps;H_pasting_pictures_in_views_steps;',0)} See related
topics



Deciding what new reports look like
Approach provides a number of layouts and styles. Select one of each to determine the basic appearance of the 
report. The Sample Report previews each combination.
Command: Create - Report

Tab: Layout

View name & title
The name you enter appears in the header on the report and in the view tab. For example:

Layout
Layouts arrange the fields on the report. Choose from one of these layouts:

Blank
Build your own report by adding fields to a blank view. 

Columnar
Columns of field data, one record per line, make it easy to read down a column and compare field data from record to
record. 

To quickly add totals or to group records after you create the report, use PowerClick reporting options.

Columnar with grand total
Shows columns of field data, one record per line, and grand totals for the columns you select.
For example, you can list all accounts receivable transactions issued for the month, and compute a grand total on the
Amount Due field. You can also calculate averages, counts, and so on.

Columnar with groups & totals
Shows columns of field data, one record per line; groups these records according to the fields you select; and adds 
totals for each group and the whole report.
For example, you have records of individual sales, but for this meeting, you want those sales grouped by 
salesperson. This report displays all Jane Smith's records in a single group and then subtotals her sales. You can 
also choose calculate averages, counts, and so on.



Repeating Panel Report
Shows all the records from one database and pulls details from joined databases.
For example, use this report to list all the orders for each of your customers. Like a repeating panel on a form, this 
report lists each customer with details of their order information.
Note This report option is only available when you have joined databases.

Standard
Shows field data, but doesn't limit a record to one line. Fields that don't fit on the first line are wrapped to the next line.
Use this report when you want to see multiple records with more detail than can display in a single row. Think of this 
report as showing "mini forms" for data entry or detailed comparisons between records.

Summary Only
Shows an easy-to-read executive summary with totals by groups and a grand total.

Style
Styles set properties such as background color and text attributes for the report.
To change the default style so that Approach automatically creates forms according to your preferences, go to Design
and choose Create - Named Style. Select the default style and click Edit.

{button ,AL(`H_ADDING_FIELDS_TO_REPEATING_PANELS_STEPS;H_Creating_custom_smartmasters_steps;H_
MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_O
NE_RELATIONSHIPS_OVER;H_adding_fields_to_reports;H_reports_over;H_working_with_named_styles_over',0
)} See related topics



Grouping records in new repeating panel reports
Select the Group field for a    repeating panel report from your main database. All of the records from this database 
appear on the report.
For example, suppose you have a database for customers and a second database for orders. A repeating panel 
report grouped by customer shows all customers and their orders, including customers with no orders.
Command: Create - Report

Tab: Groups
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Fields" box.
3. Click Next.

{button ,AL(`H_GROUPING_RECORDS_IN_NEW_REPORTS_STEPS;',0)} See related topics



Grouping records in new reports and crosstabs
The Report and Crosstab Assistants let you use field values to group records in the view. 
These controls are available on the assistant's Group tab from a pop-up menu next to the field name.

They are available from the "Group by" box above the fields list. The grouping option shown in the "Group by" box 
applies to the field selected in the list below.
Different grouping options are available according to the field type of the selected Group field. For example, if you 
select a date field to group by, you can select grouping options such as Year, Quarter, or Month.    Time fields have 
grouping options such as Hour and Minute.
Note Dates, times, or numbers must be in date, time, or numeric fields in order to use these grouping options.

Grouping text
In addition to alphabetical order, you can group text in sets according to the first few letters in the text field. For 
example, group part numbers:

Grouping numbers
For numeric fields, select a grouping option according to the predominant values in the Group field. For example, if 
you are grouping the quantity of product's sold and all values are greater than 1000, choose a grouping option of 
1000's so that the records appear in meaningful groups.
A grouping option much smaller than the costs displays records in groups of one on the report. A grouping option 
much larger than the costs displays all records in a single group on the report.



{button ,AL(`H_BASIC_PROPERTIES_OF_REPORTS_CS;H_grouping_records_in_reports_STEPS;H_removing_or_
reordering_fields_while_creating_new_views_steps;',0)} See related topics



Grouping records in new reports
Command: Create - Report

Tab: Groups
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
Records appear on the report grouped by the values in these fields.

3. Click Add.
4. (Optional) To select grouping ranges instead of single values,    select a grouping range option in the "Group by" 

box.
These options create groups for ranges of field values instead of groups for unique values.
Note If you make grouping selections in the Report Assistant; you cannot add or modify these groupings after the
report is created.

5. To add additional fields, repeat steps 1- 4.
6. Click Next.

{button ,AL(`H_grouping_records_in_new_reports_and_crosstabs_ref;H_grouping_records_in_reports_STEPS;H_re
moving_or_reordering_fields_while_creating_new_views_steps;',0)} See related topics



Details: Grouping records in reports
Approach lets you use field values to group records on a report. Reports read one record at a time. When the value of
the group field changes, Approach displays summary panels. A report can have two kinds of summary panels.

 Leading Summary
Adds a summary panel    at the 
beginning of each group. 
Typically used to show the value 
of the group field.

 Trailing Summary
Adds a summary panel at the 
end of each group. Typically 
associated with summary 
calculations.

After you create summary panels, you probably want to move the group field into the summary panel. This makes the
report easier to read.
You can also add summary calculations. See Adding summaries to reports.

Example
A database includes employee information including employee department and the product line the employee works 
on. 
To analyze employees by product line, you group the report by product line by selecting the Product Line field and 
clicking the Trailing Summary icon. To display a count of employees supporting each product line, you select the 
name field and click the Count icon. 
Because you created a trailing summary, the summary information follows each group of data.
To analyze employees by department, you group by department. Start with the original columnar report, select the 
Department field, and click the Leading Summary icon. To display a count of employees in each department, you 
select the name field and click the Count icon. 
Because you created a leading summary, the summary information precedes each group of data.

{button ,AL(`H_GROUPING_RECORDS_IN_REPORTS_STEPS',1)} Go to procedure



Grouping records in reports
Follow these steps to modify an existing report using PowerClick reporting.

 Are you in Design?
1. If necessary, from the View menu, select Show Data.

2. Select the field you want to use for grouping records.
3. For the desired grouping option, click a PowerClick icon:

 Leading Summary

 Trailing Summary
4. If the data is not sorted on the group field, a dialog box appears asking whether to sort on that field. If that is what 

you want, click Yes.
Approach adds a leading or trailing summary panel to the report.

5. If you want to add both summary panels, repeat step 3 for the other panel. 

Moving the group field to the summary panel
You probably want to move the group field to a summary panel so it prints only once per group.
1. From the View menu, deselect Show Data.
2. Select the field you chose to group by.
3. Drag this field to where you want it to appear in the summary panel.

Tip  To position the group field on the first line of data, you can use the InfoBox for the leading summary panel. 
On the Display tab, select left alignment.

4. From the View menu, select Show Data.
Instead of listing the group field in every row of the report, the report shows one entry in the summary panel for 
each group.

{button ,AL(`H_GROUPING_RECORDS_IN_REPORTS_DETAILS',1)} See details
{button ,AL(`H_adding_summaries_to_reports_steps;H_choosing_report_layouts_and_looks_steps;H_grouping_reco

rds_in_new_reports_and_crosstabs_ref;H_report_panels_over;H_reports_over;H_select_print_preview_to_see_re
port_summaries_ref',0)} See related topics



Details: Moving and resizing report columns
You can view your formatted report as you work by selecting View    - Show Data. 
From the Report or Column menus, when you select Turn on Columns, you determine how Approach works with 
columns as you design your reports. The Turn on Columns toggle command is only available when View - Show Data
is selected.
When Turn on Columns is ON, Approach lets you manage column headings and column fields together. 

Action Result
Select a column field or 
heading

The entire column is selected 
and appears in reverse 
highlighting.

Resize or move the column The columns to the right adjust
their positions accordingly.

When Turn on Columns is OFF, Approach lets you size and move the column headings and fields independently.

Action Result
Select a column field Only the field is selected.
Select a column heading Only the heading is selected
Resize or move a column 
field or heading

The columns to the right do 
not change their positions
The link between the field and 
the heading is broken. 
From now on, even when Turn
on Columns is ON,    you must 
work with the objects in this 
column independently.

{button ,AL(`H_MOVING_AND_RESIZING_REPORT_COLUMNS_STEPS',1)} Go to procedure



Moving and resizing report columns

 Are you in Design?
Tip Choose View - Show Data to size the column and its data together.

1. Select the column to be sized or moved.
2. From the Column menu, be sure Turn on Columns is checked.
3. Drag the column to a new position.
4. Resize it by dragging the right edge of the column.

Moving or resizing only the column head or the column data
1. To select the report, click in the left margin of the report.
2. From the Report menu, be sure Turn on Columns is not checked.
3. Select the field or heading object you want to move or resize.

Tip To select the column data, click a field value in the column.
4. Drag or resize the column head or column data.

{button ,AL(`H_MOVING_AND_RESIZING_REPORT_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_NUMBER_OF_COLUMNS_IN_REPORTS_STEPS;H_EDITING_COLUMN_HEAD

ER_TEXT_STEPS;H_REPEATING_PANELS_OVER;H_resizing_objects_steps;',0)} See related topics



Overview: Reports
Reports let you organize and present data from multiple records. You can choose what field data to present, group 
the records by field values, and calculate summary information for them. 
Approach provides a number of predesigned report layouts and styles. Pick one of each to determine the basic 
appearance of the report. Approach provides professional styles for reports which you can customize for a polished 
presentation.
Reports can show field data, summary information calculated from field data, or a combination of the two.

Viewing reports
If you're in a report and can't see aspects of the report like

• Totals and subtotals
• Group names

It's probably because you're in Browse. You need to be in Print Preview. From the File menu, choose Print Preview. 

You can also see report totals and group names in Design when View - Show Data is selected.

You can set Approach to display report summaries when you go to a report view. From the File menu, choose User 
Setup, then choose Approach Preferences. In the Display tab, select "Report summaries".    From now on, even when
you are in a view in Browse and switch to a report view, Approach displays the report in Design so you can see the 
summaries.

Creating reports
The Report Assistant helps you follow this process to create a report:
1. Choose Create - Report.
2. Select a report layout and style.
3. Choose the fields for the body of the report.
4. Set groupings for the contents of the report.
5. Select fields to summarize.

PowerClick reporting
Through PowerClick reporting, Approach provides a powerful way to modify reports. PowerClick reporting lets you 
use simple menu options or icons in the set of SmartIcons to add groups and add summary calculations to a report. 
These options are described in Grouping records in reports    and Adding Summaries to reports.

Selecting reports
To select a report in Design so that you can change report properties, click the background of the report, outside of 
any headings or fields. The Report menu appears in the menu bar when you are successful. 

{button ,AL(`H_ADDING_FIELDS_TO_REPORTS_STEPS;H_ADDING_SUMMARIES_TO_NEW_REPORTS_STEPS
;H_ADDING_SUMMARIES_TO_REPORTS_STEPS;H_BASIC_PROPERTIES_OF_REPORTS_CS;H_CREATING
_TITLE_PAGES_FOR_REPORTS_STEPS;H_LINES_AND_COLORS_FOR_VIEW_CS;H_deciding_what_new_re
ports_look_like_ref;H_report_panels_over',0)} See related topics



Overview: Report panels
Reports are made up of panels that you can see in Design when View - Show Data is turned off. Choose View - 
Panel Labels to show labels for each panel.

The way field data appears in a report is determined by the kind of panel it is in. For example, if a field is in the body 
panel, the field data from every record appears in the report. 
Below, you see fields in the body panel:

The corresponding report looks like this:

If the field is in a summary panel, the field data appears once for each unique field value. Below, you see fields in the 
body panel; they are grouped by the field in the summary panel:

The report, showing records in groups, looks like this:

The results from calculated fields in summary panels appear once for each group the summary applies to.

{button ,AL(`H_BASIC_PROPERTIES_OF_REPORT_PANELS_CS;H_MAIN_AND_DETAIL_DATABASES_IN_A_VIE
W_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;H_Selecting_m
oving_and_deleting_report_panels_steps;H_adding_fields_to_repeating_panels_steps;H_adding_summaries_to_r



eports_steps;H_grouping_records_in_reports_steps',0)} See related topics



Selecting, moving, and deleting report panels

 Are you in Design?
Tip To more easily work with panels and fields, deselect View - Show Data.

Selecting panels
To select a panel, do one of the following:

• Click the edge of the panel
• CTRL+click the panel area
• Click the panel label

Moving panels
The header, footer, and body panels cannot be moved. To move a summary panel, select the panel and drag it into 
position.

Resizing panels
If you are trying to increase the size of a field on the panel, increase the size of the panel first, then resize the field.
1. Select the panel.
2. When the mouse pointer is a two-headed arrow, drag the border of the panel.

Deleting panels
To delete a panel, select the panel and press DEL. You cannot delete the body panel.

{button ,AL(`H_report_panels_over;H_resizing_objects_steps;',0)} See related topics



Summary calculations
You can create summary calculations for numeric, date, and time fields, and text fields whose values are numbers. 
You can create a summary count of fields without numbers; if a field has a non-numeric value, but is not empty, it 
counts as one.

• Average 
• Count 
• Maximum 
• Minimum 
• Variance 
• Standard deviation 
• Sum 

{button ,AL(`H_ADDING_SUMMARIES_TO_REPORTS_STEPS;H_GROUPING_RECORDS_IN_REPORTS_STEPS
;H_POWERCLICK_REPORTING_DEF;H_removing_or_reordering_fields_while_creating_new_views_steps;H_su
mmary_calculations_ref',0)} See related topics



Summary dialog box
Use this dialog box to add a summary panel to an existing report. You can then add summary calculations to the 
report.

Command: Create - Summary
Approach adds a summary panel for each group or all records.

Alignment
Left Alignment places the summary panel on the left of the first line printed for each group.
Center Alignment places the summary panel on a new line, leading or trailing each group.
Right Alignment places the summary panel on the right of the first line printed for each group.

{button ,AL(`H_REPORTS_OVER;H_PANELS_OVER;',0)} See related topics



Adding envelopes to form letters
Command: Create - Form Letter

Tab: Envelope
The Envelope tab is only available if you select Block, Letterhead, or Modified Block in the Layout tab.
1. Select "Create envelopes to match the inside address" if it is not already selected.

Note If you do not want to create an envelope, select "Do not create an envelope."
2. Select "Print return address" if it is not already selected.
3. Select a standard size envelope under Envelope size.

If your envelope does not match the standard sizes, select Custom and enter the envelope's height and width 
under Dimensions.

4. Select either Portrait or Landscape in the Orientation area.
5. Click Done.

{button ,AL(`H_ADDING_THE_CLOSE_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_T
O_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDIN
G_THE_SALUTATION_TO_FORM_LETTERS_STEPS;H_DECIDING_WHAT_NEW_FORM_LETTERS_LOOK_LI
KE_REF',0)} See related topics



Adding fields to form letters

 Are you in Design?
1. Click to enter the text block.

The insertion point appears at the top left corner of the text block.
2. Click where you want the field to appear.
3. From the Text menu, choose Insert, then choose Field Value.
4. Select a field in the list.
5. Click OK to add it to the form letter.

Entering field names manually
Enter the field name in the text block in this format: <<DATABASE.FIELD>>. 
If there are spaces in the names, you must put quotes around them: <<"DATA BASE"."FIELD ONE">>.

{button ,AL(`H_ADDING_FIELDS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LET
TERS_STEPS;H_CHANGING_THE_DATE_FORMAT_ON_FORM_LETTERS_STEPS;H_ENTERING_TEXT_IN_
FORM_LETTERS_STEPS;H_MOVING_OR_DELETING_FORM_LETTER_FIELDS_STEPS',0)} See related 
topics



Adding text to mailing labels
• Add text, such as a comma between address fields or a general message, to each label.
• The text block you create appears on all labels in the view. 

 Are you in Design?
1. Choose View - Show Data to turn off Show Data.

2. Choose Create - Drawing - Text.

3. Create a text block on a label.
4. Enter text in the text block.

{button ,AL(`H_ADDING_TEXT_BLOCKS_STEPS;H_CHANGING_OR_DELETING_CUSTOM_MAILING_LABEL_TY
PES_STEPS;H_CREATING_CUSTOM_MAILING_LABEL_TYPES_STEPS;H_CREATING_MAILING_LABELS_S
TEPS;H_MOVING_OR_RESIZING_MAILING_LABEL_FIELDS_STEPS;H_SETTING_FIELDS_TO_SLIDE_STEP
S',0)} See related topics



Adding the close to form letters
Command: Create - Form Letter

Tab: End
The closing for the letter can be longer than a single line. 
1. Click inside the edit box and enter your closing text.

Note If you do not want to enter a close, click None.
2. Click Next or Done.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_FIELDS_TO_FORM_LETTERS
_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN
_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LETTERS_STEPS;H_
DECIDING_WHAT_NEW_FORM_LETTERS_LOOK_LIKE_REF',0)} See related topics



Adding the recipient address to envelopes
Command: Create - Envelope

Tab: To
1. Select the number of lines you want in the recipient address in the "Address Layout" box.
2. Be sure the database containing the field you want is showing in the "Database" box.
3. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
4. Click Add.
5. To add additional fields, repeat steps 2 - 4.
6. Click Next or Done.

The Define Main Database box appears if the envelope uses fields from more than one database. Select the 
database you want to be the main database for the envelope.

Note To place a field in a specific location under Fields for the address, select the destination box before you select a
field and click Add.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO
_ENVELOPES_STEPS;H_DECIDING_WHAT_NEW_ENVELOPES_LOOK_LIKE_REF;H_ENVELOPES_OVER;H
_SELECTING_PRINT_SETTINGS_FOR_ENVELOPES_STEPS;',0)} See related topics



Adding the recipient address to form letters
Command: Create - Form Letter

Tab: To
The To tab is only available if you select Block, Letterhead, or Modified Block in the Layout tab.
1. Select the number of lines you want in the recipient address in the "Address layout" box.
2. Be sure the database containing the field you want is showing in the "Database" box.
3. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
4. Click Add.
5. To add additional fields, repeat steps 2 - 4.
6. Click Next or Done.

The Define Main Database box appears if the form letter uses fields from more than one database. Select the 
database you want to be the main database for the form letter.

Note To place a field in a specific location under Fields for the address, select the destination box before you select a
field and click Add.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_FIELDS_TO_FORM_LETTERS
_STEPS;H_ADDING_THE_CLOSE_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO
_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LETTERS_STEPS;H_DECIDING_WH
AT_NEW_FORM_LETTERS_LOOK_LIKE_REF',0)} See related topics



Adding the return address to envelopes
Command: Create - Envelope

Tab: From
The From tab is only available if you select Standard as your layout. 
1. Click inside the edit box and enter the return address.
2. Click Next or Done.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_
TO_ENVELOPES_STEPS;H_DECIDING_WHAT_NEW_ENVELOPES_LOOK_LIKE_REF;H_ENVELOPES_OVE
R;H_SELECTING_PRINT_SETTINGS_FOR_ENVELOPES_STEPS;',0)} See related topics



Adding the return address to form letters
Command: Create - Form Letter

Tab: From
The From tab is only available if you select Block or Modified Block in the Layout tab.
1. Click inside the edit box and enter the return address.

Note If you do not want to enter a return address, click None.
2. Click Next or Done.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_FIELDS_TO_FORM_LETTERS
_STEPS;H_ADDING_THE_CLOSE_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_T
O_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LETTERS_STEPS;H_DECIDING_W
HAT_NEW_FORM_LETTERS_LOOK_LIKE_REF',0)} See related topics



Adding the salutation to form letters
Command: Create - Form Letter

Tab: Start
1. Enter text into the text box to use in your salutation.

The default text for this box is "Dear."
2. Select a field from the current database to use as the first word in the salutation.
3. Select a field from the current database to use as the second word in the salutation.

Note If you don't want to include a salutation, select None.
4. Enter punctuation into the text box

The default for this box is a colon (:).
5. Click Next or Done.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_FIELDS_TO_FORM_LETTERS
_STEPS;H_ADDING_THE_CLOSE_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_T
O_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO_FORM_LETTERS_STEPS;H_DECIDI
NG_WHAT_NEW_FORM_LETTERS_LOOK_LIKE_REF',0)} See related topics



Overview: ZIP code database
The Approach CD-ROM includes an Approach file and database file that contains the city, county, state and ZIP code 
information for all areas across the US. You can copy the files from the CD-ROM to your hard drive, then use them to 
automatically enter address information and generate reports based on ZIP codes. The files are stored in the 
directory EXTRA\APPROACH\DBASES with the names ZIP.APR and ZIP.DBF.

Using the ZIPcode database
Once you have joined the ZIP code database to your database, you can enter a city, county, or state, and Approach 
will automatically supply the ZIP code. You can also enter the ZIP code and Approach automatically enters the city, 
county, and state.
The .APR file contains two reports, one organized by city, the other organized by ZIP code. If you join the database to
a customer, contact, or order database you have a powerful tool for tracking product sales by ZIP code.



Creating mailing labels
A mailing label is a collection of field data combined to create a mailing address.
1. Choose Create - Mailing Label.

2. Name the view that displays the mailing labels in the "Mailing label name" box.
3. Select a layout in the "Select an address layout" box.
4. Be sure the database containing the field you want is showing in the "Database" box.
5. Select a field in the "Fields" box.

Use SHIFT+click or CTRL+click to select more than one field.
6. Click Add.
7. Repeat steps 4 - 6 for each element of the address. 
8. Select a label type in the "Label type" box.
9. Click OK.

{button ,AL(`H_ADDING_TEXT_TO_MAILING_LABELS_STEPS;H_CHANGING_OR_DELETING_CUSTOM_MAILIN
G_LABEL_TYPES_STEPS;H_CREATING_CUSTOM_MAILING_LABEL_TYPES_STEPS;H_MOVING_OR_RESI
ZING_MAILING_LABEL_FIELDS_STEPS;H_SETTING_OBJECTS_AND_FIELDS_TO_SLIDE_WHEN_PRINTIN
G_STEPS',0)} See related topics



Deciding what new envelopes look like
Approach provides a number of layouts and styles. Select one of each to determine the basic appearance of the 
envelope. The Sample Envelope previews each combination.
Command: Create - Envelope

Tab: Layout

View name & title
The name you enter appears in the view tab. 

Layout
Layouts arrange the fields on the envelope. 

• Standard creates a standard business envelope with return address and recipient address. 
• Preprinted omits the return address.

Style
Styles set properties such as text attributes for the envelope.
To change the default style so that Appproach automatically creates forms according to your preferences, go to 
Design and choose Create - Named Style. Select the default style and click Edit.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_
TO_ENVELOPES_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO_ENVELOPES_STEPS;H_ENVELOPES_
OVER;H_SELECTING_PRINT_SETTINGS_FOR_ENVELOPES_STEPS;',0)} See related topics



Deciding what new form letters look like
Approach provides a number of layouts and styles. Select one of each to determine the basic appearance of the form
letter. The Sample Letter previews each combination.
Command: Create - Form Letter

Tab: Layout

View name & title
The name you enter appears in the view tab. 

Layout
Approach lets you choose from four predefined layouts.

This Layout Displays
Block The return address, date, 

recipient address, salutation, 
closing, and body of the letter 
all in left-aligned blocks

Letterhead The recipient address, 
salutation,and body of the letter
in left-aligned blocks; the date, 
and closing appear on the right;
return address is omitted 

Modified Block The recipient address, 
salutation,and body of the letter
in left-aligned blocks; the return
address, date, and closing 
appear on the right

Personal The salutation and body of the 
letter in left-aligned blocks; the 
date and closing appear on the 
right; inside address and return
address are omitted

Style
Styles set properties such as background color and text attributes for the form letter.
To change the default style so that Approch automatically creates forms according to your preferences, go to Design 
and choose Create - Named Style. Select the default and click Edit.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_FIELDS_TO_FORM_LETTERS
_STEPS;H_ADDING_THE_CLOSE_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_T
O_FORM_LETTERS_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDIN
G_THE_SALUTATION_TO_FORM_LETTERS_STEPS',0)} See related topics



Entering text in form letters
When you finish selecting the database fields and entering the text necessary to create the form letter,    click Done. 
Regardless of what environment you started from, Approach switches you to Design. Now you can enter the body 
text of the form letter.
A form letter is a single large text block. 

• Enter and edit text in the form letter just as you would with any other text block. 
• From the View menu, choose Show Rulers to display and optionally change margins and tab stops.
• Approach automatically wraps text from one line to the next and creates additional pages as you enter text, just 

like a word processor. 
• There's no need to press ENTER unless you want to start a new line.

{button ,AL(`H_ADDING_TEXT_BLOCKS_DETAILS;H_ADDING_FIELDS_TO_FORM_LETTERS_STEPS;H_ADDIN
G_THE_SALUTATION_TO_FORM_LETTERS_STEPS;H_CHANGING_THE_DATE_FORMAT_ON_FORM_LETT
ERS_STEPS;H_MOVING_OR_DELETING_FORM_LETTER_FIELDS_STEPS;',0)} See related topics



Overview: Envelopes
An envelope displays a combination of field data for the mailing address and text for the return address. Approach 
creates a copy of the envelope for each record, using the name and address information from the records. 
You can also select layout, style, and print settings for the envelope.

Finding distinct records
If you have a database with multiple instances of records containing the same names, you'll want to exclude the extra
records from your found set. Otherwise you'll create more than one copy of the same envelope for the same person. 
To exclude multiple instances of the same names, use the Find Assistant and select Find distinct records. The found 
set will consist of one record for each name. 

Spacing around fields
Because database fields contain information of varying lengths, Approach automatically positions the database fields 
to match the envelope format and adjusts the spacing around fields. You see the adjusted spacing in Print Preview, 
and in Design if View - Show Data is on.

{button ,AL(`H_ADDING_THE_RECIPIENT_ADDRESS_TO_ENVELOPES_STEPS;H_ADDING_THE_RETURN_AD
DRESS_TO_ENVELOPES_STEPS;H_DECIDING_WHAT_NEW_ENVELOPES_LOOK_LIKE_REF;H_SELECTIN
G_PRINT_SETTINGS_FOR_ENVELOPES_STEPS;',0)} See related topics



Overview: Form letters
A form letter is a view  that displays a combination of database fields and text you enter in a letter format. Approach 
creates a copy of the letter for each record in the current found set, adding the name and address information from 
the records to the text you provide.
A typical form letter consists of database fields for the recipient's name and address, as well as a salutation, closing, 
and a return address. You can use all of these elements, or just select the ones that are appropriate to your mailing.
The Form Letter Assistant lets you create envelopes to match the inside address information on your letter.

Example
To send a year-end letter to each customer you've done business with in the past year, use the assistant to combine 
names, addresses, and other pertinent field data to create a personalized letter for each customer.

Finding distinct records
If you have a database with multiple instances of records containing the same names, you'll want to exclude the extra
records from your found set. Otherwise you'll create more than one copy of the same form letter for the same person.
To exclude multiple instances of the same names, use the Find Assistant and select Find distinct records. The found 
set will consist of one record for each name. 

Spacing around fields
Because database fields contain information of varying lengths, Approach automatically adjusts the spacing around 
fields to create a smooth flow between typed text and database fields. You see the adjusted spacing when you go to 
Browse, Print Preview, and in Design if View - Show Data is on.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_THE_CLOSE_TO_FORM_LET
TERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RET
URN_ADDRESS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LETTERS_STEP
S;H_DECIDING_WHAT_NEW_FORM_LETTERS_LOOK_LIKE_REF',0)} See related topics



Overview: Mailing labels
A Mailing Label view  displays field data and text in a mailing address format. The field data for each mailing address 
comes from one record. 
You can have many mailing labels on a page. The number of mailing labels you see on a page depends on the label 
size and page layout you select when you create the labels. Choose from more than 50 standard Avery mailing label 
formats or create other formats of your own.

Example
Use a customer database to prepare a mailing label for each customer who will receive a year-end letter. Each label 
contains the data from one record:

Finding distinct records
If you have a database with multiple instances of records containing the same names, you'll want to exclude the extra
records from your found set. Otherwise you'll create more than one copy of the same mailing label for the same 
person. To exclude multiple instances of the same names, use the Find Assistant and select Find distinct records. 
The found set will consist of one record for each name. 

Spacing around fields
Because database fields contain information of varying lengths, Approach automatically positions the database fields 
to match the mailing label format and adjusts the spacing around fields. You see the adjusted spacing in Print 
Preview, and in Design if View - Show Data is on.

{button ,AL(`H_ADDING_TEXT_TO_MAILING_LABELS_STEPS;H_CHANGING_OR_DELETING_CUSTOM_MAILIN
G_LABEL_TYPES_STEPS;H_CREATING_CUSTOM_MAILING_LABEL_TYPES_STEPS;H_CREATING_MAILIN
G_LABELS_STEPS;H_ENVELOPES_OVER;H_MOVING_OR_RESIZING_MAILING_LABEL_FIELDS_STEPS;H_
SETTING_OBJECTS_AND_FIELDS_TO_SLIDE_WHEN_PRINTING_STEPS',0)} See related topics



Moving or deleting form letter fields
You cannot move fields in a form letter by dragging.

 Are you in Design?

Moving fields in form letters
1. Select the field you want to move.

You must select the entire field name, including the angle brackets.
2. Choose Edit - Cut.

3. Click where you want to place the field.
4. Choose Edit - Paste.

Deleting fields in    form letters
1. Select the field.
2. Choose Edit - Cut.

{button ,AL(`H_ADDING_FIELDS_TO_FORM_LETTERS_STEPS;H_ADDING_THE_SALUTATION_TO_FORM_LET
TERS_STEPS;H_CHANGING_THE_DATE_FORMAT_ON_FORM_LETTERS_STEPS;H_ENTERING_TEXT_IN_
FORM_LETTERS_STEPS;',0)} See related topics



Moving or resizing mailing label fields
• Approach automatically slides fields over or up to eliminate any empty space between them.
• You can also adjust the space between fields yourself.

 Are you in Design?

Moving mailing label fields
Turn off the View - Show Data option. Drag the field to the location you want. Make sure the whole field fits inside the 
field boundaries so that all of its contents are printed.
If you make a field too small, Approach shows only as much data fits in the field object.
When moving fields in a mailing label, it is best to use the arrow keys instead of the mouse.

Resizing mailing label fields
Drag a field handle to the size you want.

{button ,AL(`H_MOVING_OBJECTS_STEPS;H_RESIZING_OBJECTS_STEPS;H_ADDING_TEXT_TO_MAILING_L
ABELS_STEPS;H_CHANGING_OR_DELETING_CUSTOM_MAILING_LABEL_TYPES_STEPS;H_CREATING_C
USTOM_MAILING_LABEL_TYPES_STEPS;H_CREATING_MAILING_LABELS_STEPS;H_SETTING_FIELDS_T
O_SLIDE_STEPS;',0)} See related topics



Selecting print settings for envelopes
Command: Create - Envelope

Tab: Printer 
1. Select a standard size envelope in the Envelope size box.

If your envelope does not match the standard sizes, select Custom and enter the envelope's height and width 
under Dimensions.

2. Select either "Portrait" or "Landscape" in the Orientation area.
3. Click Done.

{button ,AL(`H_ADDING_ENVELOPES_TO_FORM_LETTERS_STEPS;H_ADDING_THE_RECIPIENT_ADDRESS_
TO_ENVELOPES_STEPS;H_ADDING_THE_RETURN_ADDRESS_TO_ENVELOPES_STEPS;H_DECIDING_W
HAT_NEW_ENVELOPES_LOOK_LIKE_REF;H_ENVELOPES_OVER;',0)} See related topics



Details: Defining fields
Naming fields
When you define a field, give the field a name that you can easily recognize later. The name should also comply with 
the restrictions of the length of field names and use of special characters as dictacted by the database format. 
Follow these guidelines when you name a field:

• Begin the name with a character
• Use only letters, numbers and underscores
• Use no more than 10 characters

If you use these guidelines, your field names will work in any database format. If you create a field name that does 
not comply with the field name restrictions for the database format, Approach produces compatible field names and 
maps these names to the names you enter in the Field Definition dialog box.
Here are some other tips on naming fields that will help to avoid problems.

• Do not include spaces within field names. If you want a field name containing more than one word, join it with an 
underline. For example, social_security_number. 

• Avoid using special characters, such as $, &, @, etc. They are not acceptable by most database formats, and 
may cause confusion about what you want users to enter in the field. 

If you want to use a field in a formula, and the field contains anything other than letters, numbers, or underscores, you
must enclose the name in double quotes.

Length of field names
Field names are limited in length according to the database format. The maximum length for field names in the 
default database format, dBASE, is 32 characters.

Data types
See Types of fields for descriptions of each field type. 

Field size
Enter a maximum length for text fields in all types of databases and for numeric fields in some types of databases.
A text field is limited in length according to the database format. The maximum length for text fields in the default 
database format, dBASE, is 254 characters.

Numeric fields
The default length of numeric fields appears in the Field Definition dialog box as 10.2, ten digits left of the decimal 
and two digits right of the decimal. You can have up to 19 digits on the left and up to 15 on the right, but the total 
number of digits cannot exceed 19. 
dBASE and FoxPro databases require a length for numeric fields.

Field order
Fields are stored in a database and the Approach file in the order they were created. You can change that order for 
the Approach file. You cannot change the order in the database file.
The "View fields by" box displays orders you can use to display the fields.

Order Description
Default Order Displays fields in the order 

they appear in the database
Field Name Displays fields alphabetically 

by field name
Data Type Groups fields by their data 

type
Custom Order Displays fields in an order you 

create
You can reorder the fields by dragging them to a new position. That order is saved as the Custom order. Select the 
field you want to move by clicking the arrow to the left of its name.    When the hand appears, drag the field to the new
location.



Calculated and variable fields always appear at the end of the list. They are part of the Approach file, not part of the 
database.

Key fields for a Paradox database
When you define fields for a new Paradox database, you must define a key field for the database. See Specifying a 
key field.

Displaying fields in a view
After you define fields, they become available to add to a view. See Adding fields to a view.

Formatting fields
After you define a field and add it to a view, you can change the format of the field in the InfoBox.
For example, you can format a numeric field to automatically insert the parentheses and hyphen in the correct 
positions for a phone number: (408) 345-1234.

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS',1)} Go to procedure
{button ,AL(`H_Microsoft_access_tables_in_approach_ref;H_Query_files_in_approach_ref;H_basic_properties_of_fie

lds_cs;H_dbase_files_in_approach_ref;H_deleting_fields_from_a_database_steps;H_foxpro_files_in_approach_re
f;H_ibm_db2_tables_in_approach_ref;H_mapping_fields_in_approach_files_steps;H_odbc_data_sources_in_appr
oach_ref;H_oracle_sql_tables_in_approach_ref;H_paradox_files_in_approach_ref;H_sql_server_tables_in_appro
ach_ref;',0)} See related topics



Defining fields 
If you're trying to add an existing field to a view, see Adding fields to a view. 
1. From the Create menu, choose Field Definition.
2. Scroll to the empty line at the bottom of the field list.
3. Enter a name for the field.
4. Double-click the cell under Data Type and select a data type.
5. If you define a text field, enter the maximum number of characters you want the field to store.
6. (Optional) Click Options to define a default value, valid entries, or a formula to calculate the field contents. 
7. Click OK.

Approach switches to Design, and the Add Field dialog box appears.
8. (Optional) Add the field to the view.

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_DETAILS',1)} See details
{button ,AL(`H_BASIC_PROPERTIES_OF_FIELDS_CS;H_DELETING_FIELDS_FROM_A_DATABASE_STEPS;H_D

ISPLAYING_FIELDS_AS_CHECK_BOXES_STEPS;H_DISPLAYING_FIELDS_AS_SCROLLING_LISTS_STEPS;
H_DISPLAYING_FIELDS_AS_RADIO_BUTTONS_STEPS;H_ADDING_TEXT_BLOCKS_STEPS;H_TYPES_OF_
FIELDS_OVER;',0)} See related topics



Selecting records for summary in calculated fields

To apply the formula to Select
A set of records in a group as 
defined by the report summary panel
that the calculated field is in

Summary panel where this 
field is placed

Every record in the selected 
database (or found set if one is in 
effect)

Summary of all records in 
database
This option is repeated for 
each joined database in the 
current Approach file.

Every record in all databases joined 
in the Approach file (or found set if 
one is in effect)

Summary of all records in all 
databases



Details: Specifying a key field
When exporting data from Approach or saving a database file to a different file format, you must specify a key field or 
set of fields that can identify each record as unique. If you do not specify a key field that is unique, an error message 
displays indicating that you can't export or save the file because a duplicate key exists. 

Exporting to a Paradox database
In the Select Key Field dialog box, click Add Key Field to insert a numeric field named Approach_key_name at the 
beginning of each record. The key field value is a serial number starting at 1 in the first record, and incremented by 1 
through all records. Most often, this is the best solution for creating the key field.
The other option is to select an existing field from the list in the Select Key Field dialog box. This list shows all the 
text, numeric, date, and time fields defined for the database. If one or a set of these existing fields meets the 
requirements for a key field (in other words, that it is a unique identifier), you can select that field as the key field.

Modifying an existing key in a Paradox database
To change the key field in an existing Paradox database, do one of the following: 

• In Browse, export the database into a new Paradox database using File - Export Data . 
• Save the database as dBASE and then save it again as Paradox.

Exporting to other database formats
In the Select Key Field dialog box, select one or more key fields that can identify each record as unique.

{button ,AL(`H_APP_SPECIFYING_A_KEY_FIELD_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_PARADOX_FILES_IN_APPROACH

_REF;H_SAVING_A_COPY_OF_AN_APPROACH_FILE_AND_A_DATABASE_FILE_STEPS;',0)} See related 
topics



Specifying a key field
When you save a database or export data to another database file format, specify a key field or a set of fields that 
can uniquely identify each record as unique.
1. Export the data or save the file to the database format.
2. Do one of the following:

• For Paradox files: Click Add Key Field to have Approach add a key field named Approach_key_name at the 
beginning of each record.
If a suitable field already exists in the database, you can select that field from the list in the Select Key field 
dialog box instead of adding a new key field.

• For other file formats: Select a field or set of fields from the list in the Select Key Field dialog box. The field or 
set of fields must be able to identify each record as unique.

3. Click OK.

{button ,AL(`H_APP_SPECIFYING_A_KEY_FIELD_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_PARADOX_FILES_IN_APPROACH

_REF;H_SAVING_A_COPY_OF_AN_APPROACH_FILE_AND_A_DATABASE_FILE_STEPS;H_EXPORTING_DA
TA_FROM_APPROACH_STEPS;',0)} See related topics



Details: Deleting fields from a database
Before deleting a field, make sure you no longer need the data it contains and that you no longer need the field in 
another Approach file. You cannot retrieve data from a deleted field.

Deleting fields used in a join
A field used in a join cannot be deleted until the databases are unjoined. If the Approach file contains views based on 
the joined database, these views are deleted.

Deleting fields included in formulas or macros
If you delete a field used in a formula or macro, Approach replaces the field reference with NO_FIELD_REFERENCE 
on the view or in the formula. In a formula, Approach interprets the reference as blank; the formula may still return a 
result.

{button ,AL(`H_DELETING_FIELDS_FROM_A_DATABASE_STEPS',1)} Go to procedure
{button ,AL(`H_EDITING_FIELDS_OF_A_DATABASE_STEPS;H_UNJOINING_DATABASE_FILES_STEPS;',0)} See 

related topics



Deleting fields from a database
Caution You cannot retrieve the data from a deleted field.
1. If the field you want to delete is used in a join, unjoin the field. 
2. Choose Create - Field Definition.
3. Be sure you're in the database that contains the field you want to delete.
4. Click the name of the field.
5. Click Delete.
6. Click OK in the Delete Field message box.
7. Click OK.

{button ,AL(`H_DELETING_FIELDS_FROM_A_DATABASE_DETAILS',1)} See details
{button ,AL(`H_EDITING_FIELDS_OF_A_DATABASE_STEPS;H_UNJOINING_DATABASE_FILES_STEPS;H_DELE

TING_ALL_RECORDS_STEPS;H_DELETING_FILES_STEPS;H_DELETING_SPECIFIC_RECORDS_STEPS;',0)
} See related topics



Details: Editing fields of a database
Changing the field names
If you change the name of a field, the new name appears wherever the old name was used. This includes field 
references in formulas and macros. Labels  on fields in views, however, do not change.

Changing the data type
If you change the type of a field that contains data, Approach tries to convert the data to the new type. If it cannot 
convert the data in a particular field, Approach warns you that the data will be deleted and asks if it's OK to delete the 
data.
Tip You can preserve the contents of a field before changing its type by exporting the data from that field. This is 
especially helpful for saving the results from calculated fields. 

• You can change a field type from numeric to text or from text to numeric (if the field does not contain any text) 
without losing data. 

• If you change a calculated field to another type of field, you lose the calculated result. 
• If you change any other type of field, Approach warns you that data will be deleted and asks if it's OK to delete the

data.

Changing the field size
If you decrease the length of a field that already contains data, the data is truncated to the new length.

Changing a formula
If you change a formula, Approach recalculates the formula in all the records. If the result is used in formulas in other 
fields, those formulas are also recalculated.

{button ,AL(`H_EDITING_FIELDS_OF_A_DATABASE_STEPS',1)} Go to procedure
{button ,AL(`H_BASIC_PROPERTIES_OF_FIELDS_CS;H_Exporting_data_from_approach_steps;H_Types_of_fields

_over;',0)} See related topics



Editing fields of a database
Caution  If you reduce the length of a field or change the field type, you may lose information in the database.
1. Choose Create - Field Definition.
2. Be sure you're in the database that contains the field you want to edit.
3. Edit the field definition. 
4. If a message box appears, click OK to confirm the changes. 
5. Click OK.
6. Choose File - Save Approach File.

{button ,AL(`H_EDITING_FIELDS_OF_A_DATABASE_DETAILS',1)} See details
{button ,AL(`H_DELETING_FIELDS_FROM_A_DATABASE_STEPS;H_EDITING_LABELS_STEPS;',0)} See related 

topics



Details: Entering data automatically
To remove a previously set option in the Default Values tab, click Nothing.

To enter Click
Data from the same field in 
the last record added during 
the current session

Previous record.

Date or time the record was 
created

Creation date or Creation time.

Date or time the record was 
last modified

Modification date or 
Modification time.

Data in the field in every new 
record

Data. Then enter the data in 
the text box.

A unique number in the field 
in each new record

Serial number. Then enter a 
value for the first record in 
"starting at" and an increment 
value in "incremented by." A 
positive increment increases 
the number, a negative one 
decreases the number.

Result of a formula when you
create the record

Creation formula. Then click 
Formula and write the formula.

Result of a formula when you
create the record and also 
update the result whenever 
you modify the record

Modification formula. Then click
Formula and write the formula.

{button ,AL(`H_ENTERING_DATA_AUTOMATICALLY_STEPS',1)} Go to procedure



Entering data automatically
1. Choose Create - Field Definition.
2. Add or edit a text, numeric, date, time, or Boolean field.
3. Click Options.
4. On the Default Value tab, set the option for the value you want entered automatically in the field.

See details 
5. Click OK.

{button ,AL(`H_ENTERING_DATA_AUTOMATICALLY_DETAILS',1)} See details
{button ,AL(`H_ENTERING_THE_SAME_DATA_INTO_MANY_RECORDS_STEPS;',0)} See related topics



Printing a list of database fields
1. Choose Create - Field Definition.
2. Be sure you're in the database for which you want a field list.
3. Click Print.

The Print dialog box appears.
4. Click OK to close the Print dialog box.
5. Click OK.

{button ,AL(`H_PRINTING_VIEWS_STEPS;H_PRINTING_A_DIAGRAM_OF_JOIN_RELATIONSHIPS_STEPS;H_P
RINTING_APPROACH_VIEWS_OVER;H_PRINTING_MACRO_COMMANDS_STEPS;',0)} See related topics



Setting data options for a variable field
Set the data type for a variable field depending on how you use the field in calculations.
1. Choose Create - Field Definition.
2. Add or edit a variable field.
3. Click Options.
4. Select a data type in the "Select the field type" box.
5. (Optional) To give the field an initial value, set a default value. 
6. Click OK.

{button ,AL(`H_ENABLING_VARIABLE_FIELDS_FOR_NOTES_FX_STEPS;H_types_of_fields_over;',0)} See related
topics



Details: Setting OLE options for PicturePlus fields
Linking and embedding
When you link  an OLE object, the object is not stored in the field, but a copy of the object appears there. The original
object remains in its source file; the copy in the PicturePlus field is updated automatically to match changes in the 
original.
When you embed  an OLE object, the object is stored in the field.

Default OLE object type
If you have a default OLE object type, the corresponding application starts when you double-click an empty 
PicturePlus field or when you press SPACEBAR with an empty PicturePlus field selected. You can then create an 
object, and it will be embedded in the field.
If an object that doesn't correspond to the default object type is already in a field, double-clicking the field opens a 
dialog box from which you can specify an application to edit the object.

{button ,AL(`H_SETTING_OLE_OPTIONS_FOR_PICTUREPLUS_FIELDS_STEPS',1)} Go to procedure
{button ,AL(`H_BASIC_PROPERTIES_OF_PICTUREPLUS_FIELDS_CS;H_MODIFYING_LINKS_BETWEEN_OBJE

CTS_STEPS;',0)} See related topics



Setting OLE options for PicturePlus fields
1. Choose Create - Field Definition.
2. Add or edit a PicturePlus  field.
3. Click Options.
4. Select an object type.
5. Click OK.

{button ,AL(`H_SETTING_OLE_OPTIONS_FOR_PICTUREPLUS_FIELDS_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_LINKS_BETWEEN_OBJECTS_STEPS;H_CHANGING_DISPLAY_OPTIONS_FOR_A_

PICTUREPLUS_FIELD_STEPS;H_EDITING_LINKED_OBJECTS_STEPS;H_OLE_LINKS_OVER;',0)} See 
related topics



Overview: Types of fields
When you define a field, you give it a name and a type. The field type determines what kind of data you can store in 
the field. The type also affects how you can use the field for finding and sorting records or for data validation.
For example, if you store a date in a text field, you can only use the date format of MM/DD/YYYY as an input in a 
date calculation. Also, only text grouping options are available for the field: you cannot use the field to group by 
month, quarter, or year on reports and crosstabs.
You can use all field types except PicturePlus in calculations.

Boolean field
Stores a value of Yes, Y, or 1; or No, N, or 0. Define a Boolean field for information that requires a simple yes or no, 
such as whether a payment has been received. 

Calculated field
Stores the result of a formula. Create the formula when you define the field; Approach displays the result in the field. 
The result can be text, a number, a date, a time, or a Boolean value. You can find, sort, or group using a calculated 
field; the calculated field behaves like the type of the result. You cannot edit values in calculated fields. Calculated 
fields are part of an Approach file (.APR) rather than a database file.
If you select Calculated field type, you must define a formula to calculate the field values. See Writing formulas for 
calculated fields. The results of a calculation are shown in the field in Browse or Print Preview, and are read-only. 
Calculated fields that use information from multiple records are summary calculations whose results are shown only 
in Print Preview. The results of all calculated fields are not stored in the database, they exist only in memory and 
the .APR file.

Date field
Stores a single date. Find and sort records using a date field, and use a date in some calculations. A sort on a date 
field is in either ascending order (earliest to latest) or descending order (latest to earliest).

Memo fields
Stores any characters. Memo fields are useful for large amounts of data in a single field. You cannot define data entry
options for memo fields. You can search for characters in a memo field and use a memo field in a formula, but cannot
use a memo field in a sort. 

Numeric field
Stores data that you need to use in calculations or find or sort arithmetically. You can define the number of digits on 
both sides of the decimal place. Sort records by a numeric field in either ascending order (smallest to largest) or 
descending order (largest to smallest).

PicturePlus field
Stores a graphic or an object that comes from an application that supports OLE. Some common OLE objects are 
graphics, charts, sound files, and data ranges. Paste or import the graphic or object into a PicturePlus field. 
You can also draw in a PicturePlus field. Marks made with the pen cursor are saved separately from the objects in the
field.

Text field
Stores any characters, including letters, numbers, and symbols. Search on a text field using any character in the field.
A sort on a text field is alphabetical in either ascending order (0 to 9, then A to Z) or descending order (Z to A, then 9 
to 0).

Time field
Stores a single time. Find and sort records on a time field, and use a time in some calculations. A sort on a time field 
is in either ascending order (earliest to latest) or descending order (latest to earliest).

Variable field
Stores data in memory while the Approach file is open. The value is the same for all records.    Set the data type for 
the variable field and its initial value. Use variable fields to store intermediate values for macros. Variable fields are 
part of an Approach file (.APR) rather than a database file.



Storing field data and definitions
The following table shows where data and field definitions are stored for each field type. 

Data/field definition Is stored in
Text, numeric, date, time, and 
Boolean field data

Database file 

Text, Numeric, Date, Time, and 
Boolean field definitions

Database file 

Memo field data Memo file 
PicturePlus field data Memo file 
Variable and calculated field 
definitions

Approach file (.APR)

          

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_APPROACH_SAVES_DATA_AUTOMATICALLY_R
EF;H_DELETING_FIELDS_FROM_A_DATABASE_STEPS;H_EDITING_FIELDS_OF_A_DATABASE_STEPS;H_
ENTERING_DATA_AUTOMATICALLY_STEPS;H_FILE_EXTENSIONS_IN_APPROACH_REF;H_SETTING_DAT
A_OPTIONS_FOR_A_VARIABLE_STEPS;H_SETTING_OLE_OPTIONS_FOR_PICTUREPLUS_FIELDS_STEPS
;H_VERIFYING_THE_ACCURACY_OF_ENTERED_DATA_STEPS;',0)} See related topics



Details: Verifying the accuracy of entered data
To verify that Select
Value added in a new record 
does not already exist in 
another record

Unique.

Value is within an 
alphabetical, numerical, or 
chronological range

From/to. Then enter values for 
the beginning and end of the 
range (inclusive).

Some value must be 
specified in this field before a
new record is complete

Filled in.

The value matches one of 
the values in a set

One of. Enter each acceptable 
value in the text box and click 
Add. To remove a value from 
the set, select it and click 
Remove.

Formula evaluates to Yes 
when this value is used

Formula is true. Then click 
Formula and write the formula. 
For example, the formula 
"Number of Guests" >100 
accepts only values greater 
than 100 in the Number of 
Guests field.

Value matches a value in 
another field in this database
or in a database joined to it

In field. Then select the other 
field in the list. If the other field 
is in a different database, 
select the database in the drop-
down box.

{button ,AL(`H_VERIFYING_THE_ACCURACY_OF_ENTERED_DATA_STEPS',1)} Go to procedure



Verifying the accuracy of entered data
Prompts when invalid values are entered in this field in a new record.
To set up an ID field on which to join databases, use this procedure to ensure that the field is filled in and contains 
unique values. For more information on verifying data in ID fields, see Creating ID fields. 
1. Choose Create - Field Definition.
2. Add or select a text, numeric, date, time, or Boolean field.
3. Click Options.
4. Click the Validation tab.
5. Set the options for verifying data in the field. 

See details 
6. Click OK.

{button ,AL(`H_VERIFYING_THE_ACCURACY_OF_ENTERED_DATA_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATA_AUTOMATICALLY_STEPS;',0)} See related topics



Details:    Writing formulas for calculated fields
When you write a formula, you specify the operation to perform and the values to operate on. Your formula can 
consist of operators, operands (constants and field references), functions, and expressions.

Formula results
It is important to use appropriate field types and values when you create a formula, because Approach performs the 
calculation and produces a result depending on the field type. For example,    if you create a formula that uses date 
fields, the result is a date. If the formula uses a time field and a numeric value, the result is a time.

Time calculations
You can add or subtract times in calculations. The results of time calculations are in hundredths of a second 
(milliseconds). For example, suppose you create the following formula: END_TIME - START_TIME. You want to 
calculate the number of hours worked by your employees. In one record, START_TIME is 8:10 AM and END_TIME is
4:10 PM. The result in milliseconds is 2,880,000. You can then convert the result to more useful formats:

To convert the result to Divide by
seconds 100
minutes 6000
hours 360000
days 8640000

So a more useful formula for calculating the number of hours worked is (END_TIME - START_TIME)/36000. The 
answer in hours for this example is 8 hours.
You can also use the TextToTime  function to convert text to a time value in calculations involving time. Use the 
following formula to calculate elapsed time: 

TextToTime(END_TIME - START_TIME). 
The formula, however, returns a time: 08:00:00 AM. Change the format so that it displays as 8, use the InfoBox  to 
format the calculated field.

Other sample formulas
To do this Enter this formula
Concatenate two fields containing a 
person's first name (First_Name, a 
text field) and last name 
(Last_Name, a text field)

Combine ("First_Name", ' ',"Last_Name")

Calculate a person's age from their 
date of birth (Date_of_Birth, a date 
field) or if no date is present, enter 
"NO DOB" in the field.

If(IsBlank("Date_of_Birth"), 'NO DOB', 
Trunc(((Today() - "Date_of_Birth") / 365.25), 0))

Calculate from the invoice date 
(Invoice_Date, a date field) if an 
invoice (net 30 days) is overdue

If("Invoice_Date" >= Today() - 30, 'No', 'Yes')

Round a number (in NUM_FIELD, a 
numeric field) up or down to the 
nearest 10

ROUND(NUM_FIELD/10) * 10

Round a number down to the 
nearest 10

TRUNC(NUM_FIELD/10) * 10

{button ,AL(`H_FORMULAS_OVER;H_FUNCTIONS_OVER;H_OPERATORS_OVER;H_FUNCTIONS_ALPHA_REF;'
,0)} See related topics



Details: Adding fields to a view
Normally, the Add Field dialog box shows all the fields defined for databases associated with the current Approach 
file. The Add Field dialog box appears immediately after you create new fields in the Field Definition dialog; however, 
it shows only the newly created fields.
To see all the fields of the database, click "Show All Fields" at the bottom of the Add Field dialog box.
You can set your Approach preferences so that the dialog box does not appear automatically. With this option set, 
choose Add Field on the context menu or click the Add Field icon on the Tools palette to show the dialog box.

Adding join fields
If you want to be able to enter values into a join field, you must add the join field from the main database for the view. 
If you try to enter data into a join field from a detail database for the view, Approach displays the error message, "This
field is used in a join. Modifying this field is not revertible.".
To prevent this error message from displaying, whenever you add a join field from a detail database for the view, 
make the join field read-only with the Basics tab of the InfoBox.

{button ,AL(`H_ADDING_FIELDS_TO_A_VIEW_STEPS',1)} Go to procedure
{button ,AL(`H_SHOWING_THE_ADD_FIELD_DIALOG_BOX_AFTER_CREATING_NEW_FIELDS_STEPS;H_addin

g_fields_to_a_database_steps;',0)} See related topics



Adding fields to a view
A new database field does not appear in a view until you add it. Add the field to each view where you want this data to
appear.
If you're trying to define fields for a database, see Defining fields for a database.

 Are you in Design?
1. Choose Add Field in the context menu.

2. Be sure the database containing the field you want is showing.
3. Drag the field from the dialog box to the view.

Use SHIFT+click or CTRL+click to select more than one field.
4. (Optional) Update the tab order so the new field is in the correct position.
Approach adds the field as a field box. Use the InfoBox  to change the data-entry type of the field.

{button ,AL(`H_ADDING_FIELDS_TO_A_VIEW_DETAILS',1)} See details
{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_ADDING_FIELDS_TO_NEW_FORMS_STEPS;H_

ADDING_FIELDS_TO_NEW_REPORTS_STEPS;H_ADDING_FIELDS_TO_REPEATING_PANELS_STEPS;H_A
DDING_FIELDS_TO_REPORTS_STEPS;H_ADDING_OR_MOVING_FIELDS_IN_CROSSTABS_STEPS;H_FIEL
DS_OVER;H_TYPES_OF_FIELDS_OVER;H_adding_pictureplus_fields_to_a_view_steps;H_ADDING_FIELDS_T
O_FORM_LETTERS_STEPS;',0)} See related topics



Adding PicturePlus fields to a view

 Are you in Design?
1. Be sure that the PicturePlus field has been added to the database.
2. Choose Add Field on the context menu.

The Add Field dialog box appears.
3. Be sure the database containing the field is showing.
4. Drag the field from the dialog box to the view.

5. If necessary, resize the PicturePlus field by dragging one of its handles.

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_PASTING_PICTURES_IN_FIELDS_STEPS;H_TYP
ES_OF_FIELDS_OVER;',0)} See related topics



Changing the tab order in views

 Are you in Design?

Changing the tab order of a few objects
1. Choose View - Show Tab Order.

Squares with tab order numbers appear.
2. Select a number and type a new number.
3. Repeat step 2 to change other numbers.
4. Click OK in the action bar.

Changing the tab order of all objects
1. Choose View - Show Tab Order.
2. Click Clear Tabs in the action bar.
3. Click the squares in the order you want to enter field data.

Numbers appear in the squares as you click.
4. Click OK in the action bar.
Note Click Revert in the action bar to return the tab order to its original sequence.

{button ,AL(`H_PUTTING_OBJECTS_AND_FIELDS_IN_THE_TAB_ORDER_STEPS;H_removing_objects_and_field
s_from_the_tab_order_steps;',0)} See related topics



Overview: Fields
A field is a category of information in a database. For example, an address database would likely have fields for 
name, street, city, state, and Zip code.
To work with a field, you must add it to a view in an Approach file.

Fields in a database
When you create a database from scratch or open a new database from a SmartMaster, each piece of information in 
the database is stored in a field. You define new database fields, modify existing ones, or delete fields in the Field 
Definition dialog box in Approach. In this dialog box you specify the name, type, and size of the field.

This dialog box also contains controls for setting default field values and for verifying that the values entered into the 
field are valid.
When you enter data into a field on a view, the data goes directly into the database.

Fields in an Approach file
When you add a field to an Approach view, you make a connection from the view to the database field. Changes you 
make to the contents of the field are made to the database itself. 
You can make more than one connection between Approach views and a database field. For example, you can add a
field to a form for data entry, and you can also add the same field to a report and to a worksheet. Each representation
of the field in a view is a connection to the same field in the database.
The Approach field has different characteristics from the database field:

In Design, change Approach field properties using the InfoBox.

These field properties are saved in the Approach file and are not part of the database. Changes you make to the 
Approach field properties do not affect the database field; changes to the database field properties made in the Field 
Definition dialog box do not change the Approach field properties.

{button ,AL(`H_ADDING_FIELDS_TO_A_VIEW_STEPS;H_BASIC_PROPERTIES_OF_FIELDS_CS;H_CREATING_
A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_CREATING_A_NEW_DATABASE_WITH_A_SET_OF_READ
YTOUSE_FIELDS_STEPS;H_TYPES_OF_FIELDS_OVER',0)} See related topics



Rearranging a set of radio buttons or check boxes

 Are you in Design?
1. Select the field displayed as radio buttons or check boxes.
2. Drag a handle to define a new area.

The radio buttons or check boxes arrange themselves as necessary to fit within the area.

{button ,AL(`H_RESIZING_OBJECTS_STEPS;',0)} See related topics



Adding macros to the Run Macro menu
You can display macros you've created in the Run macro menu and then run those macros from the menu.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro to be added to the menu.
3. Select "Show in Menu."
4. To add additional macros to the menu, repeat steps 2 and 3.
5. Click Done.

Removing macros from the menu
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro you want to remove from the menu.
3. Deselect "Show in Menu."
4. To remove additional macros from the menu, repeat steps 2 and 3.
5. Click Done.

{button ,AL(`H_CREATING_MACROS_BASED_ON_EXISTING_MACROS_STEPS;H_CREATING_NEW_MACROS_
STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DELETING_MACROS_STEPS;H_MACRO_COMMANDS_A
LPHA_REF;H_MACROS_OVER;H_PRINTING_MACROS_STEPS;H_SAMPLE_MACRO_PROCEDURES_CS;',0
)} See related topics



Browse, macro command
Go to Browse.



Close, macro command
Close the current Approach file. You can set Approach to automatically disconnect from the server while the macro 
runs.



Converting macros to scripts
1. From the Edit menu, choosed Script & Macros, and then choose Macros.
2. Select a macro in the Macros dialog box.
3. Click Convert to Script.

The Convert Macro to Script dialog box appears.
4. Enter a name for the script in the "Enter a name for your script" box.
5. Click OK.

The IDE Script Editor displays your script.
6. Edit and debug your script using the tools in the IDE Script Editor.
7. Choose File - Save Scripts.
 

{button ,AL(`H_RUNNING_SCRIPT_FUNCTIONS_WITH_A_MACRO_STEPS;H_MACROS_OVER;',0)} See related 
topics



Creating keystroke sequences in macros
The Send Key macro lets you enter keystroke sequences in your macro. Keystroke sequences perform operations 
that are not available through the Approach macro commands. These operations include using the backspace, 
directional arrow, and function keys.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click Edit, New, or Copy.

The Define Macro dialog box appears.
3. Select Send Key in the "Command" box.
4. Click inside the "Keystroke sequence" box.
5. Enter a keystroke sequence for the operation you want to perform in the "Keystroke sequence" box.

When you advance to the next line of the Define Macro dialog box, the keystroke sequence you created appears 
in the "Options" line.

6. Enter any additional instructions needed to complete the macro.
7. Click OK to close the Define Macro dialog box.
8. Click Done.

{button ,AL(`H_SEND_KEY_KEYSTROKES_REF;H_SEND_KEY_MACRO_COMMAND_REF;H_DEFINE_MACRO_
DIALOG_BOX_REF;H_CREATING_NEW_MACROS_STEPS;',0)} See related topics



Creating looping macros
These macros repeat a set of instructions for each record in a found set. The first one ends after it finishes working 
on the last record. The second one continues running.

Creating a looping macro that ends when it reaches the last record
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the Macro name box.
4. (Optional) To run the macro using a function key, select a key in the Function key box.
5. Add the instructions to be performed within the loop.
6. Add the Records command to the list and select Next record.

This is the second to last instruction in the macro.
7. Add the Run command to the list and select the current macro.

This is the last instruction in the macro. The macro stops when the last record has gone through the loop.
8. Click OK to close the Define Macro dialog box.
9. Click Done.

Creating a looping macro that runs another macro after it reaches the last record:
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the Macro name box.
4. (Optional) To run the macro using a function key, select a key in the Function key box.
5. Add the instructions to be performed within the loop.
6. Add the Run command to the list and type IsLastRecord() in the If formula box.
7. Select "run macro" in the "Is True" box, and in the box on the right, select the macro to run after the last record 

has gone through the loop.
8. Select "continue this macro" in the "else" box.
9. Add the Records command to the list and select Next record.
10. Add another Run command to the list and select the current macro.
11. Click OK to close the Define Macro dialog box.
12. Click Done.

{button ,AL(`H_DEFINE_MACRO_DIALOG_BOX_REF;H_DEFINING_A_CONDITIONAL_MACRO_STEPS;H_FINDI
NG_A_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNING_MACROS_FROM_BUTTONS_IN_A_MES
SAGE_BOX_STEPS;H_RUNNING_SCRIPT_FUNCTIONS_WITH_A_MACRO_STEPS;H_SAVING_A_FIND_REQ
UEST_AS_PART_OF_A_MACRO_STEPS;H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO_STEPS;H_S
WITCHING_TO_ANOTHER_VIEW_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO
_STEPS;',0)} See related topics



Creating macros based on existing macros
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro you want to copy.
3. Click Copy.

The Define Macro dialog box appears.
4. Enter a name for the macro in the "Macro name" box.

• To run the macro when you open the Approach file, type Open as the macro name.
• To run the macro when you close the Approach file, type Close as the macro name.

5. (Optional) To run the macro by pressing a function key, select a key in the "Function key" box.
6. Change the instructions in the macro as appropriate .

Be sure the instructions are in the order you want them carried out.
7. Click OK to close the Define Macro dialog box.
8. To display the macro in the Run Macro menu, select the macro and select "Show in menu."
9. Click Done.

{button ,AL(`H_ADDING_MACROS_TO_THE_RUN_MACRO_MENU_STEPS;H_CREATING_NEW_MACROS_STE
PS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DELETING_MACROS_STEPS;H_EDITING_MACROS_STEPS;
H_MACRO_COMMANDS_ALPHA_REF;H_MACROS_OVER;H_PRINTING_MACRO_COMMANDS_STEPS;H_S
AMPLE_MACRO_PROCEDURES_CS;',0)} See related topics



Creating new macros
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the "Macro name" box.

• To run the macro when you open the Approach file, type Open as the macro name.
• To run the macro when you close the Approach file, type Close as the macro name.

4. (Optional) To run the macro by pressing a function key, select a key in the "Function" key box.
5. To add an instruction to the macro, select a command from the "Command" box.
6. Specify the appropriate options for the command.
7. To add additional instructions, repeat steps 5 and 6.

Enter each instruction in its own row.
Be sure the instructions are in the order you want them carried out.

8. Click OK to close the Define Macro dialog box.
9. (Optional) To remove the macro from the Run Macro menu, select the macro and deselect "Show in menu."
10. Click Done.

{button ,AL(`H_ADDING_MACROS_TO_THE_RUN_MACRO_MENU_STEPS;H_CREATING_MACROS_BASED_O
N_EXISTING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DELETING_MACROS_STEPS;H_
EDITING_MACROS_STEPS;H_MACRO_COMMANDS_ALPHA_REF;H_MACROS_OVER;H_PRINTING_MACR
O_COMMANDS_STEPS;H_SAMPLE_MACRO_PROCEDURES_CS;',0)} See related topics



Define Macro dialog box
Want the big picture? See Overview: Macros, and see Macro commands for descriptions of each command.

Selecting macro commands
A macro consists of one or more macro commands. To select a macro command: In the Command column on the 
left, click

to see the list of available commands. Then select the command you want. If necessary, record further instructions by
completing the options that appear at the bottom of the dialog box.
Put each macro command on its own line. 

Options
Many macro commands have options for setting specific conditions for the execution of the command. These options 
appear at the bottom of the Define Macro dialog box after you select a command.
For example, you can specify to set your print options here, such as the range of records to print, so that when you 
run the print macro, it does not open the Print dialog box.
When you specify an option for a macro command, your specification appears in the Options column on the right.

Function key
You can assign one of the function keys to a macro, so that the macro runs immediately when you press that function
key.
For example, you may have a macro that prints the current record. Assign the function key F12 to this macro. Then 
you can print the current record simply by pressing F12.

Inserting commands
Click Insert to add a blank row in an existing sequence. Then complete an instruction in that row.
For example, you created a macro that automates printing. Then you decide that you want to sort records before you 
print them, so you need to add the sort instruction before the print instruction. 
Insert a sort command in front of the print command in your print macro, specify the sort options, and save your 
changes.
To insert a blank row, click anywhere in the row you want to follow the blank row. Then click Insert.

Deleting commands
• Delete removes commands that you no longer want in your macro.
• Clear All removes all of the commands from the macro.

Moving commands
Rearrange commands by dragging them into new locations. Select a row by clicking the arrow in the left margin next 
to the command name. The entire row is highlighted, and the mouse pointer changes to a hand. Drag the row to the 
new position.



Details: Defining a conditional macro
Conditional options
The "is true" box specifies the action Approach takes when the conditional statement is true. The "else" box specifies 
the action Approach takes when the conditional statement is false. The macro can perform the following instructions 
when either condition is met.

To Select
Run a different macro Run macro and select the 

macro in the box that appears 
to the right

Run a different macro and 
return to the current macro

Run & return from macro and 
select the macro to branch to in
the box that appears to the 
right

Continue running the current 
macro

Continue this macro

End the macro End this macro

{button ,AL(`H_DEFINING_A_CONDITIONAL_MACRO_STEPS',1)} Go to procedure



Defining a conditional macro
You can create a conditional macro to verify that a certain condition exists in the current record before either 
continuing the current macro or running a second macro. 
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the "Macro name" box.
4. (Optional) To run the macro by pressing a function key, select a key in the "Function key" box.
5. Add the Run command as the first instruction in the list.
6. Select If and do one of the following:

• Write a formula in the box to the right of the If button.
• Click Formula, and write a formula in the Formula dialog box.

7. To have the macro perform an action when the condition is true, select an instruction from the "is true" box.
8. (Optional) To have the macro perform an action if the condition is false, select "else" and select an action from the

"else" box.
9. If necessary, add additional instructions to this macro.
10. Click OK to close the Define Macro dialog box.
11. Click Done.

{button ,AL(`H_DEFINING_A_CONDITIONAL_MACRO_DETAILS',1)} See details
{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_FINDING_A

_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNING_MACROS_FROM_BUTTONS_IN_A_MESSAG
E_BOX_STEPS;H_RUNNING_SCRIPT_FUNCTIONS_WITH_A_MACRO_STEPS;H_SAVING_A_FIND_REQUES
T_AS_PART_OF_A_MACRO_STEPS;H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO_STEPS;H_SWIT
CHING_TO_ANOTHER_VIEW_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO_ST
EPS;',0)} See related topics



Delete, macro command
Delete the current record, found set, or Approach file.
Select "Don't show warning dialog before deleting" to keep confirmation dialog boxes from interrupting the execution 
of the macro. Be sure the macro won't be deleting anything you might want before selecting this option.



Deleting macros
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro(s) you want to delete.
3. Click Delete.
4. Click Yes to confirm deleting the macro(s).
5. Click Done.

{button ,AL(`H_CREATING_NEW_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_EDITING_MACR
OS_STEPS;H_MACROS_OVER;H_PRINTING_MACROS_STEPS;',0)} See related topics



Dial, macro command
Dial the telephone number in the field you select. Approach uses the modem settings you specify in the Dialer tab of 
the Approach Preferences dialog box.



Editing macros
New commands can be added anywhere in the sequence of an already existing macro.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro you want to edit.
3. Click Edit.

The Define Macro dialog box appears.
4. Change the instructions in the macro as appropriate.

Be sure the instructions are in the order you want them carried out.
5. Click OK to close the Define Macro dialog box.
6. Click Done.

{button ,AL(`H_ADDING_MACROS_TO_THE_RUN_MACRO_MENU_STEPS;H_CREATING_MACROS_BASED_O
N_EXISTING_MACROS_STEPS;H_CREATING_NEW_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_
REF;H_DELETING_MACROS_STEPS;H_MACRO_COMMANDS_ALPHA_REF;H_MACROS_OVER;H_PRINTIN
G_MACRO_COMMANDS_STEPS;H_SAMPLE_MACRO_PROCEDURES_CS;',0)} See related topics



Edit, macro command
Use these commands from the Edit menu: Cut, Copy, Paste, or Select All. You can also have the macro open the 
Paste Special dialog box and wait for input while the macro runs.
The Edit macro command is used mostly for putting data on the Clipboard or pasting it.



Enter, macro command
Enter the current record in the database. This command is equivalent to pressing ENTER or clicking the Enter icon.



Exit, macro command
Exit Approach.



Export, macro command
Do one of the following:

• Set Approach to open the Export Data dialog box during the macro and wait for the user to complete the dialog 
box.

• Set export options now. Click Edit Export to select the records and fields to be exported, as well as the file to 
export to.



Find, macro command
Do one of the following:

• Do a named find.
Select a named find from the "Named find/sort" box.
To create a named find or edit an existing named find for your macro, click New Find or Edit Find.

• Go to Find during the macro.
Users of your macro can then create a find request and execute it.

• Open the Find Assistant during the macro.
Users of your macro can then create a find and execute it.

Note If your macro includes any of the three instructions above, consider what you want to happen if the find fails to 
find any records. For example, you may want to display a message telling users to try again. Create a macro that 
Approach can run in the event that no records are found, and select that macro in the box under "When no records 
are found, run macro."

• Choose Find Again during the macro.
Users of your macro can modify the previous find conditions to further narrow the results.

• Refresh the found set to include the latest data from a network database.
• Find all records so that the next macro instruction affects all records in the database.



Import, macro command
Do one of the following:

• Set Approach to open the Import Data dialog box during the macro and wait for the user to complete the dialog 
box.

• Set or edit import options now.
• Click Define Import File to set up a new import.
• Click Edit Import Setup to modify existing import options.



Overview: Macros

What is a macro?
A macro is a series of instructions, written by you and executed by Approach, that can simplify tasks, speed up their 
accomplishment, and thus make you more productive. 
You name the macro and write the instructions, using one or more macro commands supplied by Approach. Then you
assign the macro to an event that runs the macro. Common events include clicking a button that you add to a view or 
pressing a function key that you define when you create the macro.

What's the benefit of creating a macro?
Macros simplify your work by automating repetitive tasks. You can link macros to each other to automate a series of 
tasks. For example, you can create macros to do the following:

• Automate procedures you normally perform from the keyboard or with the mouse, such as changing the color of 
text.

• Perform complex tasks and programming procedures, such as loops and if-then-else statements.
• Guide users who are unfamiliar with Approach through tasks and applications that you create and control.

Examples
You can use a macro to perform a simple task, such as switching from a form to a report, or multiple tasks, such as 
finding all unpaid invoices, sorting them by date in ascending order, switching to a past-due notice form letter, and 
printing individual past-due notices.

What's the first step in creating a macro?
Plan ahead. Thoroughly understand the task you want to accomplish with the macro. List the instructions you want to 
give Approach, step by step.
If the task is complex, here's how to have Approach write most of the macro for you: 
From the Edit menu, choose Script & Macros, and then choose Record Transcript. Then do the task. As you do the 
task, Approach records your actions using the macro language. 
When you finish the task, turn off Record Transcript: From the Edit menu, choose Script & Macros, and then choose 
Stop Recording. Go to the Define Macro dialog box, and edit the macro.

What macro commands are available in Approach?
See Macro commands for descriptions of each command.

Combining macros with LotusScript
Approach's macro language doesn't allow you to automate everything you can do in the application. You can control 
more of Approach by writing programs using LotusScript. You may then want to incorporate a LotusScript program 
into a macro, or conversely, incorporate a macro into a script.
See Running Script functions with a macro.

Running macros
To run a macro from Do this
The Run Macro menu From the Edit menu, choose Script

& Macros, and then choose Run 
Macro.
See Adding macros to the Run 
Macro menu.

An assigned function key Press the function key.
A button Tab to or away from the button, or 

click the button.
An object Tab to or away from the object, or 

select the object.
A field Tab to or away from the field, or 

change the data in the field.



A view Switch to or from the view.
Opening an Approach file Name the macro Open.
Closing an Approach file Name the macro Close.
A list of all macros From the Edit menu, choose Script

& Macros, and then choose 
Macros. Select the macro to run, 
and click Run.

{button ,AL(`H_CREATING_MACROS_BASED_ON_EXISTING_MACROS_STEPS;H_CREATING_NEW_MACROS_
STEPS;H_DELETING_MACROS_STEPS;H_EDITING_MACROS_STEPS;H_PRINTING_MACRO_COMMANDS_
STEPS;H_SAMPLE_MACRO_PROCEDURES_CS;H_ATTACHING_MACROS_STEPS',0)} See related topics



Macro commands
Browse
Close
Delete
Dial
Edit 
Enter 
Exit 
Export
Find
Import
Mail 
Menu Switch
Message
Open
Page To
Print 
Print Preview
Records
Replicate
Run
Save
Send Key 
Set
Sort
Spell Check
Tab
View
Zoom



Mail, macro command
Do one of the following:

• Set Approach to open the TeamMail dialog box during the macro and wait for the user to complete the dialog box.
• Set mailing options now. Click Edit - TeamMail to send an e-mail during the macro.



Menu Switch, macro command
Switch to the menu bar you specify. To create a custom menu now, go to Design and click Customize Menus.



Message, macro command
Display a message box that contains the title and text you enter.
You can define one of two buttons to appear in the message box.
You must give the button a name and attach an instruction to it. The instruction can be

• A macro
• **CONTINUE**, which executes the next instruction in the current macro
• **STOP**, which ends the macro

{button ,AL(`H_RUNNING_MACROS_FROM_BUTTONS_IN_A_MESSAGE_BOX_STEPS;',0)} See related topics



Open, macro command
Do one of the following:

• Set Approach to open the Open dialog box during the macro and wait for the user to complete the dialog box.
• Name the file that you want to open at this point in the macro.

The file can be another Approach file, a different database file, or another application, such as Lotus 1-2-3. You 
could even open a communication application that uses a script to upload your data to another computer.



Page To, macro command
Go to a page of a multi-page form.
Note Page To works within a single record. To go to a different record, use the Records macro command.



Printing macros
Prints the instructions that make up a macro.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Select the macro you wish to print.
3. Click Edit.

The Define Macro dialog box appears.
4. Click Print.
5. Click OK to close the Define Macro dialog box.
6. Click Done.

{button ,AL(`H_DEFINE_MACRO_DIALOG_BOX_REF;H_EDITING_MACROS_STEPS;H_MACRO_COMMANDS_A
LPHA_REF;H_MACROS_OVER;H_SAMPLE_MACRO_PROCEDURES_CS;H_APPROACH_FILE_PROPERTIE
S_REF',0)} See related topics



Print, macro command
Do one of the following:

• Set Approach to open the Print dialog box during the macro and wait for the user to complete the dialog box.
• Set printing options now and print automatically during the macro. Click Edit Print.



Print Preview, macro command
Go to Print Preview.



Recording macros and scripts 
Record a transcript of actions you do in Approach, and then create a macro or LotusScript procedure based on the 
transcript.
1. From the Edit menu, choose Script & Macros, and then choose Record Transcript.
2. Under Record, select whether you want the transcript recorded as a macro, a script, or a script to be inserted in 

the IDE at the current location of the insertion point.
3. Do one of the following:

• Select the name of an existing macro from the "As macro" drop-down box, or enter a new name.
• Select the name of an existing script from the "As script" drop-down box, or enter a new name.

4. Click Record.
5. Execute the operations in Approach you want to record. 
6. From the Edit menu, choose Script & Macros, and then choose Stop Recording.

The Define Macro dialog box or the IDE appears, depending on how you record the transcript.
7. When you are finished editing the macro or script, do one of the following: 

• To save the macro, click OK. 
• To save the script, choose File - Save Scripts.

Note  You can overwrite existing macros and scripts if you choose to by entering their names in the "As macro" or 
"As script" drop-down boxes.        

{button ,AL(`H_CREATING_NEW_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_CONVERTING_
MACROS_TO_SCRIPTS_STEPS;',0)} See related topics



Records, macro command
Go to a record, hide a record, duplicate a record, or create a new record.

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO
_STEPS;',0)} See related topics



Replicate, macro command
Do one of the following:

• Set Approach to open the Replicate Notes Database dialog box during the macro and wait for the user to 
complete the dialog box.

• Set replication options now and replicate automatically during the macro. Click Edit Replicate.



Running macros from buttons in a message box
By default, the message box displays an OK button which continues the current macro when pressed.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the "Macro name" box.
4. (Optional) To run the macro by pressing a function key, select a key in the "Function key" box.
5. Select the Message command from the "Command" box.
6. Enter the title and text of the message box.
7. Enter the name of the button.
8. Select the macro that runs when users click the button.
9. Click OK to close the Define Macro dialog box.
10. Click Done.

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DEFINING_
A_CONDITIONAL_MACRO_STEPS;H_FINDING_A_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNI
NG_SCRIPT_FUNCTIONS_WITH_A_MACRO_STEPS;H_SAVING_A_FIND_REQUEST_AS_PART_OF_A_MAC
RO_STEPS;H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO_STEPS;H_SWITCHING_TO_ANOTHER_
VIEW_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO_STEPS;',0)} See related 
topics



Running script functions with a macro
Use a macro to call a global LotusScript function or procedure.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the "Macro name" box.
4. (Optional) To run the macro by pressing a function key, select a key in the "Function key" box.
5. Select Run from the "Command" box.
6. Select the script function or procedure you want to run from the "Run macro" box.
7. If you want to return to the next line in this macro after the script is executed, select "Return to the next line in this 

macro."
8. Click OK to close the Define Macro dialog box.
9. Click Done.

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DEFINING_
A_CONDITIONAL_MACRO_STEPS;H_FINDING_A_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNI
NG_MACROS_FROM_BUTTONS_IN_A_MESSAGE_BOX_STEPS;H_SAVING_A_FIND_REQUEST_AS_PART_
OF_A_MACRO_STEPS;H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO_STEPS;H_SWITCHING_TO_A
NOTHER_VIEW_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO_STEPS;',0)} See 
related topics



Run, macro command
Do one of the following:

• Run another macro or a global script.
Branch to the macro or global script you select. This transfers control to the selected macro or global script.

• Run a macro and then return to the next line of the originating macro.
The macro you select becomes a subroutine of the macro you're working on. After the selected macro finishes 
running, control returns to the originating macro.

• Write a formula whose result determines the next instruction on the macro. The formula must evaluate to either 
Yes or No.

• Click Formula to open the Formula dialog box. Write the formula. When Approach recognizes the formula as 
valid, the checkered flag is no longer crossed out:

• Select an instruction for Approach to follow if the formula evaluates to Yes ("is true").
• (Optional) Select an instruction for Approach to follow if the formula evaluates to No ("else").

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINING_A_CONDITIONAL_MACRO_STEPS;',0)} 
See related topics



Sample macro procedures
Choose a procedure

Creating looping macros
Defining a conditional macro
Running macros from buttons in a message box
Setting a value in a field with a macro
Switching to another view with a macro

{button ,AL(`H_WORKING_WITH_MACROS_CS;H_MACROS_OVER;H_MACRO_COMMANDS_ALPHA_REF;H_R
ECORDING_MACROS_AND_SCRIPTS_STEPS',0)} See related topics



Save, macro command
Do one of the following:

• Set Approach to open the Save As dialog box during the macro and wait for the user to complete the dialog box.
• Automatically save the Approach file (.APR) at this point in the macro.

Note Approach saves all changes to data automatically, so if your macro users are only entering or editing data, 
you don't need to use this macro command.



Send Key keystrokes

Keyboard keys
To enter nonprinting keyboard keys (such as Tab or Backspace), or keys that perform actions in the active window 
(such as Page Up), in the Keystroke sequence box of the Send Key command use the key codes from the following 
table. Type the key code surrounded by braces in the Keystroke sequence box. The key code can be either 
uppercase or lowercase.

Key Code
Backspace {BS} or {BKSP} or 

{BACKSPACE}
Break {BREAK}
Caps Lock {CAPSLOCK}
Clear {CLEAR}
Del {DEL} or {DELETE}
Down arrow {DOWN}
End {END}
Enter ~ or {ENTER}
Esc {ESC} or {ESCAPE}
Function keys {F1} to {F16}
Help {HELP}
Home {HOME}
Ins {INSERT}
Left arrow {LEFT}
Num Lock {NUMLOCK}
Pg Dn {PGDN}
Pg Up {PGUP}
Right arrow {RIGHT}
Scroll lock {SCROLLLOCK}
Tab {TAB}
Up arrow {UP}

To enter a character from the following table, enclose it in braces as shown.

Character Code
Brace {{ } or {}}
Bracket {[ } or {]}
Caret {^}
Parenthesis {( } or {)}
Percent sign {%}
Plus sign {+}
Tilde {~}

Combination keys      
The following table shows how to designate keys pressed in combination with ALT, CTRL, or SHIFT.

Combination key Code Example
ALT % %{F4} represents 



ALT+F4
CTRL ^ ^{F4} represents 

CTRL+F4
SHIFT + +{F4} represents 

SHIFT+F4
To apply a combination key to a sequence of keys, enclose the sequence in parentheses. For example, +(xy) holds 
down the SHIFT key for both x and y. It is equivalent to +x+y.

Errors
Send Key does not work if the keystroke sequence contains any of the following:

• An unmatched brace
• An incorrectly entered key code
• More than 30,000 characters

{button ,AL(`H_SEND_KEY_MACRO_COMMAND_REF;H_CREATING_KEYSTROKE_SEQUENCES_IN_MACROS
_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_CREATING_NEW_MACROS_STEPS;',0)} See related 
topics



Send Key, macro command
Include keystrokes in a macro so that your macro can perform operations that are not available through the Approach
macro commands. You can include keystrokes in a macro by entering them in the Keystroke sequence box.

What are keystrokes?
The name of every command and every dialog box option in Approach has one underlined character. That character 
is the keystroke you use to execute the command or select the option. For example, to add a page to a form, you 
switch to the Design environment and choose Form - Add Page. The keystrokes for that command are r and d.
Use the keys ALT and CTRL in combination with other keys to execute some commands. Press ALT to go to the menu 
bar. For example, press ALT and v to open the View menu. Then, to display the rulers, press r. The whole sequence 
is ALT v r. 
Sometimes there is more than one key combination that you can use to execute a command. For example, pressing 
CTRL and j also displays the rulers.
For information about entering nonprinting keys, see Send Key keystrokes.

{button ,AL(`H_SEND_KEY_KEYSTROKES_REF;H_CREATING_KEYSTROKE_SEQUENCES_IN_MACROS_STEP
S;H_DEFINE_MACRO_DIALOG_BOX_REF;H_CREATING_NEW_MACROS_STEPS;',0)} See related topics



Setting a value in a field with a macro
Create a macro that changes the value in a field for all records in a database, automatically going from one record to 
the next and setting values until all records are updated.
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the "Macro name" box.
4. (Optional) To run the macro by pressing a function key, select a key in the "Function key" box.
5. Add the Set command to the list and select a field.
6. Enter a value or write a formula for the selected field in the "To this value" box.
7. Add the Records command to the list and select Next Record.
8. Add the Run command to the list and select the current macro.

The macro stops after it reaches the value in the last record.
9. Click OK to close the Define Macro dialog box.
10. Click Done.

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DEFINING_
A_CONDITIONAL_MACRO_STEPS;H_FINDING_A_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNI
NG_MACROS_FROM_BUTTONS_IN_A_MESSAGE_BOX_STEPS;H_RUNNING_SCRIPT_FUNCTIONS_WITH_
A_MACRO_STEPS;H_SAVING_A_FIND_REQUEST_AS_PART_OF_A_MACRO_STEPS;H_SWITCHING_TO_A
NOTHER_VIEW_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO_STEPS;H_FOR
MULAS_OVER;',0)} See related topics



Set, macro command
Set the field you specify to the value you enter or the formula you define (click the Formula button).
Use Set for any field, except a calculated field.

{button ,AL(`H_SETTING_A_VALUE_IN_A_FIELD_WITH_A_MACRO_STEPS;',0)} See related topics



Sort, macro command
Do one of the following:

• Set Approach to open the Sort dialog box during the macro and wait for the user to complete the dialog box.
• Set sort options now to sort records automatically at this point in the macro.

Set sort options for summary fields. Click Summaries.



Spell Check, macro command
Open the Spell Check dialog box during the macro to check the spelling of data on records, including text in memo 
fields.



Switching to another view with a macro
Use a macro like this anytime you need to switch from one view to another.

 Show me a QuickDemo 
1. From the Edit menu, choose Script & Macros, and then choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter a name for the macro in the Macro name box.
4. (Optional) To run the macro by pressing a function key, select a key in the Function key box.
5. Under Switch, show, or hide views, click Switch the current view to, and select a view in the View list.
6. Click OK to close the Define Macro dialog box.
7. Click Done.

{button ,AL(`H_CREATING_LOOPING_MACROS_STEPS;H_DEFINE_MACRO_DIALOG_BOX_REF;H_DEFINING_
A_CONDITIONAL_MACRO_STEPS;H_FINDING_A_SET_OF_RECORDS_WITH_A_MACRO_STEPS;H_RUNNI
NG_MACROS_FROM_BUTTONS_IN_A_MESSAGE_BOX_STEPS;H_RUNNING_SCRIPT_FUNCTIONS_WITH_
A_MACRO_STEPS;H_SAVING_A_FIND_REQUEST_AS_PART_OF_A_MACRO_STEPS;H_SETTING_A_VALU
E_IN_A_FIELD_WITH_A_MACRO_STEPS;H_USING_AN_IF_CALCULATION_IN_A_MACRO_STEPS;',0)} See 
related topics



Tab, macro command
Tab to an object. To find out where an object is in the tab order, in Design, choose View - Show Tab Order.



View, macro command
Go to another view in the Approach file, show a view, or hide a view.



Working with macros
Choose a task

Adding macros to the Run Macro menu
Converting macros to scripts 
Creating new macros
Creating macros based on existing macros
Deleting macros
Editing macros
Printing macros
Running script functions with a macro
 

{button ,AL(`H_SAMPLE_MACRO_PROCEDURES_CS;H_MACROS_OVER;H_RECORDING_MACROS_AND_SC
RIPTS_STEPS;H_MACRO_COMMANDS_ALPHA_REF',0)} See related topics



Zoom, macro command
Scale the current window by zooming in or out, or zooming to a specific percent.



Adding buttons to run macros
Add a button to a view and attach a macro to the button. You can run the macro in Browse or Print Preview.

 Are you in Design?
1. From the Create menu, choose Control, and then choose Button.

2. Drag to draw the button.
The InfoBox appears.

3. In the Macros tab of the InfoBox, select the user action that starts the macro.
If you need to create a macro, see Creating new macros.

4. Select the macro to run.
5. Click the Basics tab.
6. Enter a label for the button in the "Button text" box.
7. Select display options and a shadow color for the button.
8. Click the Font tab.

9. Select properties for the button label.    
10. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_EDITING_MACROS_STEPS;H_SWITCHING_TO_ANOTHER_VIEW_WITH_A_MACRO_STEPS;H_
RUNNING_MACROS_FROM_BUTTONS_IN_A_MESSAGE_BOX_STEPS;H_SAMPLE_MACRO_PROCEDURE
S_CS;',0)} See related topics



Adding multiple objects to a view
Use the Tools palette to add fields and graphic objects to a view.

 Are you in Design?
1. Press CTRL+L. 

The Tools palette appears.
2. Double-click a tool in the Tools palette.

The mouse pointer changes to the selected tool.
3. Drag across the view to create the object.
4. Repeat step 3 until you're finished adding that type of object.
5. Click the selection tool.

{button ,AL(`H_ALIGNING_AND_DISTRIBUTING_OBJECTS_STEPS;H_BASIC_PROPERTIES_OF_OBJECTS_AN
D_FIELDS_CS;H_DRAWING_GEOMETRIC_OBJECTS_STEPS;H_GROUPING_AND_UNGROUPING_OBJECT
S_STEPS;H_NAMING_VIEWS_AND_OBJECTS_STEPS;',0)} See related topics



Details: Adding text blocks

Text blocks and text fields
• A text block is an object that holds text you type directly into a view, such as a name for the view or instructions 

for entering data. It is part of the design of the view, not part of a record or database.
• A text field is a field type that you define in a database. Text fields can only contain as many characters as you 

specify in Field Definition and are used to store text-based information such as names or addresses.

Margins and tabs in text blocks
When you work in a text block, the top ruler shows margins and tab stops. 

To Do this
Change margins Drag the margin arrow to a 

new position
Change a tab position on the 
ruler

Drag the tab arrow

Create a tab stop Click the ruler
Delete a tab stop Drag the arrow off the ruler

{button ,AL(`H_ADDING_TEXT_BLOCKS_STEPS',1)} Go to procedure
{button ,AL(`H_TYPES_OF_FIELDS_OVER;H_SHOWING_RULERS_STEPS',0)} See related topics



Adding text blocks
Text you enter using this procedure becomes part of the design of the view, not part of a database.
Troubleshooting If you want to make a block of text part of a record, create a field and define it as text or memo.

 Are you in Design?
1. Choose Create - Drawing - Text.
2. Drag to draw the text block.
3. Enter the text.
4. Click outside the text block when you're done to deselect the text block.

Adding text blocks with the Tools Palette
1. Choose View - Show Tools Palette.

2. Click the Text SmartIcon. 

The SmartIcon stays selected until you select a different one.
3. Drag to draw the text block.
4. Enter the text.
5. Click outside the text block when you're done to deselect the text block.
Note  You can always change the formatting for, move, and resize the text block.

{button ,AL(`H_ADDING_TEXT_BLOCKS_DETAILS',1)} See details
{button ,AL(`H_ENTERING_TEXT_IN_FORM_LETTERS_STEPS;H_SELECTING_TEXT_IN_A_TEXT_BLOCK_STE

PS;H_CHANGING_PROPERTIES_OF_TEXT_IN_TEXT_BLOCKS_AND_OBJECTS_STEPS;H_ADDING_TEXT_
TO_MAILING_LABELS_STEPS;H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS_TO_REPORTS_STEPS;',0
)} See related topics



Applying named styles
A named style applies a set of defined properties to the selected object.

 Are you in Design?
1. Select one or more objects.
2. Choose Named Style from the context menu.

• If the InfoBox is visible, focus changes to the Style tab.
• If the InfoBox is not visible, it is opened to the Style tab.

3. Select a style from the "Style name" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DELETING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;H_DEFINING_NE
W_NAMED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H_MANAGING_NAMED_STYLES_STEP
S;H_REDEFINING_NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_OVER;',0)} See related 
topics



Applying properties from another object (Fast Format)
Fast Format can apply properties only to objects in the same view.

 Are you in Design?
1. Select the object with the properties you want to copy.
2. Choose Fast Format on the context menu.

The mouse pointer changes shape:

3. Click the objects you want to apply the properties to.
Each object you click inherits the line, color, and text properties of the selected object.

4. Choose Fast Format again to turn it off.

{button ,AL(`H_CHANGING_PROPERTIES_OF_TEXT_IN_TEXT_BLOCKS_AND_OBJECTS_STEPS;H_CHANGIN
G_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_DEFINING_NEW_NAMED_STYLES_STEPS;',0)} 
See related topics



Creating an unbound field 
An unbound field is not attached to a database field, so you cannot use it to enter into a database.
You can use it to start a macro or script. For example, you could create an unbound check box with the label "I need 
to start over." When the user selects this check box, the attached macro would delete any data the user entered and 
then create a new record.

 Are you in Design?
1. Select the field box, check box, or radio button tool from the Tools Palette.
2. Add the field where you want it to appear in the view.

• If you create a field box, go to step 3.
• If you create a check box or radio button, define values and enter a label.

3. Click the Basics tab of the InfoBox.

4. Select <unbound field> in the "Field" box.

{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_ADDING_FIELDS_TO_A_VIEW_STEPS;H_ATTAC
HING_MACROS_STEPS;',0)} See related topics



Moving views

 Are you in Design?
1. Click the tab of the view you want to move.
2. Click the tab again.

The mouse pointer changes shape.
3. Drag the view to its new position.

{button ,AL(`H_HIDING_VIEWS_STEPS;H_NAMING_VIEWS_AND_OBJECTS_STEPS;',0)} See related topics



Changing the order of overlapping objects
Overlapping objects can be moved closer to the front or farther to the back to create an image and then grouped into 
a single object.

 Are you in Design?
1. Select the object.
2. Choose one of the following actions:

To place object Choose
First in stack (on top) Object - Arrange - Bring to 

Front

Last in stack (on bottom) Object - Arrange - Send to 
Back

One level up from current 
position

Object - Arrange - Bring 
Forward

One level back from current 
position

Object - Arrange - Send 
Backward

{button ,AL(`H_GROUPING_AND_UNGROUPING_OBJECTS_STEPS;H_ALIGNING_AND_DISTRIBUTING_OBJEC
TS_STEPS;',0)} See related topics



Copying named styles

 Are you in Design?
1. From the context menu, choose Named Style.

The InfoBox appears and displays the Style tab.

2. Click Manage Styles.
The Named Styles dialog box appears.

3. Select the named style you want to copy.
4. Click Copy.

The Define Style dialog box appears.
5. Enter the name of the new named style in the "Style name" box.
6. (Optional) To copy an existing style to the new named style, in the "Based on" box, select a style.

This causes future changes to the existing named style to also show up in the new style you create.    
7. To define the properties of the new named style, click the Font, Lines & Colors, Label, Picture, and Background 

tabs and set the options.
8. Click OK to close the Define Style dialog box.

The new named style appears in the list.
9. Click Done to close the Named Styles dialog box.
10. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_DEFINING_NEW_NAMED_STYLES_STEPS;H_DELETIN
G_NAMED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_O
VER;',0)} See related topics



Details: Cutting or copying objects or text
Cut and Copy commands

• Cut removes the selection from the view and puts it on the Clipboard. 
• Copy leaves the selection in place and puts a copy of it on the Clipboard.
• The Clipboard stores only one item at a time. When you cut or copy, you erase the current contents of the 

Clipboard.

Location of pasted objects
If you don’t specify a location, the object is pasted on top of the original object. You can then move the pasted object.
If you paste into another view, the object is pasted at the same location as in the original view.

Formatted text
When you cut or copy formatted text and then paste it into a text block or form letter, the text retains all its original 
formatting, such as bold and italics.

{button ,AL(`H_CUTTING_OR_COPYING_OBJECTS_OR_TEXT_STEPS',1)} Go to procedure
{button ,AL(`H_TEXT_ATTRIBUTES_FOR_LABELS_AND_DATA_CS;',0)} See related topics



Cutting or copying objects or text

 Are you in Design?
1. Select the object or text in a text block.
2. Choose Edit - Cut or Copy.

 

3. Click where you want to paste the selection.
When you paste text, you must click in a text object. Text is pasted at the insertion point.

4. Choose Edit - Paste.

Note  To cut or copy all the objects in a view, choose Edit - Select All before using Edit - Cut or Edit - Copy.

{button ,AL(`H_CUTTING_OR_COPYING_OBJECTS_OR_TEXT_DETAILS',1)} See details
{button ,AL(`H_SELECTING_OBJECTS_STEPS;H_SELECTING_TEXT_IN_A_TEXT_BLOCK_STEPS;H_COPYING

_SELECTIONS_TO_THE_CLIPBOARD_STEPS;H_INSERTING_LINKED_OBJECTS_FROM_THE_CLIPBOARD
_STEPS;H_MOVING_OBJECTS_TO_ANOTHER_PAGE_IN_FORMS_STEPS;',0)} See related topics



Defining a named style based on an existing object's properties
If you already have an object with properties you want to apply to other objects, use this procedure to save the 
properties as a named style.

 Are you in Design?
1. Double-click the object.

• If the InfoBox is visible, focus changes to the Style tab.
• If the InfoBox is not visible, it is opened to the Style tab.

2. Click Create Style.
The Create Named Style dialog box appears.

3. Enter the name of the named style in the "Style name" box.
4. (Optional) Enter a description for the style in the "Description" box.
5. Click OK to close the Create Named Style dialog box.

The new named style appears in the list. The new style has all the properties set in the InfoBox for the selected 
object.

6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_REDEFINING_NAMED_STYLES_STEPS;H_MANAGING_
NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_OVER;H_DEFINING_NEW_NAMED_STYLE
S_STEPS;',0)} See related topics



Defining new named styles

 Are you in Design?
1. From the context menu, choose Named Style.

The InfoBox appears and displays the Style tab.

2. Click Manage Styles.
The Named Styles dialog box appears.

3. Click New.
The Define Style dialog box appears.

4. Enter the name of the new named style in the "Style name" box.
5. (Optional) To base the new named style on an existing one in the "Based on" box,

select a style.
This causes future changes to the existing named style to also show up in the new style you create. 

6. To define attributes and properties of the named style, click the Font, Lines & Colors, Label, Picture, and 
Background tabs and set the options.

7. Click OK to close the Define Style dialog box.
The new named style appears in the list.

8. Click Done to close the Named Styles dialog box.
9. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;H_DELETING_NA
MED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_OVER;
H_DEFINING_A_NAMED_STYLE_BASED_ON_AN_OBJECTS_PROPERTIES_STEPS;H_LINE_AND_COLOR_
PROPERTIES_CS;H_TEXT_ATTRIBUTES_FOR_LABELS_AND_DATA_CS;H_DRAWING_IN_PICTUREPLUS_F
IELDS_STEPS;',0)} See related topics



Deleting elements of a view
Approach lets you permanently delete anything from a view. If you delete a field, the field is deleted only from the 
current view, not from the database or from other views.

 Are you in Design?
1. Select the element.
2. Choose Edit - Clear.
Note  You can undo the deletion of any element you delete.

{button ,AL(`H_DELETING_VIEWS_STEPS;H_DUPLICATING_VIEWS_STEPS;H_DELETING_FIELDS_FROM_A_D
ATABASE_STEPS;H_MOVING_OR_DELETING_FORM_LETTER_FIELDS_STEPS;H_SELECTING_REMOVING
_AND_DELETING_REPORT_PANELS_STEPS;',0)} See related topics



Deleting named styles

 Are you in Design?
1. Choose Named Style from the context menu.

• If the InfoBox is visible, focus changes to the Style tab.
• If the InfoBox is not visible, it is opened to the Style tab.

2. Click Manage Styles.
The Named Styles dialog box appears.

3. Select the named style you want to delete.
You can delete only styles that you created.

4. Click Delete.
5. Click OK in the message box.

Deleting a named style does not affect the properties of existing objects that use the style.
6. Click Done to close the Named Styles dialog box.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;H_DEFINING_NEW
_NAMED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_OV
ER;',0)} See related topics



Deleting views

 Are you in Design?
1. Change to the view you want to delete.
2. Choose Delete from the context menu. 

The name of the command changes depending on the current view. If, for example, you are in a worksheet, the 
command is Worksheet - Delete Worksheet.

3. Click Yes in the message box to delete the view.

{button ,AL(`H_DUPLICATING_VIEWS_STEPS;H_HIDING_VIEWS_STEPS;',0)} See related topics



Drawing geometric objects

 Are you in Design?
1. Choose Create - Drawing and then the object: Line, Ellipse, Rectangle, or Rounded Rectangle.

You can also show the Tools palette and click the icon for any of these geometric objects.

Object Tools palette icon
Line

Ellipse

Rectangle

Rounded Rectangle

2. Drag to draw the object.

To draw Press SHIFT and use
Circle Ellipse
Square Rectangle
Rounded square Rounded rectangle
Straight line at 0,
45, or 90 
degrees

Line

{button ,AL(`H_ADDING_MULTIPLE_OBJECTS_TO_A_VIEW_STEPS;H_BASIC_PROPERTIES_OF_OBJECTS_AN
D_FIELDS_CS;H_SHOWING_THE_TOOLS_PALETTE_STEPS;H_ALIGNING_AND_DISTRIBUTING_OBJECTS
_STEPS;H_DRAWING_IN_PICTUREPLUS_FIELDS_STEPS;',0)} See related topics



Duplicating views

 Are you in Design?
1. Change to the view you want to duplicate.
2. Choose Duplicate from the context menu.

The name of the command changes depending on the current view. If, for example, you are in a form, the 
command is Form - Duplicate Form.

{button ,AL(`H_DELETING_VIEWS_STEPS;H_CREATING_APPROACH_OLE_OBJECTS_IN_APPROACH_STEPS;
',0)} See related topics



Editing named styles

 Are you in Design?
1. Choose Named Style from the context menu.

• If the InfoBox is visible, focus changes to the Style tab.
• If the InfoBox is not visible, it is opened to the Style tab.

2. Click Manage Styles.
The Named Styles dialog box appears.

3. Select the named style you want to edit.
You can edit the default style as well as styles that you created.

4. Click Edit.
The Define Style box dialog appears.

5. To define the properties of the new named style, click the Font, Lines & Colors, Label, Picture, and Background 
tabs and set the options.

6. Click OK to close the Define Style dialog box.
7. Click Done to close the Named Styles dialog box.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;H_DEFINING_NEW
_NAMED_STYLES_STEPS;H_DELETING_NAMED_STYLES_STEPS;H_WORKING_WITH_NAMED_STYLES_
OVER;',0)} See related topics



Grouping and ungrouping objects
When you group objects, you can treat them as a single object. One set of handles appears around the entire group. 
You can change any of the properties available in the InfoBox for all the grouped objects, at the same time. 

 Are you in Design?

Grouping objects
1. Select the objects by dragging a selection rectangle around them, or SHIFT+click each object you want to group.
2. Choose Object - Group.

Ungrouping objects
1. Select the grouped objects.
2. Choose Object - Ungroup.

{button ,AL(`H_CHANGING_THE_ORDER_OF_OVERLAPPING_OBJECTS_STEPS;H_SELECTING_OBJECTS_ST
EPS;H_ALIGNING_AND_DISTRIBUTING_OBJECTS_STEPS;',0)} See related topics



Inserting dates or times
• Dates and times you enter using these procedures become part of the design of the view, not part of a database.
• Approach updates the date or time whenever you open, preview, or print the Approach file.

Troubleshooting If you want to make a date or time part of a record, create a field and define it as date or time.

 Are you in Design?

Inserting    the date
Choose Insert - Today's Date on the context menu.

Inserting the time
Choose Insert - Current Time on the context menu.

Moving the date or time
Drag the date or time to move it where you want it to appear on the view.

{button ,AL(`H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS_TO_REPORTS_STEPS;H_CHANGING_THE_DA
TE_FORMAT_ON_FORM_LETTERS_STEPS;',0)} See related topics



Managing named styles

 Are you in Design?
1. Choose Named Style from the context menu.

• If the InfoBox is visible, focus changes to the Style tab.
• If the InfoBox is not visible, it is opened to the Style tab.

2. Click Manage Styles.
The Named Style dialog box appears.

3. Create a new style, or select a style then edit, delete, or copy the style.
4. Click Done to close the Named Style dialog box.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_WORKING_WITH_NAMED_STYLES_OVER;H_DEFINING_NEW_NAMED_STYLES_STEPS;H_RE
DEFINING_NAMED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H_APPLYING_NAMED_STYLES
_STEPS;H_DELETING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;',0)} See related 
topics



Named styles

Choose a task
Defining a named style based on an existing object's properties 
Redefining named styles 
Managing named styles 



Named Styles dialog box
Define the properties of a named style by either creating a new style or basing it on an existing one. You can edit the 
definition of a named style, copy it, delete it, or apply it to one or more objects. 

Choose a task
Working with named styles
Defining new named styles
Copying named styles
Editing named styles
Deleting named styles



Pasting pictures in views
Pictures you paste using these procedures become part of the design of the view, not part of a database.
Troubleshooting To make a picture part of a record, so it shows only when you show that record, define a 
PicturePlus field and then add it to a view.

 Are you in Design?

Pasting pictures from a file
1. Click where you want to position the top left corner of the picture. 

If you don't click anywhere, the picture is pasted in the top left corner of the view.
2. Choose Edit - Picture - Import.
3. Specify the file you want to paste.
4. Click OK.

Pasting pictures from the Clipboard
1. Select the picture in the picture's source application.
2. Choose Edit - Copy.
3. In Approach, click where you want to position the top left corner of the picture. 

If you don't click anywhere, the picture is pasted in the top left corner of the view.
4. Choose Edit - Paste.

{button ,AL(`H_ADDING_PICTUREPLUS_FIELDS_TO_A_VIEW_STEPS;H_FILE_EXTENSIONS_IN_APPROACH_
REF;H_INSERTING_LINKED_OBJECTS_FROM_THE_CLIPBOARD_STEPS;H_PASTING_PICTURES_IN_FIEL
DS_STEPS;',0)} See related topics



Redefining named styles

 Are you in Design?
1. Double-click an object that has the named style you want to change.

2. Redefine properties and add new ones, using the options in the InfoBox.
The object changes as you redefine the properties.

3. Click the Named Style tab in the InfoBox.

4. Click Redefine Style.
The Redefine Style dialog box appears.

5. (Optional) Change the description for the style in the "Description" box.
6. Click OK to close the Redefine Style dialog box.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_WORKING_WITH_NAMED_STYLES_OVER;H_DEFINING_NEW_NAMED_STYLES_IN_THE_INFO
BOX_STEPS;H_MANAGING_NAMED_STYLES_STEPS;',0)} See related topics



Selecting objects
A selected object has handles around it.

 Are you in Design?

Selecting an object
Click the object or its border.

Selecting more than one object
Do one of the following:

• Drag a selection rectangle around the objects.
• SHIFT+click each object.

Selecting all the objects in a view
Choose Edit - Select All.

To deselect an object from several selected objects
SHIFT+click the object.

Canceling a selection
Click another part of the view.

{button ,AL(`H_CUTTING_OR_COPYING_OBJECTS_OR_TEXT_STEPS;H_GROUPING_AND_UNGROUPING_OB
JECTS_STEPS;H_MOVING_OBJECTS_STEPS;H_SELECTING_FIELDS_STEPS;',0)} See related topics



Selecting text in text blocks
A range of text is highlighted when it is selected.

 Are you in Design?

Selecting a text block
Click the text block.
If you select the entire text block, any changes you make apply to all text in the block.

Showing the insertion point in text
1. Select the text block.
2. Click inside the text block.

A blinking insertion point appears where you click.

To select Do this
A range of text Drag across the text

or
SHIFT+click

One word Double-click it

Canceling a selection
Click another part of the view.

{button ,AL(`H_CHANGING_TEXT_ATTRIBUTES_OF_LABELS_OR_DATA_STEPS;H_SELECTING_WITHIN_FIEL
DS_REF;',0)} See related topics



Showing data 
In the Design environment, Approach has two ways to display fields. By toggling the View - Show Data command, 
you can see fields in either of the following ways:

• Displaying data from records 
• Displaying field names, or in some cases, displaying only the structure of the view 

 Are you in Design?

Showing data 
Choose View - Show Data.

A check mark appears next to the menu item, to show that you turned on Show Data.
Note  Be sure to turn on Show Data when you are looking at a crosstab or chart. Otherwise, you cannot see the data
in the crosstab or the components of the chart.

Showing field names
Choose View - Show Data.
The check mark disappears.
Note  If the Approach file has joined databases, the database names appear along with the field names. For 
example, EMPLOYEE.Address indicates the Address field in the EMPLOYEE database.

{button ,AL(`H_JOINING_DATABASE_FILES_STEPS;H_ZOOMING_IN_AND_OUT_STEPS;',0)} See related topics



Details: Showing rulers
Rulers show the position of an object. As you move the pointer in the work area, lines in the rulers identify the 
pointer's position. If you move or resize an object, the lines show the size of the object. 
1 inch or 1 centimeter on a ruler is equal to 1 inch or 1 centimeter on a printed page.
To change the measurement unit for the grid, choose File - User Setup - Approach Preferences and click the Display 
tab. In the Units box, select Inches or Centimeters. 

{button ,AL(`H_SHOWING_RULERS_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SNAPPING_OBJECTS_

TO_THE_GRID_STEPS;',0)} See related topics



Showing rulers
The measurement unit you select for the grid determines the units for the rulers.

 Are you in Design?

Showing rulers
Choose View - Show Rulers.

Hiding rulers
Choose View - Show Rulers.

{button ,AL(`H_SHOWING_RULERS_DETAILS',1)} See details
{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SNAPPING_OBJECTS_

TO_THE_GRID_STEPS;',0)} See related topics



Showing the grid to help you design views
• The grid works like graph paper. It helps you see the alignment of objects in a view.
• The grid appears onscreen as dotted lines. It does not print. 

 Are you in Design?

Showing the grid
Choose View - Show Grid.

Tip Show the grid. It's an easy way to tell you're in Design.

Hiding the grid
Choose View - Show Grid.

{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SNAPPING_OBJECTS_
TO_THE_GRID_STEPS;',0)} See related topics



Showing the Internet Tools palette
Show a floating Tools palette with SmartIcons for opening, saving, and publishing files to the Internet, and for 
accessing the SmartSuite reference library. 

Showing the palette
Choose View - Show Internet Tools. 

Hiding the palette
Choose View - Show Internet Tools.



Showing the Tools palette
Show a floating Tools palette with SmartIcons for drawing objects, creating controls, adding fields, and creating data-
entry types for fields. 

 Are you in Design?

Showing the palette
Choose View - Show Tools Palette. 

Hiding the palette
Choose View - Show Tools Palette.

{button ,AL(`H_ADDING_MULTIPLE_OBJECTS_TO_A_VIEW_STEPS;H_DRAWING_GEOMETRIC_OBJECTS_STE
PS;',0)} See related topics



Snapping objects to the grid
• Force objects to line up along the grid when you draw, move, or resize them.
• Snapping works even when you hide the grid.

 Are you in Design?

Snapping objects to the grid
Choose View - Snap to Grid. 

Turning off snapping
Choose View - Snap to Grid.

{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;H_SHOWING_THE_GRID_
TO_HELP_YOU_DESIGN_VIEWS_STEPS;',0)} See related topics



Overview: Working with named styles
A named style is a set of object properties that you define and save. It lets you apply consistent formatting to objects 
in an Approach file, instead of applying one property at a time. 
You can apply a named style to any object.
Note If you usually use Fast Format, but want to use the style information in many views, create a named style.
A named style can include such properties as

• Text attributes for field data and labels
• Borders, shadows, and fill color
• Line and color settings for all objects
• Picture settings for PicturePlus fields
• Width and color settings for drawn objects

The properties in a named style are the same as they are in the InfoBox, but by saving properties in a style you can 
easily apply them to more than one object. If you change any properties of a named style, all objects that use the 
style are updated to match the changes automatically.
If you apply a named style to an object, and then change one or more properties of that object, future changes to the 
named style do not update the object.
You can create a new style from scratch or base it on an existing style. Copy most of the properties from an existing 
style, change some of those properties, and create a separate style that has its own properties. 
You can also create a new style based on the properties of an object. If you have an object that contains all the 
properties you want to apply to other objects, select the object then create a new named style.
You can also update an existing style by redefining it. All objects formatted with this style inherit the new properties.

{button ,AL(`H_APPLYING_NAMED_STYLES_STEPS;H_COPYING_NAMED_STYLES_STEPS;H_DEFINING_NEW
_NAMED_STYLES_STEPS;H_DELETING_NAMED_STYLES_STEPS;H_EDITING_NAMED_STYLES_STEPS;H
_SETTING_DISPLAY_PREFERENCES_FOR_THE_APPROACH_WINDOW_REF',0)} See related topics



Zooming in and out
Zoom in for a closer look. Zoom out to see the entire view reduced in size.

 Are you in Design?

Changing the zoom setting
1. Choose View - Zoom To.
2. Select a percentage from the available steps: 25, 50, 75, 85, 100, 200.

Zooming in by steps
Choose View - Zoom In. 

Zooming out by steps
Choose View - Zoom Out.

Returning to 100%
Choose View - Zoom To 100%.
Note  You can only zoom in Design or Print Preview.



Adding new records

 Show me a QuickDemo 

 Are you in Browse?
1. Click New Record in the action bar.

2. Enter data in fields.
3. Press ENTER to save the record.

CTRL+N saves the current record and displays a new record.
Approach saves the record to the database immediately. Choosing File - Save is not necessary.

Backing out of an unfinished record
Press ESC to back out of an unsaved record so that Approach does not enter the data in the database.

{button ,AL(`H_DELETING_SPECIFIC_RECORDS_STEPS;H_MOVING_BETWEEN_FIELDS_USING_ENTER_STE
PS;H_ADDING_FIELDS_TO_A_VIEW_STEPS;H_DUPLICATING_RECORDS_STEPS',0)} See related topics



Changing pen properties for drawing in fields

 Are you in Browse?
1. Select the PicturePlus field.

The mouse pointer changes shape:

2. Choose PicturePlus - PicturePlus Properties.
3. Modify the pen width and pen color.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DRAWING_IN_PICTUREPLUS_FIELDS_STEPS;H_ADDING_PICTUREPLUS_FIELDS_TO_A_VIEW
_STEPS;',0)} See related topics



Deleting data from many records at once
Caution You cannot undo deleting data from many records.

 Are you in Browse?
1. Create a found set  of all the records with data you want to delete. 
2. Select the field you want to clear. 

In a worksheet, select the column by clicking its header.
3. Choose Fill Field on the context menu.
4. Under To the following, delete any data so the text box is empty.
5. Click OK.
6. Click Yes in the message box.



Deleting pictures from records

 Are you in Browse?
1. Select the PicturePlus field.
2. Do one of the following:

• To delete the picture permanently, choose Edit - Clear.
• To delete the picture so you can use it in another record, choose Edit - Cut.



Fill Field dialog box
Choose a task

Deleting data from many records at once 
Entering the same data into many records 



Changing to another language in the main dictionary
1. Choose Edit - Check Spelling.

2. Click Language Options.
3. Select the language you want in the "Language" box.
4. Click OK to return to the Spell Check dialog box.
5. Click OK.

{button ,AL(`H_RUNNING_THE_SPELLING_CHECKER_STEPS;H_SETTING_OPTIONS_FOR_CHECKING_SPELL
ING_STEPS;',0)} See related topics



Spell Check dialog box
Choose a task

Checking spelling 
Setting options for checking spelling 
Editing the user dictionary 
Changing to another language in the main dictionary 



Deleting all records
Caution You cannot undo deleting all records.
Make a backup of your database before deleting all records.

 Are you in Browse?

In forms, form letters, and envelopes
1. Press CTRL+F.

2. Type an asterisk (*) in any field in the find request.
3. Click OK.

Approach finds all records.
4. Choose Delete - Found Set on the context menu.

5. Click Yes in the confirmation message box.
The Approach file and an empty database remain.

In other views
1. Choose Edit - Select All.
2. Press DELETE.

3. Click Yes in the confirmation message box.
The Approach file and an empty database remain.

{button ,AL(`H_DELETING_A_FOUND_SET_OF_RECORDS_STEPS;H_DELETING_SPECIFIC_RECORDS_STEP
S;H_EXPORTING_DATA_FROM_APPROACH_STEPS;H_APP_DELETING_DATA_FROM_MANY_RECORDS_A
T_ONCE_STEPS;H_DELETING_FILES_STEPS;',0)} See related topics



Deleting a found set of records
Caution  You cannot undo deleting a found set of records.

 Are you in Browse?

In forms, form letters, and envelopes
1. Find the records you want to delete.
2. Choose Browse - Delete Found Set.
3. Click Yes in the confirmation message box.

In other views
1. Find the records you want to delete.
2. Choose Delete - Found Set on the context menu.
3. Click Yes in the confirmation message box.

Approach displays the remaining records in the file.

{button ,AL(`H_finding_records_with_the_find_assistant_over;H_CREATING_FIND_REQUESTS_STEPS;H_DELETI
NG_ALL_RECORDS_STEPS;H_DELETING_SPECIFIC_RECORDS_STEPS;H_FINDING_DUPLICATE_RECOR
DS_WITH_THE_FIND_ASSISTANT_STEPS;H_HIDING_RECORDS_STEPS;H_THE_FOUND_SET_OVER;H_A
PP_DELETING_DATA_FROM_MANY_RECORDS_AT_ONCE_STEPS;',0)} See related topics



Deleting specific records
Caution  You cannot undo deleting a record.

 Are you in Browse?

In forms, form letters, and envelopes
1. Show the record.
2. Press CTRL+DELETE.

3. Click Yes in the confirmation message box.

In other views
1. Select the record or records.
2. Press DELETE.

3. Click Yes in the confirmation message box.

{button ,AL(`H_FINDING_RECORDS_WITH_THE_FIND_ASSISTANT_OVER;H_DELETING_A_FOUND_SET_OF_
RECORDS_STEPS;H_DELETING_ALL_RECORDS_STEPS;H_FINDING_DUPLICATE_RECORDS_WITH_THE_
FIND_ASSISTANT_STEPS;H_HIDING_RECORDS_STEPS;H_APP_DELETING_DATA_FROM_MANY_RECORD
S_AT_ONCE_STEPS',0)} See related topics



Drawing in PicturePlus fields
Draw on a picture to highlight or enhance it.

Allowing drawing
1. In Design, double-click the PicturePlus field.
2. Click the Basics tab in the InfoBox.

3. Select Allow drawing.
4. (Optional) Move, collapse, or close the InfoBox.
5. Switch to Browse to begin drawing in the field.

Drawing in the field
Note You cannot undo what you draw.
1. In Browse, select the PicturePlus field.

The mouse pointer changes shape:

2. Modify the field.

{button ,AL(`H_PASTING_PICTURES_IN_FIELDS_STEPS;H_PASTING_PICTURES_IN_VIEWS_STEPS;H_APP_C
HANGING_PEN_PROPERTIES_FOR_DRAWING_IN_FIELDS_STEPS;H_APP_DELETING_PICTURES_FROM_
RECORDS_STEPS;',0)} See related topics



Duplicating records
Duplicate a record when it contains much of the same data you want to appear in other records. Then just change 
data in fields that differ.

 Are you in Browse?

In forms, form letters, and envelopes
1. Show the record.
2. Choose Browse - Duplicate Record.

In other views
1. Select a record or records.
2. Choose Records - Duplicate on the context menu.

{button ,AL(`H_ADDING_NEW_RECORDS_STEPS;H_DELETING_SPECIFIC_RECORDS_STEPS;H_DUPLICATIN
G_VALUES_FROM_THE_LAST_RECORD_MODIFIED_STEPS;',0)} See related topics



Duplicating a value from the last record modified
Duplicating a value is useful when you are entering new records that need the same value in the same field over and 
over again.
For example, you have 40 customers in France. You can enter their address records, and Approach can automatically
add the value of France to the Country field.
The previous record must have been modified in the current Approach session.
If you're trying to

• Add the same value to many records that already exist, use Fill Field.
• Duplicate an entire record, use Duplicate Record.

 Are you in Browse?
1. If necessary, choose New Record on the action bar.

2. Enter data in all fields except the one that is the same as the last field modified in the last record.
3. Select the same field as the last field modified in the last record.
4. From the context menu, choose Insert, and then choose Previous Value.

Approach inserts the value and then advances to a new blank record.



Editing the user dictionary
1. Choose Edit - Check Spelling.

2. Click Edit Dictionary.

Adding a word to the dictionary
1. Enter the word in the "New word" box.
2. Click Add.
3. Click OK.

Deleting a word from the dictionary
1. Select the word in the "Current words" box.
2. Click Delete.
3. Click OK.

{button ,AL(`H_RUNNING_THE_SPELLING_CHECKER_STEPS;H_SETTING_OPTIONS_FOR_CHECKING_SPELL
ING_STEPS;H_CHANGING_TO_ANOTHER_MAIN_DICTIONARY_STEPS',0)} See related topics



Details: Entering dates in date fields
Number of digits in a year
Enter one, two, three, or four digits for the year. If you don't type a year, Approach enters the current year (based on 
your system settings).

The year 2000 and beyond
If you enter a one-digit or two-digit year, Approach assumes 00 to 29 indicates the years 2000 to 2029 and assumes 
30 to 99 indicates the years 1939 to 1999.    You can override these assumptions by entering four-digit years. To 
enable users to enter four-digit years, you must uncheck "Show date entry format" on the Format tab of the InfoBox.

Approach will correctly perform calculations where dates cross the millenium. For example, if you create a invoice on 
December 6th, 1999 which is due in 30 days, Approach will calculate the due date as January 5th, 2000.

Date formats
Regardless of the date format, enter the date in the following way:
MM/DD/YY
For example, for July 12, 1983, enter
07/12/83
The date changes to the format when you move out of the field.
If "Show data entry format" is on, slashes appear in the field as separators and underlines show the maximum 
number of characters. Press SPACEBAR to enter the current month, day, or year.
Set "Show data entry format" in the InfoBox Format tab.

Use SPACEBAR or slash (/) to advance to the next position in the date field if you only enter one digit. For example, to 
enter July 9, 1983, type 7 SPACEBAR 9 SPACEBAR 83.

International formats
Your system may expect a different order for entering dates (such as "day, month, year” or “month, day, year”). Enter 
the date numbers in the order specified in the operating system settings for date order.

{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_STEPS',1)} Go to procedure
{button ,AL(`H_FORMATTING_DATES_DETAILS;H_ENTERING_TIMES_IN_TIME_FIELDS_DETAILS;H_INSERTIN

G_DATES_OR_TIMES_STEPS;H_TYPES_OF_FIELDS_OVER;',0)} See related topics



Entering dates in date fields

 Are you in Browse?

Entering dates
Enter the month, day, and year as numbers separated by spaces or slashes (/).
For example, type 6 15 96 to enter 06/15/96.

Entering today's date
Press SPACEBAR.

For example, on June 15, 1996, press SPACEBAR three times to enter 06/15/96.

Entering a day of the current month and year
Enter a number in the day section. 
For example, in June 1996 you can type 15 to enter 06/15/96.

{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_DETAILS',1)} See details
{button ,AL(`H_ENTERING_TIMES_IN_TIME_FIELDS_STEPS;H_INSERTING_DATES_OR_TIMES_STEPS;H_TYP

ES_OF_FIELDS_OVER;H_FORMATTING_DATES_STEPS;H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS
_TO_REPORTS_STEPS;H_FORMATTING_DATES_AS_QUARTERS_THIRDS_AND_SO_ON_STEPS;',0)} See 
related topics



Details: Entering text in text or memo fields
Field lengths
Determine the length of a text field when you define the field. The maximum is 256 characters, but it varies slightly 
depending on the database file type you use.
The amount of text allowed in a memo field is much more than in a text field. The length of a memo field is limited 
only by the database format.

Using a PicturePlus field to store large documents
If you have a large document that you created in a word processor, and you want to make that document part of a 
record, you can embed or link    the document in a PicturePlus field, so long as the word processor supports OLE as a
server. See Creating linked objects from files.

Entering dates and times in a text field
You can enter today's date or the current time in a text or memo field. 

To insert Press or click
Today's date CTRL+SHIFT+D

Current time CTRL+SHIFT+T

To sort a database chronologically, use a date, time, or numeric field type.

{button ,AL(`H_ENTERING_TEXT_IN_TEXT_OR_MEMO_FIELDS_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_FIELDS_TO_A_DATABASE_STEPS;H_SETTING_A_FORMAT_FOR_DATA_IN_TEXT_FIE

LDS_STEPS;',0)} See related topics



Entering text in text or memo fields

 Are you in Browse?
1. Select the field.
2. Type letters, numbers, or symbols in the field.
3. Press TAB to enter the contents.

{button ,AL(`H_ENTERING_TEXT_IN_TEXT_OR_MEMO_FIELDS_DETAILS',1)} See details
{button ,AL(`H_MOVING_BETWEEN_FIELDS_USING_ENTER_STEPS;H_TYPES_OF_FIELDS_OVER;H_ENTERI

NG_DATA_AUTOMATICALLY_STEPS;H_SELECTING_WITHIN_FIELDS_REF;H_ADDING_TEXT_BLOCKS_ST
EPS;',0)} See related topics



Entering the same data into many records
Caution You cannot undo entering the same data into many records.

 Are you in Browse?
1. Find the records you want to fill. 
2. Select the field you want to fill. 

In a worksheet, select the column.
3. Choose Fill Field on the context menu.
4. If necessary, enter or edit the fill value.

The fill value can be a formula.
5. Click OK.
All records in the found set now contain this field data.

{button ,AL(`H_USING_FUNCTIONS_AND_FORMULAS_OVER;H_creating_find_requests_steps;H_finding_records
_with_the_find_assistant_over;H_ENTERING_DATA_AUTOMATICALLY_STEPS;',0)} See related topics



Details: Entering times in time fields
12-hour or 24-hour clock
24-hour times are indicated by default with an "h" suffix. For 12-hour times, if you enter an hour less than 12 without a
suffix of AM or PM, Approach assumes AM.

Time formats
The time is formated when you move out of the field.
If "Show data entry format" is on, colons appear in the field as separators, and underlines show the maximum number
of characters. Set "Show data entry format" in the InfoBox Format tab.

Use SPACEBAR or colon (:) to advance to the next position in the time field if you only enter one digit. For example, to 
enter 5:05 PM, type 5 SPACEBAR 5 SPACEBAR PM.

International formats
Your system may expect a different time separator than the colon for entering times. Use whatever separator is 
specified in the operating system settings for time.

{button ,AL(`H_ENTERING_TIMES_IN_TIME_FIELDS_STEPS',1)} Go to procedure



Entering times in time fields

 Are you in Browse?

Entering a time in a time field
Enter the time as one of the following:

• Hours and minutes separated by a colon (HH:MM)
• Hours, minutes, and seconds separated by colons (HH:MM:SS)
• Hours, minutes, seconds, and hundredths of a second separated by colons and a decimal (HH:MM:SS.00)

Entering the current time
Press SPACEBAR.

For example, at 8:01 you can press SPACEBAR twice to enter 8:01, if you are using the (HH:MM) format.

Entering only an hour
Enter a number. 
For example, type 8 to enter 8:00.

{button ,AL(`H_ENTERING_TIMES_IN_TIME_FIELDS_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATES_IN_DATE_FIELDS_STEPS;H_INSERTING_DATES_OR_TIMES_STEPS;H_TY

PES_OF_FIELDS_OVER;H_ADDING_DATES_TIMES_OR_PAGE_NUMBERS_TO_REPORTS_STEPS;H_FOR
MATTING_TIMES_STEPS;',0)} See related topics



Entering values in Boolean fields

 Are you in Browse?
1. Select the field.
2. Enter one of the following:

If the answer is Yes If the answer is No
Yes, yes No, no
Y, y N, n
1 0 



Details: Entering values in numeric fields
Numbers only
Numeric fields won't accept text or symbols.

Numeric format
The data is formatted when you move out of the field. Type a decimal point if the data needs one, but don't type other 
characters such as currency symbols and commas; the format provides them.
For example, to enter a value in a numeric field formatted for telephone numbers, type:
8003011010
The formatted result appears in the field:
(800) 301-1010
If "Show data entry format" is selected, the fixed characters of the format appear in the field, and underlines show the 
maximum number of characters. 
Set "Show data entry format" in the InfoBox Format tab.

{button ,AL(`H_ENTERING_VALUES_IN_NUMERIC_FIELDS_STEPS',1)} Go to procedure



Entering values in numeric fields

 Are you in Browse?
1. Select the field.
2. Enter numbers, including decimal points if necessary.

{button ,AL(`H_ENTERING_VALUES_IN_NUMERIC_FIELDS_DETAILS',1)} See details
{button ,AL(`H_TYPES_OF_FIELDS_OVER;H_FORMATTING_NUMBERS_STEPS;',0)} See related topics



Finding text

 Are you in Browse?
1. Choose Edit - Find & Replace Text.
2. Specify the text you're looking for in the "Find" box.
3. Under Search, select the scope of the search.
4. (Optional) Select search options.
5. Click Find Next.

{button ,AL(`H_REPLACING_TEXT_STEPS;H_FIND_AND_REPLACE_DIALOG_BOX_OPTIONS_REF;',0)} See 
related topics



Find & Replace Text dialog box options

Search
Select this To search
Selection The value in the selected field
Current record The values in all the fields of 

the current record
Found set The found set
Selection across found set All values in the selected field, 

in all records of the found set
Entire worksheet All values in the worksheet

Case sensitive
Search only for text with exactly the same use of uppercase and lowercase letters that you specify in the "Find" box.
For example, to replace Mr. MCCabe with Mr. McCabe, type Mr. McCabe and select "Case sensitive."
If "Case sensitive" is not selected, Approach ignores the case of the text.

Match whole field
Search only for the whole word of the specified text. This skips words which are made up, in part, by the text you are 
looking for.
For example, to find the word "fun," select this option. Approach then skips words like "function" and "fundamental."

Memo fields only
Search only in memo fields.



Find & Replace Text dialog box
Choose a task

Finding text 
Replacing text 



Hiding records
A hidden record is not included in sorts or calculations, and you cannot print it or delete it.

 Are you in Browse?

Hiding a record in forms, form letters, and envelopes
1. Show the record.
2. Choose Browse - Hide Record.

Hiding a record in other views
1. Select a record or records.
2. Choose Records - Hide on the context menu.

{button ,AL(`H_DELETING_SPECIFIC_RECORDS_STEPS;H_SHOWING_HIDDEN_RECORDS_STEPS;H_HIDING
_VIEWS_STEPS;H_SHOWING_ALL_RECORDS_STEPS;',0)} See related topics



Moving through records one record at a time

 Are you in Browse?

Moving forward in forms, form letters, and envelopes
Press PG DN.

Moving backward in forms, form letters, and envelopes
Press PG UP.

Moving in worksheets and crosstabs
Each row in a worksheet is a record.
Press

•  or ¯, to move between records
• ® or ¬, to move between fields

{button ,AL(`H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_BETWEEN_FIELDS_USING_ENTER_STEPS;H_
MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MOVING_TO_A_SPECIFIC_RECORD_STEPS;H_M
OVING_TO_THE_FIRST_OR_LAST_RECORD_STEPS',0)} See related topics



Moving to a specific record
You can move to a specific record if you know its position in the current order of records. Remember, the order 
changes depending on how you sort the records. 

 Are you in Browse?
1. Click the Record button in the status bar.

2. Enter the number of the record to move to.
3. Click OK.
Tip If you don't know the record number, instead of following this procedure you can create a find request  and enter 
find conditions that are specific to the record.

{button ,AL(`H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_BETWEEN_FIELDS_USING_ENTER_STEPS;H_
MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MOVING_ONE_RECORD_AT_A_TIME_STEPS;H_
MOVING_TO_THE_FIRST_OR_LAST_RECORD_STEPS;',0)} See related topics



Moving to the first or last record

 Are you in Browse?

Moving to the first record
Press CTRL+HOME.

Moving to the last record
Press CTRL+END.

 

{button ,AL(`H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_BETWEEN_FIELDS_USING_ENTER_STEPS;H_
MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MOVING_TO_A_SPECIFIC_RECORD_STEPS;H_M
OVING_ONE_RECORD_AT_A_TIME_STEPS',0)} See related topics



Pasting pictures in fields
A picture you paste using these procedures becomes part of the record .
If you're trying to make a picture part of the design of the view, see Pasting pictures in views.

 Are you in Browse?

Pasting a picture from a file
1. Select the PicturePlus field.
2. Choose Edit - Picture - Import
3. If necessary, change the type of file.
4. Select the graphic file.
5. Click Import.

Pasting a picture from the Clipboard
1. In the picture's source application, select the picture and choose Edit - Copy.
2. In Approach, select the PicturePlus field and choose Edit - Paste.

Paste Special
If a picture is stored on the Clipboard in more than one format, the Paste Special command is available in the Edit 
menu. Choose Paste Special rather than Paste to select the format you want for the pasted picture. 

{button ,AL(`H_SETTING_OLE_OPTIONS_FOR_PICTUREPLUS_FIELDS_STEPS;H_DRAWING_IN_PICTUREPLU
S_FIELDS_STEPS;H_PASTING_PICTURES_IN_VIEWS_STEPS;H_TYPES_OF_FIELDS_OVER;H_APP_DELE
TING_PICTURES_FROM_RECORDS_STEPS;H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS;',0)} See 
related topics



Replacing text

 Are you in Browse?
1. Choose Edit - Find & Replace Text
2. Specify the text you want to replace in the "Find" box.
3. Specify the new text in the "Replace with" box.
4. Under Search, specify the scope of the search.
5. (Optional) Select search options.
6. Do one of the following:

• To replace each instance of found text individually, click Find Next. Click Replace if you want to substitute the 
new text.

• To replace all instances of found text at once, click Replace All.

{button ,AL(`H_FINDING_TEXT_STEPS;H_FIND_AND_REPLACE_DIALOG_BOX_OPTIONS_REF;',0)} See related 
topics



Details: Checking spelling
Selecting the scope
In Browse, you can select any text in a record. In Design, you cannot check the spelling of labels; you can check the 
spelling only of text selected in a text block. 

Option Checks spelling for
Selection The currently selected text
Current record All fields of the current record

Current view Text in all text objects in the 
current view

Found set All text in all records in the 
current found set

Selection across found set Selected text in a field in all 
records in the found set

Responding to a questioned word
• To replace the word, either edit the text in the "Replace with" box or select another word in the "Alternatives" box, 

and then click Replace All or Replace. Replace All changes the word wherever it occurs in the text you're 
checking, and Replace changes only this occurrence of it.

• To accept the word, click Skip All or Skip. Skip All accepts the word wherever it occurs in the text you're checking, 
and Skip accepts only this occurrence of it.

• To accept the word and add it to the user dictionary, click Add to Dictionary. Approach will not question the word in
future spell checks.

{button ,AL(`H_RUNNING_THE_SPELLING_CHECKER_STEPS',1)} Go to procedure



Checking spelling
1. Select the text you want to check, if not all text.
2. Choose Edit - Check Spelling.

3. Select the scope of the text you want to check.
4. Click OK.
5. If necessary, specify what to do for each questioned word, then click OK in the message box.

{button ,AL(`H_RUNNING_THE_SPELLING_CHECKER_DETAILS',1)} See details
{button ,AL(`H_EDITING_THE_USER_DICTIONARY_STEPS;H_SETTING_OPTIONS_FOR_CHECKING_SPELLIN

G_STEPS;H_CHANGING_TO_ANOTHER_MAIN_DICTIONARY_STEPS;',0)} See related topics



Details: Selecting fields to enter data
• You cannot select a calculated or read-only field.
• Press SHIFT+TAB to move to the previous field in the tab order.
• Tab out of the last field in the last record to create a new record.

If your preferences are set this way, you can also press ENTER or SHIFT+ENTER to move to the next or previous field. 
See Moving between fields using   ENTER  .

{button ,AL(`H_SELECTING_FIELDS_STEPS',1)} Go to procedure



Selecting fields to enter data

 Are you in Browse?
• Click a field.

Clicking places the insertion point in the field. Data you enter is added to the data already there.
• Press TAB to go to the next field in the tab order.

Tabbing selects the entire contents of a field. Data you enter replaces everything that's already there.

{button ,AL(`H_SELECTING_FIELDS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_TAB_ORDER_ON_VIEWS_STEPS;H_SELECTING_WITHIN_FIELDS_REF;H_SE

LECTING_OBJECTS_STEPS;H_MOVING_BETWEEN_FIELDS_REF;',0)} See related topics



Details: Selecting values in drop-down boxes
Adding entries to a drop-down box
There are two kinds of drop-down boxes:

• Field box & list allows a user to enter new values or choose from existing ones.
• Drop-down box allows choices only from an existing list.

Selecting the list item
For both kinds of drop-down boxes, when you tab out of the field, the value selected is what goes in the record.

Selecting the drop-down box to expand it
Change the way drop-down boxes work so that they expand to show the list as soon as you select them. See 
Displaying the contents of drop-down boxes automatically.

{button ,AL(`H_SELECTING_FROM_A_DROPDOWN_BOX_STEPS',1)} Go to procedure



Selecting values in drop-down boxes

 Are you in Browse?
1. Select the field.
2. Do one of the following:

• Click the arrow

and select a value from the list.
• Press ALT+  up arrow to open the list, and then press the up or down arrows until the value you want is selected.

Note You can only select one value from the list. 
3. To enter the selected value in the database, press ENTER or tab out of the field.

{button ,AL(`H_SELECTING_FROM_A_DROPDOWN_BOX_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_THE_CONTENTS_OF_DROPDOWN_BOXES_AUTOMATICALLY_STEPS;H_DISPLA

YING_DESCRIPTIVE_VALUES_IN_A_SCROLLING_LIST_STEPS;H_DISPLAYING_FIELDS_AS_SCROLLING_L
ISTS_STEPS',0)} See related topics



Details: Selecting radio buttons or check boxes
Radio buttons
Only one radio button in a set can be on at a time. When you select a radio button, another button in the set is 
automatically deselected. Once you have selected a radio button, the only way to deselect it is by selecting another 
button in its set.
The field with radio buttons is empty until you click a button.

Check boxes
When you click a check box for the first time, you enter its checked value in the field; if you click the check box a 
second time, you enter its unchecked value.
The field with a check box is empty until you click the check box.

{button ,AL(`H_SELECTING_RADIO_BUTTONS_OR_CHECK_BOXES_STEPS',1)} Go to procedure



Selecting radio buttons or check boxes

 Are you in Browse?
Do one of the following:

• Click the radio button or check box.
• Tab to the set of radio buttons or the check box and then press SPACEBAR.

{button ,AL(`H_SELECTING_RADIO_BUTTONS_OR_CHECK_BOXES_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_FIELDS_AS_RADIO_BUTTONS_STEPS;H_DISPLAYING_FIELDS_AS_CHECK_BOX

ES_STEPS',0)} See related topics



Details: Setting options for checking spelling
The options remain in effect until you change them.

To Turn on
Find words that appear twice in a row,
such as "the the"

Check for repeated 
words

Check the spelling of words with 
numerals, such as Invoice2

Check words with 
numbers

Check the spelling of words that 
begin with a capital letter, such as 
London

Check words with 
initial caps

Show words from the user dictionary 
in the Alternatives list while you check 
spelling

Include user dictionary
alternatives

{button ,AL(`H_SETTING_OPTIONS_FOR_CHECKING_SPELLING_STEPS',1)} Go to procedure



Setting options for checking spelling
1. Choose Edit - Check Spelling.

2. Click Options.
3. Turn on the options you want.

See details 
4. Click OK to return to the Spell Check dialog box.
5. Click OK.

{button ,AL(`H_RUNNING_THE_SPELLING_CHECKER_STEPS;H_CHANGING_TO_ANOTHER_MAIN_DICTIONA
RY_STEPS;',0)} See related topics



Showing hidden records

 Are you in Browse?

Showing hidden records along with the current found set
1. Choose Find - Find Again on the context menu.
2. Press ENTER.

Showing all records
Do one of the following:

• Select "All records" from the named find box on the action bar.
• Choose Find - Find All on the context menu.

{button ,AL(`H_HIDING_VIEWS_STEPS;H_HIDING_RECORDS_STEPS;H_SHOWING_ALL_RECORDS_STEPS;',0
)} See related topics



Details: Adding Notes/FX fields to a Notes form
Approach File Properties fields
To create a field that exchanges File Properties data, use a Notes field name and data type listed in the table below.

File Properties field Notes field name Data type
Description Description Text
Keywords Keywords Text
Date Created DateCreated Time
Date last revised LastRevisionDate Time
Total revisions NumberOfEdits Number
Total editing time EditingTime Number
(not displayed) DocumentClass Text

DocumentClass
DocumentClass provides the OLE class name of the embedded application object. Use this field if a Notes database 
contains documents with embedded objects from different applications and you want to display the application name 
in a form or view. 
The table below lists the OLE class names for Lotus desktop applications.

Application OLE class name
1-2-3 123Worksheet
Word Pro WordProDocument
Freelance Graphics FLWPresentation
Approach ApproachApplication

Types of fields
Notes supports single-use and shared fields.

• Single-use fields are used only in a single form. Even if you use the same field name and definition in another 
form, the two fields are unrelated.
Select "Create field to be used only within this Form" to create a single-use field.

• Shared fields allow you to re-use a field in any number of forms within a particular database. Every time you 
update one instance of the shared field, Notes automatically updates all other instances, because they use the 
same field definition.
Select "Create shared field that can be used in other Forms" to create a shared field.

{button ,AL(`H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_STEPS',1)} Go to procedure



Adding Notes/FX fields to a Notes form
Exchange data between Notes and Approach by adding a field to a Notes form that matches the name of an 
Approach field that is defined for Notes/FX. For more information on the fields, see details.
1. In Notes, choose Design - Forms from the Folders navigator.
2. Select a form to edit, or choose Create - Design - Form to create a new form.
3. Choose Create - Field to create a new field.
4. Enter the Notes field name of an Approach File Properties field or variable field in the "Name" box of the InfoBox.
5. Choose File - Close.
6. Click Yes to save the form.

{button ,AL(`H_EMBEDDING_AN_APPROACH_OBJECT_IN_AN_EXISTING_NOTES_FORM_STEPS;H_EMBEDDI
NG_AN_APPROACH_OBJECT_IN_A_NOTES_FORM_DESIGN_STEPS;H_ENABLING_VARIABLE_FIELDS_FO
R_NOTES_FX_STEPS;H_TYPES_OF_FIELDS_OVER;',0)} See related topics



Creating a new Notes document
To use Notes/FX in a new Notes document, create the document from a form that contains an embedded Approach 
object.    Notes embeds a new copy of the object in each new document you compose.
1. In Notes, choose Create.
2. Choose the name of a form that contains an embedded Approach object.
3. If the form does not automatically launch Approach, double-click the Approach object.
4. In Approach, enter new information in the database.

{button ,AL(`H_UPDATING_FIELDS_IN_A_NOTES_DOCUMENT_FROM_APPROACH_STEPS;H_UPDATING_INF
ORMATION_IN_APPROACH_FROM_A_NOTES_DOCUMENT_STEPS;H_SETTING_UP_FIELDS_FOR_TWOW
AY_EXCHANGE_WITH_NOTES_STEPS;H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_DETAILS;H_S
ETTING_UP_NOTES_FIELD_EXCHANGE_OVER;H_EXCHANGING_DATA_BETWEEN_APPROACH_AND_NO
TES_OVER;H_NOTESFLOW_OVER;',0)} See related topics



Embedding an Approach object in a Notes document
To exchange data between Approach and Notes, embed an Approach object in any Rich Text field in an existing 
Notes document. The Approach object must have Notes/FX-enabled fields.
1. In Notes, open a document for editing.
2. Position the insertion point where you want to insert the Approach object.
3. Choose Create - Object.
4. To embed a new Approach object in the Notes document, select "Create a new object" and specify an Approach 

object as the object type. For information about embedding new objects in Notes forms, refer to Notes Help about
creating objects.
To embed an existing Approach file as an object in the Notes document, select "Create an object from a file" and 
specify an existing Approach file.    For information about creating objects in Notes forms from existing files, refer 
to Notes Help about creating objects.

5. Click OK.

{button ,AL(`H_CREATING_A_NEW_NOTES_DOCUMENT_STEPS;H_EMBEDDING_AN_APPROACH_OBJECT_IN
_A_NOTES_FORM_DESIGN_STEPS;H_UPDATING_FIELDS_IN_A_NOTES_DOCUMENT_FROM_APPROACH
_STEPS;H_SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_STEPS;H_SETTING_UP_NO
TES_FIELD_EXCHANGE_OVER;H_EXCHANGING_DATA_BETWEEN_APPROACH_AND_NOTES_OVER;H_N
OTESFLOW_OVER;',0)} See related topics



Embedding an Approach object in a Notes form
To exchange data between Approach and Notes, embed an Approach object in the design of a Notes form. New 
documents composed with this form automatically include the embedded Approach object. The Approach object must
have Notes/FX-enabled fields.
1. In Notes, choose Create - Design.
2. Choose Form.
3. Position the insertion point where you want to insert the Approach object.
4. Choose Create Object.
5. To embed a new Approach object in the Notes form, select "Create a new object" and specify an Approach object 

as the object type. For information about embedding new objects in Notes forms, refer to Notes Help about 
creating objects.
To embed an existing Approach file as an object in the Notes form, select "Create an object from a file" and 
specify an existing Approach file. For information about creating objects on Notes forms from existing files, refer 
to the Notes help about creating objects.

6. Click OK.
7. Close the Notes form
8. Click Yes to save the form.

{button ,AL(`H_NOTESFLOW_OVER;H_CREATING_A_NEW_NOTES_DOCUMENT_STEPS;H_SETTING_UP_NOT
ES_FIELD_EXCHANGE_OVER;H_SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_STEP
S;H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_DETAILS;H_EXCHANGING_DATA_BETWEEN_APP
ROACH_AND_NOTES_OVER;',0)} See related topics



Overview: Exchanging data between Approach and Notes
Notes/FX lets you exchange field data between Approach and Notes.    With Notes/FX

• Display data from Approach File Properties fields in a Notes form
• Pass the value of any Approach database variable field back and forth between Notes and Approach
• Run Approach scripts automatically whenever you close or update an Approach application embedded in Notes

Using Notes/FX
To use Notes/FX with Approach

• Define fields in Approach to exchange
• Embed in the design of a Notes document or form an Approach object that contains those fields
• Create new Notes documents that exchange data with embedded Approach objects
• Create Approach scripts that use the field information passed from Notes to Approach
• Create Approach scripts that set the value of variable fields passed from Approach to Notes

For example, you can create a Notes form for a sales report and embed an Approach application object in the form. 
When you compose a new report, Notes passes data to the Approach application, which uses this information to 
create the report.
When you complete the sales report and close Approach, you can update the document object embedded in the 
Notes form. Information from the sales report, such as the name and address of the company and the total sales for 
the period, now appears in the Notes document or in the Notes view. The sales report is centrally stored in a Notes 
database with other sales reports.

{button ,AL(`H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;H_APPROACH_FILE_PROPERTIES_REF;H_A
DDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_STEPS;H_EMBEDDING_AN_APPROACH_OBJECT_IN_A
N_EXISTING_NOTES_FORM_STEPS;H_EMBEDDING_AN_APPROACH_OBJECT_IN_A_NOTES_FORM_DESI
GN_STEPS;H_CREATING_A_NEW_NOTES_DOCUMENT_STEPS;',0)} See related topics



Overview: NotesFlow

What is NotesFlow?
NotesFlow is a collection of tools in Notes (such as Notes/FX and publishing forms) used to build applications that 
drive a flow of work. These applications not only share information but integrate Notes with other desktop products.
You can use NotesFlow to design applications for automating work that otherwise would require complicated or 
repetitive tasks. Documents automatically share information or launch files created in other products. NotesFlow also 
lets you control the flow of work and the actions available to users. 
NotesFlow can be built into any type of application to allow transparent interaction between Notes and other 
applications such as word processing and spreadsheet programs (through the use of OLE objects and Notes/FX 
technology). 
For instance, you can combine NotesFlow features to build a powerful workflow application that can:

• Automatically route a document or notifications to the next specified user or approver
• Send reminders 
• Request and process approvals 
• Run scheduled batch processes 

Set up forms to exchange field information with other application documents
You can create forms in Notes that automatically share information with documents created in other OLE-registered 
applications. When users modify the contents of a field in a Notes document, the changes are automatically made to 
the corresponding fields in the other application's document. Data exchange can also occur in both directions. Users 
can edit fields in either Notes or the other application and the modifications are automatically exchanged.

Publish actions that apply across applications
The ability to create and publish actions that take effect across applications is one of the most powerful aspects of 
NotesFlow. When you publish an action in a form, Notes makes the action available on the Action menu in any open 
OLE server application that supports Notes/FX.
If you follow a flow of work that involves switching between Notes and other desktop products, you can create and 
publish actions that simplify the workflow. Publishing Notes actions lets you limit user access to commands, integrate 
file creation and storage in other desktop products with the document sharing, storage, security, and management 
tools of Notes.
Since the actions you create can incorporate functions, @commands, and LotusScript, there is no limit to the way 
you can apply them. Notes also supplies a number of simple actions    (such as Move to Folder) that let you 
incorporate useful actions in your form design without having to program in LotusScript.

Design forms to automatically launch objects
You can design a form that automatically launches an embedded object or a new object created using any OLE-
registered desktop application. The autolaunch can occur when users create, edit, or read a document based on the 
form. This makes the flow of work involving multiple applications smoother, and it allows users who are familiar with 
other products to work within that application without ever leaving Notes.

Access information in external databases using ODBC
You can use the Open Database Connectivity (ODBC) standard to access data contained in external databases. 
Using formulas and scripts from within Notes, you can bring information from a non-Notes database into Notes 
documents and summarize it in Notes views for reporting and searching.



Setting up fields for two-way exchange with Notes
Notes can read the value in Approach variable fields. In order for Notes to modify these fields, you must enable the 
fields in Approach. 
1. Choose File - Approach File Properties.
2. Under "Variable Fields", select the fields you want to set up for two-way exchange with Notes.
3. Click OK.
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Overview: Setting up Notes/FX
To set up Notes/FX, you define fields in Approach to exchange with Notes, and then embed an Approach object with 
those fields into a Notes document.

What can you exchange?
You can exchange the following types of data between Approach and Notes:

• Approach File Properties fields
• Approach variable fields

You can also use Approach scripts to automatically update information in the Notes database when you close the 
database or change field information.

File Properties fields supplied by Approach
Approach supplies File Properties fields with predefined names that contain information about a database, such as its
description and creation date. You can use any of these fields in an exchange with Notes.

Variable fields
Notes/FX reads all Approach variable fields into Notes as shared fields, accessible from any form or view. To use 
variable fields, you create fields with matching names and types in both the Approach object and the Notes forms or 
views.

Approach update scripts
You can use the Close and FXupdate scripts with Notes/FX. 

• Close executes automatically when an Approach application closes. 
• FXupdate events are triggered whenever Notes passes field information to Approach through Notes/FX. 

For more information, see the Notes application developers documentation.
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Updating fields in a Notes document from Approach
You can update any changes in Approach File Properties or variable fields to a Notes document.
1. In Notes, display the document that contains the fields you want to update.
2. Double-click the embedded Approach object.
3. In Approach, enter any new information into Notes/FX fields defined in Approach File Properties or in variable 

fields.
4. Do one of the following:

• Choose File - Exit & Return to Lotus Notes to close Approach and return to Notes.
• Choose File - Close & Return to Lotus Notes to close the Approach document without closing Approach.
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Updating information in Approach from a Notes document
When an Approach object embedded in a Notes document contains Notes/FX-enabled fields, you can update these 
fields from the Notes form.
1. In Notes, select the document you want to edit.
2. Choose Actions - Edit Document.
3. Enter new information in the Notes/FX fields.
4. Launch the embedded Approach object to view these changes in Approach.
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Overview: Alias joins
It's sometimes useful to join a database to itself. You may also want to join the same database two or more times to 
different databases.
To make either of these kinds of joins, you create an alias version -- a virtual copy -- of the database. An alias is not a 
physical duplicate of a database; it does not contain the database's data. It acts, however, like a duplicate for the 
purposes of joining.      

Example
Suppose you want to keep track of which employees in your company are managers and who they are responsible 
for managing. Managers are also employees, so their records are in the same employee database.
The records in this database are identified as unique by an employee ID field. Each employee record also has a field 
that identifies the employee's manager. The manager is identified using his or her employee ID. 
For example, in the following illustration notice that employee Joann Willis (Empl ID 74) is the manager of Jean-Pierre
Renault and Keng Wu, whose records show 74 in the Mgr ID field.    

Alias joins can be an efficient way to use data because you don't need to duplicate the manager records in a 
separate database. But you do need a second instance of the database -- an alias -- to see the join relationships from
one record to another record within that database. 
Creating an alias lets you link records that have related information in the database. You can display information (on 
forms and repeating panels) that would not have been available without the alias join.

Name of an alias
When you create an alias, Approach adds a 1 to the name of the database, and gives the alias the same name as the
database, plus a 2 (or a 3, and so on). EMPLOYEE:1 has an alias named EMPLOYEE:2. 
These names appear only in the Approach file containing the joins. The names do not affect the name of the 
database file itself or the name of the database in any other Approach file.

Joining to an alias
To join a database to itself, you create a "copy" of the database in the Join dialog box. The copy is not an actual 
duplicate of the database, but only another listing of it, called an alias. After you create the alias, you can set up a join
between the database and its alias.

Example
You can join the manager ID in an employee database to the employee ID in an alias database called EMPLOYEE:2. 
EMPLOYEE:1 represents the "copy" of the database that you think of as containing only manager information:

The manager database (represented by EMPLOYEE:1) has a one-to-many relationship with the employee database 



(EMPLOYEE:2). You can display the results of this alias join using a repeating panel on a form based on the manager
database (EMPLOYEE:1).

If you create more than one alias of a database, you can join one alias to another and even join an alias to a different 
database.

Joining to a different database
It is also useful to join the alias to a different database.

Example
Suppose you have a project list database where each project needs both a primary contact and a secondary contact. 
The contacts are in the employee database. Since the contacts come from the same source and one employee can 
be a primary contact on one project and a secondary contact on several others, you could join two aliases of the 
employee database to the project database as Contact 1 and Contact 2.
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Automatically entering unique values into existing records
This task consists of the following parts:

 Unique values in ID fields
 Adding a variable field
 Creating the Increment macro
 Creating the Renumber macro
 Running the Renumber macro 

Adding a variable field
Add this variable field, named VarForNUmber, to your Approach (.APR) file. This is a necessary step for automatically
filling in unique values for every existing record in your database. After this step, you must create the Increment and 
Renumber macros.      
1. Go to a form view.
2. From the Create menu, choose Field Definition
3. Scroll to the empty line at the bottom of the field list.
4. Enter the name VarForRenumber for the field.
5. Double-click the Data Type drop-down box, and select the Variable data type.

The Size and Formula/Options fields are automatically filled in.
6. Click OK.
7. Drag the VarForRenumber field from the Add Field dialog box to a form.
8. When a message box appears asking which environment you want to work in, click Browse.



Creating ID fields
When you join two databases, you must select a join field to link them together. You can create a field specifically for 
joining that contains numbers that identify every record in the database. This is referred to as an ID field.
1. From the Create menu, choose Field Definition.
2. Scroll to the empty line at the bottom of the field list.
3. Enter a name for the field.
4. Double-click the Data Type drop-down box, and select the Numeric data type.
5. Click Options.
6. On the Default Value tab, select "Serial number starting at."
7. Enter the value you want to use for a starting point in the "Serial number starting at" box.

Note If you have already entered unique ID numbers in your existing records, use the last record's ID number as 
your starting point. 

8. Enter the value by which the ID number is increased for each new record you want to use in the "Incremented by"
box.

9. Click the Validation tab.
10. Select "Unique" and "Filled in."
11. Click OK.
12. Drag the ID field from the Add field dialog box to the view.
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Automatically entering unique values into existing records
This task consists of the following parts:

 Unique values in ID fields
 Adding a variable field
 Creating the Increment macro
 Creating the Renumber macro
 Running the Renumber macro 

Creating the Increment macro
Before you create the Increment macro, you must define an ID field for your database. The ID field must contain a 
unique value that corresponds to each record in the database. After you define the ID    field and set your incremental 
value to whatever you want, you have completed the second of three steps in automatically filling the existing records
in a database with unique records.    
1. From the Edit menu, choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter "Increment" in the Macro name box.
4. (Optional) To run the macro by pressing a function key, select a key in the Function key box.
5. Select the Set command from the Command box.
6. Select your ID field in the "Set this field" box. 
7. Enter VarForRenumber in the "To this value" box.
8. Select the Set command from the Command box.
9. Select VarForRenumber in the "Set this field" box.
10. Click Formula and enter VarForRenumber+x in the Formula box.

X is whatever incremental value you choose.
11. Select the Records command from the Command box.
12. Select Next record in the "Go to" box. 
13. Select the Run command from the Command box.
14. Select Increment in the "Run macro" box.
15. Deselect "Return to the next line on this macro."
16. Click OK to close the Define Macro box.
17. Click Done.



Automatically entering unique values into existing records
This task consists of the following parts:

 Unique values in ID fields
 Adding a variable field
 Creating the Increment macro
 Creating the Renumber macro
 Running the Renumber macro 

Creating the Renumber macro
The Renumber macro lets you set the initial value of the variable field to whatever you want. This value is your 
starting point for renumbering your ID fields in each record of the database.    
1. From the Edit menu, choose Macros.
2. Click New.

The Define Macro dialog box appears.
3. Enter "Renumber" in the Macro name box.
4. (Optional) To run the macro by pressing a function key, select a key in the Function key box.
5. Select the Records command from the Command box.
6. Select First record in the "Go to" box.
7. Select the Set command from the Command box.
8. Select VarForRenumber in the "Set this field" box.
9. Enter whatever value you want to use as the starting point for the Renumbering process in the "To this value" box.
10. Select the Run command from the Command box.
11. Select Increment in the "Run macro" box.
12. Deselect "Return to the next line on this macro."
13. Click OK to close the Define Macro dialog box.
14. Click Done.
After you have finished creating the two macros, run Renumber. The Renumber macro calls Increment and 
automatically enters unique values into whatever ID field you defined in just the existing records. 

Synchronize existing and new records
After entering unique values in the ID field for your existing records, you want to make sure that the new records in 
your database will also contain unique values. Synchronize the values for existing and new records by going to the 
last record and verifying the value in the ID field. Add this value to whatever you use as an incremental value for a 
starting serial number for new records. See Entering data automatically.



Normalization: Improving the efficiency of your database application
When you design your database applications, take a good look at how you have arranged your data. Do you have 
one large database that is full of repetitive information? Have you clearly defined the relationships between the fields?
You can rearrange your database into several smaller databases containing related information. This simplifies the 
relationships within the database. It also makes whatever database functions you use (finding, sorting, entering and 
deleting data) more efficient.
The process of breaking down large, complex databases into related groups of smaller, simpler databases and 
eliminating repetitive information is known as normalization. After the databases are rearranged, they are joined on 
fields that contain unique values. Save these related databases in one Approach file (.APR) to create a database 
application.    

Advantages
The advantages of normalization are:

• The database is stable and does not need to be continually redesigned as you add new information.
• Databases require less physical storage space.
• Database operations are faster.
• You create better reports.
• There is less likelihood of errors when entering, deleting, or updating information.

The first three rules of normalization, referred to as forms, are explained below.

First normal form
The fields in your database must contain only one value. The fields cannot be collections of items. If the fields in your 
database contain more than one value, it is not possible for you to search for data or calculate values based on other 
fields. For example, a Personnel database that contains first name, middle initial, and last name in the Names field 
will not let you differentiate between employees having the same last name when performing a find. 

Names
Janine T. Adams
Thomas W. Elliott
Alicia M. Gordon
William J. Gordon

To follow good database design, separate the Names field into three new fields: First Name, Initial, and Last Name. 
The new Personnel database is shown below. 

First Name Initial Last Name
Janine T Adams
Thomas W Elliott
Alicia M Gordon
William J Gordon

For a database to be normalized to the first form, you must also eliminate repeating groups of data. For example, you
might enter your company's sales into a large database called Transactions. Transactions contains the following 
fields:

Transactions
Sales_Date
Sales_Amount
Sales_By Product
Product_Price
Units Sold
Customer Name
Customer Address
Customer Phone



Date Shipped to Customer
The first five fields contain information that the Sales department needs to know. The last four fields (Customer 
Name, Customer Address, Customer Phone, and Date Shipped to Customer) contain information that the shipping 
department needs to know. There are currently two different groups of data in the same database. One group 
pertains to sales and the other group pertains to shipping. 
These two departments need to synchronize their information so that the Shipping department knows what needs to 
shipped after a sale, how much, and where it is shipped to. The Sales department needs to know if and when the 
product associated with a particular sale has been shipped to the customer. You can solve this problem by 
normalizing the Transactions database and turning it into two separate databases, Sales and Shipping.    

Sales Shipping
Sales ID Sales ID
Sales Date Product Name
Product Name Units to be Shipped
Units Sold Amount Billed
Unit Price Customer Name
Customer Name Customer Address
Sales Rep Name Customer Phone
Sales Rep ID Date Shipped

Name of Carrier
 
Notice that a unique ID field, Sales ID, has been defined in both Sales and Shipping. Sales ID is a numeric field that 
automatically assigns a serial number to each sales transaction, making it the link between information about sales 
and information about shipping. The two databases are joined on this field.    Sales and Shipping have now been 
normalized to the first normal form.      

Second normal form
For a database to be normalized to the second normal form, all redundant data should be eliminated. 

            



Joining calculated fields
Calculated fields do not display in the Join dialog box unless you select the option to display calculated fields in the 
Approach Preferences dialog box.
If after you select that option you still cannot see the calculated fields you want, that is because the calculated fields 
were created in an .APR other than the one in which you are joining databases.
Calculated fields exist only in the .APR in which they are created, so you must re-create the calculated fields in the 
APR in which you are joining databases. To do that, you must first create a temporary join between the two 
databases so that you can have access to the fields used in the calculated fields.

Creating a temporary join between databases
1. In the .APR in which you want to join databases, turn on the option to display calculated fields.
2. From the Create menu, choose Join.
3. Click Open.

The Open dialog box appears.
4. Select the database that contains the field(s) used in the calculated field.
5. Join two fields that are not calculated fields.
6. Click OK.

Recreating the calculated field
In the same Approach file that contains the temporary join, recreate the calculated field.
Now that the newly-created calculated field is part of the current Approach file, the calculated field should appear in 
the Join dialog box field list.

Removing the temporary join and joining on the calculated field
1. From the Create menu, choose Join.
2. Click the join line between the temporary join fields.
3. Click Unjoin.
4. Join the newly-created calculated field to a calculated field in the other database.
5. Click OK.

The calculated fields in each database are now joined. 

Deleting the unneeded Approach file
You need only one Approach file for the two databases, so delete the Approach file that does not contain the join.
Note  Be sure not to delete the database file.
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Organizing your databases into an application
When you design a database application in Approach, you bring together data from more than one database by 
joining the databases in a single Approach file (.APR). Although you can join unrelated databases in a single.APR, 
your application will be easier to work with if the data in the databases is related. The data should be about the same 
subject and have a logical connection. This connection is usually a dependency of some kind. Something that 
happens to the data in one database affects the data in another database.    

Identifying related data 
For example, suppose you own a restaurant. You have many aspects of the business to consider: hiring new 
employees, creating a salary structure, calculating state and federal payroll taxes, and so on. You also print menus, 
perfect your recipes, check your inventory, and order food from suppliers.
To reduce your headaches, you organize these parts of your business into categories of related data. The two areas 
of related data that take up most of your time and attention are reordering inventory and personnel issues.          

Defining an inventory database application
To solve the problem of tracking inventory, you decide you need three databases. One database stores the names of 
foods needed for your recipes; another tracks inventory levels on hand; and the last is for ordering food from 
suppliers. You create the following databases: 

• Recipes
• Inventory
• Suppliers

These databases are related because they deal with the same category of data: food. They are also dependent on 
one another. You know which foods you need to make your customers' favorite recipes, and you have to keep a 
certain level of these foods on hand. When the inventory level is below a certain point, you need to order food from 
your suppliers. If you don't order from the suppliers, you won't be able to make your recipes.    
Each food that you order and restock is assigned a unique identifying number in a field called Food_ID. All three 
databases contain this field. Because the value in the Food_ID field for each food is unique, you can use this field for 
the join field. When you join the three databases, they form a database application. You can save these databases in 
one Approach file (.APR) called Food.APR.
You now know the recipes that use each food and the supplier to order the food from. By creating calculated fields, 
you can compare current inventory to the inventory reorder level for each food. Thanks to this application, you should 
never be out of your most popular dishes.            

Defining a personnel database application
A separate category of related data for your restaurant concerns your personnel. You create a database called 
Employees to keep track of all the people who work for you. This database only contains general information, such as
you might find on a job application. Employees has the following fields:

• First name
• Last name
• Street
• City
• State
• ZIP
• Phone
• Social security number 

The social security number field would be good to use for a join field. Unlike the first name and last name fields, you 
can be sure that an employee's social security number is unique.
In another database named Payroll, you keep track of payroll information. The Payroll database has the following 
fields:

• Social security number
• Current annual salary
• Biweekly salary
• Bonuses paid



• State payroll taxes
• Federal payroll taxes
• Contribution to 401K plan        

The Employees database is joined to the Payroll database using the social security number field as the join field. 
These two databases are related because they keep track of different but interrelated aspects of your employee's 
data. 
You cannot get any useful information from the Payroll database until you know what the employee's social security 
number is from the Employees database.
 You can also save this database application in one Approach file (.APR) called Personnel.APR.

Unrelated databases
The databases for reordering food and those for personnel are not related to each other because they do not affect 
each other. There is no dependency. If an employee's annual salary goes up or his address changes, it does not 
affect the information in Recipes, Inventory, or Suppliers. If the inventory levels for certain foods drop too low, it does 
not change the information in Employees or Wages.    
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Automatically entering unique values into existing records
This task consists of the following parts:

 Unique values in ID fields
 Adding a variable field
 Creating the Increment macro
 Creating the Renumber macro
 Running the Renumber macro

Running the Renumber macro
1. From the Edit menu, choose Macros.
2. Select Renumber in the Macro name box.
3. Click Run.

The Renumber macro enters unique values in your database's ID field, using the starting point and incremental 
value you selected when creating the macro.



Automatically entering unique values into existing records
This task consists of the following parts:

 Unique values in ID fields
 Adding a variable field

 Creating the Increment macro

 Creating the Renumber macro

 Running the Renumber macro 

Unique values in ID fields
Join fields in Approach usually have an ID field. ID fields must contain a unique value that corresponds to each record
in the database. You can define your ID field (or any other field you select) to be automatically filled with unique 
values in the Field Definition dialog box. You also select the starting point and the incremental value. 
However, this process only fills in unique values for new records. It does not enter values for the existing records in 
your database. To automatically enter unique values into existing records, you must go through these steps:

• Add a variable field to the view. The variable field is used to temporarily calculate and store values used in the 
looping macro, Increment.

• Create a macro named Increment. This is a looping macro that goes through all the records in the database and 
increments the value in the selected ID field by whatever value you choose for the variable field.    

• Create and run a macro named Renumber. This macro goes to the first record in the database, sets the variable 
field to whatever initial value you enter, calls the Increment macro, and enters values into the existing fields using 
the incremental value you decide on.                



What if a find returns unexpected data?    
When you create a view that displays data from a detail database, you may not see the data you expect after a find. 

If the find does not display any data
Your index files may have been corrupted. Compress each of the joined database files to rebuild its index. If the 
database files are dBASE or FoxPro files, (.DBF) you can compress the files from within Approach.

If the find returns ambiguous data
• If the join is made on fields that contain non-unique data, the find will return ambiguous matches. The join field 

should contain a unique value for each record in the database.
You can define a field that has ID numbers, referred to as an ID field. An ID field has a unique value for each 
record in the database. Join your databases on this ID field.
If there is no ID field available, join the databases on a field that uniquely identifies records, such as a social 
security number. 

• The way values are entered into the fields may not match. For example, Database1 contains a numeric field 
named Serial_Number where numbers are entered as 1234. Database2 also contains a numeric field named 
Serial Number where numbers are entered as 1-234.

• The databases may be joined on fields that are not logically related.
For example, a company that sells laboratory equipment for several manufacturers wants to join a SALES 
database to an INVENTORY database. One record is used for each transaction. The amount of the sale is 
deducted from the inventory until the product's inventory amount reaches a reorder point. The two databases 
have the following field definitions:

SALES INVENTORY
Product Name Product Name
Part Number Part Number
Manufacturer Manufacturer
Date of Sale Total Sale
Unit Price Inventory before sale
Number Sold Inventory after sale
Total Sale Time to reorder?

The logical field to join in these two databases is the Part Number field. The Part Number is unique; it establishes 
who the manufacturer is, the name of the product, and the unit price. In the INVENTORY database, each Part 
Number also has inventory amounts before and after the sales transaction. A Boolean field tells you whether to 
reorder or not. 
Creating a join involving the Product Name or Manufacturer fields would not be logical. This company sells many 
types of beakers, flasks, and cylinders but only the Part Number field gives you the specifics for each of these 
products. 
The company sells products for several different manufacturers so the Manufacturer field does not give us unique 
information.        
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Overview: Joined databases
Even if you don't have a lot of data and complexity to begin with, data has a tendency to grow over time. A database 
design that is well-organized from the start can help you avoid problems later.
An efficient way to handle data is to logically group it into separate, manageable database files -- for example, one for
departments and another for employees. 
For more information on planning a database, see Why build a database?

Approach works best with joined databases
When you have multiple databases with related information, you can join the databases together in an Approach file. 
Approach is a relational database application, which means that you can bring together data from separate database 
files and use it as if all the data were stored in one place. 
To do this, you join the databases in the Approach file. Joining creates a relationship between the data in the joined 
databases. The forms, reports, and other views in the Approach file can use data from any of the databases joined in 
that file.

Advantages of joined databases
• A database application comprising of joined databases has much greater efficiency, accuracy, and flexibility than 

a database application that stores all data in a single database file. 
• With joined databases, you need to store only one copy of your data, even if you use certain kinds of data in more

than one place.
For example, suppose you maintain a database of your company's retail stores. Each store sells many different 
products. If you keep the store and product data in a single database, you have to enter a record for each product
that each store carries. 
But if you use a set of joined databases, you enter the store data once in its own database, regardless of how 
many products are in a particular store. The product data has its own separate database and can be grouped by 
each store. Joining these two databases lets you relate certain stores to certain products. 

• Joined databases save time and effort in data entry and updating. 
They also make it easier to maintain the consistency and accuracy of shared data. If you need to update shared 
data, just make the changes in one place, and the change automatically appears in all views where the data is 
used. 

• Joined databases give you flexibility in presenting data. 
You can see and edit a record from one database and one or more related records from a joined database 
together in a single view.    For example, data showing the name and address of a store and a list of its products 
can be displayed on a single form, rather than having to repeat the same information across many forms. The 
relationships between records in joined databases can be shown with a repeating panel on a form as one-to-
many and many-to-many.

How databases are joined
To design a set of joined databases, divide the fields for the data into logical groups. Each group becomes a separate
database file. Data should not be duplicated from one database to another. 
To join two databases, establish a relationship between one or more fields the databases have in common by linking 
them. These are called the join fields. It's usually best to define one field in each database specifically to be a join 
field and then enter an ID value in that field in each record. 
If you do not have a field you can use as a join field, you can join databases on other fields they have in common. 
Together the fields should uniquely identify records in one of the databases, such as first name, last name, and phone
number. Ideally, join fields should be the only duplicate fields in joined databases.
When a record in one database has the same join value as a record in a joined database, the two records are 
"related."

Examples
Suppose you want to compile a list of all the employees in each department in your company. Divide the data into two
database files, one for departments and one for employees, and give each file a department ID field. 
The employee database contains personal data, such as first and last names, address and phone number. The 
department database contains department information, such as manager, location, and cost center. Join the two 
databases on the ID field:



The employee database also needs to be joined to another database that stores payroll information. This payroll 
database lets the company keep track of pay increases, changing tax rates, when the employees are paid, and so on.
These two databases should be linked together using a common field. 
Since the employee database already has the Empl ID field, this field should be included in the payroll database as 
well. Empl ID is the common field that links two separate sets of information. The information in each record of the 
payroll database is determined by the value in the Empl ID field. Join the two databases on the Empl ID field.
BMC of employee and payroll being joined
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Joining a database to itself (alias join)
Join a database to itself to create an alias join. 
1. Choose Create - Join.
2. Select a database you want to join to itself.
3. Click Alias.

A copy of the current database appears.
4. For each field you to want to join on, click the field in one database and then drag and drop to a field in the alias 

database.
5. (Optional) Click Options to review the insertion and deletion options for this join.
6. Click OK.

{button ,AL(`H_ALIAS_JOINS_OVER;H_JOINING_DATABASE_FILES_STEPS;H_UNJOINING_DATABASE_FILES_
STEPS;',0)} See related topics



Details: Joining database files
What makes good join fields?
To join two databases, you must select a join field in each to link them together. Any field that meets one of the 
following criteria can be a join field:

• A field that is common to the two databases. 
A field that is common does not need to have the same name in the two databases, nor does it have to be of the 
same type. What the join fields must have in common is the nature of the values in the fields. 
For example, a PUBLISHERS database has a Name field, and an AUTHORS database has a Publishers field. 
Name and Publishers are possible join fields. Why? Because they contain the same type of information: the 
names of publishing companies.                  

• A    field containing ID numbers, referred to as an ID field. 
An ID field contains a unique value for each record in the database. For example, you want to link DEPARTMENT
and EMPLOYEE databases. Every department must have an ID number, and each employee must belong to a 
department. Define a Dept ID field for both databases and join them on this field.    

• A set of fields that, taken together, uniquely identify records in the databases, such as first name, middle name, 
and last name.
If you do not have an ID field you can use for the join field, link the databases on two or more of these fields.

Why don't I see all my fields?
Fields that are defined with any of the following field types do not appear in the Join dialog box field lists: 

• Boolean
• Memo
• PicturePlus
• Variable

Joins on calculated fields
To join databases on a calculated field, you must first display the calculated fields. See Making calculated fields 
available for joins.    
Calculated fields appear in italics at the bottom of the field list, after the database fields. A field list shows database 
fields and the calculated fields that refer to fields in the database. Summary fields do not appear in the list.
To make calculated fields appear in a field list for a secondary database, see Joining calculated fields. 

Valid joins
You can join a database to more than one database. Use the same join field in all of its joins or different fields for 
different joins.
Every database you open in the Join dialog box must be joined to at least one other database in the dialog box. 
All the databases must be joined together into one set. If you have three databases open in the Join dialog box, then 
having database1 joined to database2, and database2 joined to database3 would be considered one set, though it is 
not the only possible one. Database3 could also be joined to either database1 or database2.

Circular joins
Relational databases such as Approach do not allow circular join relationships. A circular join occurs when three or 
more databases are joined and you can follow the path of the join lines from the original database to other databases 
and back to the original database. For example, suppose database1 is joined to database2 and database2 is joined 
to database3. Database3 cannot be joined to database1, because that join forms a circular relationship.

Valid                                                                                          Not Valid
To avoid circular joins, you may want to create an alias join. By joining a database to an alias "copy" of itself, you can 
link records that have related information in the database. 

Invalid joins
The OK button is dimmed if any joins in the dialog box are invalid. When you correct the errors, you can click OK.



Limits on joins in one .APR file
The greatest number of joins you can create between databases (that will be read-write) in one .APR file is 30. Any 
joins you create after that will be read-only, up to a limit of 50 joins.
If more than 30 databases are open or you have created more than 30 joins in one .APR file, you cannot save 
the .APR file with the File - Save As command. 

Joins on unrelated databases
You can also join databases that are not logically related. Join the databases on any field from either database. You 
can then use a single .APR file to access the joined, though unrelated, databases.
This allows you to create views that have the different databases as their main database, so you can easily work with 
all your data in one place. 
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Joining database files
Join two databases by establishing a link on one or more common fields.
Want the big picture? See Overview: Joined databases.
1. From the Create menu, choose Join.
2. Click Open to select a database that already exists.

If you open a database you don't want to join, click its list of fields and then click Close.
3. For each field you want to join on, click the field in one database and then drag to a field in the other database.

If you don't know what fields you want to join on, see details.
4. (Optional) Click Options to review the insertion and deletion options for this join.
5. Click OK.
6. Now that you have joined the databases, you can do the following:

Add fields 
Add a repeating panel to an existing form 
Create new forms using fields from the joined database files    
Create new forms that include a repeating panel 
Do finds on data in the joined database files 
Unjoin the database files 

{button ,AL(`H_JOINING_DATABASE_FILES_DETAILS',1)} See details
{button ,AL(`H_ALIAS_JOINS_OVER;H_JOINED_DATABASES_OVER;H_MAIN_AND_DETAIL_DATABASES_IN_A

_VIEW_OVER;H_MANY_TO_MANY_RELATIONSHIPS_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND_ON
E_TO_ONE_RELATIONSHIPS_OVER;H_SETTING_OPTIONS_FOR_A_JOIN_STEPS;H_APP_JOINING_CALC
ULATED_FIELDS_STEPS;',0)} See related topics



Join dialog box
Choose a task

Joining database files 
Setting options for a join 
Joining a database to itself (alias join) 
Unjoining database files 
Printing a diagram of join relationships
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Overview: Main and detail databases in a view
Each form, report, or other view in an Approach file that uses joined databases has one main database and can have 
one or more detail databases. 
The main database provides the basic information for that view; each record from the main database appears in it. 
The other joined databases can act as detail databases, providing additional, related information to display in the 
view.
Each view in an Approach file can have a different main database. You specify which database is the main one for a 
view when you create the view. You can change the main database later by using the InfoBox. 

Forms
In a form, you can view one record at a time from the main database. The maximum number of records you can view 
is the number of records in the main database.

Example
The main database of this form is a department database. There are five departments, and so there are five records 
in the database. Five is the maximum number of records you can see on this form.

There is another database joined to the department database: the employee database. There are 100 employees, 
and so there are 100 records in the employee database. 
On a form that has the employee database as its main database, the maximum number of records you can see is 
100.

Showing details about records of the main database
Suppose that when you look at the department form, you also want to see a list of all employees assigned to that 
department. You can do that by creating a repeating panel on the department form.
A repeating panel on a form is always based on one of its detail databases.The panel shows all the records from the 
detail database that match the values in the main database's join fields.
So in this example, the repeating panel is based on the employee database. The form still can display only the five 
records of its main database (the department database), but the repeating panel can show employee data related to 
each of those records. This is possible because the two databases share a field in common: the department ID.
So when Approach finds an employee record that contains the same department ID as the department record 
displayed on the form, Approach displays that employee's data in the repeating panel. 

Reports
In a report, you see all the records from the main database as line items in the body of the report. One exception is a 
summary only report, which summarizes all the records in the main database, but does not show each one. 

Example
This report is based on an employee database and lists every employee in the company grouped by department:    



Choosing a main database
When you design a report that uses joined data, it's important to base the report on the database from which you 
want to display all the records. In the employees report shown above, you want to see all the records from the 
employee database. You make the employee database the main database of the report.    Use summary panels for 
the department groupings. If you were to base the report on the department database rather than the employee 
database, you would see all the departments, but only one employee for each department.
A repeating panel report is always based on the main database and displays all of its records. However, it also 
includes those records from a detail database that    match the values in the main database's join field.
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Overview: Many-to-many relationships
In a many-to-many relationship, many records in one database can be related to many records in the other database.
A set of orders for products is a common application of this. Each order can include many products, and each product
can appear on many orders. A many-to-many relationship is a one-to-many in both directions.

Joining two databases directly
You cannot set up a many-to-many relationship directly between two databases. For example, if you join an orders 
database and a products database directly on an order number, each product can appear on only one order (because
the order number becomes part of the product's record).
Similarly, if you join the two databases on a product number, each order can have only one product (because the 
product number becomes part of the order's record).

Joining through a third database
To set up a many-to-many relationship between two databases, you need to add an intermediate database. The other
databases each have a one-to-many relationship with this database.
For the orders and products databases, you would use a third database that stores the "many" line item data for the 
repeating panel on your order form:

The third database keeps the orders data out of the products database and the products data out of the orders 
database. Now each order can have many products, and each product can be on many orders. You can display one-
to-many data both on order views and on product views. You can also see the detail records.

{button ,AL(`H_ALIAS_JOINS_OVER;H_JOINED_DATABASES_OVER;H_JOINING_DATABASE_FILES_STEPS;H_
MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_ONE_TO_MANY_MANY_TO_ONE_AND_ONE_TO_O
NE_RELATIONSHIPS_OVER;H_SETTING_OPTIONS_FOR_A_JOIN_STEPS;',0)} See related topics



Overview: One-to-many, many-to-one, and one-to-one relationships
The relationship between records in two joined databases is usually one-to-many or many-to-one.

One-to-many
In a one-to-many relationship, a record in one database can be related to one or more records in the other database. 
If, for example, a department has several employees, then a record in a department database has the same 
department ID as several records in an employee database.
To show the result of a one-to-many relationship on a form, you add a repeating panel to a form. The form is based 
on the "one" database. The repeating panel is based on the "many" database, and each line in the panel is a record 
in that database.
To show the result of a one-to-many relationship on a report, create a Repeating panel report using the Report 
Assistant. Base the report on the "one" database by choosing a field from that database in the Groups tab.
The report presents a group heading for each record in the "one" database. Under each group heading are the 
records from the "many" database that relate to the group. Each line in the body of the report is a record in the 
"many" database.
For example, this report shows a group for each record in the products database and the invoices that include each 
product.

Many-to-one
A many-to-one relationship is the reverse of one-to-many. If, for example, several employees are in the same 
department, then several records in an employee database have the same department ID as one record in a 
department database. 
On this employee form, the department data is the same for several employees in the many-to-one relationship:

Many-to-one relationships are often used as a lookup, to provide a convenient means of displaying data in a view. If 
you type a department ID on the employee form above, the department name and location for that ID appear 
automatically. 
For a lookup to work properly, the ID field must come from the main database for the view, and the fields with the 
lookup data must come from a detail database. On the employee form, the department ID field comes from the 
employee database, and the other department fields come from the department database.



One-to-one
In a one-to-one relationship, a record in one database is related to only one record in the other database. For 
example, a vehicle number in one database might be related to a license number for the vehicle in a joined database.
You don't normally need to use one-to-one relationships in Approach. You can store a single set of data (such as 
everything about one vehicle) together in a single record in one database.
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Printing a diagram of join relationships
1. Choose Create - Join.
2. Click Print.
3. Click OK.

{button ,AL(`H_JOINING_DATABASE_FILES_STEPS;H_SETTING_OPTIONS_FOR_A_JOIN_STEPS;',0)} See 
related topics



Details: Setting options for a join
Join options apply to a particular relationship between databases. You can set options for each relationship between 
databases, but all joins between the same two databases have the same options.
The options at the top and the bottom of the Relational Options dialog box are the same. They just apply to different 
directions of the selected join.

Insert options
With an Insert option selected, Approach inserts a new record in this case:

If this condition exists Approach
You type in a blank field for a 
detail database on a view and
a matching record for the 
main database's join value 
does not exist.

Inserts a new record in the 
detail database.

Example
Suppose you select "Insert: If no records match the DEPTMENT record, typing into a blank EMPLOYEE field inserts 
a new record" in the Relational Options dialog box. In this relationship, DEPTMENT is the main database and 
EMPLOYEE is the detail database.
When you enter data in a blank field for the employee database on a department form, Approach inserts the new 
record in the employee database with the join fields filled in.The new record joins to the current DEPTMENT record.
If you have a one-to-one relationship between the two databases, you would enter the record on a department form in
a field(s) from the employee database. If you have a one-to-many relationship between the two databases, you would
enter the record on a repeating panel based on EMPLOYEE.

Delete options
With a Delete option selected, Approach deletes records in this case:

If you Approach
Delete a record from the 
database listed first in the 
Delete option.

Deletes all records in the 
database listed second in the 
Delete option that have a join 
value matching the record you 
deleted.

Example 
Suppose you select "Delete: Deleting a record from DEPTMENT deletes matching records from EMPLOYEE." If you 
delete a department, Approach deletes all the employees for that department from the employee database.

Joins on calculated fields
If any of the join fields on the detail side of a joined database relationship is a calculated field, you cannot insert new 
records, even if you have this option selected. But if a calculated field is defined on the main side of the relationship, 
records may be added in the repeating panel.
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Setting options for a join
Approach can automatically insert or delete related records in a database joined in the current Approach file.
1. Choose Create - Join.
2. Join two database files.
3. Click Options.

The Relational Options dialog box appears.
4. To have Approach insert related records automatically for the join, select an Insert option.
5. To have Approach delete related records automatically for the selected join, select a Delete option.
6. Click OK to close the Relational Options dialog box.
7. Click OK.
Note  To insert related records automatically, you must enter a value into a field on the form or the repeating panel, 
depending on the type of relationship you created between the databases. 
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{button ,AL(`H_ALIAS_JOINS_OVER;H_JOINED_DATABASES_OVER;H_JOINING_DATABASE_FILES_STEPS;H_

MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_MANY_TO_MANY_RELATIONSHIPS_OVER;H_ONE
_TO_MANY_MANY_TO_ONE_AND_ONE_TO_ONE_RELATIONSHIPS_OVER;',0)} See related topics



Unjoining database files
If you unjoin and close a database in the Join dialog box, Approach deletes the views and repeating panels that are 
based on that database.
Troubleshooting A common mistake is to unjoin a database and then try to close the Join dialog box by clicking OK. 
The OK button is grayed until you select any unjoined databases and close them.
1. Choose Create - Join.
2. Click the join line connecting the databases you want to unjoin.
3. Click Unjoin.
4. For each database left without a join, select its list of fields and click Close.
5. If a message box appears, click Yes to unjoin the database. 

Approach displays a message box for each database you close that is the main database for any views or 
repeating panels.

6. Click OK.
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Approach file properties
Command: File - Approach File Properties

The Approach File Properties dialog box lets you enter a description of an Approach file, along with the name of the 
author and title. You can also enable a variable field for Notes/FX. 
This dialog box displays information about the

• Drive, directory, and name of the Approach file (.APR)
• Drive, directory, and name of the database file(s) 
• Date and time the file was created
• Date and time the file was last revised
• Total number of revisions
• Views in the Approach file
• Macros available in the file

Keywords
Enter keywords that indicate the contents of the Approach file. For example, is it a customer list, a record of 
transactions, or a demographic analysis? 
Keywords are used in conjunction with Notes/FX. When one or more databases are embedded in a Notes/FX 
document, keywords become a field in the document. You can create a view that shows the fields, then sort by 
keywords, and search for the keywords that interest you. 

Variable fields
Notes/FX lets Notes and Approach share information. From the Approach end, the sharing is accomplished with 
variable fields that have been enabled for Notes/FX. When an Approach variable field is enabled, Notes can write to 
the field and can read its contents without having to open an Approach view. 
To enable a variable field in the Approach File Properties dialog box, select the check box to the left of the variable 
field name in the "FX enable" column.

Route steps
If you are connected to a network and have access to an e-mail package, you can include Approach views and data 
in your e-mail messages. Enter the names of those people who you want to be recipients of your e-mail in the Route 
steps box and create a routing list.

Print
Click Print for a printout of file properties.



Delete File dialog box

Choose a topic
Deleting Approach files 
Deleting database files 



Do you really need that .APR?
Everytime you create a new database, Approach creates a new Approach file (.APR) to go with it, and gives you a 
chance to save the Approach file.
But you don't necessarily need to save that Approach file. Before you save it, consider the following points:

• To save. . . If this database stands on its own, and you don't plan to join it to other databases, then save the 
Approach file. It becomes the interface through which you can work with the data in your database.

• Or not to save. . . Do you intend to join this database with other databases to create a relational database 
application? If so, you need only one Approach file to work with. All the data in all the joined databases is 
available from within the single .APR you keep. It's much more efficient, and better database design, if a single 
Approach file serves as the interface for your whole database application.

If I delete the .APR without saving it, will I lose the database and my data?
No. You won't lose your database, your data, or your field definitions. 
After you join this database to another, you'll be able to see the field definitions of all your joined databases in the 
Field Definition dialog box of the .APR you keep. 
Just be sure to create all your joins in the .APR you plan to keep.
You can create many views in the .APR, and each view can represent a different database of your application.

Which .APR should I keep?
It makes sense to keep the .APR that you've worked hardest on and that has the most views that you want to use in 
your application. But technically it doesn't matter which .APR you keep, so long as you create all your joins in 
that .APR. (Approach stores information about joins in the .APR.)
Calculated fields exist only in the .APR in which they are created. Once you delete the .APR file, all the formulas you 
created in the calculated fields are deleted as well. To save the formulas you created, join the calculated fields from 
the .APR you want to delete to calculated fields in another .APR. Save them in the second .APR file, then delete the 
first .APR file.      

But I don't want to lose all the design work I did in the other Approach files.
This is not a problem. You can consolidate all the views you designed into one .APR. Follow this process:

• Decide which Approach file you want to keep.
• In that Approach file, join all the databases you plan to use in this application.
• In each of the .APRs that you no longer need, go to Design and delete any views that you won't need in your 

database application.
• Open the Approach file you want to keep, go to Design, and import the other .APRs.
• Map the fields used in the imported .APRs to the fields of their corresponding joined databases. (For more 

information on mapping fields, see the next question.)
• Delete the .APRs you don't need.

What do I do in the Field Mapping dialog box?
Because you join the database before you import the .APR, Approach can easily recognize that the fields referred to 
in the incoming .APR correspond to the fields in one of the joined databases.
Approach sets up the fields in the Field Mapping dialog box so that all you have to do is confirm that the fields in the 
left column, from the incoming .APR, correspond to the fields on the right, in the joined database.
For example, suppose you're a chef and you joined a database named INGRDNTS.DBF to a database named 
RECIPES.DBF. Then you imported the views in INGRDNTS.APR into RECIPES.APR.
When the Field Mapping dialog box appears, Approach sets up the fields for you to map, like this:

Fields in "INGRDNTS.APR"  Fields in "RECIPES.APR"
Field1 INGRDNTS.Field1
Field2 INGRDNTS.Field2
Field3 INGRDNTS.Field3

Just click the middle column between the fields you want to map. The imported views will have INGRDNTS.DBF as 
their main database, and the data from INGRDNTS.DBF will appear in the fields.



What's a main database?
One Approach file can have many views, and each view can represent a different database. The database that a view
represents is called its main database. 
The main database determines how many, and what kind of, records can be visible in a view. 
For example, suppose again you're that chef who stores recipes in a database application. This application has a 
single Approach file as its interface: RECIPES.APR. Two databases are joined in the Approach file: INGRDNTS and 
RECIPES. 
You have two hundred recipes in RECIPES.DBF and 400 ingredients listed in INGRDNTS.DBF. 

• In views that have RECIPES as their main database, the largest number of records that the chef can ever see is 
the number of records in RECIPES.DBF: currently, 200. 

• In views that have INGRDNTS as the main database, the largest number of records that the chef can ever see is 
the number of records in the INGRDNTS.DBF: currently, 400.

That doesn't mean that you can't see information from INGRDNTS, in a view that has RECIPES as its main 
database. 
For example, part of each recipe is a list of ingredients. You display the ingredients by creating a repeating panel in a 
view whose main database is RECIPES. The ingredients come from INGRDNTS.DBF. 
Although the main database of the view is RECIPES, it can display information from INGRDNTS, which is called the 
detail database. So in this view, you can see 200 records, one per recipe; but each recipe displays a list of 
ingredients from INGRDNTS.DBF.

How do I find out what the main database of a view is?
Go to Design and double-click the view, away from any object. The InfoBox appears and displays the properties for 
the view. The name of its main database appears on the Basics tab. 
You can change the main database to any of the other joined databases in your application.

What if I change my mind and want all my .APRs back?
You can change your mind. Suppose you want to help another chef start a recipe database. You're not going to give 
away your recipes, of course, but you don't mind getting her started with your list of ingredients.
You can re-create INGRDNTS.APR in two ways:

• Choose File - Open. Instead of specifying an .APR, specify the database, in this case, INGRDNTS.DBF. 
Approach creates an .APR for the database, and the .APR contains a form and a worksheet that display all the 
fields of the database. Of course, your data from INGRDNTS.DBF will also be there.

• Choose File - Save As and rename your database application. In the renamed version, unjoin all the databases 
and close all of them except INGRDNTS.DBF. Approach deletes all the views that have RECIPES.DBF as their 
main database and leaves the ones that have INGRDNTS.DBF as their main database.
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0)} See related topics



Installing the Approach Web browser
You can install the Approach Web browser from the Surf the Net SmartMaster application (SURFNET.MPR), or 
directly from the Approach CD-ROM.    You do not need to have any other browser installed on your computer for the 
Approach Web browser to work. 
After you install the browser, see Overview: OLE Custom Controls    for more information on how to use the ActiveX 
controls in Approach.

Installing the Web browser from the Surf the Net SmartMaster 
1. Start from one of the following:

• In the Welcome dialog box, click "Create a New File Using a SmartMaster."
• From the File menu, choose New Database.

2. Select Applications in the "SmartMaster types" box.
3. Select the "Internet World Wide Web Sites" SmartMaster application.
4. Click OK.
5. Click Setup on Surf the Net Main Menu.
6. Click "To install the WebTrek OCX browser."

A message box appears. 
7. Do one of the following:

• Verify the Approach CD-ROM is in the drive. 
• Copy the Approach CD-ROM to your network.

8. Click OK.
The WebTrek Install dialog box appears.

9. Specify the correct path.
10. Click OK.
11. Follow the instructions onscreen to install the browser.

Installing the Web browser from the CD-ROM
1. Insert the Approach CD-ROM.
2. Click Start and choose Run.

The Run dialog box appears.
3. Enter the path of the files on your CD-ROM drive.

For example, d:\extra\approach\webtrek\webtrek.exe.
4. Follow the instructions onscreen to install the browser.

{button ,AL(`H_APP_INSTALLING_THE_APPROACH_WEB_BROWSER_DETAILS',1)} See details



Opening files created in previous versions of Approach

.APR files
When you open and save Approach 2.x .VEW files, Approach 3.x .APR files, Approach 96 .APR files, or Approach 
97 .APR files with Lotus Approach Release 9, it converts the files to Lotus Approach Release 9 format. Once 
converted, you cannot open the .APR in a version released prior to Approach 97.

Database files
Approach Release 9 does not convert the database itself, however. You can open the database in the 3.x, Approach 
96, or Approach 97 versions without any problems. 
To open the databases in the 2.x version, you must delete the .ADX files associated with the database. To ensure that
any information in your database and/or .APR or .ADX files is not lost, make backup copies of your data before 
opening these files in Approach Release 9.

{button ,AL(`H_OPENING_APPROACH_FILES_STEPS;',0)} See related topics



Closing Approach files
Since Approach automatically saves any data changes or new data entries, you do not need to worry about saving 
your data when you close the Approach file.
1. Choose File - Close.

If you made design, join, or field definition changes you haven't saved, a message box asks if you want to save those
changes.
2. Click Yes to save changes to the Approach file.

{button ,AL(`H_SAVING_APPROACH_FILES_AND_A_DATABASE_FILE_STEPS;H_SAVING_A_COPY_OF_AN_AP
PROACH_FILE_AND_A_DATABASE_FILE_STEPS;H_SAVING_A_COPY_OF_AN_APPROACH_FILE_ONLY_S
TEPS;',0)} See related topics



Confirming passwords
1. Enter the password exactly as you defined it in the Edit TeamSecuity dialog box.

The password is case-insensitive.
2. Click OK.

{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_COPY_STEPS;H_DEFINING_PASSWORD_PRIVIL
EGES_USING_NEW_STEPS;',0)} See related topics



Overview: Connecting to an SQL or ODBC data source
To connect to an SQL or ODBC data source, use the SQL Assistant. The SQL Assistant lets you define a SELECT 
statement before you retrieve any records. By creating a SELECT statement, you save processing time by not 
opening the entire database and retrieving all of the records. You work only with those records that match the criteria 
you define.
You can also connect to an SQL or ODBC data source by choosing the File - New Database, Open, Save As, Import 
Data, or Export Data commands and selecting the appropriate file type. However, these commands do not let you 
define criteria for a SELECT statement. 

Using the SQL Assistant
Go through the SQL Assistant tabs to define, join, view, sort, and edit the criteria. The SQL statement in the SQL tab 
is based on your input in the previous tabs. The role each tab has in the process is described here. For more 
information on the individual tabs, see the related topics.
1. Choose File - Open/Edit SQL.

2. To specify the database file type, connection, database name, and the name of the table, click the Tables tab.
In the Tables tab, do one of the following:

• Create a new SQL statement by selecting "Create a new SQL statement." Click Add to open a table.    
• Edit the last SQL statement you created for the current Approach file by selecting "Edit the existing SQL 

statement."
3. To join the tables, click the Join tab.
4. To create a find condition, click the Condition tab.
5. To select fields to place on the view, click the Fields tab.
6. To select fields for sorting, click the Sort tab.
7. To edit the SQL statement you created based on the previous tabs, click the SQL tab. 

Bypassing the SQL Assistant tabs
You can bypass the other SQL Assistant tabs by clicking the Tables tab, adding the tables you want to work with, and 
then clicking the SQL tab. The SELECT statement box, which would contain an SQL statement if you had gone 
through the other tabs first, contains the names of those tables that were opened from the Tables tab. Click the 
SELECT statement box to create your own SQL SELECT statement. 
Once you start manually entering an SQL statement, all the tabs are disabled except for the Tables and SQL tabs. If 
you click Restore SQL Statement, the SQL statement will be restored and all the tabs become available.
When you finish the SQL statement, click Done. The SQL statement is parsed and sent to the SQL database (or 
whatever type of database you are using).

Errors
Approach notifies you of any errors in the SQL statement. The resulting error message box gives you the number and
a description of the SQL error. To resolve the problem, make note of the error number and refer to your SQL 
documentation. 
The error messages for some file types do not contain error numbers. However, all SQL error messages have 
descriptions of the error.        

{button ,AL(`H_CREATING_FIND_CONDITIONS_IN_THE_CONDITION_TAB_STEPS;H_CREATING_JOINS_IN_TH
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Connecting to Internet servers
1. Choose File - Internet - FTP Connection Setup.
2. Click Hosts.

The FTP Hosts dialog box appears.
3. Click New.
4. Enter the host server description, address, and other connection information.
5. Select a connection type. 
6. (Optional) If you select "Use Proxy," select the proxy.
7. Click Save.
8. Click Done to close the FTP Hosts dialog box.
9. Click OK to close the Internet Options dialog box.

{button ,AL(`H_CONNECTING_TO_INTERNET_SERVERS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_I
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Details: Connecting to Internet servers
Internet host information
The host is the computer connected to the Internet that contains data that can be displayed on the Internet. To 
connect to the Internet, you need to get information about your host from your system administrator.    If you do not 
have a system administrator, you should contact your local Internet Service Provider (ISP) to get access to the 
Internet.
The host description can be any descriptive name you choose to distinguish it from other host connections. 
The host address is the domain address of the File Transfer Protocol (FTP) server to which you want to connect. It is 
a unique IP address to identify it on the Internet. It contains sets of numbers separated by periods, for example, 
204.155.122.1. 

User ID and password
Your user ID identifies you as someone with an account on the host. Your system adminstrator or ISP supplies you 
with your user ID and an initial password, which you can later change. 

Types of connections
There are three ways to connect to the host: 

• If the host supports FTP without requiring a user ID and password, select "Anonymous FTP," and use your e-mail 
address as the password. 

• If you are connected to the Internet via a firewall that supports passive transfers, select "Passive (PASV)." 
Firewalls prevent unauthorized Internet users to access private networks connected to the Internet.

• If you are connected to the Internet via a firewall that acts as a proxy server, select "Use Proxy," and select the 
proxy that identifies the network address of the proxy server and its port number. A proxy server intercepts all 
messages on the network and hides the network's true address.
If you select "Use Proxy," you must set up your proxy information. To do this, click Edit Proxies and add new 
information or edit the existing proxy information.

For more information on connecting to the Internet, see your system administrator.

{button ,AL(`H_CONNECTING_TO_INTERNET_SERVERS_STEPS',1)} Go to procedure
{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_I
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Creating a new database from scratch
1. Start from one of the following:

• In the Welcome dialog box, click "Create a New File Using a SmartMaster."
• From the File menu, choose New Database.

2. Select Blank Database and click OK.
The New dialog box appears.

3. Enter a name for the database file.
4. Select the default database type offered by Approach (dBASE IV) or another file type.
5. Click Create.

The Creating New Database dialog box appears.
6. Define the names, data types, and sizes of fields for the database.

If you decide at this point to use a set of ready-to-use fields, select one from the " Template" box.
7. Click OK.

• Approach creates the new database file in whatever format you select.
• The Approach file (.APR) you create contains two views: a form and a worksheet. 
• Both views display the fields you created.
• You can start to enter data now. 

Do you really need that .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    

{button ,AL(`H_CREATING_A_NEW_DATABASE_THAT_IS_A_READYTOUSE_APPLICATION_STEPS;H_CREATIN
G_A_NEW_DATABASE_WITH_A_SET_OF_READYTOUSE_FIELDS_STEPS;H_CREATING_NEW_DATABASE_
FILES_REF;H_IMPORTING_DATA_INTO_DATABASES_STEPS;H_WHY_BUILD_A_DATABASE_REF',0)} See 
related topics



Creating a new database that is a ready-to-use application
SmartMasters are fully developed database applications that you can copy and modify. For more information, review 
the description of the applications.
1. Start from one of the following:

• In the Welcome dialog box, click "Create a New File Using a SmartMaster."
• From the File menu, choose New Database.

2. Select Applications in the "SmartMaster types" box.
3. Select an application.
4. Click OK.

• The Approach file (.APR) you create contains forms, worksheets, standard reports, and other features to help 
you conduct business. 

• You can start to enter data now. 
• You can also modify all aspects of the database and the Approach file.

5. To clear the sample data in the database so you can enter your own data, delete all records.

{button ,AL(`H_CREATING_A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_CREATING_A_NEW_DATABASE_
WITH_A_SET_OF_READYTOUSE_FIELDS_STEPS;H_CREATING_NEW_DATABASE_FILES_REF;H_WHY_BU
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',0)} See related topics



Creating a new database with a set of ready-to-use fields
SmartMaster templates provide predefined fields for common kinds of databases. For more information, review the 
description of the templates.
1. Start from one of the following:

• In the Welcome dialog box, click "Create a New File Using a SmartMaster."
• From the File menu, choose New Database.

2. In "SmartMaster Types", select Templates.
3. Select a template.
4. Click OK.

The New dialog box appears.
5. Enter a name for the database file.
6. Select the default database type offered by Approach (dBASE IV) or another file type.
7. Click Create.

• Approach creates the new database file in whatever format you select.
• The Approach file (.APR) you create contains two views: a form and a worksheet. 
• Both views display the fields you created.
• You can start to enter data now. 

Do you really need that .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    

{button ,AL(`H_CREATING_A_NEW_DATABASE_WITH_A_SET_OF_READYTOUSE_FIELDS_DETAILS',1)} See 
details

{button ,AL(`H_CREATING_A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_CREATING_A_NEW_DATABASE_
THAT_IS_A_READYTOUSE_APPLICATION_STEPS;',0)} See related topics



Details: Creating a new database with a set of ready-to-use fields
Joining template files
Each SmartMaster template is a self-contained database file with fields for storing useful data. The template 
databases are more powerful, however, when you join them to other template databases. 

Example
An art gallery wants to create a database application containing information about their inventory using the Art 
Collection template. The Art collection template has the following fields:

• Artwork Title
• Artwork ID
• Artist ID
• Purchase Price

The gallery also wants to store personal information about each of the artists represented in their collection. It is far 
more efficient to keep information about the artists in a separate database, the Artist List template, than to have all 
the related information in one database. The Artist List template has the following fields:

• First Name
• Last Name
• Artist ID
• Nationality

To create a database application, join the two template databases on a unique ID field: Artist ID. This field links the 
artist to works of art in the gallery. Save the databases in one Approach file (.APR). Once the databases are joined, 
the gallery can create views in the Approach file displaying information from both databases. The Approach file could 
have a view for the artwork, another view for the artists, and as many more as are needed.      
                      

{button ,AL(`H_CREATING_A_NEW_DATABASE_WITH_A_SET_OF_READYTOUSE_FIELDS_STEPS',1)} Go to 
procedure

{button ,AL(`H_CREATING_NEW_DATABASE_FILES_REF;H_WHY_BUILD_A_DATABASE_REF',0)} See related 
topics



Creating custom SmartMasters
You can save an Approach file as a custom SmartMaster application (.MPR). You can then use the SmartMaster 
application as the basis for new Approach files.
1. Choose File - Save As.

2. Specify the SmartMaster directory.
The directory is c:\lotus\smartmasters\approach unless you changed it.

3. Select the SmartMaster file type (.MPR) in the "Save as type" box. 
4. (Optional) Enter a new name for the SmartMaster application.
5. Click Save.

Approach saves the Approach file as a SmartMaster application and then displays the Save Database As dialog 
box.

6. Under Save, select whether to save as an Exact copy or a Blank copy.
7. Click Save.
8. If you have more joined databases in this file, repeat steps 5 - 7 for each database.
The custom SmartMaster application appears in the list of SmartMaster applications when you choose File - New or 
when you're in the Welcome dialog and click "Create a New File Using a SmartMaster."

{button ,AL(`H_IDENTIFYING_DEFAULT_DIRECTORIES_STEPS;H_SAVING_A_COPY_OF_AN_APPROACH_FILE
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related topics



Creating databases from delimited text files
When you open an ASCII text file with delimited text, Approach creates

• An Approach file (.APR)
• A database file with a copy of the text-file data

1. From the File menu, choose Open.

2. Select Text - Delimited in the "Files of type" box.
3. Specify the text file and click Open.

The Text File Options dialog box appears.
4. Select the separator used in the text file.

If the separator does not appear in the list, select Other and enter the character.
5. Select the character set used in the text file.
6. To use the text in the first row of the file as field names, select "First row contains field names."
7. Click OK.

The New dialog box appears.
8. Enter a name for the database file in the "File name" box.
9. Select a database file type in the "Create type" box.
10. Click Create.

Do you really need that .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    

{button ,AL(`H_CREATING_DATABASES_FROM_DELIMITED_TEXT_FILES_DETAILS',1)} See details
{button ,AL(`H_CREATING_DATABASES_FROM_FIXEDLENGTH_TEXT_FILES_STEPS;H_CREATING_DATABAS

ES_FROM_SPREADSHEETS_STEPS;',0)} See related topics



Details: Creating databases from delimited text files
Separators
A delimited text file uses separators such as commas, spaces, or tabs to break up the text into discrete units. When 
you create a database from delimited text, these separators mark where one field ends and the next one begins. A 
paragraph return marks where one record ends and the next one begins.

Field names
If the first row of the text file has text that identifies the rest of the file contents (such as Name, Address, and City), 
use this row to provide the field names.
If the first row cannot provide field names, be sure to deselect "First row contains field names." The fields are then 
initially named Field 1, Field 2, Field 3, and so on.    Rename them in the Field Definition dialog box.

{button ,AL(`H_CREATING_DATABASES_FROM_DELIMITED_TEXT_FILES_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_DATABASES_FROM_FIXEDLENGTH_TEXT_FILES_STEPS;H_CREATING_DATABAS

ES_FROM_SPREADSHEETS_STEPS;',0)} See related topics



Details: Creating databases from fixed-length text files
How text is divided
You need to know the contents of the text file to define the text blocks correctly. In a fixed-length text file, the text on 
each line is broken into blocks of text that are a specific length. If the text does not fill the entire length, it has spaces 
after it until the next block begins. 
When you create a database from fixed-length text, tell Approach how long each block of text is. Approach uses fixed-
length fields for the text in the database.
A paragraph return in the text file marks where one record ends and the next one begins. If the records do not have 
paragraph returns, the next record begins at the end of the last block. 

Field names
You can name the fields when you create a database from a fixed-length text file. If the first row of the file has text 
that identifies the rest of the file contents (such as Name, Address, and City), you can use this first row to provide the 
field names.
If you name the fields yourself, follow the restrictions on characters and the length of field names for the database file 
type. 

{button ,AL(`H_CREATING_DATABASES_FROM_FIXEDLENGTH_TEXT_FILES_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_DATABASES_FROM_DELIMITED_TEXT_FILES_STEPS;H_CREATING_DATABASES_
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Creating databases from fixed-length text files
When you open an ASCII text file with fixed-length text, Approach creates

• An Approach file (.APR)
• A database file with a copy of the text-file data

1. From the File menu, choose Open.

2. Select Text - Fixed-Length in the "Files of type" box.
3. Specify the text file and click Open.

The Fixed Length Text File Setup dialog box appears.
4. Select the character set used in the text file.
5. Define the first field with a name and data type.
6. In Start, enter the position of the first character to include in the database.
7. In Width, enter the number of characters contained in the fixed-length block.
8. Repeat steps 5 and 7 for each fixed-length block.

Approach provides the starting position after the first.
9. Click OK.

The New dialog box appears.
10. Enter a name for the database file in the "File name" box.
11. Select a database file type in the "Create type" box.
12. Click Create.

Do you really need that .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    

{button ,AL(`H_CREATING_DATABASES_FROM_FIXEDLENGTH_TEXT_FILES_DETAILS',1)} See details
{button ,AL(`H_CREATING_DATABASES_FROM_DELIMITED_TEXT_FILES_STEPS;H_CREATING_DATABASES_
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Creating databases from spreadsheets
When you open a Lotus 1-2-3 or Microsoft Excel file, Approach creates

• An Approach file (.APR)
• A database file with a copy of the spreadsheet data

1. From the File menu, choose Open. 

2. Select a file type from the "Files of type" box. 
3. Specify the spreadsheet file.
4. Click Open.

To create a database from a Lotus 1-2-3 spreadsheet, select the sheet or named range with the data you want in 
the Select Range dialog box.

5. To use the text in the first row of the spreadsheet as field names, select "First row contains field names" in the 
Select Range dialog box (for Lotus 1-2-3) or the Field Names dialog box (for Excel).

6. Click OK.
The New dialog box appears.

7. Enter a name for the database file in the "File name" box.
8. Select a database file type in the "Create type" box.
9. Click Create.

Do you really need that .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    

{button ,AL(`H_CREATING_DATABASES_FROM_SPREADSHEETS_DETAILS',1)} See details
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Details: Creating databases from spreadsheets
Fields and records
When you create a database from a spreadsheet, the rows in the spreadsheet become records in the database and 
the columns become fields.

Field names
If the first row of the spreadsheet has text that identifies the rest of the contents (such as 1st Qtr, 2nd Qtr, and so on), 
use this row to provide the field names.
If the first row cannot provide field names, be sure to deselect "First row contains field names." The fields are then 
initially named A, B, C, and so on. Rename them in the Field Definition dialog box. 

Data from 1-2-3 and Excel 
When you create a database from a spreadsheet, all of the data from the spreadsheet is copied into the database. 
Any new records you enter and all changes to the data become part of the newly created database file, not the 
spreadsheet.

{button ,AL(`H_CREATING_DATABASES_FROM_SPREADSHEETS_STEPS',1)} Go to procedure
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Creating find conditions for an SQL SELECT statement
Command: File - Open/Edit SQL

Tab: Condition
1. Select the database to be used in the find condition.
2. Select a field in the Fields box.
3. Select an operator in the Operator box. 
4. Enter data used for the find condition in the Values box. 

To create an OR statement, enter data on each line of the Values box. 
5. To create additional criteria for the find, click "Find on Another Field." 
6. In the second Condition tab that appears, click either "Find more records" or "Find fewer records." The first option 

adds an OR between the two Conditions. The second option adds an AND between the two Conditions.
7. Repeat steps 2 - 7 for each additional condition.
8. To delete a condition, click the Condition's tab and then click Delete Condition.

The Delete Condition button appears on all the Condition tabs after you click "Find on Another Field." 
9. Click Next.
Note The Description box displays the find condition you create in an English language format. 

{button ,AL(`H_CONNECTING_TO_AN_SQL_OR_ODBC_DATA_SOURCE_OVER;H_SQL_TABLES_IN_APPROAC
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See related topics



Creating joins for an SQL SELECT statement
Command: File - Open/Edit SQL

Tab: Join
1. Click two fields in different tables that you want to join.
2. Click Join.
3. To create additional joins, select more fields in different tables and click Join again.
4. Click Options.

The Relational Options dialog box appears.
5. To create an inner join between the fields, select Only Matching Records - Only Matching Records.
6. To create a left outer join between the fields, select All Records - Only Matching Records.
7. To create a right outer join between the fields, select Only Matching Records - All Records.
8. Click OK to close the Relational Options dialog box.
9. Click Next.

Creating an alias file
Click Alias to create a copy of the selected database in the Join tab. You can join a field to an alias copy of itself just 
like any other database.
This lets you set up join relationships between fields in the same database without having to duplicate the records in 
another database.

Example
An employee database has unique employee IDs and manager IDs to identify each employee's manager. By creating
an alias copy of the employee database, you can join the manager ID in the first database to the employee ID in the 
second database. The alias database has a one-to-many relationship with the employee database. It displays which 
employees belong under which managers.

Removing joins
To remove the join between the two tables, click the connecting line between two fields and then click Unjoin.
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Creating new database files
You do not need to have any other database product besides Approach to create a database file. 

Default database file type
Approach creates a dBASE IV (.DBF) database file by default.

Other standard file types
The "Create type" box shows the file types available for a new database. Besides dBASE IV, the standard file types 
are dBASE III+, FoxPro, and Paradox. 

Saving the Approach file
Approach automatically creates an Approach file (.APR) for a new database so that you can begin to work with your 
data immediately.
Although Approach automatically saves any data you enter in the database file, it does not automatically save 
the .APR file. 
You can decide whether you need to save this .APR. You may not need it. For more information, see Do you really 
need that .APR? 

{button ,AL(`H_CREATING_A_NEW_DATABASE_FROM_SCRATCH_STEPS;H_CREATING_A_NEW_DATABASE_
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ASE_FILES_OVERVIEW',0)} See related topics



Defining password privileges using Copy
1. From the File menu, choose TeamSecurity.

2. Select one of the defined group or user names.
See details.

3. Click Copy.
The Edit TeamSecurity dialog box appears.
Copy of Name appears in the "Group or user name" box, where Name is the defined group or user name you 
selected.

4. Enter a new name in the "Group or user name" box.
5. Enter a unique password in the "Approach file password" box.
6. Review the settings in the Database tab.

If you want to set a password for a database and require its use, click Database Password, define the password, 
and then select "Require passwords to each database."

7. Review the settings in the View tab.
8. Review the settings in the Advanced tab.

Caution Once the Edit TeamSecurity dialog box is open, Approach will not let you define a password and exit the 
dialog box unless at least one group or user has been assigned password privileges in the Advanced tab.

9. Click OK.
The Confirm Password dialog box appears.

10. Confirm the password by entering it in the "Retype password" box.
11. Click OK to close the Confirm Password and Edit TeamSecurity dialog box.

The new name appears in the TeamSecurity dialog box.
12. Click Done.
13. From the File menu, choose Save Approach File.

{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_COPY_DETAILS',1)} See details
{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_NEW_STEPS;H_DEFINING_PASSWORDS_FOR_

A_DATABASE_STEPS;H_DELETING_GROUPS_OR_USERS_STEPS;H_EDITING_PASSWORD_PRIVILEGES_
STEPS;H_TEAMSECURITY_REF;',0)} See related topics



Details: Defining password privileges using Copy
The TeamSecurity dialog box    has four predefined levels of user privileges. Each level is defined by a set of default 
privileges.
The four levels offer a suggested way of setting up your user privileges. You can create your own levels of user 
privileges and redefine the defaults in the Edit TeamSecurity dialog box.
The following table shows each level of default user privileges and the kinds of access it grants the user:

Level of user 
privilege

Write privileges 
in databases

Have access
to views

Can work 
in Design

Can change 
passwords

Manager Yes Yes Yes Yes
Designer Yes Yes Yes No
Editor Yes Yes No No
Reader No Yes No No

Approach file and database passwords
TeamSecurity lets you set access privileges and passwords for Approach files (.APR). After entering the password, 
you have access to the Approach file's associated database files for modfiying and entering data, and entering new 
records. 
Set passwords for database files in the Password tab of the Preferences dialog box. Set a read/write password, a 
read-only password, or both types of passwords for the database file. You can reach the Preferences dialog box by 
clicking Database Password in the Edit TeamSecurity dialog box.

{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_COPY_STEPS',1)} Go to procedure
{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_NEW_STEPS;H_DEFINING_PASSWORDS_FOR_

A_DATABASE_STEPS;H_DELETING_GROUPS_OR_USERS_STEPS;H_EDITING_PASSWORD_PRIVILEGES_
STEPS;H_TEAMSECURITY_REF;',0)} See related topics



Defining password privileges using New 
1. From the File menu, choose TeamSecurity.

2. Click New.
The Edit TeamSecurity dialog box appears.

3. Enter the name of a group or individual user in the "Group or user name" box.
4. Enter a unique password in the "Approach file password" box.
5. Review the settings in the Database tab.

If you want to set a password for a database and require its use, click Database Password, define the password, 
and then select "Require passwords to each database."

6. Review the settings in the View tab.
7. Review the settings in the Advanced tab.

Caution Once the Edit TeamSecurity dialog box is open, Approach will not let you define a password and exit the 
dialog box unless at least one group or user has been assigned password privileges in the Advanced tab.

8. Click OK.
The Confirm Password dialog box appears.

9. Confirm the password by entering it in the "Retype password" box.
10. Click OK to close the Confirm Password and Edit TeamSecurity dialog box.

The new name appears in the TeamSecurity dialog box.
11. Click Done.
12. From the File menu, choose Save Approach File.

{button ,AL(`H_DEFINING_PASSWORDS_FOR_A_DATABASE_STEPS;H_DELETING_GROUPS_OR_USERS_ST
EPS;H_EDITING_PASSWORD_PRIVILEGES_STEPS;H_DEFINING_PASSWORD_PRIVILEGES_USING_COPY
_STEPS;H_TEAMSECURITY_REF;',0)} See related topics



Deleting connections to Internet servers
1. Choose File - Internet - FTP Connection Setup.
2. Click Hosts.

The FTP Hosts dialog box appears.
3. Select the host you want to delete in the "Host description" box.
4. Click Delete.
5. Click Done to close the FTP Hosts dialog box.
6. Click OK to close the Internet Options dialog box.

{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_I
NTERNET_STEPS;H_EDITING_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;H_MANAGING_PROXIE
S_STEPS',0)} See related topics



Deleting database files
When you delete a database file from within Approach, all associated files (index file, memo file, key field file) are also
deleted. The .APR file is not deleted.
1. From the File menu, choose Delete Approach File.
2. Select the kind of file in the "Delete type" box. 
3. Specify the file you want to delete.
4. Click Delete.

A message box appears.
5. Click Yes to delete the file. 

Deleting files using Windows Explorer
You can delete files in the Windows Explorer, but to ensure that you delete all the files associated with the database, 
delete the file from Approach.
 

{button ,AL(`H_SAVING_A_COPY_OF_AN_APPROACH_FILE_AND_A_DATABASE_FILE_STEPS;H_DELETING_F
ILES_STEPS;',0)} See related topics



Deleting Approach files
1. From the File menu, choose Delete Approach File.
2. Specify the file you want to delete.
3. Click Delete.

A message box appears.
4. Click Yes to delete the file. 

Approach displays a message box for every joined database file associated with the Approach file (.APR).
5. Click Yes to delete the database file, No to keep the file.

Approach deletes all the index and memo files associated with the database file. 

Deleting files using Windows Explorer
You can delete files in the Windows Explorer, but you cannot delete an Approach file and its database files all in one 
step. To ensure that you delete all databases associated with your Approach file, delete the file from Approach.

{button ,AL(`H_SAVING_A_COPY_OF_AN_APPROACH_FILE_AND_A_DATABASE_FILE_STEPS;H_DELETING_D
ATABASE_FILES_STEPS;H_APP_DO_YOU_REALLY_NEED_THAT_APR_OVER;',0)} See related topics



Deleting groups or users
Deleting a group or user deletes the password you associated with that group or user.
1. Choose File - TeamSecurity.

2. Select a group or user name.
3. Click Delete.

{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_NEW_STEPS;H_DEFINING_PASSWORDS_FOR_
A_DATABASE_STEPS;H_EDITING_PASSWORD_PRIVILEGES_STEPS;H_DEFINING_PASSWORD_PRIVILEG
ES_USING_COPY_STEPS;H_TEAMSECURITY_REF;',0)} See related topics



Editing connections to Internet servers
1. Choose File - Internet - FTP Connection Setup.
2. Click Hosts.

The FTP Hosts dialog box appears.
3. Select the host you want to edit in the "Host description" box.
4. Make the changes to the connection.
5. Click Save.
6. Click Done to close the FTP Hosts dialog box.
7. Click OK to close the Internet Options dialog box.

{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_I
NTERNET_STEPS;H_DELETING_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;H_MANAGING_PROXI
ES_STEPS',0)} See related topics



Editing password privileges
1. Choose File - TeamSecurity.

2. Select a group or user name.
3. Click Edit.

The Edit TeamSecurity dialog box appears.
4. Change the password and/or the privileges defined in the Database,View, and Advanced tabs.
5. Click OK to close the Confirm Password and Edit TeamSecurity dialog box.
6. Click Done.
7. Choose File - Save Approach File.

{button ,AL(`H_DEFINING_PASSWORD_PRIVILEGES_USING_NEW_STEPS;H_DEFINING_PASSWORDS_FOR_
A_DATABASE_STEPS;H_DELETING_GROUPS_OR_USERS_STEPS;H_DEFINING_PASSWORD_PRIVILEGE
S_USING_COPY_STEPS;H_TEAMSECURITY_REF;',0)} See related topics



Editing SQL statements
Command: File - Open/Edit SQL

Tab: SQL
To edit the last SQL statement you created while using the current Approach file (.APR), select "Edit the existing SQL 
statement" in the Tables tab before clicking the SQL tab. 
The following procedure is the same whether you are editing an existing SQL statement or in the process of building 
a new one.
1. To move a field from the Fields box to the SELECT Statement box, move your cursor to the desired location and 

double-click the field. 
This inserts the field name used in the SQL statement.

2. To edit the SQL statement, click in the SELECT Statement box and make your changes. 
If you edit the SQL statement, you cannot go back through the SQL Assistant and change the query you made in 
the other tabs. All the tabs in the SQL Assistant are disabled except the SQL tab. 

3. To restore the SQL statement that the Assistant created and remove any edits, click Restore SQL Statement.
All the tabs in the SQL Assistant become available.

4. Click Done.

{button ,AL(`H_CONNECTING_TO_AN_SQL_OR_ODBC_DATA_SOURCE_OVER;H_CREATING_FIND_CONDITIO
NS_IN_THE_CONDITION_TAB_STEPS;H_CREATING_JOINS_IN_THE_JOIN_TAB_STEPS;H_SELECTING_FIE
LDS_IN_THE_FIELDS_TAB_STEPS;H_SORTING_FIELDS_IN_THE_SORT_TAB_STEPS;H_SQL_TABLES_IN_
APPROACH_REF;',0)} See related topics



Entering Approach file passwords
1. Enter the Approach file password exactly as you defined it in the Edit TeamSecurity dialog box.

The password is case-insensitive.
2. Click OK.
3. If you defined a password for the database file associated with the Approach file, enter it in the "Enter dBASE 

password" box.
4. Click OK.

{button ,AL(`H_OPENING_APPROACH_FILES_STEPS;',0)} See related topics



FTP Hosts dialog box

Choose a task
Connecting to Internet servers
Editing connections to Internet servers
Deleting connections to Internet servers



Importing QMF forms in Approach
You must open a QMF Query before you import a QMF form. The type of file (such as DB2, dBASE IV, or Oracle) 
does not matter.    
The QMF form does not contain any data, but its attributes are used to create a new Approach report or crosstab 
view and display data from the open file.

 Are you in Design? 
1. Open a QMF Query.
2. Choose File - Import Approach File.
3. Select QMF Form in the "Files of type" box.

The Logon to QMF Server dialog box appears.
4. Select a server in the "Server Name" box.

If the server you select is an APPC server type, complete the "User ID" and "Password" boxes. 
5. (Optional) Enter the name of the database the QMF server should connect to in the "Database Name" box. 
6. If you do not enter a database name, a connection is made to the default database location on the QMF server.
7. Click OK.
8. (Optional) If a connection string appears, double-click the string.
9. Specify the name of the QMF form to import.
10. Click Open.
11. If the Variable Resolution dialog box appears, enter values for each variable.
12. The Import Approach File Setup dialog box appears (unless the data file and QMF form have fields with the same 

name, in which case they are mapped automatically).
13. Map the fields.
14. Click OK. 

{button ,AL(`H_IMPORTING_QMF_FORMS_IN_APPROACH_DETAILS',1)} See details
{button ,AL(`H_OPENING_QMF_FILES_IN_APPROACH_STEPS;H_QMF_FILES_IN_APPROACH_REF;H_IMPORT

ING_QMF_QUERIES_IN_APPROACH_STEPS;',0)} See related topics



Details: Importing QMF forms in Approach
Some of the QMF form attributes that are supported on the host are not supported when you import the QMF form 
into Approach. The attributes that Approach does not support are listed below.

Attributes Details
FORM.CONDITIONS NA

FORM.DETAIL • Repeat detail heading at the beginning 
of each new break level.

• Include detail values in the group 
summary.

Aggregation codes • FIRST, LAST
• CSUM, PCT, CPCT, TPCT, and TCPCT 

are supported via field definition in 
Approach if entered manually by the 
user.

• STDEV produces different results 
because it is treated as the population 
instead of sample deviation in 
Approach.

• MAXIMUM and MINIMUM are ignored 
for character columns.

Form variables • &row, &count, and some &an variables 
for those aggregation functions that are 
not supported or explicitly supported.

FORM.CALC and 
column definition

• Across reports, including columns with 
CALCid usage code.

• PASS NULLS are ignored.
• Expressions with the following 

operators, functions, or variables:
Arithmetic operators: %, //, and **
Comparative operators:    ==,    /=, /==, 
and    <>
Concatentation operator: | |
Logical operator: &&
REXX execs and built-in functions
Form variables that are not supported; 
however, this is the only attribute that 
does not support the variable &PAGE 
Global variables
Variables representing calculated 
column(s)

Multiple GROUP usage 
codes

• Treated as different GROUP levels.

Duplicate BREAK levels • Treated as different BREAK levels.

Line breaks • Line wrapping width
• Report text line width
• Column wrapped line kept on a page
• Page renumbering at the highest break 

level

Edit codes • Wrap-related
• Binary
• Time stamp



• Graphic
• User-defined time/date
• Locally-defined time/date edit codes

Host related 
dependencies

• REXX execs on host

Fixed columns NA

Across-heading 
separator

• NA; crosstab reports are in worksheet 
format.

Column headings • Group and across-column headings in 
QMF across reports

 

{button ,AL(`H_IMPORTING_QMF_FORMS_IN_APPROACH_STEPS',1)} Go to procedure
{button ,AL(`H_QMF_FILES_IN_APPROACH_REF;H_IMPORTING_QMF_FORMS_IN_APPROACH_STEPS;H_OP

ENING_QMF_FILES_IN_APPROACH_STEPS;',0)} See related topics



Importing QMF queries in Approach
You can import an existing QMF Query's SQL statement using the SQL Assistant. After importing, you can execute 
the SELECT statement against a DB2 server. However, the DB2 data source must already be defined. If it is not 
defined, then QMF Query will not appear in the "Files of type" box.      
1. Choose File - Open/Edit SQL.
2. Select "Create a new SQL statement."
3. Click Add.
4. Select QMF Query in the "Files of type" box.

The Logon to QMF Server dialog box appears.
5. Select a server in the "Server Name" box.

If the server you select is an APPC server type, complete the "User ID" and "Password" boxes.
6. (Optional) Enter the name of the database the QMF server should connect to in the "Database Name" box. 

If you do not enter a database name, a connection is made to the default database location of the QMF server.
7. Click OK.
8. (Optional) If a connection string appears, double-click the string.
9. Specify the name of the QMF query to import.
10. Click Open.
11. (Optional) If the Variable Resolution box appears, enter a value for each variable.

The SQL statement of the QMF Query displays in the SQL tab (whether the Variable Resolution box appears or 
not).

12. Click Done.
The DB2 Logon dialog box appears.

13.  Select the correct database.
14. Complete the "User ID" and "Password" boxes.

The SQL statement is submitted to the DB2 database directly.

{button ,AL(`H_QMF_FILES_IN_APPROACH_REF;H_IMPORTING_QMF_FORMS_IN_APPROACH_STEPS;H_OP
ENING_QMF_FILES_IN_APPROACH_STEPS;H_IMPORTING_DATA_INTO_DATABASES_STEPS;',0)} See 
related topics



Configuring ODBC drivers 
If ODBC is installed on your computer, you need to install an ODBC driver in the Windows Control Panel for each 
database type you wish to open. 
1. In Windows, click Start.
2. Under Settings, click Control Panel. 
3. Double-click the ODBC icon.
4. In the Data Sources box, select Drivers.
5. In the Drivers box, click Add.
6. In the Add Driver box, type the name of the drive and directory for the driver in the text box, or click Browse to 

select a drive and directory name.
7. Click OK.
8. In the Install Drivers box, select the driver you want to install in the Installed ODBC Drivers list.
9. Click OK.

{button ,AL(`H_OPENING_APPROACH_FILES_STEPS;H_DBASE_FILES_IN_APPROACH_REF;H_FOXPRO_FILE
S_IN_APPROACH_REF;H_MICROSOFT_ACCESS_TABLES_IN_APPROACH_REF;H_ORACLE_SQL_TABLES
_IN_APPROACH_REF;H_PARADOX_FILES_IN_APPROACH_REF;H_SQL_TABLES_IN_APPROACH_REF',0)} 
See related topics



Managing proxies
For information and help using proxies, see your system administrator.
1. Choose File - Internet - FTP Connection Setup.
2. Click Hosts.

The FTP Hosts dialog box appears.
3. Select "Use Proxy."
4. Click Edit Proxies.

The Edit Proxies dialog box appears.
5. Do one of the following:

• To add a proxy, click New and enter the proxy address and port.
• To edit a proxy, select the proxy address and enter the new information.
• To delete a proxy, select the proxy address and click Delete.
• To make a proxy the default, select the proxy address and select "Default proxy."

6. Click Save.
7. Click Done to close the Edit Proxies dialog box.
8. Click Done to close the FTP Hosts dialog box.
9. Click OK to close the Internet Options dialog box.

{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_I
NTERNET_STEPS;H_CONNECTING_TO_INTERNET_SERVERS_STEPS;H_DELETING_CONNECTIONS_TO_
INTERNET_SERVERS_STEPS;H_EDITING_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;',0)} See 
related topics



Mapping fields
Approach uses field mapping to ensure

• The accuracy of field definitions
• The relationship between fields in a view and data in a database

How do you map fields?
When you map fields, you work only

• In the center column, headed by a blue arrow

• In the right-hand column, which lists the fields of the current database

To Do this
Map a field on the left to a 
field on the right

Click the center column 
between them. An arrow 
appears. 

Unmap fields Click the arrow between the 
fields to remove it.

Move a field on the right so it 
lines up with a field on the left

Drag the field and drop it on 
another. The two fields swap 
positions.

Unmap all fields at once Click Clear.
Restore Approach's original 
attempt to map the fields

Click Clear, and then click 
Automatically Line Up Fields.

When do you need to map fields?
Approach tries to map fields, but it cannot always follow the logic of what you want to do, so it's important to check 
how fields are mapped. Approach automatically maps fields with the same name unless they have different field 
types.
The following table describes the situations in which you may need to map fields.

File 
command

Left column 
shows

Right 
column 
shows

Mapping 
answers this 
question

Open
(more 
information, 
below)

Fields as they 
were the last 
time you 
saved 
the .APR

Fields as they
now are in the
current 
database

Which fields 
on the left 
correspond to 
which fields on
the right?

Import Data
(in Browse)

Fields of data 
you want to 
import

Fields in the 
current 
database

Which fields in
the current 
database 
should get the 
incoming 
data?

Import 
Approach File
(in Design)

Fields used in 
the views you 
want to import

Fields in the 
current 
database

What data in 
the current 
database 
should appear 
in the fields of 
the incoming 
views?

Replace 
button in the 

Fields in the 
current 

Fields in the 
database file 

Which fields 
on the left 



Join dialog 
box

database and 
the database 
file it is joined 
to        

joined to the 
current 
database and 
in the 
database file 
that is to 
replace the 
current 
database    

correspond to 
which fields on
the right?

Mapping fields when opening a file
When you open an Approach file, the field mapping dialog box appears if the following is true:
The last time you worked in this file, or in a file associated with the same database you are trying to open, you 
changed the definition of a field in the database, and then you closed the Approach file without saving it (the .APR).
Field definition changes that require you to save the Approach file:

• Deleting a field from the database (Create - Field Definition - Delete)
• Changing the name of a field
• Changing the field type

Unmapped fields
You don't have to map all fields. Approach ignores all unmapped fields. They do not show data in the Approach file.
File - Import Data: Unmapped fields do not receive any imported data.
File - Open and File - Import Approach File: Field boxes that were associated with fields you did not map show no 
data.

• In Design, when View - Show Data is turned off, these field boxes display NO_FIELD_REFERENCE instead of a 
field name.

• In Browse, when you select one of these fields, a message tells you that you cannot edit the field. Go to Design 
and assign a database field to it.      

        



New File
If you're trying to add a new view, you do not need to create a new database or Approach (.APR) file. From the 
Create menu, choose the type of view you want to add. 
At the end of this task, you will have created at least two files:

• A database file, where data is stored
• An Approach file (.APR), where you

• Use forms and other views to enter the data that you want to store in the database
• Manipulate your data using different views that you create

If you plan to join databases, you do not necessarily need to save an .APR for each database. For more information, 
see Do you really need that .APR?
Tip If you want to create a database from a spreadsheet, make sure the information in the first row of the 
spreadsheet can be used as field names in Approach. 

Choose a task
Creating a new database from scratch 
Creating a new database with a set of ready-to-use fields 
Creating a new database that is a ready-to-use application 

How do I create an Approach file for a database that already exists?
 Opening databases created in other applications



Opening Approach files
To use a database that already has an Approach file (.APR) associated with it, open the Approach file rather than the 
database file. 
If you're trying to access an ODBC database from Approach, you must first configure the ODBC driver and create a 
data source for each database type.    
1. From the File menu, choose Open. 

2. Specify the Approach file to open.
Caution: If you select a database file, Approach creates a new .APR file for it, even if an Approach file associated
with the database already exists. If you save this new Approach file, you may write over the existing one.

3. (Optional) To open the file only for viewing, select "Open as read-only."
4. Click Open.
5. If necessary, map the fields in the file and click OK.

Opening one of the last Approach files used
Select one of the names at the bottom of the File menu or in the Welcome dialog box.

{button ,AL(`H_OPENING_APPROACH_FILES_DETAILS',1)} See details
{button ,AL(`H_CLOSING_APPROACH_FILES_STEPS;H_IMPORTING_APPROACH_FILES_STEPS;H_MAPPING_

FIELDS_REF;H_OPENING_DATABASES_CREATED_IN_OTHER_APPLICATIONS_STEPS;H_PASSWORDS_O
VER;H_OPENING_FILES_CREATED_IN_PREVIOUS_VERSIONS_OF_APPROACH_REF;',0)} See related 
topics



Details: Opening Approach files
Open as read-only 
If this setting is on, you cannot edit data, but you can save design changes in the Approach file. This setting applies 
only to your current session with the file.

Database file passwords
If a database requires a password, Approach asks you to provide the password when you open an Approach file that 
uses that database.
A database can have a read/write password, a read-only password, or both a read/write and a read-only password. 

{button ,AL(`H_OPENING_APPROACH_FILES_STEPS',1)} Go to procedure
{button ,AL(`H_CLOSING_APPROACH_FILES_STEPS;H_IMPORTING_APPROACH_FILES_STEPS;H_MAPPING_

FIELDS_REF;H_OPENING_DATABASES_CREATED_IN_OTHER_APPLICATIONS_STEPS;H_SETTING_PASS
WORD_PRIVILEGES_STEPS;',0)} See related topics



Opening Approach files from an FTP server on the Internet
1. Choose File - Internet - Open from Internet.

Or 
Choose File - Open and click Internet.

2. Select "FTP" as the server type.
3. (Optional) To create a new connection to an FTP server, click Hosts.
4. Select a host server from the "FTP Servers" box.
5. Click Connect if you do not have the Auto connect option checked in the Internet Options dialog box.
6. (Optional) Specify the directory containing the file you want to open.
7. Select the file.
8. Click Open.

{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_OPENING_APPROACH_FILES_FROM_A_SERVER_
ON_THE_INTERNET_OVER;H_OPENING_APPROACH_FILES_FROM_A_WEB_SERVER_ON_THE_INTERNE
T_STEPS;H_SAVING_APPROACH_VIEWS_TO_OTHER_FILE_FORMATS_STEPS;H_SAVING_APPROACH_VI
EWS_TO_THE_INTERNET_STEPS;H_SETTING_AUTOMATIC_CONNECTIONS_TO_THE_INTERNET_STEPS;
H_CONNECTING_TO_INTERNET_SERVERS_STEPS;H_DELETING_CONNECTIONS_TO_INTERNET_SERVE
RS_STEPS;H_EDITING_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;H_MANAGING_PROXIES_STEP
S',0)} See related topics



Overview: Opening Approach files from a server on the Internet

FTP and World Wide Web servers
You can download files from either a File Transfer Protocol (FTP ) server or from a Web server. 

• If you download from an FTP server, you can browse through different directories to find the file you want. 
• If you download from a Web server, you must know the exact name and location of the file, for example 

http://www.lotus.com/helpfile.apt.

APT files
You can download Approach .APT files that you or another user place on the server. Approach places the file you 
download in a directory on your system as a read-only file. If you want to make changes to the file, choose File - Save
As to save it under a new name as an .APR file. Approach prompts you for new names for the .APR and any 
associated databases.

Auto connect to a server
You do not have to select a host server in the Open from Internet dialog box every time you open a file. Select one of 
the auto connect options from the Internet Options dialog box. The FTP server you select becomes the default for 
opening files from the Internet. See "Setting automatic connections to the Internet." 

List by description
Select the "List by description" box to display the FTP servers by name. Deselect "List by description"    to display the 
FTP servers by their IP address. 

{button ,AL(`H_OPENING_APPROACH_FILES_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_OPEN
ING_APPROACH_FILES_FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS;H_WORKING_WITH_THE_I
NTERNET_OVER;',0)} See related topics



Opening Approach files from a Web server on the Internet
1. Choose File - Internet - Open from Internet.

Or 
Choose File - Open and click Internet.

2. Select "WWW" as the server type.
3. Enter the URL path and the name of the file you want to open.

For example, to open an Approach file from the Lotus Web page, type http://www.lotus.com/filename.APT.
4. If you use a server proxy, select "Use proxy" and select the proxy name.
5. Click Open.
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Details: Opening databases created in other applications
Open as read-only 
If you check this setting, you cannot enter or edit data, but you can save style and layout changes.

SQL tables
If you select Oracle, SQL Server, DB2-MDI, Notes, or any other client/server type and are not already connected to 
an SQL server, a dialog box appears that lets you connect to the server.

Key fields for a Paradox database
Approach requires a key field to work with Paradox tables. If you open a Paradox database and Approach cannot find
a key field, Approach asks if you want to make a copy of the database with a key field. Type a different name for the 
copy and click Save. Approach creates a copy of the database file and adds the new field to it, with a unique number 
for each record.

Saving in another file type
You can save the database file as another file type. For example, if you open a database that's on a mainframe 
computer, save a copy of the database in dBASE IV so you can use it on your own computer.
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Opening databases created in other applications
Opening a database created in another application in Approach creates a new Approach file (.APR).
The data remains in the original database file. The Approach file provides a set of views of the data and lets you enter
new data.
1. Choose File - Open.

2. Select the database file type in the "Files of type" box. 
3. Specify the database.
4. (Optional) To open the database file only for viewing, click "Open as read-only."
5. Click Open.

Approach creates a new file (.APR) with a default form and worksheet.
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Opening QMF files in Approach
You can open QMF procedures and queries from Approach. The queries and procedures are run on the QMF server, 
and the results appear in an Approach form and worksheet.        
1. Choose File - Open.

2. Select the QMF Procedure or QMF Query file type in the "Files of type" box.
The Logon to QMF Server dialog box appears.

3. Select a server in the "Server Name" box.
If the server you select is an APPC server type, complete the "User ID" and "Password" boxes. 

4. (Optional) Enter the name of the database the QMF server should connect to in the "Database Name" box. 
If you do not enter a database name, a connection is made to the default database location on the QMF server. 

5. Click OK.
6. (Optional) If a connection string appears, double-click the string. 
7. Specify the name of the QMF procedure or query to open.
8. Click Open.
9. If the Variable Resolution dialog box appears, enter values for each variable. 
10. Click OK to close the Variable Resolution dialog box.      
11. Click OK.
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Details: Opening QMF files in Approach
DASPWAPI.INI
The names of all the server profile entries displayed in the "Server Name" box are defined in the client connections 
initialization file, DASPWAPI.INI. 
Approach provides a sample DASPWAPI.INI file if it is not already on your system. You can customize the sample 
DASPWAPI.INI file to your needs. If you do not have an existing DASPWAPI.INI, then DASPWAPI.INI is located by 
default in the Approach main directory. You can change the location of the initialization file during installation or by 
using the DSSPATH registry setting. 
Edit DASPWAPI.INI with any text editor. For more information on setting parameters in the client connections 
initialization file, see    the header of the sample DASPWAPI.INI.
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Opening query files in Approach
• When you open a query file (.QRY), you automatically connect to a server using the log-on information in the file. 
• The SELECT statement executes a find or sort and returns data to a read-only file on your hard-disk drive.

1. Choose File - Open. 

2. Select Query in the "Files of type" box.
3. Specify the file you want to open.
4. Click Open.
5. If a Connect box appears, fill in the information.

The box appears if you are not already connected to the appropriate SQL server.

{button ,AL(`H_QUERY_FILES_IN_APPROACH_REF;',0)} See related topics



Open dialog box
See files in all drives and directories and open databases that have already been created, either in Approach or 
another application. 
To open an existing database in Approach, open the Approach file associated with the database. When you open an 
Approach file, you may have to enter a password. 
When you open a database created in another application, Approach automatically creates a new Approach file for it. 
After saving the Approach file, you can work with the database as if it had been created in Approach.

Choose a task
Opening Approach files
Entering Approach file passwords
Creating databases from spreadsheets 
Opening databases created in other applications
Creating databases from delimited text files
Creating databases from fixed-length text files 
Opening query files in Approach
Connecting to an SQL or ODBC data source



Open from Internet dialog box
You can open an Approach .APT file from a File Transfer Protocol (FTP) server or a World Wide Web server via the 
Internet. When you open an .APT file on the Internet, Approach copies the file to your workstation as a read-only file. 
If you want to make changes to the file, save it under a new .APR file name.

Choose a task
Opening Approach files from a Web server on the Internet 
Opening Approach files from an FTP server on the Internet 



Publishing Approach views to the Web
When you publish the current Approach view to the Web, not every part of the Approach view is saved in HTML 
format. For example, field data remains the same after conversion to HTML, but some user interface controls are 
changed or deleted.        
The following table shows which parts of an Approach view are saved to HTML format.

 Parts of the view  Saved to 
HTML?

Comment

Buttons No Buttons do not appear 
on the HTML page.

Check boxes No The check box's label 
and current value 
appear in HTML.

Radio buttons No The radio button's label 
and current value 
appear in HTML.

Pictures No All pictures are deleted.
Field data Yes All field data is saved.
Labels in reports, 
worksheets, and 
crosstabs 

Yes Labels appear at the top
of each HTML page.

Labels on forms Yes Labels appear in HTML 
in the same relative 
position as in the view.

Scrolling lists Yes A scrolling list is 
converted to a field box 
and displays the current
value.
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Save Approach File As dialog box
The Save Approach File As dialog box lets you save copies of your Approach files and their associated database files
under a new name. The copies can be saved to the same or a different location, and in the same or a different file 
type.

Choose a task
Saving a copy of an Approach file only
Saving a copy of an Approach file and a database file 
Creating custom SmartMasters



Saving Approach files
Save an Approach file when you make design changes, create joins, or change field definitions. Examples of design 
changes include:

• Customizing the layout of a view
• Changing color, fonts, and styles
• Adding additional fields or changing the existing ones    

Saving an Approach file the first time
1. From the File menu, choose Save Approach File.

2. Specify a name and location for the file. 
3. (Optional) Enter a description of the file. 
4. Click Save.

Saving changes to existing Approach files
From the File menu, choose Save Approach File.

Saving joins
You must save the Approach file whenever you create joins.    

Why is Save Approach File dimmed on the menu?
Save Approach File is dimmed until you change the design of the .APR file. When you change the design of the .APR
file, Save Approach File becomes available.          
If you change data in records or add new records, Save Approach File stays dimmed because Approach saves data 
automatically.              

Do you really need this .APR?
If you're building a database application and plan to join database files, you may not need this Approach file, but only 
the database file that Approach automatically created along with it. For more information, see Do you really need 
that .APR?    
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Details: Saving Approach files
Approach files and database files
You work with two kinds of files in Approach: Approach files (.APR) and database files.
An Approach file stores 

• Views, and all their style and layout information
• Calculated fields
• Variable fields

You do all your work in Approach files, including entering and editing data, finding and sorting records, and organizing
and printing information.
The data you see in an Approach file is stored behind the scenes in one or more database files. You do not work 
directly in a database file, but use the Approach file as a "window" into it. You can work with database files in a variety
of file formats in Approach. 
When you create a new database file in Approach (or open an existing database file, spreadsheet, or text file from 
another application), Approach automatically creates and opens a new Approach file so that you can begin entering 
data. Then whenever you want to work with the data again, you open the Approach file for it rather than the database 
file. You can do this from the Welcome dialog box or the File menu.
You don't need to save changes to your data. Approach automatically saves changes to data in an underlying 
database file as you work and whenever you close a file.
You need to save an Approach file manually after Approach creates the file (such as for a new database file) and 
whenever you make design, join, or field definition changes. You do this by choosing File - Save Approach File.
You can also save a copy of a database file and an Approach file, either to back up a database or to prepare a 
template for other databases. 
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Saving Approach views to other file formats 
You can save reports, worksheets, and forms to other file formats. The available file formats are .htm (for HTML), .rtf 
(Rich Text Format), and .txt (Plain Text). Forms can only be saved to the .htm file format.The .rtf and .txt file formats 
are only available for reports and worksheets.
Note File - Save View As is only available in the Browse and Print Preview environments.
1. Choose File - Save View As.
2. Specify a location to save the file in the "Save in" box (unless you want to save the file to an FTP server). 
3. Enter a name in the "File name" box.
4. Select a file type in the "Save as type" box.
5. (Optional) To specify layout and navigation preferences for an HTML file, click Preferences. 

• Enter your preferences.
• To save your preferences as the default, click Save Default.
• Click OK. 

6. To save the view as an HTML file to your local drive, click Save.
7. (Optional) To save the view as an HTML file to an FTP server on the Internet, click Internet.

The Save to Internet dialog box appears.
8. (Optional) Select a host server and specify a location on the FTP server for the file.
9. (Optional) Click Save.

The Preferences dialog box appears.
10. (Optional) Specify layout and navigation preferences.
11. (Optional) Click OK.    
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Details: Saving Approach views to other file formats

HTML files
You can save Approach views as Hypertext Markup Language (HTML) files. HTML is an authoring language used to 
create documents for the World Wide Web. HTML files contain commands, called tags, that specify how a document 
appears onscreen in a browser. 

HTML files also support links to other documents, graphics, audio, and visual files. 

Approach automatically creates tags and links when you save the view. If you view HTML files with a text editor, such 
as Wordpad, you can see the tags around the contents of the file. 

Creating .HTM files
Saving Approach views as HTML files creates a separate .HTM file for each page of the view. Each of these .HTM 
files is saved under the name you entered in the "File name" box. All the pages except for the first one end with an 
underscore character (_) and a page number. 
These files are saved on your local drive in whatever directory you indicate unless you choose to save them directly 
to the Internet.
For example, if you save a three-page worksheet named "Employee" to the HTML format, Approach creates the 
following files:

• EMPLOYEE.HTM contains page 1 of the worksheet.
• EMPLOYEE_2.HTM contains page 2 of the worksheet.
• EMPLOYEE_3.HTM contains page 3 of the worksheet. 

Viewing .HTM files 
To view .HTM files, open them in a text editor or double-click them in Windows Explorer. When the Open With dialog 
box opens, create an association between the .HTM file and whatever Internet browser you use. This method lets you
view the files as they look on the Internet. 
Each .HTM file represents a page of the view you save. When you move from one page to another, you are moving 
from one .HTM file to another. By default, you can navigate through the pages by clicking Previous, First, Next, or 
Last at the bottom of each page. Approach lets you position the navigation commands at the top of the page, the 
bottom of the page, at both locations, or not display them.    
After saving your Approach views to the HTML file format, upload the .HTM files to the Internet using your FTP 
software. 

Saving forms as HTML files
When you save a form to HTML, one page is created regardless of how many records are in the found set. When you
save worksheets and reports, everything in the found set is saved and as many pages as needed are created.

Internet
Save your HTML files to an FTP site on the Internet by clicking Internet. The Internet button is only available for the 
HTML file type. Enter your FTP server information and specify a location to save the file in the Save to Internet dialog 
box. When you click Save, the Preferences dialog box appears (even if you have already entered your preferences). 
This lets you make any necessary changes to the preferences before you save the HTML file to the Internet.        

HTML preferences
You can specify HTML layout and navigation preferences and an Internet e-mail address by clicking Preferences in 
the Save View As dialog box.    
Select/deselect the Preferences options:    

• Specify whether you want Approach to create an Index page 
• Specify whether to display a border around tables.
• Specify where navigation links (Previous, First, Next, Last) appear on each HTML page.
• Specify an Internet e-mail address (for forms only) in the "Send e-mail from HTML forms to this address" box.

When you use this option, your HTML form on the Internet includes the specified e-mail address. Anyone who 
wants to respond to your HTML form can automatically send a return message to this address.            

Saving preferences
When you select your preferences and click OK, they are used only for the current save operation. They do not 
become default preferences. After you finish the current save operation and close the Save View As dialog box, these



settings do not remain. The next time you open the Preferences dialog box the default settings are again in effect. If 
you want to save your current preferences as defaults, click Save Default.      

Saving views as .RTF and .TXT files
Save Approach views to the .RTF and .TXT formats when you want to create a report from information in the view. 
Use your word processor's Copy and Paste Special commands to bring the .RTF or .TXT files into your word 
processor and edit the report.      
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Saving Approach views to the Internet
Appproach lets you combine selected views and data into a single .APT file and place it on an Internet server. Other 
Approach users can download the .APT file and extract their own read-only version of your information. 
1. Choose File - Internet - Save to Internet.

Or
Choose File - Save As and click Internet.

2. Under Save, either use the default option "Current view only" or select    "All of the views."
3. (Optional) Deselect "Include data from" if you want only the Approach (.APR) file saved in the .APT file.
4. Select the amount of data you want to save: "All databases, " "Found set," "Current record," or "Blank databases."

If you selected "All of the views" under Save, only "All databases" or "Blank databases" are available.
5. Click Save.
6. (Optional) If you have no servers configured, click Hosts.

Enter the connection information in the FTP Hosts dialog box. If you do not know the host's IP address, contact 
your Network Administrator. You must click Save to save the information before you click Done.

7. Select a host server from the "FTP Servers" box.
8. Click Connect.
9. Specify a location on the server for the file.
10. Enter a file name with an .APT file extension in the "File name" box.
11. Select Lotus Approach (.APT) in the "Save as type" box.
12. Click Save.
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Details: Saving Approach views to the Internet
Saving Approach files as .APT files 
File - Internet - Save to Internet lets you share Approach views across the Internet with other Approach users. When 
you save an Approach view to the Internet, the .APR file and its associated databases (.DBF files) are packaged as 
an .APT file to an FTP (File Transfer Protocol) server. The .APT file is copied to the specified Internet location. 
When other users want to access the Approach view, they use an FTP server to download it . The .APT file is copied 
to the local directory. This file is read-only until the recipient chooses the File, Save As command. When the file is 
saved, both an .APR and a database file (.DBF) are created. 

Auto connect to a server
You do not have to select a host server in the Save to Internet dialog box every time you upload a file. Select one of 
the auto connect options from the Internet Options dialog box. The FTP server you select becomes the default for 
saving views to the Internet. See "Setting automatic connections to the Internet." 

List by description
Select the "List by description" box to display the FTP servers by name. Deselect "List by description" and click the 
drop-down box to display the list of FTP servers by their IP address. 
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Details: Saving a copy of an Approach file and a database file
Exact copy 
Exact copy makes an exact copy of the database, including the data. Use this setting to create a backup of a 
database. 

Blank copy (save without records)
Blank copy makes a copy of the database with everything except    the data. Use this setting to create a template for 
other databases.

Same database
Same database associates the new Approach file to the same database file. The name of the database file does not 
change.

Saving joined databases
When you save joined databases, the Save Database As dialog box appears for each database. The name of each 
joined database appears in the File name box. Select one of the Save options for each database and click Save. You 
can save a copy of the joined database with or without data on an individual basis. 
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Saving a copy of an Approach file and a database file
Saving a copy of an Approach file (.APR) and its associated database file(s) lets you do any of the following:

• Back up a database application
• Move and rename Approach and database files
• Create a template or SmartMaster application for new databases

1. From the File menu, choose Save As.

2. Specify a different location and/or name for the copy of the Approach file.
3. (Optional) Enter a description of the file.
4. Click Save.

Approach saves the Approach file (.APR) and then displays the Save Table As dialog box.
5. Specify a different location and/or name for the copy of the database file. 
6. (Optional) To change the type of database, select a type in the "Save as type" box.
7. Under Save, select "Exact copy," "Blank copy," or "Same database."

Note If you select "Exact Copy" or "Blank Copy" and do not specify a different database file name and/or location 
for the copied file, none of the changes you have made so far are saved, and the message "Database cannot be 
saved over itself" appears.

8. Click Save.
When you save joined database files, the Save Table As dialog box appears for each database. 

9. (Optional) Repeat steps 5 - 8 for each joined database file.
10. (Optional) If you saved the data to a different database file format, specify a key field.
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Saving a copy of an Approach file only
You can set up multiple Approach files that are all associated with the same database file(s).
1. Choose File - Save As.

2. Specify a different location and/or name for the copy of the Approach file.
3. (Optional) Enter a description of the file.
4. Select "Save .APR file only."
5. Click Save.
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Selecting fields for an SQL SELECT statement
Command: File - Open/Edit SQL

Tab: Fields
1. Be sure the database containing the field you want is showing in the Database box.
2. Select a field in the Fields box.

Use SHIFT+click or CTRL+click to select more than one field.
3. Click Add.
4. To add additional fields, repeat steps 1 - 3.
5. Click Next.
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Selecting tables for an SQL SELECT statement
Command: File - Open/Edit SQL

Tab: Tables
1. Select "Create a new SQL Statement."
2. To add one or more tables to the Selected Tables box, click Add.

The Open dialog box appears.
3. Select a database file type in the "Files of type" box.
4. Click Connect.

The Connect To dialog box appears if it is needed for the file type selected in step 2. 
5. Enter information into Server name, User name, and Password, or select a Prior connection.

On some types of connections, you can reuse the information in Prior connections.
6. Click OK to close the Connect To dialog box.
7. Select the name of the table to open in the File name box.
8. Click Open.

All the selected tables appear in the Selected Tables box.
9. Click Next.

Removing a table 
To remove a table from the Selected Tables box, select the table and click Remove.

Connecting to dBASE files
dBASE files do not require entering information into the Connect To dialog box.
You can only have one non-SQL database (such as dBASE) open at any time.
        

{button ,AL(`H_CONNECTING_TO_AN_SQL_OR_ODBC_DATA_SOURCE_OVER;H_CREATING_FIND_CONDITIO
NS_IN_THE_CONDITION_TAB_STEPS;H_CREATING_JOINS_IN_THE_JOIN_TAB_STEPS;H_EDITING_SQL_S
TATEMENTS_IN_THE_SQL_TAB_STEPS;H_SELECTING_FIELDS_IN_THE_FIELDS_TAB_STEPS;H_SORTING
_FIELDS_IN_THE_SORT_TAB_STEPS;H_SQL_TABLES_IN_APPROACH_REF;',0)} See related topics



Setting automatic connections to the Internet
If you regularly connect to the same server, set options so that you automatically connect to that server when opening
or saving a file on the Internet.
1. Choose File - Internet - FTP Connection Setup.
2. To connect to the same    server whenever you download files, select "Auto connect Open from Internet" and the 

name of the server.
3. To connect to the same server whenever you upload files, select "Auto connect Save to Internet" and the name of

the server.
4. To record the date, time, and location of the files you download, select "Capture record of Open from Internet."
5. (Optional) To add or edit connection information, click Hosts.
6. Click OK.

{button ,AL(`H_WORKING_WITH_THE_INTERNET_OVER;H_CONNECTING_TO_INTERNET_SERVERS_STEPS;
H_DELETING_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;H_EDITING_CONNECTIONS_TO_INTERN
ET_SERVERS_STEPS;',0)} See related topics



Sorting fields for an SQL SELECT statement
Command: File - Open/Edit SQL

Tab: Sort
1. Be sure the database containing the field you want is showing in the Database box.
2. Select a field in the Fields box.

Use SHIFT+click or CTRL+click to select more than one field.
3. Click Add.
4. To determine the sort order, select Ascending or Descending.
5. To add additional fields, repeat steps 1 - 4.
6. Click Next.

{button ,AL(`H_CONNECTING_TO_AN_SQL_OR_ODBC_DATA_SOURCE_OVER;H_CREATING_FIND_CONDITIO
NS_IN_THE_CONDITION_TAB_STEPS;H_CREATING_JOINS_IN_THE_JOIN_TAB_STEPS;H_EDITING_SQL_S
TATEMENTS_IN_THE_SQL_TAB_STEPS;H_SELECTING_FIELDS_IN_THE_FIELDS_TAB_STEPS;H_SORTING
_FIELDS_IN_THE_SORT_TAB_STEPS;H_SQL_TABLES_IN_APPROACH_REF;H_DBASE_FILES_IN_APPROA
CH_REF',0)} See related topics



TeamSecurity
When you open the Edit TeamSecurity dialog box, all the databases and views are already selected by default. If you 
are setting the privileges for other users, you must deselect any databases or views you do not want them to have 
access to.

Groups of users
A group consists of a number of individuals who use the same name and password to access an Approach file. 
For example, if you wanted to have a group called Team A, enter Team A as the group name, enter a unique 
password, and set the privileges you want everyone in the group to have. Then inform everyone belonging to Team A 
to use that unique password.

Single-password access
After you set your password, the user only has to enter a single password to have access to the Approach files 
(.APR). Even if the database is joined to other database files, the user only has to enter the password once when 
opening the Approach file containing the joined databases.
To set passwords for the Approach file's associated database files, you must open the Preferences dialog box and 
define the database password in the Password tab. You can reach the Preferences dialog box by clicking Database 
Password in the Edit TeamSecurity dialog box.

Example
Say that the Employee database is joined to the Product, Salary, and Region databases. Use TeamSecurity to assign
the same password to all four databases at the Approach file level. Once you open Employee and enter your 
password once, you can open Product, Salary, and Region without being prompted for additional passwords.
If all four databases had been assigned different passwords in the Preferences dialog box, you would need to enter 
database passwords for each file.

Database
Define read/write and read-only privileges in the Database tab. To give the user read/write privileges to modify 
existing data, enter new data or new records, select the database. Deselect the database to make it read-only.

Requiring database passwords
Select "Require passwords for each database" to override single-password access and require users to enter a 
password for each database.

View
Select which views a user can have access to in the View tab. For example, you might want to let a certain user have
access to the database and worksheet, but not have access to forms and reports.
Any views that exist display in the View tab. Selecting the view lets the user have access to it. Deselecting the view 
means it is hidden from the user. 
Note New views added after you define user privileges are available by default, so the password administrator must 
edit privileges to hide the new view.

Advanced
In the Advanced tab, you specify who has designer privileges and can change passwords. This is the highest level of 
TeamSecurity. Any user having password privileges can also decide read-only and view privileges for other users. At 
this level of privilege, you also have access to Design; other users do not.
There must be at least one user at the password privileges level of security, and you can have as many users at this 
level as you want. Once the Edit TeamSecurity dialog box is open, Approach will not let you define a password and 
exit the dialog box until someone has been assigned password privileges in the Advanced tab. If no one was 
assigned password privileges, then all users could potentially be locked out of the Edit TeamSecurity dialog box.
 



TeamSecurity dialog box
The TeamSecurity dialog box lets you define passwords for the Approach (.APR) file, as well as who has the right to 
change or define passwords. You can limit which views the users have access to, their read/write privileges in the 
databases associated with the Approach file, and who can make changes to the Approach file.
Set passwords for databases in the Preferences dialog box.

Choose a task
Defining password privileges using Copy
Defining password privileges using New
Editing password privileges
Deleting groups or users
Defining passwords for a database 



Welcome dialog box: Open an Existing Approach File

Most recently used files
Double-click the file you want in the list, or select a file and click OK.

Browse for More Files
Click to open the Open dialog box, where you can see files in all drives and directories. Use this dialog box to open 
existing data files created with other applications as well as Approach (.APR) files.

Open SQL
Click to open the SQL Assistant, where you can create an SQL SELECT statement.

Hiding the Welcome dialog box
1. Choose File - User Setup - Approach Preferences.

2. On the Display tab, under Show, deselect Welcome dialog.
3. Click OK.



Overview: Opening Approach files on the Internet
Using Approach, you can open a compacted Approach (.APT) file from a File Transfer Protocol (FTP ) server or a 
World Wide Web server via the Internet. You can also save an .APR and its associated databases as an .APT file to 
an FTP server.
Before you can open or save a document on the Internet, the following must be true:

• Your computer and the server must both be connected to the Internet.
• Your computer must have a WinSock-compatible TCP/IP stack installed.
• The server must meet one of the following criteria:

• It is a public Web server.
• It supports anonymous FTP.
• It supports FTP and you have an account with permission to access files.

Opening and modifying files
When you open an .APT file on the Internet, Approach copies the file to your computer, where you can view it as a 
read-only file. If you want to make changes to the file, from the File menu, choose Save As, and Approach prompts 
you for a new .APR file name and new names for all the associated databases. 
If you have read-write permission for an FTP server, you can save the modified file. From the File menu,    choose 
Internet, and then choose Save to Internet. Approach compacts the .APR and associated databases into a 
single .APT file, so other users can open the file to view the changes. 

FTP servers
FTP servers are owned by companies or Internet providers who use them to store files for displaying on the Internet. 
If you have access to an FTP server, you can store and retrieve files in much the same way as you would do the 
same tasks on your computer. To connect to an FTP server you need to know its unique IP address. 
You can maintain a list of the addresses of FTP servers you use most often. You can also add, edit, and delete FTP 
connection information. Access to FTP servers can be anonymous or require a user ID and password. You can 
access a server directly or via a firewall, which is hardware or software designed to prevent unauthorized access to a 
server.

Web servers
Web servers display Web pages on the Internet. They have a unique IP address and a domain name such as 
lotus.com. When you enter the URL (Universal Resource Locator) http://www.lotus.com in your browser, it sends a 
request to the server lotus.com to send a page, so it sends INDEX.HTML and your browser displays it.
To open other files on a Web server you must know the exact path and file name, for example:
http://www.lotus.com/support/approach.apt

Connecting to servers
If you regularly connect to the same server, you can set Internet options so you automatically connect to that server 
when you open or save a file on the Internet. You can also capture a transaction record of the date, time, and full path
of the file you open from the Internet.
For each Internet connection, Approach keeps a log of the messages sent from the server. The log file is called 
LTSNET.LOG and is stored in the Windows\Temp directory. Approach only maintains a log of your most recent 
connection and writes over the file each time you connect to a server.

Internet SmartMaster application
Approach has a SmartMaster application called Internet World Wide Web Sites that lets you work with the Internet. It 
contains a list of over 500 Web sites that you can browse through using the WebTrek browser supplied with 
Approach, or your own Internet browser tool. Web pages are listed by title, category, and URL, and you can sort on 
any of these fields. 
If you would like to search for a particular Web site, you can search by category, keyword, or URL. If information 
about a Web site changes, you can edit the data. You can also add new Web sites to the database.

Internet file retriever
You can use Approach to download files that are not Approach files from FTP or World Wide Web servers, such as 
bitmaps and sound files. From the File menu, choose Internet, and then Open from Internet, and enter the file name 



of the file you want to download. Approach places the file in your working directory. 
You can then open the file in the appropriate application, such as Paintbrush.

{button ,AL(`H_OPENING_APPROACH_FILES_FROM_A_SERVER_ON_THE_INTERNET_OVER;H_OPENING_AP
PROACH_FILES_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_OPENING_APPROACH_FILES_
FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS;H_SAVING_APPROACH_VIEWS_TO_OTHER_FILE_F
ORMATS_STEPS;H_SAVING_APPROACH_VIEWS_TO_THE_INTERNET_STEPS;H_SETTING_AUTOMATIC_C
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NG_CONNECTIONS_TO_INTERNET_SERVERS_STEPS;H_EDITING_CONNECTIONS_TO_INTERNET_SERV
ERS_STEPS;H_MANAGING_PROXIES_STEPS',0)} See related topics



Approach saves data automatically
When the time comes to save your work, keep these points in mind:

• If all you did was enter or edit data, you DO NOT have to save your work; Approach saves the data in the 
database file the moment you enter a record, move to another record, or change to another view.
This idea may take some getting used to, but you can be sure that Approach is saving any data you enter. You 
never have to worry about this.

• If you created new views or worked in Design to change the layout of views or the style of objects, use File - Save
Approach File to save the Approach file (.APR).

How to tell if you need to save the Approach file
• If the command File - Save Approach File is available, then you have made a change that requires you to save 

the Approach file.
• If you have changed data in the database or entered new data, the command File - Save Approach File is not 

available. That is because Approach takes care of saving data for you automatically.

Approach files (.APR) and database files
Whenever you work in Approach, you work in an Approach file (.APR). The data you see in Approach, however, is not
actually stored in the Approach file, but in the database file(s) associated with the Approach file. 

With this arrangement, you have much greater freedom:
• You can create forms, reports, and other kinds of views, all in the same Approach file, with each view associated 

with a different database file.

• Approach does not convert your data to a new database format: you have access to your data in the original 
format.

• You have access through Approach to a large selection of database types, for example, Lotus Notes, dBASE IV, 
and Paradox.

• You have access to and can produce output in a large selection of database types, such as Lotus Notes, dBASE 
IV, and Paradox. You don't need to own the database product in which the database file was created.

• You can share your data with others who are not using Approach. Again, no conversions are needed!

{button ,AL(`H_APP_APPROACH_FILES_APR_AND_DATABASE_FILES_OVERVIEW;',0)} See related topics



A sort is not a find
Finds and sorts are easy to confuse, but really they give you quite different results.

A find selects a subset of records

A sort arranges records

Do a When you want to
Find Look for certain records from the database

that satisfy conditions you give to 
Approach. After you do the find, you're 
working with a found set--a subset of all 
the records in the database.

Sort Organize the records in a database in a 
certain order, for example, alphabetical 
order from A - Z. You're working with all 
the records, or if you already did a find, 
with the found set of records.

After you do a find
• You can work with the found set the same way you work with the entire database: sort it, create a report based on

the data, and so on.
• You can save the find as a named find so that you can use it again.

How to go back to working with all the data after a find
To work with all your records again, rather than just the found set, select All Records from the named find box in the 
action bar.

If the action bar is not visible, then from the context menu, choose Find, and then choose Find All.



Browse is for data, Design is for style
In Approach, you do all your work in an Approach file (.APR), which consists of one or more views.
You must also be sure to be in the right environment to do the task you want to do.

Approach has different environments for different tasks

 In Browse, you use a view to work with the data stored in database files. You can do the following kinds of tasks in 
Browse:

• Enter data
• Create and update records
• Find specific information
• Sort records

 In Design, you work with Approach views to do the following kinds of tasks:
• Customize view layout
• Add color, change fonts and styles
• Make calculations and summaries

These environments reflect Approach's relationship to your data.
• In Browse, you work with data stored in a database file (such as .DBF, .123, or .NSF). Because you access the 

data directly, your changes are saved automatically.
• In Design, you cannot enter or edit data; rather, you work with views and objects, which are stored in the 

Approach file (.APR).

How to tell which environment you're in
Right away you notice that these two environments look different:

• Background

Browse

Design

• Status bar also indicates the environment.

Browse

Design

How to switch environments
Go to another environment from any of these places in Approach:

• Action bar



• View menu

• Environment button (in the status bar)



Select Print Preview to see report summaries
If you're in a report and can't see aspects of the report like

• Totals and subtotals
• Group names

It's probably because you're in Browse. You need to be in Print Preview. To go to Print Preview: From the File menu, 
choose Print Preview.

Only data from records appears in Browse:

Summaries and group names appear in Print Preview. Here's that same report seen in Print Preview. You can now 
see that the report has its records organized by Gold, Preferred, and Premium customer groups.



Print Preview also shows how fields are arranged before printing. For example, if you set a field to slide left to the end
of the previous field, Print Preview shows the final position of the field data.
You can also see report totals and group names in Design when View - Show Data is turned on.

Showing summaries in reports
You can set Approach to display report summaries by default whenever you go to a report view. From the File menu, 
choose User Setup, and then choose Approach Preferences. In the Display tab, select "Report summaries." Click 
Save Default, and then click OK.
From now on, whenever you go to a report, Approach automatically switches to the Print Preview or Design 
environment, so you can see the summaries.



Assigning Approach field names 

If you are And you want Then
Exporting data 
from Approach 

To export the names of 
the fields that contain 
that data

Select "First row contains field 
names"

Importing data 
into Approach

The data in the first row 
of the sheet to be 
defined as field names

Select "First row contains field 
names"

Opening a 
sheet in 
Approach

The data in the first row 
of the sheet to be 
defined as field names

Select "First row contains field 
names"



Changing the icon for inserted OLE objects
1. Under Icon, do one of the following:

• To display the object as the current icon, select Current.
• To display the object as the default icon, select Default.
• To display the object as an icon created from a file (such as an .exe or .bmp file), select "From File" and enter 

the path and filename.
2. Enter a new label in the "Label" box or use the default label.
3. Click OK.      

{button ,AL(`H_EMBEDDING_NEW_OLE_OBJECTS_STEPS;H_EMBEDDING_EXISTING_OLE_OBJECTS_STEPS
;H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS;',0)} See related topics



Overview: Communicating between applications using OLE
In the Microsoft Windows environment, information shared between applications can be either static or dynamic.

Static shared information: Using Edit Copy and Edit Paste
To share static information, use the Clipboard to copy data from one application and paste it into another application. 
When you change the original information, the copy that you pasted does not automatically change. You must repeat 
the copy and paste to keep the information up to date.

Dynamic shared information: Links
To share information dynamically, create a link between the two applications. A link is a communication channel 
through which

• Information is transferred from one application to another.
• Information can be automatically updated in the receiving (or client) application whenever the information 

changes in the originating (or server) application.

The communication channel: OLE
Windows provides two kinds of communication channels to create links: Dynamic Data Exchange (DDE) and Object 
Linking and Embedding (OLE). Whenever you create a link involving Approach, you are using OLE.

Linking servers to clients
Every link connects a server and a client. For example, when you create a link from a Lotus Word Pro document to a 
PicturePlus field in Approach, Word Pro is the server because it provides data to Approach, and Approach is the client
because it uses the data from Word Pro.
A server can provide data to several clients, and a client can obtain data from several servers. Approach can be both 
an OLE server and a client simultaneously.
A link is like a telephone conversation. The client starts the conversation by calling the server. If the server responds, 
the client then asks the server for a specific piece of information. If the server has the information, it provides the 
information to the client.
As long as the conversation continues, the server notifies the client whenever the information changes. Either the 
client or the server can end the conversation at any time. 

Automatic and manual links
When you establish a link, you can choose either automatic or manual links. Most links are automatic links, so when 
the information in the server changes, the link is automatically updated.
Links can also be manual. With a manual link, the link is updated only when you choose Edit - Manage Links and 
click Update Now. You can create manual links, or change existing automatic links to manual links.
When you have many links in a file, and the data in the server application changes frequently, you may want to make 
the links manual to improve system performance.

OLE embedded objects
In addition to creating OLE links, you can also use OLE to create OLE embedded objects. Embedded objects are not 
links, but they share some characteristics of links.
Similar to links, OLE embedded objects give you access to the server application when you are in the client 
application. When you embed an object, however

• The data is stored in the client application.
• There is no link to a file in the server application. 
• You edit the embedded object by opening the server application from within the client application. 

Embed objects using Create - Object or Edit - Paste Special.

{button ,AL(`H_CREATING_APPROACH_OLE_OBJECTS_FROM_OTHER_APPLICATIONS_STEPS;H_CREATING
_APPROACH_OLE_OBJECTS_IN_APPROACH_STEPS;H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS
;H_EMBEDDING_AN_APPROACH_OBJECT_IN_ANOTHER_APPLICATION_OVER;H_OLE_EMBEDDED_OBJE
CTS_OVER;H_OLE_LINKS_OVER',0)} See related topics





Copying PicturePlus pictures to a file
You can copy the picture in a PicturePlus field to a graphics file only if the picture is not an OLE object.
Tip When you create a PicturePlus field in the Field Definition box, click Options and deselect "Allow OLE objects."    

 Are you in Browse?
1. Select the PicturePlus field that contains the image you want to copy.
2. From the Edit menu, choose Picture, and then choose Export.

3. Select the directory where you want to export the file.
4. Enter a name for the file in the "File name" box.
5. Select the file type in the "Picture type" box.
6. Click Export.

{button ,AL(`H_CREATING_APPROACH_OLE_OBJECTS_FROM_OTHER_APPLICATIONS_STEPS;H_CREATING
_APPROACH_OLE_OBJECTS_IN_APPROACH_STEPS;H_FILE_EXTENSIONS_IN_APPROACH_REF;H_PAST
ING_PICTURES_IN_FIELDS_STEPS;H_PASTING_PICTURES_IN_VIEWS_STEPS;H_SETTING_OLE_OPTION
S_FOR_PICTUREPLUS_FIELDS_STEPS',0)} See related topics



Creating Approach OLE objects from other applications
When you create a new Approach object from within another application, it can contain either Aproach as an 
application or a single view that you create using an Approach assistant.
1. Embed a new OLE object following the instructions provided by the container application.
2. Select the type of Approach object you want to use; either the Approach application or one of the Approach views.
3. (Optional) To have the object appear as an icon, select "Display As Icon."
4. (Optional) To change the icon, click Change Icon.
5. Click OK.

The Approach Open dialog box appears. 
6. Select the database you want to use.
7. Click Open.

If you selected a view, the appropriate assistant appears.
8. Use the assistant to create the view.
9. Click Done.
10. From the menu in Approach, choose File - Exit & Return.
If you do not select "Display As Icon" when selecting the type of Approach object, the entire view is embedded in the 
container application.
Note  You can create objects in Approach for the application or the following object types:

• Chart
• Crosstab
• Envelope
• Form
• Form Letter
• Mailing Labels
• Report
• Worksheet

{button ,AL(`H_COPYING_PICTUREPLUS_PICTURES_TO_A_FILE_STEPS;H_CREATING_APPROACH_OLE_OB
JECTS_IN_APPROACH_STEPS;H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS;H_OLE_EMBEDDED_
OBJECTS_OVER;',0)} See related topics



Details: Creating Approach OLE objects in Approach
You can choose whether to include data in a view object and the amount of data to be included.
If you include data in a view object, the object and its data are a self-contained unit. This format is convenient for 
sending an Approach form to someone via e-mail. The recipient can then enter data into the form and send it back to 
you.
If you choose not to include data in the object, Approach still adds references to the data so that you can see data in 
the OLE object as long as the object and the database file it points to are on the same network or hard drive.

{button ,AL(`H_CREATING_APPROACH_OLE_OBJECTS_IN_APPROACH_STEPS',1)} Go to procedure
{button ,AL(`H_COPYING_PICTUREPLUS_PICTURES_TO_A_FILE_STEPS;H_CREATING_APPROACH_OLE_OB

JECTS_FROM_OTHER_APPLICATIONS_STEPS;',0)} See related topics



Creating Approach OLE objects in Approach (Copy View)
When you create an Approach OLE object from within Approach, it becomes available to any other application for 
linking.

 Are you in Browse?
1. Go to a view you want to include in the OLE object. 
2. Be sure nothing is selected in the view.

One way to be sure is to check the context menu. If it refers to an object in the view (instead of the view) then an 
object has been selected.

3. Choose Edit - Copy View.
4. To create an object that

• Consists of only the current view, select "Copy current view only." 
• Includes all of the views in the current Approach file, select "Copy all views.” 

5. To include data in the object, select "Include data from."
6. Select the amount of data: All databases, Found Set, or Current Record.

Found Set is not available when choosing fields from joined databases.
7. Click OK.
Approach copies the object to the Clipboard. 
Choose Edit - Paste or Edit - Paste Special in another application to embed or link the Approach object. 

{button ,AL(`H_CREATING_APPROACH_OLE_OBJECTS_IN_APPROACH_DETAILS',1)} See details
{button ,AL(`H_COPYING_PICTUREPLUS_PICTURES_TO_A_FILE_STEPS;H_CREATING_APPROACH_OLE_OB

JECTS_FROM_OTHER_APPLICATIONS_STEPS;H_OLE_EMBEDDED_OBJECTS_OVER;',0)} See related 
topics



Creating linked objects from files
1. Do one of the following:

• To add the object as part of the design of a view, go to Design and click where you want the object to appear.
• To make the linked object part of a record, go to Browse, go to the record, and select a PicturePlus field.

2. From the Create menu, choose Object.

3. Select "Create from File."
4. Specify the path and name of the file you want to link to.

Click Browse to select a file in the Browse dialog box.
5. (Optional) To have the object appear as an icon, select "Display As Icon."
6. (Optional) To change the icon>STEPS, click Change Icon.
7. Select "Link" to link the object to its source file.
8. Click OK.
If you do not select "Display As Icon" when creating linked objects from files, the contents of the file are pasted as an 
object to the view or PicturePlus field. Any changes to the source file are reflected in the linked object in Approach.

{button ,AL(`H_EDITING_LINKED_OBJECTS_STEPS;H_EMBEDDING_NEW_OLE_OBJECTS_STEPS;H_INSERTI
NG_LINKED_OBJECTS_FROM_THE_CLIPBOARD_STEPS;H_MODIFYING_LINKS_BETWEEN_OBJECTS_ST
EPS;H_OLE_EMBEDDED_OBJECTS_OVER;',0)} See related topics



Editing embedded objects
• Go to Design to edit an object embedded in a view.
• Go to Browse and go to the record that contains the embedded object.

1. Double-click the object you want to edit.
2. Make the changes you want in the embedded object and choose File - Update from the server application.

If the server application supports in-place editing, then it displays Approach menus. Choose the appropriate 
Approach commands to update and save the file. 

3. Close the server application window and return to the Approach window.

{button ,AL(`H_EMBEDDING_EXISTING_OLE_OBJECTS_STEPS;H_EMBEDDING_NEW_OLE_OBJECTS_STEPS
;',0)} See related topics



Editing linked objects
• If the linked object is a design element, go to Design.
• If the linked object is in a PicturePlus field, go to Browse, go to the record that contains the object, and select the 

PicturePlus field.
1. Double-click the object to open the source document.

The server application opens in a separate window. 
2. Make your changes to the object in the server application.
3. Choose File - Save from the server application.
4. Choose File - Exit from the the server application.

Any changes made to the object in the source document are updated in the Approach view.

{button ,AL(`H_INSERTING_LINKED_OBJECTS_FROM_THE_CLIPBOARD_STEPS;H_CREATING_OLE_OBJECT
S_FROM_FILES_STEPS;H_MODIFYING_LINKS_BETWEEN_OBJECTS_STEPS;',0)} See related topics



Overview: Embedding an Approach object in another application

Approach as an OLE server
When you embed an Approach object into a file in another application, the Approach object is stored in the other 
application file, but you use Aproach to create and edit the object from inside the other application.

Embedding an existing object
To create an Approach object based on an Approach file that already exists, in Approach go to Browse and choose 
Edit - Copy View. Then use Edit - Paste Special in the other application, selecting the appropriate Approach object 
Clipboard format to embed the object in the other application's file. 

OLE-specific File commands
When the current Approach window contains an Approach object embedded in another application, the following 
commands are available in the Approach File menu:

• File - Close & Return: Closes the Approach window and returns to the client application.
• File - Update: Updates data in the embedded object.
• File - Save Copy As: Saves a copy of the Approach object as an Approach file or another file type.
• File - Exit & Return: Ends the Approach session and returns to the client application.

{button ,AL(`H_COMMUNICATING_BETWEEN_APPLICATIONS_USING_OLE_OVER;H_CREATING_APPROACH_
OLE_OBJECTS_FROM_OTHER_APPLICATIONS_STEPS;H_CREATING_APPROACH_OLE_OBJECTS_IN_AP
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ER;H_OLE_LINKS_OVER',0)} See related topics



Embedding OLE objects based on existing files
An embedded object is different from a link. Changes in the embedded object do not update the original file, nor do 
changes in the original file update the embedded object. 
Embedded objects are stored separately from the original file. Objects embedded in records are stored in the 
database. Objects embedded as part of the design of a view are stored in the Approach file. 
1. In the server application, create the object you want to embed.
2. Open the Approach file and go to the view you want to use.
3. Do one of the following:

• To embed the object as part of the design of a view, go to Design and click where you want the object to 
appear.

• To embed the object part as part of a record, go to Browse, go to the record, and select a PicturePlus field.
4. From the Create menu, choose Object.

5. Click "Create from File."
6. (Optional) To have the object appear as an icon, select "Display As Icon."
7. (Optional) To change the icon>STEPS, click Change Icon.
8. Click Browse to select a file in the Browse dialog box.
9. Click OK.
If you do not select "Display As Icon" when embedding an OLE object based on an existing file, the contents of the 
file as an object are inserted into the view or PicturePlus field. You can only make changes to the object when the 
server application window is still open. 

Deleting embedded objects
In Design, select the object and choose Edit - Cut or Clear.
In Browse, select the PicturePlus field and choose Edit - Cut or Clear.

{button ,AL(`H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS;H_EDITING_EMBEDDED_OBJECTS_STEPS;
H_EMBEDDING_NEW_OLE_OBJECTS_STEPS;H_OLE_EMBEDDED_OBJECTS_OVER;',0)} See related topics



Embedding new OLE objects
You can embed an OLE object without creating the object first. 
A new embedded object is different from a link. Anything you do in an embedded object is unrelated to any file that 
exists in the server application. 
Embedded objects are stored separately from the original file. Objects embedded in records are stored in the 
database. Objects embedded as part of the design of a view are stored in the Approach file. 
1. Open the Approach file and go to the view you want to use.
2. Do one of the following:

• To embed the object as part of the design of a view, go to Design and click where you want the object to 
appear.

• To embed the object part as part of a record, go to Browse, go to the record, and select a PicturePlus field.
3. From the Create menu, choose Object.

4. Select "Create New."
5. (Optional) To have the object appear as an icon, select "Display As Icon."
6. (Optional) To change the icon>STEPS, click Change Icon.
7. Select the type of object you want to create in the "Object Type" box.
8. Click OK.
9. In the server application window, create the object and choose File - Update. 
10. Close the server application window and return to Approach.
If you do not select "Display As Icon" when embedding a new OLE object, a object of the type you selected is 
inserted into the view or PicturePlus field. You can only make changes to the object when the server application 
window is still open. 
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)} See related topics



Details: Exporting data from Approach
Delimited text files
If you select the Text - Delimited file type, Approach opens the Text File Options dialog box.
A delimited text file uses separators (special characters like commas, spaces, or tabs) to show where one field ends 
and the next one begins. If you're exporting data as a text file to another application as the destination, check that 
application's documentation to be sure you have chosen the correct delimiters in Approach.

Character set for text files
Identify the character set to be used in the export file. If you want to export DOS text with international characters, 
change the character set of the current database before exporting it. 
DOS text with international characters uses the DOS or OS/2 (PC-8) character set.

Fixed-length text files
If you select the Text - Fixed-Length file type, Approach opens the Fixed-Length Text File Setup dialog box. 
In a fixed-length text file, a specific field is always the same length in each record, regardless of how much data it 
contains. When you export a fixed-length text file, you provide the names, data types, and widths of each field. You 
enter the starting position for only the first field; Approach automatically calculates the starting position for all fields 
after the first one. 

Oracle, SQL Server, DB2, or server-based ODBC files
If you select Oracle, SQL Server, DB2, or a server-based ODBC application, Approach opens the appropriate 
Connect dialog box. Complete this dialog box to connect to the server.

Selecting records to export
• "Found set only" exports only the records you've located with the most recent find request. 
• "All records" exports all records in the database.

{button ,AL(`H_EXPORTING_DATA_FROM_APPROACH_STEPS',1)} Go to procedure
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Exporting data from Approach
Exporting saves selected data in a format that can be used by other applications. You can export all types of fields 
except variable fields and summary calculated fields.

 Are you in Browse?
1. Open the Approach file (.APR) associated with the database you want to export.
2. (Optional) To export only a found set, perform the find before exporting.
3. From the File menu, choose Export Data.

4. Select a database file type in the "Export type" box.
A new database file is created to receive the exported data.

5. Name the new database file.
6. Under Export, select "Found set only" or "All records."
7. To identify the data to be exported, be sure the displayed database is the one you want.
8. Select a field and click Add.
9. To add additional fields, repeat steps 7 and 8.
10. Click Export.
11. (Optional) If you exported the data to a different database file format, specify a key field. 

{button ,AL(`H_EXPORTING_DATA_FROM_APPROACH_DETAILS',1)} See details
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Importing Approach files
• Importing an Approach file adds its views and macros to the receiving .APR file.
• Importing an Approach file does not import any data into the database of the receiving .APR file.

 Are you in Design?
1. Open the Approach file you want to import views into.
2. Choose File - Import Approach File.
3. Select the Approach file you want to import.
4. Click Open.

The Import Approach File Setup dialog box appears (unless both Approach files have databases with the same 
fields, in which case they are mapped automatically).

5. Map the fields.
6. Click OK.
Approach adds the views and macros of the imported file to the receiving .APR file. 

{button ,AL(`H_EXPORTING_DATA_FROM_APPROACH_STEPS;H_IMPORTING_DATA_INTO_DATABASES_STE
PS;',0)} See related topics



Details: Importing data into databases
If you're working with a found set rather than the entire database, Approach updates only the records in the found set.

Delimited text files
If you select the Text - Delimited file type, Approach opens the Text File Options dialog box.
A delimited text file uses separators (special characters like commas, spaces, or tabs) to show where one field ends 
and the next one begins. Refer to the manual for the application used to create the delimited text file to see what field 
separator it uses.

Character set for text files
Identify the character set used in the import file. If you import DOS text with international characters, change the 
character set of the current database before importing into it. 
DOS text with international characters uses the DOS or OS/2 (PC-8) character set.

Fixed-length text files
If you select the Text - Fixed-Length file type, Approach opens the Fixed-Length Text File Setup dialog box. 
In a fixed-length text file, a specific field is always the same length in each record, regardless of how much data it 
contains. When you import a fixed-length text file, you provide the names, data types, and widths of each field. You 
enter the starting position for only the first field; Approach automatically calculates the starting position for all fields 
after the first one. 

Oracle, SQL Server, DB2, or server-based ODBC files
If you select Oracle, SQL Server, DB2, or a server-based ODBC application, Approach opens the appropriate 
Connect dialog box. Complete this dialog box to connect to the server.

Import options
This option Does this
Add imported data as new 
records

Adds the imported data as new
records at the end of the 
database; the new records 
have data only in the fields you 
map.

Use imported data to update 
existing records

Updates the data in existing 
records (only for the fields you 
map) when data in the fields 
you specify matches imported 
data. 

Use imported data to update 
& add to existing records

Updates the data in records 
that match imported data and 
adds new records for the data 
that does not match existing 
records.

The options to update and append data do not apply to text files, Lotus 1-2-3, and Microsoft Excel. To use these file 
types, you must convert them to a .DBF file before importing.

Viewing records
To view the actual data in the records of the imported file, click the previous record and next record buttons at the 
bottom left of the Import Setup dialog box. 

{button ,AL(`H_IMPORTING_DATA_INTO_DATABASES_STEPS',1)} Go to procedure
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Importing data into databases

 Are you in Browse?
1. Open the Approach file (.APR) associated with the database you want to import data into.
2. Choose File - Import Data.

3. Select the database file containing the data you want to import.
4. Click Import.

Your next step depends on the file type you selected. See details

Assigning imported data to the correct fields
The Import Setup dialog box appears. The left-hand column lists information from the import file. The right-hand 
column lists the fields of the current database. The arrows show how Approach plans to map the imported data.
1. Be sure the database you want to import data into is showing in the "Fields in" box.
2. Map the fields.

Selecting an import option
1. Select an import option.

If you select the second or third option, a new column appears at the far right.
In this column, click the field(s) whose data must be matched exactly by the imported data. This ensures that 
Approach updates existing records accurately.

2. Click OK.

{button ,AL(`H_IMPORTING_DATA_INTO_DATABASES_DETAILS',1)} See details
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Inserting linked objects from the Clipboard (Paste Special) 
1. In the server application, create the object you want to link to.
2. Choose Copy in the application to copy the object to the Clipboard.
3. Open an Approach file and go to the view you want to use.
4. Do one of the following:

• To add the object as part of the design of a view, go to Design and click where you want the object to appear.
• To make the linked object part of a record, go to Browse, go to the record, and select a PicturePlus field.

5. From the menu, choose Edit - Paste Special.

6. (Optional) To have the object appear as an icon, select "Display As Icon."
7. (Optional) To change the icon>STEPS, click Change Icon.
8. Select "Paste Link."
9. Click OK.
If you do not select "Display As Icon" when linking objects, a picture of the Clipboard contents is pasted to the view or
PicturePlus field. Any changes to the source file are reflected in the linked object in Approach. 

{button ,AL(`H_CREATING_OLE_OBJECTS_FROM_FILES_STEPS;H_EDITING_LINKED_OBJECTS_STEPS;H_E
MBEDDING_EXISTING_OLE_OBJECTS_STEPS;H_EMBEDDING_NEW_OLE_OBJECTS_STEPS;H_MODIFYIN
G_LINKS_BETWEEN_OBJECTS_STEPS;',0)} See related topics



Insert Object dialog box
You can embed or link new objects or objects created from files.

Choose a task
Creating linked objects from files
Embedding new OLE objects
Embedding OLE objects based on existing files

{button ,AL(`H_EDITING_LINKED_OBJECTS_STEPS;H_INSERTING_LINKED_OBJECTS_FROM_THE_CLIPBOA
RD_STEPS;H_MODIFYING_LINKS_BETWEEN_OBJECTS_STEPS;',0)} See related topics



Details: Modifying links 
You can update a linked object either automatically or manually.

• Automatic updating means that the object is updated whenever the source object changes. 
• Manual updating means that the object is updated only when you specifically update it. 

If you make frequent changes to an object, select Manual as its update method. You might want to wait until 
you're finished before manually updating it.

When Approach is the container application, it updates linked objects only if the source application is running. If you 
have a linked object in a PicturePlus field, Approach updates the object only when you manually update it. 
Select the type of update you want in the Manage Links dialog box::

To Click
Change when the link is 
updated

Automatic or Manual    

Manually update the link Update Now
Activate a linked object Open Source
Change the link to another 
source file (if, for example, 
you change the name or 
location of the source file)

Change Source and select a 
new file or path for the link in 
the Change Link dialog box

Break a link and convert the 
object into a graphic element

Break Link

{button ,AL(`H_MODIFYING_LINKS_BETWEEN_OBJECTS_STEPS',1)} Go to procedure
{button ,AL(`H_EDITING_LINKED_OBJECTS_STEPS;H_INSERTING_LINKED_OBJECTS_FROM_THE_CLIPBOA
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Modifying links 
• If the linked object is a design element, go to Design. 
• If the linked object is in a PicturePlus field, go to the record that contains the object and select the PicturePlus 

field. You must be in Browse.
1. Choose Edit - Manage Links.

2. Select the link you want to modify and make the necessary changes.
3. Click OK.

{button ,AL(`H_MODIFYING_LINKS_BETWEEN_OBJECTS_DETAILS',1)} See details
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Overview: OLE embedded objects

What is an OLE embedded object?
An OLE embedded object is a piece of data stored in a file in one application (the client) that you create and edit 
using another application (the server). 
With an embedded object, you can use the features of the server application to manipulate data in the client 
application. For example, you can embed a Lotus Word Pro Document object in an Approach file. You use Word Pro 
to create and edit the data of the embedded object, but that data is stored in either the Approach file or a database 
associated with the file.

What does an embedded object look like?
In Approach, you can make an embedded object part of the records of a database or part of the layout of a view. To 
make the embedded object

• Part of the records of a database, define a PicturePlus field to contain the object and add the field to a view. Then 
in Browse, double-click the field to work with the embedded object.

• Part of the layout of a view, in Design, use Create - Object to create the object and add it to the view. Then in 
Design, select the object to work with it.

What can you do with an OLE embedded object?
After you create an embedded object, you can move the object, copy it, or delete it just as you would any field or 
drawn object. 
When the object is in place, the action bar appears so you can make any changes to the settings. To close the action 
bar, click away from the object. To edit the object, double click it.

To Do this
Copy OLE object to other 
application

Click and drag object

Move OLE object to other 
application

Hold Shift key and drag object

Double-click an embedded object to activate the server application so that you can edit the object. You can use all the
features of the server application to change the object's data or appearance. For example, you can use Lotus Word 
Pro to format text in a Word Pro Document object so that it appears in two-column format.

When should you use OLE embedded objects?
Use OLE embedded objects when 

• You need to use information in one application that you can only create or format in another application.
• You don't need to share the information between applications.

For example, if you want to place two-column text on a page of an Approach form, and you don't need to use the data
in any other application except Approach, you can embed a Word Pro Document object in a PicturePlus field or as 
part of the layout of the form.

Example: Why embed an object in a PicturePlus field?
Suppose you have a database in which you keep the specifications of all your products. You decide it would be 
helpful if you also showed a picture of the product as part of its record.
A photographer photographs all your products, and you have these photographs converted to a graphics format of a 
product that supports OLE as a server, and which is supported by Approach. Define a PicturePlus field, and then add 
the new field to a view of the database.
Next, in Browse, you single-click the PicturePlus field to select it. Choose Create - Object and select Create from file. 
Then specify the file that contains the image you want to add to this record.

Example: Why embed an object as part of the layout of a view?
Suppose you want the background of an Approach form to be a professionally designed piece of artwork, but you 
don't have the resources to create such a background yourself. You can use any of the SmartMaster backgrounds 
available in Freelance Graphics as the background for a form simply by embedding it as an OLE object on the form.



OLE terminology
Every OLE embedded object has a class name.

Term Description
Class name The name of the application used to 

create and edit the object, and the type 
of object. For example, Approach Form 
or 1-2-3 Worksheet.
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Overview: OLE links

What is a link?
A link is a connection between data in one application (the server) and another application (the client). With an 
automatic link, the data in the client automatically changes when you change the original data in the server.
In order for Approach to update information as an OLE client, the server application must be up and running.

What does a link look like?
In Approach, you can make a link part of the records of a database or part of the layout of a view. To make the link

• Part of the records of a database, define a PicturePlus field to contain the link and add the field to a view. Then in 
Browse, double-click the field to work with the link.

• Part of the design of a view, in Design, use Create - Object to create the link and add the link to the view. Then in 
Design, select the link to work with it.

What can you do with a link?
After you create a link, you can do anything with it that you can do with other objects in Approach. For example, you 
can move the link, copy it, or delete it just as you would a field or drawn object.
There are also operations that you can perform only with links:

• Double-click a link to activate the server application so that you can change the original data for the link.
• Using Edit - Manage Links, you can display and change information about a link. For example, you can edit a link 

so that it refers to a different piece of data in the server application or change a link from automatic to manual.

When should you use links?
Use links when all of the following are true:

• You need to share data between applications.
• You expect the shared data to change.
• You need to update the shared data when the original data changes.

For example, if you keep sales and promotional information for your products in Lotus Word Pro documents and you 
want to make this information part of the records in your products database, you can create a link in a PicturePlus 
field to the Word Pro documents. In this example, Approach is the client and Word Pro is the server.

When not to use links
Do not use links when any one of the following is true:

• You need to use the data in only one application.
Instead, create an OLE embedded object.

• You do not expect the data to change.
Instead, use the Clipboard to move a static snapshot of the data to Approach.

• You do not need to update the shared data when the original data changes.
Again, use the Clipboard to move the data into Approach.

For example, if you use Freelance Graphics to create your company logo, and you want to use the logo on Approach 
forms and in Word Pro documents, you would not use links, since the logo is not likely to change. Instead, you could 
simply copy the logo in Freelance Graphics and paste it into Approach and Word Pro.

Link terminology
Every link has an application, a topic, and an item. 

Term Description
Application The OLE class name for an OLE link, 

for example, Word Pro Document
Topic Usually the name of a file in the server 

application, for example C:\
WORD_PRO\DOCS\REPORT.SAM

Item A region in the topic, such as a range in 



a spreadsheet or a bookmark in a word 
processing document
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Sending e-mail messages from inside Approach
If you are connected to a network and have access to an e-mail application, you can send e-mail messages through 
Approach.
1. Choose File -TeamMail - Send New Message.

2. To send a messge that includes a Windows Metafile (.WMF) version of the current view, select "Snapshot of the 
current view." 

3. Click Send.
4. Enter your name and password in your e-mail system's login box. 
5. Enter recipients, send mode, subject information, and message text in the TeamMail dialog box.
6. Click Send.

{button ,AL(`H_SENDING_EMAIL_MESSAGES_WITH_ATTACHMENTS_FROM_INSIDE_APPROACH_STEPS',0)} 
See related topics



Details: Sending e-mail messages with attachments from inside Approach
You can select either or both of the following options:
To send a Windows Metafile (.WMF) image of the current Approach file view, select "Snapshot of the current view." 
To send the current Approach file with either all views or the current view only, select "Approach file with."
When you attach an Approach file, you can include copies of all databases associated with the Approach file or a 
blank copy of each database associated with the Approach file. 

{button ,AL(`H_SENDING_EMAIL_MESSAGES_WITH_ATTACHMENTS_FROM_INSIDE_APPROACH_STEPS',1)} 
Go to procedure
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Sending e-mail messages with attachments from inside Approach
If you are connected to a network and have access to an e-mail application, you can attach Approach views and data 
to your e-mail messages. 
1. Choose File - TeamMail - Send New Message.

2. Select "Approach file with." 
3. Select either "Current view only" or "All of the views."
4. Select "Include data from."
5. Select either "All databases," "Found set," "Current record," or "Blank databases" to attach to the e-mail.

If you selected "All of the views," you can only include data from "All databases" or "Blank databases."
6. To send a message that includes a Windows Metafile (.WMF) version of the current view, select "Snapshot of the 

current view." 
7. Click Send.
8. Enter your name and password in your e-mail system's login box.
9. Enter recipients, send mode, subject information, and message text in the TeamMail dialog box.
10. Click Send.

{button ,AL(`H_SENDING_EMAIL_MESSAGES_WITH_ATTACHMENTS_FROM_INSIDE_APPROACH_DETAILS',1)
} See details
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TeamMail dialog box
Send e-mail messages from inside Approach with TeamMail for Lotus Approach.

Choose a task
Sending e-mail messages from inside Approach
Sending e-mail messages with attachments from inside Approach



Cannot join these two databases because it would create a circular join

Explanation
You are trying to join to a database already in the join path. This would create a circular join. Relational databases 
such as Approach do not allow circular join relationships. 
A circular join occurs when three or more databases are joined and you can follow the path of the join lines from the 
original database to other databases and back to the original database. 
For example, suppose database1 is joined to database2, database2 is joined to database3, and database3 is joined 
to database 4. Database4 cannot be joined to database1, or else it forms a circular relationship.
(Insert simple diagram of joined tables.)
There must be an end to a path of join lines.
(Insert simple diagrams of valid join relationships.)

Solution
To avoid circular joins, you may want to create an alias join. By joining a database to an alias "copy" of itself, you can 
link records that have related information in the database. 



Do you really want to delete the file/database *.*?

If you start by deleting... Then..
an .APR file confirm you want to delete the 

file. 
Approach deletes the .APR file 
and proceeds to delete the 
associated database files.

a database file confirm you want to delete the 
selected database file.
Approach deletes the database 
file and all files associated with 
the database (index file, memo 
file, key field file.)



Cannot delete the database "Filename" because someone is using it.

Explanation
This message appeared for one of the following reasons:

• You had another Approach file (.APR) open that used this database.
• You had the database open in another application.
• Another user on the network had the database open.

Solution
Do one of the following:

• Close the other Approach file (.APR).
• Close the database in the other application.
• Wait until the other user closes the database.



Cannot find the Memo and PicturePlus file for "Filename".

Explanation
Approach cannot locate the file that contains the data in memo  and PicturePlus  fields. Approach looks for this file in 
the same directory as the .DBF file.    If this file is in a different directory, renamed, or deleted, Approach cannot find it. 
The file has a different extension depending on the type of database you are using:

• For dBASE III or dBASE IV, the extension is .DBT.
• For Paradox 4.0, the extension is .MB.
• For Paradox 3.5, the extension is .DBQ.
• For FoxPro, the extension is .FPT.

Solution
Locate the file for the database, or use a backup copy.



Cannot insert a record into "Filename".

Explanation
You did not have the Insert option checked in the Relational Options dialog box. This is an option that defines 
characteristics of the join relationship. It lets you edit fields from this database on this view.

Solution 1
Switch to a view based on "Filename."

Solution 2
1. Choose Create - Join.
2. Double-click the line drawn between the two databases.
3. Click the appropriate Insert option.
4. Click OK to close the Relational Options dialog.
5. Click OK.



Cannot modify the database "Filename" because someone is using it.

Explanation
This message appeared for one of the following reasons:

• You had more than one Approach file (.APR) open that is associated with database "Filename," and tried to do 
one of the following:

• Create a database field
• Change the data type of a field
• Change the size of a field

• You    tried to modify a database on the netwrok that someone else is using.
• You had the database open in another application.

Solution
• If you have more than one Approach file (.APR) open, close all the other .APR files and try again. 
• If the file is on the network, and the error persists, make sure no one else has the data file open.



Cannot open a Paradox 4.x database while in 3.5 networking mode.

Explanation
You tried to open a Paradox 4.x file and Approach was setup to open Paradox 3.x files only.    

Solution
1. Choose File - Open
2. From Files of type, select Paradox.
3. Click Connect.    
4. Select "Use Paradox 4.x networking".



Cannot open database "Filename" because of a file mismatch.

Explanation
Someone else had the database open either in Approach, Paradox, or some other application that can open Paradox 
databases,    using a different *.NET file. 

• The *.NET file for Paradox 3.x files is PARADOX.NET.    
• The *.NET file for Paradox 4.x files is PDOXUSRS.NET.

Solution 1: To find out where Approach is looking for this file
1. Choose File - Open.
2. From Files of type, select Paradox.
3. Click Connect.    
4. Note the Network Control File Path where Approach is looking for the *.NET file.    
5. Verify the drive and path in the other application that has the file open.

Solution 2: To find out where Paradox is looking for this file
1. In DOS, change to the Paradox directory.
2. Run NUPDATE.EXE.    
3. Select the .SOM file, and press SPACEBAR. 
4. Press F2 twice to see the path for Network Control File.    

Note This drive and path needs to be the same as Approach if you want Approach and Paradox to share the data
file at the same time.



Cannot open the database "Filename" because it is open exclusively.

Explanation
You tried to open a database file that someone else had open, and the file was not set up as a shared database.

Solution
If it is a dBASE III+ or dBASE IV file, you can make it a shared database.
1. Close all open files in Approach.
2. Choose File - Open.
3. In the list of file types, select dBASE IV.
4. Click Setup.
5. Do one of the following:

• For networks with dedicated servers (for example, Novell), select "Database sharing."
• For networks with nondedicated servers (for example, LANtastic), select both "Database sharing" and "Local 

databases are shared."
• If no third party application uses the database files, select "Sharing data only with other Approach users."



Cannot open the database "Filename" exclusively because someone is using it.

Explanation
You tried to open the database for exclusive use, but another user already had the database open in sharing mode.    

Solution
To open the database for exclusive use, the other users must close the database file. 
To open files in sharing mode, follow these steps:
1. Close all open files in Approach.
2. Choose File - Open.
3. In the list of file types, select dBASE IV.
4. Click Setup.
5. Do one of the following:

• For networks with dedicated servers (for example, Novell), select "Database sharing."
• For networks with nondedicated servers (for example, LANtastic), select both "Database sharing" and "Local 

databases are shared."
• If no third party application uses the database files, select "Sharing data only with other Approach users."



Cannot save a database over itself.

Explanation
You chose File - Save As to save an exact copy of a database by the same name in the same location. This applies 
to all joined databases in the .APR file.    

Solution
Do one of the following:

• Save the file under a new name.
• Save it to a different directory.
• Use the Maintain Original File option in the Save Table As dialog box.
• Choose File - Save to save the file with the same name in the same directory.

Note You do not need to use File - Save As to save changes to the data. Approach does this automatically.



Common messages in Approach
Cannot delete the database "Filename" because someone is using it 
Cannot find the Memo and PicturePlus file for "Filename" 
Cannot insert a record into "FIlename" 
Cannot join these two databases because it would create a circular join 
Cannot modify the database "Filename" because someone is using it 
Cannot open a Paradox 4.x database while in 3.5 networking mode 
Cannot open database "Filename" because of a file mismatch 
Cannot open the database "Filename" because it is open exclusively 
Cannot open the database "Filename" exclusively because someone is using it 
Cannot save a database over itself 
Couldn't create database "Filename" 
Couldn't find database "Filename" 
Couldn't load the "Filename" DynaLink 
Couldn't open or write to server's named pipe 
Do you really want to delete the file/database *.*? 
Field "Fieldname" is used in a join 
"Fieldname" must be filled in and cannot be left blank 

N labels won't fit between left and right margins 
N labels won't fit between top and bottom margins 
Network driver not loaded 
Not enough memory to display all Database Values for "Fieldname" in the list 

One or more fields in this Approach file do not match up with current database fields 

Server is not available 
Someone locked this record in the database "Filename" 
Someone modified this record in the database "Filename" 

The 1-2-3 table being used is protected 
The current printer setup cannot print N labels across the page 
The current printer setup cannot print N labels down the page
The entry in "Fieldname" is not 'one of' the items in the data validation list 
The entry in "Fieldname" must be in the range N1 to N2 
The entry in "Fieldname" must be unique 
The entry in "Fieldname" must match an entry in the "Check Entered Data" field 
The find rule in "Fieldname" is not valid 
The formula in the "Formula is true" validation option must return a yes/no value 
The formula in the data entry option equates to an incompatible data type for this field 
The maximum record size was exceeded for "Filename" 
There is a missing ')' 
There is a missing '(' 
There is a missing double quote (") in this field 
There is a missing single quote (') in this field 
This calculated field uses a formula that refers to itself 
This change may erase or truncate the contents of the field in each record of the database 
This change may truncate the contents of the field in each record of the database 
This field is used in a join. Modifying this field is not revertible 
Too many files open 

Values in the field "FIeldname" are not grouped together 



Couldn't create database "Filename".

Explanation
Approach could not create the database for one of the following reasons:

• Your computer cannot work with any more files.
• You are out of disk space.
• You have a corrupt .ADX file.

Solution
Try each of these solutions:

Increase the file handles in your CONFIG.SYS file
This lets your computer work with more files.
1. Edit your CONFIG.SYS file.
2. Update the files= line.

It is automatically set to 60, so change it to a number larger than 60.
3. Save the file and then restart your computer.

Make a copy of your .ADX file
You may have a corrupt .ADX file. Saving your database with a new name filters out any corruptions.
1. Choose File - Save As.
2. Enter a new filename.
3. Click Save.
4. Enter a new filename for the database.
5. Select Exact Copy.
6. Click Save.



Couldn't find database "Filename".

Explanation
The Approach file (.APR) stores the path and name of the database file. If you moved or deleted the database file(s), 
Approach does not know the correct location.

Solution
Click Yes, then locate the database by Browsing.



Couldn't load the "Filename" DynaLink.

Explanation
Approach was unable to find the files it needed to load the DynaLink file.

Solution
1. To find the name of the directory where Approach is looking for the files, open the registry to location 

HKEY_LOCAL_MACHINE\Software\Lotus\Components      
•

For standalone installations of Approach, check the entry LocalPath =
• For network installations of Approach, check the entry NetworkPath =

2. Verify that the following six files exist in the directory:
• LTBUBN12.DLL
• LTDLGN03.DLL
• LTICNC71.DLL
• LTSBC61.DLL
• LTTMC11.DLL
• LTUIN21.DLL

3. If these files do not exist, do one of the following
• Check if the files exist in another LOTUSAPP directory.

If they exist, do one of the following:
a. Edit the path in the registry to reflect the directory where they exist.
b. Move the files to the directory listed in the registry.

• Re-install Approach to install the .DLL files Approach needs.



Couldn't open or write to server's named pipe.

Explanation
Approach uses two named pipe connections to connect to the server, and the server ran out of connections.    

Solution
Contact your system administrator to check the following:

• Network driver
• Network configuration
• Network cables
• Verify there are at least two connections available.



Editing the registry
1. In the Windows taskbar, click Start, and then choose Run.
2. Type regedit
3. Click OK.

The Registry Editor appears.
4. Navigate to:

HKEY_CURRENT_USER
      Software
            Lotus
                  Approach
                        97.0

5. Open the folder required by your task.
6. Make the changes to the appropriate data values.



Error messages
Error messages may come from three different sources:

• An ODBC driver
• The database system
• The driver manager

ODBC driver errors
An error reported on an ODBC driver has the following format:
[vendor] [ODBC_component] message
ODBC_component is the component in which the error occurred. For example, an error message from the 
INTERSOLV SQL Server driver would look like this:
[INTERSOLV] [ODBC SQL Server driver] Login incorrect.
If you get this type of error, check the last ODBC call your application made for possible problems, or contact your 
ODBC application vendor.

Database system errors
An error that occurs in the data source includes the data source name, in the following format:
[vendor] [ODBC_component] [data_source] message
With this type of message, ODBC_component is the component that received the error from the data source 
indicated. For example, you may get the following message from an Oracle data source:
[INTERSOLV] [ODBC Oracle driver] [Oracle] ORA-0919:    specified length too long for CHAR column
If you get this type of error, you did something incorrectly with the database system. Check your database system 
documentation for more information, or consult your database administrator. 

Driver manager errors
The driver manager is a .DLL that establishes connections with drivers, submits requests to drivers, and returns 
results to applications. An error that occurs in the driver manager has the following format:
[vendor] [ODBC DLL] message
Vendor can be Microsoft, Apple, or INTERSOLV. For example, an error from the Microsoft driver manager might look 
like this:
[Microsoft] [ODBC Driver Manager] Driver does not support this function
If you get this type of error, consult the Programmer's Reference for the Microsoft ODBC Software Development Kit, 
available from Microsoft.



"Fieldname" must be filled in and cannot be left blank.

Explanation
The designer of this field assigned it a validation option of Filled in, so you cannot leave it blank.    

Solution 1
Enter some data.

Solution 2
1. In Design, select the field.
2. Choose Create - Field Definition.
3. Click Options.
4. Click the Validation tab.
5. Deselect Filled in.
6. Click OK.



Field "Fieldname" is used in a Join.

Explanation
You tried to map a join field to a PicturePlus, Boolean or variable field, that cannot be used in a join. 

Solution
For information on mapping fields, see Mapping Fields.
1. Align the database field on the right side with the field on the left.
2. Click the middle column between the fields. 

A blue arrow appears.
3. Click OK.    
4. Choose File - Save Approach File. 



Network driver not loaded.

Explanation
Approach could not locate the SQLNet driver. 

Solution
Check your Oracle client online documentation.



Not enough memory to display all Database Values for "Fieldname" in the List.

Explanation
You are defining a drop-down list field based on values contained in another field. Approach can display up to 200 
values in the drop-down list. If the list contains more than 200 values, Approach warns you it cannot display them all 
in this dialog. However, the list still contains all the values you entered, and will function normally when you are in 
Browse.

Solution
Click OK to acknowledge the message. You can continue to enter more values if necessary.



N labels won't fit between left and right margins.

Explanation
Approach cannot fit this arrangement of labels on the page. The combined label width, gaps between the labels, and 
margin size add up to more than the width of the page.

Solution 1
In the Options tab of the Mailing Label Assistant, do one of the following:

• Decrease the number of labels going across.
• Decrease the Horiz. gap 
• Decrease the Left margin.
• Decrease the right margin.

Solution 2
1. In the Options tab of the Mailing Label Assistant, choose Printer Setup.
2. Specify a wider paper size.

Solution 3
Choose a different printer.



N labels won't fit between top and bottom margins.

Explanation
Approach cannot fit this arrangement of labels on the page. The combined label height, gaps between the labels, and
margin size add up to more than the height of the page.

Solution 1
In the Options tab of the Mailing Label Assistant, do one of the following:

• Decrease the number of labels going down.
• Decrease the Vert. gap 
• Decrease the Top margin.
• Decrease the Bottom margin.

Solution 2
1. In the Options tab of the Mailing Label Assistant, choose Printer Setup.
2. Specify a taller paper size.

Solution 3
Choose a different printer.



One or more fields in this Approach file do not match up with current database fields.

Explanation
This database was modified outside of the current APPROACH FILE (.APR).    One or more fields of the database 
file(s) no longer match the fields in the .APR.    

Solution
To keep full functionality, click Yes to map  the unmatched fields.



Server is not available.

Explanation
Approach could not access the files on the server, because of one of the following reasons:

• The server was down.
• All connections were in use.

Solution
Verify with your network administrator that the server is running, and that there is a connection available for this 
server.



Someone locked this record in the database "Filename".

Explanation
• Another person was using this database to do a find. This required Approach to create an index. So you were 

locked out until Approach finished creating the index.
• That database does not have Optimistic Record Locking turned on, and another person is editing this record.

Solution
• Wait until Approach finishes creating the index.
• If Approach isn't creating an index and you get this error, verify that all users are using optimistic record locking. 

If all users have this option checked, more than one user can edit the same record at the same time.    If all users 
do not have this option checked, only one user at a time can edit any given record.



Someone modified this record in the database "Filename".

Explanation
This message occurred because

• Someone else on the network tried to edit the same record in the database at the same time you did.
• The file uses optimistic record locking.

Solution
Do one of the following:

• If you want to write over the other person's changes, click Yes. 
Approach saves your changes and writes over the changes made by another user on the network.    

• If you do not want to write over the other person's changes, click No. 
Approach displays the changes made by the other user in your view of the record. 

• If you do not want to write over the changes, or update the record with the other user's changes, click Cancel to 
continue with your edits.



There is a missing ')'. 

Explanation
You entered a formula that contains an open parenthesis, without a corresponding close parenthesis. 
As a general rule, the number of open parentheses should equal the number of close parentheses.    Also, the 
parentheses need to be located in the correct position.

Solution
Enter the missing close parenthesis.



There is a missing double quote (") in this field.

Explanation
You entered a find condition that includes an odd number of double quotation marks.    Approach requires you to enter
field names containing special characters within a pair of double quotation marks.

Solution
• To search for text within fields whose name contains special characters, such as a space, type the field name in 

double quotation marks.
• To search for text containing special characters, type the whole string in single quotation marks.
• To search for text containing a double quotation mark, put two double quotation marks where the original double 

quotation mark appears.    

Example 1
"table.field name"

Example 2
To find 
My "other" life.
Type:
My ""other"" life.



There is a missing '('. 

Explanation
You entered a formula that contains a close parenthesis, without a corresponding open parenthesis. 
As a general rule, the number of open parentheses should equal the number of close parentheses.    Also, the 
parentheses need to be located in the correct position.

Solution
Enter the missing open parenthesis.



There is a missing single quote (') in this field.

Explanation
You entered a find condition that includes an odd number of single quotation marks. Approach requires you to enter 
text containing special characters within a pair of single quotation marks.

Solution
• To search for text containing special characters, type the whole string within a pair of single quotation marks. 
• To search for text containing a single quotation mark, put two single quotation marks where the original single 

quotation mark appears.    

Example
To find
Approach's Help System
Type:
Approach''s Help System



The 1-2-3 table being used is protected.

Explanation
You tried to add a record to the database file. Approach tried to use the next row in the range for the new record, and 
it found that something already exists in this row.

Solution
• In Lotus 1-2-3, check the range that Approach is getting the data from. If data appears in any of the cells in the 

row beneath the last row in the range, do one of the following:
• Delete the data.
• Extend the range.

• Remove any range protection that is defined in the Lotus 1-2-3 spreadsheet.



The current printer cannot print N labels down the page.

Explanation
Approach cannot fit this arrangement of custom labels on the page.

Solution 1
In the Options tab of the Mailing Label Assistant, do one of the following:

• Decrease the number of labels going down.
• Decrease the height of the label. 

Solution 2
1. In the Options tab of the Mailing Label Assistant, choose Printer Setup.
2. Specify a taller paper size.

Solution 3
Choose another printer.



The current printer setup cannot print N labels across the page.

Explanation
Approach cannot fit the arrangement of custom labels on the page.

Solution 1
In the Options tab of the Mailing Label Assistant, do one of the following:

• Decrease the number of labels going across.
• Decrease the width of the label. 

Solution 2
1. In the Options tab of the Mailing Label Assistant, choose Printer Setup.
2. Specify a wider paper size.

Solution 3
Choose another printer.



The entry in "Fieldname" is not 'one of' the items in the data validation list.

Explanation
The designer of this field assigned it a validation option that requires you to select a value that is one of a set of 
predefined values.

Solution 1
Select one of the values as defined in the Validation tab of the Field Definition dialog.

Solution 2
1. In Design, select the field.
2. Choose Create - Field Definition.
3. Click Options.
4. Click the Validation tab.
5. In the "One of" box enter the value you want to use, and then click Add.

You can also deselect the option.
6. Click OK.



The entry in "Fieldname" must be in the range N1 to N2.

Explanation
The designer of this field assigned it a validation option that requires you to enter a value that falls between a 
specified range of values.

Solution 1
Enter some data that falls within the specified range.

Solution 2
1. In Design, select the field.
2. Choose Create - Field Definition.
3. Click Options.
4. Click the Validation tab.
5. Change the range specified in the "From" and "To" boxes, or deselect the option.
6. Click OK.



The entry in "Fieldname" must be unique.

Explanation
The designer of this field assigned it a validation option of Unique, and you tried to enter a value that is already in this
field in another record.

Solution 1
Enter some data that is not already in this field in another record.

Solution 2
1. In Design, select the field.
2. Choose Create - Field Definition.
3. Click Options.
4. Click the Validation tab.
5. Deselect "Unique."
6. Click OK.



The entry in "Fieldname" must match an entry in the Check Entered Data field.

Explanation
The designer of this field assigned it a validation option that requires you to select a value that is present in another 
field in this or another database.

Solution 1
Select one of the values as defined in the Validation tab of the Field Definition dialog.

Solution 2
1. In Design, select the field.
2. Choose Create - Field Definition.
3. Click Options.
4. Click the Validation tab.
5. Change "In Field" to use the field that contains the value you want to enter.

You can also deselect the option.
6. Click OK.



The find rule in "Fieldname" is not valid.

Explanation
Your find condition is missing information Approach needs to complete the find. 

Solution
Check to make sure you did each of the following:

• Include the name of the database when entering field names (DATABASE.FIELD), if you have joined databases in
the Approach file. Enclose the field name in double quotation marks if it contains special characters.

• Spell field names and functions correctly.
• Include all quotation marks, apostrophes, commas, open or close parentheses.
• Use the symbol , (comma) instead of the word "or."
• Space the data correctly. You don't usually need spaces, but in some cases you need to use them to separate 

functions from data or field names.



The formula in the data entry option equates to an incompatible data type for this field.

Explanation
You tried to write a formula that would result in a data type  different from the one defined for this field.

Solution
Rewrite the formula so it results in the correct data type for the field.

Example
If the field is defined as date, make the Creation formula or Modification formula result in a date. For example, use the
TexttoDate function.



The formula in the "Formula is true" validation option must return a yes/no value.

Explanation
The formula does not evaluate to Yes or No; it requires Approach to make some other evaluation beyond a simple 
yes/no test. 

Solution
Write the formula so that when Approach uses the formula to test an entered value, the response required by the 
formula is Yes or No.

Examples: Formulas that return a yes/no value
Length(FieldName)=5
Isblank(FieldName)
If(FieldName>1,'Yes','No')

Examples: Formulas that    do not return a yes/no value
Length(FieldName)    - returns a numeric value
Position(FieldName,'#',1) - returns a numeric value
If(FieldName='Approach','Easy to Use','Too Difficult') - returns either Easy to Use or Too Difficult



The maximum record size was exceeded for "Filename".

Explanation
You tried to create a database containing records whose size exceeds the database type's limitations.

Solution
Do one of the following:

• Delete some fields.
• Reduce the size of the fields.
• Click Cancel, then create a new database that supports a larger record size.

{button ,AL(`H_DBASE_FILES_IN_APPROACH_REF;H_FOXPRO_FILES_IN_APPROACH_REF;H_IBM_DB2_TAB
LES_IN_APPROACH_REF;H_LOTUS_NOTES_FILES_IN_APPROACH_REF;H_ODBC_DATA_SOURCES_IN_A
PPROACH_REF;H_ORACLE_SQL_TABLES_IN_APPROACH_REF;H_PARADOX_FILES_IN_APPROACH_REF;
H_QUERY_FILES_IN_APPROACH_REF;H_SQL_SERVER_TABLES_IN_APPROACH_REF;',0)} See related 
topics



This calculated field uses a formula that refers to itself.

Explanation
You tried to create a calculated field that refers to itself in its own formula, or another field's formula refers to itself.    

Solution
Change the formula for this field to a valid formula.

Example
You cannot have this formula in the field TOTAL, as it refers to itself:
PRICE*QUANTITY=TOTAL
Use this formula instead:
PRICE*QUANTITY
This will place the result of the calculation in the calculated field TOTAL.



This change may erase or truncate the contents of the field in each record of the 
database.

Explanation
You tried to change the data type of the field definition, such as changing a text field to a number field, and this may 
cause the loss of information in the field. 

Solution
Approach does not prevent you from making this change.
Consider saving a copy of the database before you make the change. If you make a mistake, you can revert to the 
copy.



This change may truncate the contents of the field in each record of the database.

Explanation
You tried to reduce the size of the field, and this may cause the loss of information in the field. 

Solution
Approach does not prevent you from making this change.
Consider saving a copy of the database before you make the change.    If you make a mistake, you can revert to the 
copy.



This field is used in a join. Modifying this field is not revertible.
Explanation
You tried to enter a value in the join field from the detail database . If you click OK to confirm this entry, the value of 
the join field in the detail database changes and information from the record in the detail database no longer appears 
in the current view. Undesirable results such as changes to the wrong record, or creation of unwanted records can 
also occur. 
It is best only to enter or edit data in a join field when the join field is from the main database    for the view.
To see which database the view is based on,    in Design, click the view tab and open the InfoBox. Then click the 
Basics tab of the InfoBox. The main database is named in the "Main database" box on this tab.

Solution
Click Cancel.
To avoid this message, in Design, do one of the following:

• Change the field on the view to the join field from the main database for that view.
• On the Basics tab of the InfoBox for this field, change the join field to Read-only.
• Remove the field from the view.

Changing the value of the join field in the detail database
If you want to be able to change the value of the join field in the detail database, on the current    view, add a button 
that switches to a view where this database is the main database.



Too many files open.

Explanation
If you are on a peer-to-peer network, like LANtastic or Windows for Workgroups, this error occurred if you tried to 
open too many files.

Solution
Try each of these solutions, in the following order:

• If you are using WIN 95:
• Try increasing the FILES= line in the server CONFIG.SYS file to a number higher than the default of 60. 
• Try increasing the amount of Buffers in the server CONFIG.SYS file to a number higher than the default of 30.

•  If you are on a Novell network, make sure the files setting in the NET.CFG file is large enough to accommodate 
the number of open files.    

• Close one or more Approach files and try again.



Values in the field "Fieldname" are not grouped together.

Explanation
You tried to create a report or summary group,    or switch to a report that grouped records on fields that were not part
of the current sort order.    

Solution 1
Click Yes to re-sort the records by the grouped field.

Solution 2
1. Click No to keep the current sort order.
2. (Optional) Change the default sort order so Approach sorts the grouped records in the required order.



Copyright and trademark information
Under the copyright laws, neither the documentation nor software may be copied, photocopied, reproduced, 
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OS/2 are registered trademarks, and OS/2 Warp is a trademark, of International Business Machines Corporation.
Other product and company names mentioned herein may be the trademarks or registered trademarks of their 
respective owners.



Create Object dialog box
Want the big picture about OLE?    See (Overview : Communicating between apps using OLE)
Insert the following items in a form, report, mailing label, or form letter.

• An embedded OLE object
• A linked object created from a file
• An ActiveX control
• A JavaBean

Choose a task
Adding custom controls to the Tools palette
Registering custom controls
Overview: ActiveX Controls
Inserting custom controls in views
Changing properties of custom controls 
Creating linked objects from files
Embedding OLE objects based on existing files 
Embedding new OLE objects 

(When the JavaBean topics get written, need to add more jumps to this list)



Finding records that must satisfy multiple conditions (AND)
Approach lets you specify multiple conditions to find only the records that match all of the conditions.
This is called an AND find. 

Which kind of AND find do you want to do?
• AND find with conditions entered in one field

Example: Find all records that list a salary greater than $25,000 AND less than $35,000 in the Gross_Salary field.
To do this in a find request, see Finding records with AND conditions in one field.

• AND find with conditions entered in multiple fields
Example: Find all records that have both "Finance" in the Department field AND "San Francisco" in the City field.
To do this in a find request, see Finding records with AND conditions in more than one field.

AND finds in the Find Assistant
You can do both kinds of AND finds in the Find Assistant:

• See Creating a find condition with the Find Assistant.
• See Finding records using Query by Box  to do a find by manipulating graphical representations of find conditions.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_FINDING_RECORDS_THAT_MUST_SATISFY_AT_LEAS
T_ONE_OF_MULTIPLE_CONDITIONS_(OR)_REF;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS
;',0)} See related topics



Finding records that satisfy at least one of multiple conditions (OR)
Approach lets you specify multiple conditions to find records that match at least one--but not necessarily all--of the 
conditions.
This is called an OR find.

Which kind of OR find do you want to do?
• OR find with conditions entered in one field

Example: Find all records that have either "Finance" OR "Payroll" in the Department field.
To do this in a find request, see Finding records with OR conditions in one field.

• OR find with conditions entered in multiple fields
Example: Find all records that have either "Finance" in the Department field OR "San Francisco" in the City field.
To do this in a find request, see Finding records with OR conditions in more than one field.

OR finds in the Find Assistant
You can do both kinds of OR finds in the Find Assistant:

• See Creating a find condition with the Find Assistant.
• See Finding records using Query by Box  to do a find by manipulating graphical representations of find conditions.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEP
S;H_FINDING_RECORDS_THAT_MUST_SATISFY_MULTIPLE_CONDITIONS_(AND)_REF;',0)} See related 
topics



Finding records with AND conditions in one field

 Are you in Browse?
Approach lets you specify several conditions within one field to find only the records that match all of the conditions. 
1. Change to the view you want to use for finding records.
2. Choose Find - Find using [view]    on the context menu.

Or click Find in the action bar.

3. Enter the values you want to find in the appropriate field. Separate the conditions with ampersands.
4. Press ENTER.

Approach displays the found set. Check the status bar to see the size of the found set ("Found n of nn"). 
Note The found set remains the only records available to you until you select All Records from the named find 
box in the action bar, or do another find.

5. (Optional) To change one of the conditions or narrow your search by adding more conditions, choose Find - Find 
Again on the context menu.

Example
To find all employees who earn between $25,000 and $35,000, type >$25,000 & <$35,000 in the Gross_Salary field 
of an employee form find request.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_FINDING_RECORDS_WITH_OR_CONDITIONS_IN_MO
RE_THAN_ONE_FIELD_STEPS;H_FIND_RECORDS_TO_SATISFY_ONE_OF_SEVERAL_CONDITIONS_(OR)_
STEPS;H_FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CONDITIONS_(AND)_STEPS;H_APP_FIND_RE
QUESTS_OVER;H_REPEATING_FINDS_STEPS;H_FINDING_RECORDS_THAT_MUST_SATISFY_MULTIPLE_
CONDITIONS_(AND)_REF;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS;',0)} See related topics



Overview: Find types
In Approach you can find records that match certain criteria called "find conditions", by using any one of three 
methods:

• Entering find requests in Find 
You enter your conditions in a blank form or worksheet. Simply enter the value(s) you want to find in the 
appropriate fields, or use operators and functions to do more elaborate finds.

• Using the Find Assistant 
Approach guides you through finding the records you want to display. You can use the same operators and 
functions as in your find request, but you can also find duplicate records, distinct records, and records containing 
the highest or lowest values in the database. You can also sort the found set and name the find so you can use it 
again. 

• Using Query by Box 
In the Find Assistant you can choose the Query by Box find type so you can graphically design your search 
criteria.

Use the table below to determine which procedure to use for the best results.

To find records containing Example See
A specific number, date, time, or
Boolean

Find invoices due on 
5/19/97.

Finding numbers, dates, 
and times 
Finding today's date 

A number, date, or time within a 
range

Find car owners in the age 
range 25-35.

Finding values in a range 

Specific text, or text containing 
a string of characters

Find customers in San 
Jose, San Francisco, Santa
Barbara (all contain the 
string "San").

Finding text with wildcards

Text with a specific case format 
(uppercase, lowercase, mixed 
case)

Find "boxer" but not 
"Boxer".

Finding case-sensitive 
text 

Empty fields Find clients without a 
contact name.

Finding blank or nonblank
fields 

A name you do not know how to
spell, but you know its sound

Finding a customer whose 
name sounds like Philip.

Finding a word that 
sounds like another 

A comparison of data in two or 
more fields

Finding expense items 
where the actual price was 
higher than the budgeted 
price.

Using If statements to find
data 

A specific check box or radio 
button selection

Finding all male employees
(radio button selection)    
who have laptop PCs 
(check box setting).

Finding radio button and 
check box settings 

Two or more conditions in 
different fields

Find customers in Boston 
who ordered hockey sticks.

Finding records with AND 
conditions in more than 
one field 

Two or more conditions in the 
same field

Find companies whose 
name contains Sports and 
Corporation.

Finding records with AND 
conditions in one field 

Any one of multiple conditions 
in the same field 

Finding employees in the 
Training or Documentation 
departments.

Finding records with OR 
conditions in one field 

Any one of multiple conditions 
in different fields

Finding movies starring 
Harrison Ford, or directed 
by Steven Spielberg.

Finding records with OR 
conditions in more than 
one field 





Copying named finds
1. Choose Create - Named Find/Sort.
2. Select the named find or sort you want to copy.
3. Click Copy.

The Named Find/Sort dialog box appears.
4. Enter a new name for the find or sort. 
5. Click OK.
6. (Optional) To edit the copy, select the name from the list and click Edit Find or Edit Sort.
7. Click Done.

{button ,AL(`H_DELETING_NAMED_FINDS_STEPS;H_EDITING_NAMED_FINDS_STEPS;H_NAMING_FINDS_WI
TH_THE_FIND_ASSISTANT_STEPS;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS;H_NAMING_
SORTS_STEPS;H_FINDING_RECORDS_WITH_THE_FIND_ASSISTANT_OVER;',0)} See related topics



Creating a find condition with the Find Assistant
1. Choose Find - Find Assistant on the context menu.

2. In the "Type of find" box, select Basic Find.
3. Click the Condition 1 tab.
4. Select the database and the field you want to use in the find condition.
5. Under Operator, select the condtion you want data to fulfill.
6. Enter the value used for the find condition in the "Values" box. 

To create an OR find in the selected field, enter values on additional lines in the Values box. 
7. (Optional) To create additional conditions based on other fields, click Find on Another Field.

A second Condition tab appears. Select 
• "Find more records" to relate conditions with OR

• "Find fewer records" to relate conditions with AND

8. Repeat steps 4 - 6 for each additional condition.
9. To delete a condition, click the Condition's tab and then click Delete Condition.

The Delete Condition button appears on all the Condition tabs after you click Find on Another Field.
10. Click Next or Done.
Note The Description box displays the find condition you create in an English language format. 

{button ,AL(`H_FINDING_DISTINCT_OR_UNIQUE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDIN
G_DUPLICATE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_
BY_BOX_STEPS;H_FINDING_THE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS;H_S
ELECTING_A_FIND_TYPE_WITH_THE_FIND_ASSISTANT_REF;H_DELETING_FIND_CONDITIONS_STEPS;',
0)} See related topics



Details: Creating find requests
For simple finds, just enter the value you want to find in the appropriate field. For example, to find all employees 
whose last name is "Smith", type smith in the LASTNAME    field.    
Combine operations with values for more powerful finds.

Operators in find requests
Use the following operators with the find condition you enter in a field. Enter an operator in the field, or click where 
you want the operator to go and then click its icon in the set of SmartIcons.

This operator Specifies
< Less than
> Greater than

<= Less than or equal to
>= Greater than or equal to
= Equal to (if alone, finds records

having no data in the field)
<> Not equal to (if alone, finds 

records having data in the field)
, OR conditions within a field
& AND conditions within a field
… Range of values (for example, 

A…D)
* Wildcard for zero or more 

characters
? Wildcard for one character
@ Function or field reference 

indicator used with another 
operator, such as in 
=@Today(). Do not use the @ 
(at sign) within If statements.

! Case-sensitive text find
~ Sounds like
If Compound expressions

Examples of find requests
For examples of find requests that use operators, see Overview: Find Types.

Field references in find requests
Part of a find condition can refer to values in other fields. Precede the field name with @ (at sign). For example, to 
find all employees whose bonus for 1997 was greater than their 1996 bonus, enter @BONUS96 in the field 
BONUS97. Don't use @ with fields used in an If statement. Approach assumes the contents of the If statement are 
parameters, so you do not have to use the @ for field names. For more information about specifying a field name, 
see Overview: Field references, constants, and operators. 

Troubleshooting formulas in find requests
If the formula you enter in your find request results in no records found, and you know records exist for the conditions 
you set, it is possible your formula is incorrect. To test the formula, create a calculated field in the Field Definition 
dialog box, reproduce the formula there, and make corrections. When the checkered flag is no longer crossed out you
know the formula is correct. You can then copy and paste the formula into your find request.

Finding on a summary field
Find on a summary field only if it summarizes a group of records sorted by a field. Finds do not work on a grand total 
summary field, but they work on one that summarizes a number of records.

Indexing
Approach automatically creates an index the first time you find or sort on a field and stores the index in a file with the 
extension .ADX. This makes any subsequent finds or sorts on that field faster.



{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS',1)} Go to procedure
{button ,AL(`H_FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CONDITIONS_(AND)_STEPS;H_FINDING_REC

ORDS_WITH_OR_CONDITIONS_IN_MORE_THAN_ONE_FIELD_STEPS;H_FINDING_RECORDS_THAT_SATI
SFY_AT_LEAST_ONE_OF_SEVERAL_CONDITIONS_(OR)_STEPS;H_NAMED_FIND_SORT_DIALOG_BOX_C
S;H_APP_FIND_REQUESTS_OVER',0)} See related topics



Creating find requests
• A find request starts out as a blank copy of the current view. Use it to enter find conditions.
• The group of records that match the find conditions is called the found set.

 Are you in Browse?
1. Change to the view you want to use for finding records.
2. Choose Find - Find using [view] on the context menu.

Or click Find in the action bar.

3. Enter find conditions in the fields just as you would enter data in a regular view.
See details .

4. Press ENTER.
The found set  remains the only records available to you until you select All Records from the named find box in 
the action bar, or do another find. Check the status bar to see the size of the found set ("Found n of nn").

5. (Optional) To change one of the conditions or narrow your search by adding more conditions, choose Find - Find 
Again on the context menu.

{button ,AL(`H_CREATING_FIND_REQUESTS_DETAILS',1)} See details
{button ,AL(`H_DELETING_A_FOUND_SET_OF_RECORDS_STEPS;H_APP_FIND_REQUESTS_OVER;H_FINDIN

G_RECORDS_WITH_THE_FIND_ASSISTANT_OVER;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_ST
EPS;H_REPEATING_FINDS_STEPS;H_FINDING_RECORDS_TO_SATISFY_ONE_OF_SEVERAL_CONDITION
S_(OR)_STEPS;',0)} See related topics



Overview: Defining find conditions graphically in Query by Box
Query by Box creates a box for each find condition you build from elements in Table, Field, Operator, and Value. You 
define relationships between find conditions by clicking AND or OR.
You can move these boxes. To move a box, position the mouse pointer on it, hold down the left mouse button, and 
then drag the box to its new position.
Since the relative position of the boxes indicates the logical relationship of the conditions displayed in them, moving 
them changes that relationship.

Example
You are a teacher working with a database table containing students' records. In the Query by Box tab, you create 
two boxes:
A AVG_GRADE>89
B ATTENDANCE=14

If you move box 
B

You create

Inside box A An AND relationship
Both A and B must be true for every record, so
your results show only one kind of student:
Those whose average grade is greater than 
89 and who showed up for 14 class meetings

Next to box A An OR relationship
Either A or B must be true for every record, so 
your results show two kinds of students:
Those whose average grade is greater than 
89 (but who may have showed up for less than
14 class meetings)
Those who showed up for 14 classes (but 
whose average grade may be less than 89)

{button ,AL(`H_MULTIPLE_FIND_CONDITIONS_IN_QUERY_BY_BOX_OVER;H_FINDING_RECORDS_USING_QU
ERY_BY_BOX_STEPS;',0)} See related topics



Deleting find conditions
You can delete find conditions, but only if Basic find is the type of find.
If you're trying to delete a named find, choose Create - Named Find/Sort.
1. In the Find Assistant, click the tab of the condition you want to delete.
2. Click Delete Condition.

{button ,AL(`;H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_CREATING_FIND_R
EQUESTS_DETAILS;H_FIND_RECORDS_TO_SATISFY_ONE_OF_SEVERAL_CONDITIONS_(OR)_STEPS;H_
FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CONDITIONS_(AND)_STEPS;H_FINDING_RECORDS_WIT
H_OR_CONDITIONS_IN_MORE_THAN_ONE_FIELD_STEPS',0)} See related topics



Deleting named finds
If you're trying to delete one find condition from a set of find conditions, see Deleting find conditions.
1. Choose Create - Named Find/Sort.
2. Select the named find you want to delete.
3. Click Delete.

{button ,AL(`H_COPYING_NAMED_FINDS_STEPS;H_EDITING_NAMED_FINDS_STEPS;H_EDITING_NAMED_SO
RTS_STEPS;H_NAMING_FINDS_WITH_THE_FIND_ASSISTANT_STEPS;H_NAMING_FINDS_BASED_ON_FIN
D_REQUESTS_STEPS;H_NAMING_SORTS_STEPS;H_RUNNING_NAMED_FINDS_STEPS',0)} See related 
topics



Editing named finds 
1. Choose Create - Named Find/Sort.
2. Select the named find you want to edit.
3. Click Edit Find.

If the named find was created in the Find Assistant, the Find Assistant appears.
If the named find was created in a view, the view appears displaying the find condition.

4. To edit the named find in the Find Assistant, see Selecting a find type with the Find Assistant.
5. To edit the named find, see Creating find requests.
Note You can also edit a named find in the Find Assistant by clicking "Edit an existing named find" in the Find Type 
tab and then editing the steps of the named find.

{button ,AL(`H_DEFINING_FIND_CONDITIONS_GRAPHICALLY_IN_QUERY_BY_BOX_OVER;H_FINDING_RECO
RDS_USING_QUERY_BY_BOX_STEPS;H_MULTIPLE_FIND_CONDITIONS_IN_QUERY_BY_BOX_OVER;H_D
ELETING_NAMED_FINDS_STEPS;H_COPYING_NAMED_FINDS_STEPS;',0)} See related topics



Editing named sorts
1. Choose Create - Named Find/Sort.
2. Select the named sort you want to edit.
3. Click Edit Sort.

The Sort dialog box appears.
4. Be sure the database containing the field you want is showing in the Database box.
5. Select a field in the Fields box.
6. Click Add.
7. Select a field in the "Fields to sort on" box.
8. Select either Ascending or Descending in the Sort order box.
9. To add additional fields, repeat steps 4 - 9.
10. Click OK.
11. Click Done.

{button ,AL(`H_COPYING_NAMED_FINDS_STEPS;H_DELETING_NAMED_FINDS_STEPS;H_EDITING_NAMED_
FINDS_STEPS;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS;H_NAMING_FINDS_WITH_THE_F
IND_ASSISTANT_STEPS;H_REMOVING_OR_REORDERING_FIELDS_WHILE_CREATING_NEW_VIEWS_STE
PS;H_RUNNING_NAMED_FINDS_STEPS;H_NAMING_SORTS_BASED_ON_THE_CURRENT_SORT_ORDER
_STEPS;',0)} See related topics



Finding a word that sounds like another
Use this feature when you know how a name or other proper noun sounds, but aren't sure how to spell it.
Precede the find text with a tilde (~).

Example
The find text ~Philip finds "Philip," "Filip,"    and other similar-sounding words.

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_VALUES_IN_A_RANGE_STEPS;',0)} See related topics



Finding blank or nonblank fields
Approach can isolate records with blank values in a particular field.
A field is considered blank if it has a Null value or no value.
Approach can also find on fields that are not blank.

Finding blank fields
Enter an equal sign (=) by itself in a field. 

Finding nonblank fields
Enter a not-equal sign (<>) by itself in a field.

{button ,AL(`H_FINDING_CASESENSITIVE_TEXT_STEPS;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;
H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FINDING_VALUES_IN_A_RANGE_STEPS;',0)} See related 
topics



Finding case-sensitive text
Limit a specific find to be case-sensitive even in a database that is not normally case-sensitive in its searches.
Type an exclamation point (!) in front of the find condition text.

Example
In a database that is not case-sensitive, the find text Madrid finds text that begins with "Madrid," "madrid," and any 
other combination of uppercase and lowercase letters. The text !Madrid finds only text that begins with "Madrid" (with
a capital M).

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_NUMBERS_DATES_AND_TIME
S_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FINDING_VALUES_IN_A_RANGE_STEPS;',0)} 
See related topics



Finding distinct records with the Find Assistant
Find distinct records lets you use either the entire database or the current found set for find operations.
1. Choose Find - Find Assistant on the context menu.

2. In the Type of find box, select Find distinct records.
The Find Distinct tab appears.

3. Click the Find Distinct tab.
You can only search for distinct records in the main database of the current view, whose name appears in the 
"Database to search" box.

4. Be sure the database containing the field you want is showing in the Database box.
5. Select a field in the Fields box.
6. Click Add.
7. To add additional fields, repeat steps 4 - 6.
8. Click Next or Done.

{button ,AL(`H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DUPLICAT
E_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_BY_BOX_ST
EPS;H_FINDING_THE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS;H_REMOVING_
OR_REORDERING_FIELDS_WHILE_CREATING_NEW_VIEWS_STEPS;H_SELECTING_A_FIND_TYPE_WITH
_THE_FIND_ASSISTANT_REF',0)} See related topics



Finding duplicate records with the Find Assistant
Find duplicate records lets you use either the entire database or the current found set for find operations.    
1. Choose Find - Find Assistant from the context menu.

2. In the Type of find box, select Find duplicate records.
The Find Duplicates tab appears.

3. Click the Find Duplicates tab.
You can only search for duplicates in the main database of the current view, whose name appears in the 
"Database to search" box.

4. Be sure the database containing the field you want is showing in the Database box.
5. Select a field in the Fields box.
6. Click Add.
7. To add additional fields, repeat steps 4 - 6.
8. Click Next or Done.
Note  If you click "Exclude first record found in each set of duplicates," then the first record found by Approach in a 
set of duplicate records will not be included in the found set. Use this option to delete duplicate records in the found 
set but leave the first record untouched. 

{button ,AL(`H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DISTINCT
_OR_UNIQUE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_
BY_BOX_STEPS;H_FINDING_THE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS;H_R
EMOVING_OR_REORDERING_FIELDS_WHILE_CREATING_NEW_VIEWS_STEPS;H_SELECTING_A_FIND_T
YPE_WITH_THE_FIND_ASSISTANT_REF',0)} See related topics



Finding numbers, dates, and times
Find a value in a numeric, Boolean, date, or time field.
You can also find a value in a calculated field that returns a number, Boolean value, date, or time. 

Finding a number
Type the number in a numeric or calculated field.
Do not type format characters such as currency symbols or commas with the number. If the field has a format, 
Approach provides these characters automatically.

Finding a Boolean value
Type 0 or 1, or Y or N,  in a Boolean or calculated field.

Finding a date
Type the date as numbers in a date or calculated field. 
Separate the numbers with non-numeric characters such as slashes (/). Type a single number to find a day for the 
current month and year. The order of the month, day, and year is determined by the date format of the operating 
system.
Type 1, 2, 3, or 4 digits for the year. Approach interprets one-digit (9) and two-digit (95) years to refer to the twentieth 
century. If you don't type a year, Approach assumes the current year (based on your system settings) and enters it for
you.

Finding a time
Type the time as numbers in a time or calculated field. 
Separate the numbers with colons (:). Type a single number to enter an hour.
Use either a 12-hour or a 24-hour format. If you enter an hour less than 12 without a suffix of AM or PM, Approach 
assumes AM.

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FINDING_TODAYS_DATE_STEPS;H_FINDING_VALUES_I
N_A_RANGE_STEPS;',0)} See related topics



Finding radio button and check box settings
Approach lets you look for all records that have a specified combination of radio button and check box settings. 
Turn on the radio buttons and checkboxes in the find request to specify the combination you want to find.
To specify a No value for a check box, such as "payment not received," click the check box to turn it on and then click
it again to turn it off. A check box is Null (containing no value either positive or negative) until it is clicked at least 
once.

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_VALUES_IN_A_RANGE_STEPS;',0)} See related topics



Finding records with AND conditions in more than one field

 Are you in Browse?
Enter conditions in more than one field in a single find request, and Approach finds only the records that satisfy all the
conditions.
1. Change to the view you want to use for finding records.
2. Choose Find - Find using [view] on the context menu.

Or click Find in the action bar.

3. Enter values in the appropriate fields.
4. Press ENTER.

Approach displays the found set. Check the status bar to see the size of the found set ("Found n of nn"). The 
found set remains the only records availavle to you until you select All Records from the named find box in the 
action bar, or do another find.

5. (Optional) To change one of the conditions or narrow your search by adding more conditions, choose Find - Find 
Again on the context menu.

Example
To find all employees who work in the Finance department and live in San Francisco, type Finance in the Department
field and San Francisco in the City field of an employee form. Only records that satisfy both of these conditions 
appear in the found set.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_FINDING_RECORDS_WITH_OR_CONDITIONS_IN_MO
RE_THAN_ONE_FIELD_STEPS;H_FIND_RECORDS_TO_SATISFY_ONE_OF_SEVERAL_CONDITIONS_(OR)_
STEPS;H_APP_FINDING_RECORDS_WITH_AND_CONDITIONS_WITHIN_ONE_FIELD_STEPS;H_DELETING
_A_FOUND_SET_OF_RECORDS_STEPS;H_FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CONDITIONS
_(AND)_STEPS;H_DELETING_FIND_CONDITIONS_STEPS;H_NAMING_FINDS_BASED_ON_FIND_REQUEST
S_STEPS;H_APP_FINDING_RECORDS_THAT_MUST_SATISFY_MULTIPLE_CONDITIONS_REF;H_FINDING_
RECORDS_USING_QUERY_BY_BOX_STEPS;',0)} See related topics



Finding records using Query by Box

 Show me a QuickDemo 
1. Choose Find - Find Assistant on the context menu.

2. In the Type of find box, select Find using Query by Box.
The Query by Box tab appears.

3. Click Next.
4. Select a database in the Table box.
5. Select a field in the Field box.
6. Select an operator in the Operator box.

The operator you select defines the relationship between the data in the selected field in Field box and the value 
you enter in Value. 

7. Enter a value in the Value box.
A graphical representation of the find condition appears. 

8. (Optional) To create an AND find, click And. 
(Optional) To create an OR find, click Or.

9. (Optional) Repeat steps 4 - 7 for each condition you create.
10. Click Next or Done.

{button ,AL(`H_DEFINING_FIND_CONDITIONS_GRAPHICALLY_IN_QUERY_BY_BOX_OVER;H_MULTIPLE_FIND
_CONDITIONS_IN_QUERY_BY_BOX_OVER;H_SELECTING_A_FIND_TYPE_WITH_THE_FIND_ASSISTANT_
REF;',0)} See related topics



Finding records with OR conditions in more than one field

 Are you in Browse?
For each field where you want to enter additional OR conditions, you must create a new find request form.
1. Change to the view you want to use for finding records.
2. Choose Find - Find using [view] on the context menu

Or click Find in the action bar.

3. Enter the OR condition for the first field. 
4. To add an additional condition on a different field, do one of the following:

• Click New Condition in the action bar.

• Choose Find - Find More on the context menu. 
A new find request appears.

5. Enter the OR condition for another field.
6. (Optional) To enter additional OR conditions for other fields click New Condition in the action bar.
7. Press ENTER.

Approach displays the found set. Check the status bar to see the size of the found set ("Found n of nn"). The 
found set remains the only records available to you until you select All Records from the named find box in the 
action bar, or do another find.

8. (Optional) To change one of the conditions or narrow your search by adding more conditions, choose Find - Find 
Again on the context menu.

Example
To find all employees who work in the Finance department or live in San Francisco, type Finance in the Department 
field of one find request and San Francisco in the City field of a second find request.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_DELETING_A_FOUND_SET_OF_RECORDS_STEPS;H_
FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CONDITIONS_(AND)_STEPS;H_FIND_RECORDS_TO_SAT
ISFY_ONE_OF_SEVERAL_CONDITIONS_(OR)_STEPS;H_DELETING_FIND_CONDITIONS_STEPS;H_NAMIN
G_FINDS_BASED_ON_FIND_REQUESTS_STEPS;H_APP_FINDING_RECORDS_THAT_MUST_SATISFY_MUL
TIPLE_CONDITIONS_REF;H_FINDING_RECORDS_USING_QUERY_BY_BOX_STEPS;',0)} See related topics



Overview: Finding records with the Find Assistant
The Find Assistant guides you through the process of finding and displaying a set of records that meet conditions you
define. 
To use the Find Assistant, choose Find - Find Assistant on the context menu. 

With the Find Assistant, you select the type of find and specify a find condition. You can also sort the found set, and 
name the find so you can use it again.
The Find Assistant starts with four tabs: Find Type, a context-sensitive tab, Sort, and Name. 

Find Type
Select from the different find types. You can select a general purpose find or a more specialized find, such as one that
finds only one instance of each value in a field, or top or lowest values. You can also perform a find using Query by 
Box.

Context-sensitive
The context-sensitive tab changes depending on the find type you select. On each of these tabs, you must select a 
database, fields from the database, and conditions for the find. 

Sort
Sorting your records is an optional step. The Sort tab lets you select a database, the fields to sort on, and the order of
the sort. 

Name
In Name, you can review and name the find.
A description box displays your find in an English language format.
Naming a find makes it easy for you to perform the find again. You don't have to re-create the find; you just select the 
named find from the named find box in the action bar.

{button ,AL(`H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DISTINCT
_OR_UNIQUE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DUPLICATE_RECORDS_WIT
H_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_BY_BOX_STEPS;H_FINDING_T
HE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS;H_SELECTING_A_FIND_TYPE_WIT
H_THE_FIND_ASSISTANT_REF',0)} See related topics



Finding text with wildcards
When you choose the Find command from a context-sensitive menu, you define a find condition by entering text in a 
blank field.    Approach can find text that matches a string of characters, a word, or a phrase in a text field. You can 
also include the asterisk (*) and question mark (?) wildcards in a find.
Use wildcards when you create a find condition from the view. The Find Assistant has a set of operators you can use 
when creating a find condition that takes the place of wildcards.

Finding text
Type the characters in a text field.
If you want the match to be exact, precede the characters with an equal sign.

Example of an exact match
• Payroll finds "Payroll," "Payroll Dept.," and any other text that begins with the find text.
•  =Payroll finds only "Payroll."

Matching any number of characters in a field
Include an asterisk (*) in the find text.

Example of using asterisk (*)
•  *past* finds records that contain the text "past" anywhere in the find field.
• san* can find "San Francisco" and "Santa Rosa" but not "Asante." 
•  *r* can find "red" and "green" but not "blue." 
• *o can find "solo" and "trio" but not "dot."
• g*s can find "grants" and "goods" but not "green."

Matching a single character in a field
Include a question mark (?) in the find text for wildcard replacement of a single character.

Example of using question mark (?)
•  to? can find "toy" and "tom" but not "today." 
•  ?an can find "ran" and "pan" but not "plan." 
•  to??y can find "today" and "Tommy" but not "toy" and "tom." 
•  ?o? can find "Tom" and "son" but not "today" and "Troy."

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_VALUES_IN_A_RANGE_STEPS;',0)} See 
related topics



Finding the top or lowest values with the Find Assistant
1. Choose Find - Find Assistant on the context menu.

2. In the Type of find box, select Find the top or lowest values.
The Find Top/Lowest    tab appears.

3. Click the Find Top/Lowest tab.
You can only search for the top or lowest values or percentages in the main database of the current view, whose 
name appears in the "Database to search" box.

4. Select a top or lowest value or percentage in the "Find the" box.
5. Select the number or percentage of values.
6. Select a field to find values for in the Fields box.
7. To select a summary report:

• Select a calculated field in the "values in field" box.
• Select the type of summary report you want to use in the "Summarized on" box.

Summary reports only display when you select a calculated field from a report that has grouped records.
8. Click Next or Done.

{button ,AL(`H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DISTINCT
_OR_UNIQUE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DUPLICATE_RECORDS_WIT
H_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_BY_BOX_STEPS;H_SELECTIN
G_A_FIND_TYPE_WITH_THE_FIND_ASSISTANT_REF',0)} See related topics



Finding today's date
Enter a comparison operator and @Today() in a date or calculated field.
The Today function returns the current date on your system clock, and the at sign (@) tells Approach to compare the 
system date from the Today function with values in the records.

Examples
•  =@Today() finds records with fields that match today's date.
•  >=@Today() finds records with fields that either match or are later than today's date.

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_VALUES_IN_A_RANGE_STEPS;',0)} See related topics



Finding values in a range
• Approach looks for values that fall within an inclusive range in a text, numeric, date, time, or memo field.
• You can also find values in a calculated field that return a number, date,    time, or text string.

Enter an ellipsis (…) between the beginning value and the ending value of the range.

Example
H...J in a text field finds all text strings that begin with the letters H or I. It would find the letter J but not any text 
strings that had letters after J (such as Jack).
7...9 in a numeric field finds the values 7, 8, and 9 (but not 9.0000001). 
The string 5/1/96...5/31/96 finds all dates in the month of May 1996.

{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS
;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_THE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS;',0)} See related topics



Finding records with OR conditions in one field

 Are you in Browse?
1. Change to the view you want to use for finding records.
2. Choose Find - Find using [view] on the context menu.

Or click Find in the action bar.

3. Enter the values you want to find in the appropriate field. Separate the values with commas.
4. Press ENTER.

Approach displays the found set. Check the status bar to see the size of the found set .
Note The found set remains the only records available to you until you select All Records from the named find 
box in the action bar, or do another find.

5. (Optional) To change one of the conditions or narrow your search by adding more conditions, choose Find - Find 
Again on the context menu.

Example
To find all employees who work in the Finance department or the Payroll department, type Finance,Payroll in the 
Department field of an employee form find request.

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_FINDING_RECORDS_THAT_SATISFY_MULTIPLE_CON
DITIONS_(AND)_STEPS;H_FINDING_RECORDS_THAT_MUST_SATISFY_MULTIPLE_CONDITIONS_(AND)_R
EF;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS;',0)} See related topics



Overview: Multiple find conditions in Query by Box

Conditions related by AND
Connect two or more find conditions with AND when you want to retrieve only those records for which all the 
conditions are true. For example, you want to retrieve records of employees who work in the Atlanta office and who 
are in the Sales department.
There are two find conditions:
CITY=Atlanta
DEPT=SALES
The find condition CITY=Atlanta AND DEPT=SALES is represented as

Conditions related by OR
Connect two or more find conditions with OR when you want to retrieve records for which at least one of the 
conditions is true. For example, you want to retrieve records of employees who work either in the Boston or the 
Atlanta office. 
There are two find conditions, and each record must fulfill at least one condition. It is true if it meets either condition:
CITY=BOSTON
CITY=ATLANTA
The find condition CITY=BOSTON OR CITY=ATLANTA is represented as

Conditions related by multiple operators
You can connect three or more find conditions with combinations of AND and OR relationships.
For example, you want to retrieve the records of employees in either the Boston or the Atlanta office who are in the 
Sales department.
There are three conditions. All records must meet the condition:
DEPT=SALES
In addition, each record must fulfill one of the following conditions, but not both:
CITY=BOSTON
CITY=ATLANTA
The conditions DEPT=SALES AND (CITY=Atlanta OR CITY=Boston) are represented as

{button ,AL(`H_DEFINING_FIND_CONDITIONS_GRAPHICALLY_IN_QUERY_BY_BOX_OVER;H_FINDING_RECO
RDS_USING_QUERY_BY_BOX_STEPS;',0)} See related topics



Named Find/Sort dialog box
The Named Find/Sort dialog box lets you define and name finds and sorts. After saving the finds and sorts, you easily
edit, copy, delete, and use them to find or sort again.

Choose a task
Naming finds based on find requests
Naming finds with the Find Assistant
Editing named finds
Copying named finds
Deleting named finds
Running named finds
Naming sorts based on the current sort order 
Editing named sorts



Naming and reviewing finds with the Find Assistant
Command: Find - Find Assistant on the context menu.

Tab: Name
The Name tab lets you name your find and review it. 
If you defined a sort condition in the Sort tab as well as a find, then the named find will contain both a find and a sort. 
Both the find and sort conditions display in an English language format under Description.

Naming finds
Name the find by entering a name in the named find box. By naming the find (and at the same time a sort, if you 
define one), you can repeat the find without having to create the find again.
To perform the find again, do one of the following:

•  Select the name from the named find box in the action bar.
•  Choose Create - Named Find/Sort, select the named find and click Run. 

Named finds and sorts can only be used in the Approach file (.APR) where they are created. 

Reviewing finds
The find appears in a box in Name in an English language format. The find is based on your input in the other Find 
Assistant tabs. 

{button ,AL(`H_EDITING_IN_QUERY_BY_BOX_STEPS;H_EDITING_NAMED_FINDS_STEPS;H_SORTING_FIELD
S_WITH_THE_FIND_ASSISTANT_STEPS;H_DELETING_NAMED_FINDS_STEPS;',0)} See related topics



Naming finds based on find requests
1. Choose Create - Named Find/Sort.
2. Click New.

A message box asks if you want to define your find using the current view or the Find Assistant.
3. Click View.
4. Create the find request.
5. Press ENTER.

The Name Find/Sort dialog box appears.
6. Enter a name for the find. 
7. Click OK.

The Named Find/Sort dialog box displays the name of the new find in the list of finds and sorts.
8. (Optional) To perform the new find, select it from the list and click Run.
9. Click Done.
Note Named finds and sorts can only be used in the Approach file (.APR) where they are created.

{button ,AL(`H_COPYING_NAMED_FINDS_STEPS;H_DELETING_NAMED_FINDS_STEPS;H_EDITING_NAMED_
FINDS_STEPS;H_EDITING_NAMED_SORTS_STEPS;H_NAMING_FINDS_WITH_THE_FIND_ASSISTANT_STE
PS;H_NAMING_SORTS_BASED_ON_THE_CURRENT_SORT_ORDER_STEPS;H_RUNNING_NAMED_FINDS
_STEPS;',0)} See related topics



Naming finds with the Find Assistant

 Show me a QuickDemo 
1. Choose Create - Named Find/Sort.
2. Click New.

A message box asks if you want to define your find using the current view or the Find Assistant.
3. Click Assistant.

The Find Assistant dialog box appears.
4. Using the tabs of the Find Assistant, create the find and then name it.
5. Click Done in the Find Assistant. 

The Named Find/Sort dialog box displays the name of the new find in the list of finds and sorts.
6. (Optional) To perform the new find, select it from the list and click Run.
7. Click Done.

{button ,AL(`H_COPYING_NAMED_FINDS_STEPS;H_DELETING_NAMED_FINDS_STEPS;H_EDITING_NAMED_
FINDS_STEPS;H_EDITING_NAMED_SORTS_STEPS;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_ST
EPS;H_NAMING_SORTS_STEPS;H_RUNNING_NAMED_FINDS_STEPS',0)} See related topics



Naming sorts based on the current sort order
1. Define your sort order.
2. Choose Create - Named Find/Sort.
3. Select <Current Find/Sort>.
4. Enter a name for the sort. 
5. Click Done.

The named sort appears in the named find/sort box on the action bar.
Note Named finds and sorts can only be used in the Approach file (.APR) where they are created.

{button ,AL(`H_EDITING_NAMED_SORTS_STEPS;',0)} See related topics



Repeating finds
Approach keeps track of your most recent find so that you can easily repeat it. This is useful when you want to edit 
the find and narrow its scope to include other conditions.
To repeat a find, you must be in a view based on the same database used when the find was created and have not 
used the Find All command.
1. Choose Find - Find Again on the context menu.

2. The find request appears. Edit the request to redefine the found set.
3. Press ENTER.

{button ,AL(`H_SHOWING_ALL_RECORDS_STEPS;H_RUNNING_NAMED_FINDS_STEPS;',0)} See related topics



Running named finds
You can also run a named find by selecting it from the named find box in the action bar.
1. Choose Create - Named Find/Sort.
2. Select the named find you want to run.
3. Click Run.
Note The name of the find you select appears in the action bar until you select All Records from the named find box 
in the action bar.

{button ,AL(`H_COPYING_NAMED_FINDS_STEPS;H_DELETING_NAMED_FINDS_STEPS;H_EDITING_NAMED_
FINDS_STEPS;H_EDITING_NAMED_SORTS_STEPS;H_NAMING_FINDS_WITH_THE_FIND_ASSISTANT_STE
PS;H_NAMING_FINDS_BASED_ON_FIND_REQUESTS_STEPS;H_NAMING_SORTS_STEPS',0)} See related 
topics



Selecting a find type with the Find Assistant
Command: Find - Find Assistant on the context menu.

Tab: Find Type
The Find Type tab lets you select a find type. Different find types retrieve very different information from the same 
database.
Each find type has a context-sensitive tab associated with it. Click this context-sensitive tab after you select a find 
type.

Basic find
Executes the most common finds and can include AND and OR conditions.

Find duplicate records
Finds records that have duplicate values in one or more fields. 

Find distinct records
Finds records with distinct values in one or more fields.

Find the top or lowest values
Finds some number or percentage of the highest or lowest values in numeric or calculated fields. 

Find using Query by Box
Lets you graphically create finds and can include AND and OR conditions.

Clearing finds
To clear the find so that you can work with all the records in the database, select All Records from the named find box
in the action bar.

{button ,AL(`H_CREATING_A_FIND_CONDITION_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DISTINCT
_OR_UNIQUE_RECORDS_WITH_THE_FIND_ASSISTANT_STEPS;H_FINDING_DUPLICATE_RECORDS_WIT
H_THE_FIND_ASSISTANT_STEPS;H_FINDING_RECORDS_USING_QUERY_BY_BOX_STEPS;H_FINDING_T
HE_TOP_OR_LOWEST_VALUES_WITH_THE_FIND_ASSISTANT_STEPS',0)} See related topics



Showing all records
If you're trying to determine the number of records in the current found set and the number of records in the entire 
database, look at the status bar. For example, a find condition where five of ten records in a database match the 
condition displays as "Found 5 of 10."

• When you finish working with a found set, select All Records in the named find box in the action bar so you can 
see all the records in the database again.

This also returns records to their original sort order.
• You can also choose Find - Find All on the context menu.

{button ,AL(`H_REPEATING_FINDS_STEPS;',0)} See related topics



Sorting fields with the Find Assistant
This is an optional step. You can create a find condition without sorting the fields.
If you're trying to sort all the records in a database, choose Sort - Define on the context menu. Sorting fields with 
the Find Assistant sorts the found set only. 
1. Choose Find - Find Assistant on the context menu.

2. Select a find type, click the context tab, and create the find conditions.
3. Click the Sort tab.
4. Be sure the database containing the field you want is showing in the Database box.
5. Select a field in the Fields box.
6. Click Add.
7. Select the field in the "Fields to sort on" box.
8. Select either Ascending or Descending in the Sort order box.
9. To add additional fields, repeat steps 4 - 8.
10. To select a summary report:

• Select a calculated field in the "Fields to sort on" box.
• Select a summary field in the "Summary fields" Box.
• Select the type of summary report you want to use in the "Summarized on" box.

Summary fields and reports only display when you select a calculated field from a report that has grouped 
records.

11. Click Next or Done.
Note  You can only name a find or sort in the Name tab of the Find Assistant. You must define a find condition in the 
assistant before you name the sort. 

{button ,AL(`H_NAMING_AND_REVIEWING_FINDS_WITH_THE_FIND_ASSISTANT_REF;H_REMOVING_OR_RE
ORDERING_FIELDS_WHILE_CREATING_NEW_VIEWS_STEPS;H_SORTING_RECORDS_BY_A_FIELD_IN_A
_VIEW_ASCENDING_DETAILS;H_SORTING_RECORDS_BY_A_FIELD_IN_A_VIEW_DESCENDING_DETAILS;
H_SPECIFYING_A_SORT_ORDER_DETAILS;H_NAMING_SORTS_BASED_ON_THE_CURRENT_SORT_ORD
ER_STEPS;',0)} See related topics



Sorting records by a field in a view (Ascending)
Approach lets you quickly sort the records in a view in ascending order.

 Are you in Browse?
1. Click a field to select it.
2. Choose Sort - Ascending on the context menu.

{button ,AL(`H_SORTING_FIELDS_WITH_THE_FIND_ASSISTANT_STEPS;H_SORTING_RECORDS_BY_A_FIEL
D_IN_A_VIEW_DESCENDING_STEPS;H_SPECIFYING_A_SORT_ORDER_STEPS;H_NAMING_SORTS_BASE
D_ON_THE_CURRENT_SORT_ORDER_STEPS;',0)} See related topics



Sorting records by a field in a view (Descending)
Approach lets you quickly sort the records in a view in descending order.

 Are you in Browse?
1. Click a field to select it.
2. Choose Sort - Descending on the context menu.

{button ,AL(`H_SORTING_FIELDS_WITH_THE_FIND_ASSISTANT_STEPS;H_SORTING_RECORDS_BY_A_FIEL
D_IN_A_VIEW_ASCENDING_STEPS;H_SPECIFYING_A_SORT_ORDER_STEPS;H_NAMING_SORTS_BASED
_ON_THE_CURRENT_SORT_ORDER_STEPS;',0)} See related topics



Details: Specifying a sort order
Approach Index
Approach automatically creates an index the first time you find or sort on a field (except for memo fields). This is a 
way for Approach to organize your data so subsequent finds or sorts on that field go faster.

Sort fields
A sort field can be any data type (except PicturePlus, variable, or memo) that returns text or a number, Boolean 
value, date, or time. Sort records by text fields in alphabetical order, by numeric fields in numerical order, by Boolean 
fields using Yes or No, and by date and time fields in chronological order.
The first field you specify is the primary sort field. Approach sorts the records by the contents of that field. Specify 
other sort fields for Approach to use in case any records have the same value in the primary field. For example, you 
might use Last Name as a primary sort field and First Name as an additional sort field.

Ascending or descending order
Ascending order sorts records from

• A to Z, for text (case-insensitive)
• Smallest to largest, for numbers
• Earliest to latest, for dates and times

Descending order sorts from
• Z to A, for text (case-insensitive)
• Largest to smallest, for numbers
• Latest to earliest, for dates and times

{button ,AL(`H_SPECIFYING_A_SORT_ORDER_STEPS',1)} Go to procedure



Specifying a sort order
You can sort either the current found set or the entire database.
1. Find the records you want to sort, or show all records in the database.
2. Choose Sort - Define from the context menu.
3. Be sure the database containing the field you want is showing in the Database box.
4. Select a field in the Fields box.
5. Click Add.
6. Select a field in the "Fields to sort on" box.
7. Select either Ascending or Descending in the Sort order box.
8. Repeat Steps 3 - 7 for any other fields to be sorted. 
9. Click OK.

Including summary fields in the sort
1. While the Sort box is open, click Summaries.
2. Select a field from the "Summary fields" box.
3. Click Add.
4. Select a Summarized on option. 
5. To add additional fields, repeat steps 2 - 4.
6. Click Summaries.
7. Click OK.

{button ,AL(`H_SPECIFYING_A_SORT_ORDER_DETAILS',1)} See details
{button ,AL(`H_SORTING_FIELDS_WITH_THE_FIND_ASSISTANT_STEPS;H_SORTING_RECORDS_BY_A_FIEL

D_IN_A_VIEW_ASCENDING_STEPS;H_SORTING_RECORDS_BY_A_FIELD_IN_A_VIEW_DESCENDING_ST
EPS;H_NAMING_SORTS_BASED_ON_THE_CURRENT_SORT_ORDER_STEPS;',0)} See related topics



Overview: The found set
The found set is the group of records that match your find. It is the result of performing a find either in the Find 
Assistant or by choosing Find - Find on the context menu. 
The status bar shows the number of records in the current found set and the number of records in the entire 
database. For example, a find condition where five of ten records in a database match the condition displays as 
"Found 5 of 10."
Check the status bar to see if you are still in the found set or are using the entire database. Click the status bar if you 
don't see the number of records.
Approach works with the current found set until you perform another find or select All Records from the named find 
box in the action bar. Selecting All Records shows all the records in the database and returns the records to their 
original sort order.

Results of the same find can differ
Be careful using a named find in any view other than the one you created it for.
Remember that in an Approach file that has joined databases, each view in the file can have a different main 
database. Therefore, the results of a find run in one view can differ from results of the same find run in another view.
When you're creating a find using the Find Assistant, Approach always shows you the fields of the view's main 
database first. Check that the database is the one you want and will give you the found set you expect. 

{button ,AL(`H_CREATING_FIND_REQUESTS_STEPS;H_FINDING_RECORDS_WITH_THE_FIND_ASSISTANT_O
VER;H_MAIN_AND_DETAIL_DATABASES_IN_A_VIEW_OVER;H_APP_FIND_REQUESTS_OVER',0)} See 
related topics



Details: Using If statements to find data
Field names
Enclose a field name in double quotation marks if it begins with a number, if it contains a space, a period, a comma, 
or one of the following characters:
/, #, +, -, <, >, (, )

Joined databases
If the Approach file has joined databases, include the name of the database in the reference.    Separate the database
name and the field name with a period. For example:
CUSTOMER.Address

Example of references to joined databases
The following conditional statement returns YES where the value of the Quantity field in the ORDERS database is 
greater than the Quantity field in the SUPPLY database.
If(ORDERS.Quantity>SUPPLY.Quantity)

Combining expressions
It is possible to combine expressions in an If statement with the And and Or operators. This is a more concise way to 
express compound conditions than using multiple fields with different conditions.

Example of combining expressions
If((Department='Finance')And(City='San Francisco'))
If((Amount>200)Or(Date<'4/30/94'))
If((Today()-InvoiceDate<=90)And(BalanceDue>0))

Example of a comparison expression
This statement finds records that have a higher value in the ActualCost field than in the Budget field:
If(ActualCost>Budget)

{button ,AL(`H_USING_IF_STATEMENTS_TO_FIND_DATA_STEPS',1)} Go to procedure
{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS

;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_VALUES_IN_A_RANGE_STEPS;',0)} See related topics



Using If statements to find data
When you use an If statement for finding data, Approach returns a value of Yes or No based on the If statement for 
each record in the database. The records that return Yes are included in the found set.
1. Put the statement in any field in the request. 

It does not have to be one of the fields referred to in the statement.
The statement can include field references, constants, and any other relational operators. 

2. Enclose text, date, and time constants in single quotation marks.
3. Press ENTER to begin the find. 

{button ,AL(`H_USING_IF_STATEMENTS_TO_FIND_DATA_DETAILS',1)} See details
{button ,AL(`H_FINDING_BLANK_OR_NONBLANK_FIELDS_STEPS;H_FINDING_CASESENSITIVE_TEXT_STEPS

;H_FINDING_NUMBERS_DATES_AND_TIMES_STEPS;H_FINDING_TEXT_WITH_WILDCARDS_STEPS;H_FIN
DING_VALUES_IN_A_RANGE_STEPS;',0)} See related topics



Installing more Approach options
If you chose not to install certain Approach options in your initial installation, you can install them at any time.
1. Insert the CD-ROM in the appropriate drive and close the drive door.
2. Click Start, and then choose Run.
3. Type x:install, where x: is the CD-ROM drive.
4. Click OK.

The Lotus Install program starts.
5. Follow the instructions in Install.
6. In the Install Options & Approach Folder dialog box, select "Customize features - Manual install."
7. Click Next.
8. On the Approach, SmartMasters, and PowerKeys tabs, select the options you want to install. 
9. Deselect all other features on all tabs.
10. Click Next and continue to follow the instructions in Install.



Uninstalling Approach and Approach options
If you want to remove some Approach options, Lotus recommends that first you uninstall Approach. Then, do a 
manual install and select the options you want.
This procedure ensures that you remove files stored in non-Approach directories, as well as Approach settings in the 
Windows registry. The procedure does not remove files in your approach\work directory.
1. Click Start, and then choose Settings, and then choose Control Panel.
2. Double-click the Add/Remove Programs icon.

The Add/Remove Programs Properties dialog box appears.
3. Select the edition of Lotus Approach you want to uninstall.
4. Click Add/Remove.

A confirmation box appears.
5. Click Yes.
6. Skip any folders that are not empty.

When all files are removed a box appears.
7. Click Yes.
8. In Windows Explorer, delete any remaining Approach files and folders you no longer want to keep.

{button ,AL(`H_APP_INSTALLING_MORE_APPROACH_OPTIONS_STEPS;',0)} See related topics



Getting help from the Internet
If you are experiencing problems and you can't find help in the online Help or paper documentation, contact Lotus 
Customer Support on the Internet.
Note You must have a default browser registered in Approach to use Internet support.

To get help from Customer Support
1. Choose Help - Lotus Internet Support - Lotus Customer Support.

Approach opens your Internet browser application at the Lotus Customer Support page.
2. Navigate through the menus to find the information you need.

To download files from the Lotus FTP site
1. Choose Help - Lotus Internet Support - Lotus FTP Site.

2. Navigate through the menus to find the file(s) you want to download.

To browse the Lotus Web pages
1. Choose Help - Lotus Internet Support - Lotus Home Page.

2. Navigate through the menus to find the information you need.



Using QuickDemos
QuickDemos are short, live demonstrations of actual tasks in Approach.

Running a QuickDemo
1. Click a topic in the list of QuickDemos that follows.

A Help topic appears.
2. In the Help topic, click the QuickDemo icon.

List of QuickDemos
Adding a repeating panel to existing forms 
Adding new records 
Finding records using Query by Box 
Naming finds with the Find Assistant 
Switching to another view with a macro 

What does a QuickDemo do?
• Opens a sample file. Your Approach files are not affected by the QuickDemo.
• Performs the task described in the Help topic, one step at a time. 

QuickDemos are short; they take only a few minutes to run.
Lotus recommends that you let a QuickDemo play until it ends. If you must stop the QuickDemo, press ESC.

• Closes the sample file.
• Displays the Help topic again.

Having seen the QuickDemo, you can now follow the Help topic to complete the task yourself. Help stays visible 
while you work.



Using Help

Press F1 (Help) for help where you are
Approach provides assistance on the task you can do from where you are. If you can do more than one task, 
Approach gives you a list of tasks to select from.

If you don't know where to start
1. Choose Help - Help Topics.
2. Click Index.
3. Enter the task or term you want information on.
4. Select the index entry you want, and then click Display.

Press F1 (Help) or click Help in a dialog box or InfoBox
• In the InfoBox

• In a dialog box

If you need more information about a task
Scroll to the bottom of the Help topic. Click one of the buttons to see

• Details on the current context
• An example of the task
• A procedure giving steps to complete the task
• Topics related to the current topic

If you see "If you're trying to" in a topic
Check the note to be sure you're in the right place in Approach to accomplish your task.

Let us know how we're doing!
We'd like to hear how we can help you better. Please send your comments, suggestions, and questions about the 
Help system to
User Assistance
Lotus Approach
800 El Camino Real West
Mountain View, CA 94040



Overview: Using LotusScript in Approach
LotusScript is an object-oriented programming language for automating tasks in applications you develop in 
Approach. LotusScript is more powerful and flexible than the Approach macro language, but it also requires that you 
have some basic programming skills. 
Some of the tasks that you can accomplish with LotusScript in Approach include the following:

• Triggering the execution of scripts in response to many different user actions (clicking or double-clicking the 
mouse, pressing a key)

• Changing the attributes (color, size, position, visibility) of a text block or other display element in view
• Displaying or manipulating Approach dialog boxes
• Quickly searching or making global changes to data in large databases
• Automating the display and modification of data in views
• Incorporating OCXs (OLE Custom Controls) into an application

For more information about LotusScript, see the following topics:
LotusScript Index 
Approach classes 
Approach events 
Approach methods 
Approach properties 

Automating Approach tasks
When you are planning to automate Approach tasks, keep in mind some of the other tools Approach provides for 
automating tasks. In some cases, there may be a better method than writing a script for accomplishing a particular 
task. 
For example, creating a named find lets you search for records according to the find conditions you define. Then, by 
saving the conditions, you can easily repeat the search anytime. A named find is easier and more efficient than doing 
the same task in LotusScript.
The following topics describe automating Approach tasks without using LotusScript:
Named finds
Drill-down to Data
Macros



Build the database in Approach

Previous topic
After you walk through this process to create an outline of fields and databases, you are ready to create the database
application in Approach.
1. Create a database for each group of fields, or open a SmartMaster template that comes close to what you need.
2. Create the fields in each database. You can reduce the amount of data you have to enter and maintain by using 

calculated fields.
3. Repeat steps 1 and 2 for other databases in your design.
4. Join the databases together from inside one Approach file. (You can use one Approach file for the entire 

application.)
5. Create views like forms or reports for entering information into the databases. Use data-entry controls to make 

entering data faster and more consistent.
6. Delete the extra Approach files. Once you have joined the databases and created the views you need in one 

APR, you don't need all the other APR files.
7. Create views like reports or charts for presenting the information, especially the relationships across the joined 

databases.

Now you're the director.



Check for redundant information

Previous topic
This final pass through the fields you listed for your database application is a clean-up step that makes the databases
as small and fast as possible. 

Duplicated fields
In most cases, if two databases have more than the join field or fields in common, figure out which database is a 
better fit for the duplicated fields and remove them from the other database. You may want to go back over your main 
ideas for each database to help decide where the data belongs.
No field other than a join field should appear more than one time in the entire set of information. 
The exception to this rule is a case where you want one copy of the data to stay the same even if you change the 
original. For example, in your database for your business, you have only one field for the price of a product, and you 
refer to that price field on an order. Later, if you change the price in the product database (for example, a sale price at
the year's end), the old orders automatically update to use the new price. 
In this case, you would keep the duplicate price fields to allow for a current price that can change, and a price history 
that stays the same. Approach makes it easy for you to look up the value in a field, like the current price for a product,
when you fill in another field, like the price on an order.

Unnecessary fields
If any fields can be produced from other data or existing information, remove these fields from your lists. Approach 
can make calculations using database information, current time and date, and constants, so that you do not need to 
store values that can be generated.
For example, if you record the quantity and price of an item ordered, you can define a formula to describe the 
"Extended Price" as equal to price * quantity.

Next topic 



Identify main ideas and group fields under them

Previous topic

Records
The database you design collects related fields into groups called records. Related is the important word here. 
For example, you have fields that describe the different characteristics of a movie, like the director, the title, and so 
on. All of the fields for one movie appear in the same record.
The fields with actor information though, like the actor's birth date, hometown, and real name, would not go into a 
record about a movie. Collect these fields into a record that describes a particular actor.

If you collect all of the movie records together, you have a database. If you collect all of the actor records together, 
you have another database.

Databases
This word is being thrown around a lot. Just what is a database anyway? The basic definition: "a database is a 
collection of related records." Again, that crucial word related. If you have records that each describe a movie, 
when you collect all of the records about movies together, you have a database.
Because Approach is a relational database manager, the relation between the fields in a record and the records in a
database is carefully defined. You may end up with a lot of small fields, records, and databases that are built up on 
very narrow relationships between each piece. These databases together form a system or application to help you 
get to the information in the easiest way possible.

Main ideas for movies
Now that you have all of these fields, the next step is to gather them into meaningful groups. 
What makes a meaningful group depends on how you are going to use the information. Funny how the database 
design keeps coming back to "what are you going to do with it?"



Look back at the questions you asked earlier, like "What movies did Orson Welles direct?" These questions refer to 
the movie title and data about the movie such as release dates, color, and who recommended it to you. They also 
refer to other information that isn't so dependent on one movie: information about directors, actors, and producers.

Categorizing data into main ideas
For the movie list, the main ideas are best represented by these categories:

• Movie 
• Director 
• Producer 
• Actors 

Here's another example of choosing main ideas. If you are setting up a database to track your small business's 
paperwork, such as invoices and orders, your list of main ideas might look like this:

• Orders
• Customers
• Products
• Suppliers

Records for movies
In this process you group fields to build records. All of the fields in a record must relate to each other in the same way.
That is, if your main idea for the group revolves around the field Title, all of the fields in the record must further 
describe the movie with that title. You wouldn't put an actor's birth date in such a record, but you would include the 
date the movie was released.
You are working towards a clear one-to-one correspondence between each of the fields in a single record. A more 
complicated relationship between a field and the main idea of the record indicates that the field belongs in another, 
separate database. 

Fields that contain more than one piece of data
At this point, you should identify fields that need to contain more than one piece of data or need to appear more than 
one time.
If you have sequentially numbered fields or more than one piece of information in a field, group these fields 
under another main idea. 
You discover such a field: Actors. Movies typically have more than one actor. But don't add all of the names to a 
single Actors field. 
Don't make a separate field for each actor in the movie. The following records are examples of the kind of repeated 
fields you want to avoid.
Don't do this:

Because you don't know in advance how many actors each movie has, this method may leave many fields blank. 
Also, if you search for an actor, you have to look in all of the actor fields, because you won't remember—and you 
shouldn't have to!—if you put Vivien Leigh in the Actor1 or Actor2 field. 
Another way to handle more than one actor is to make another record in the same database and repeat the movie 
information in the second record. These are repeated records and you want to avoid this, too, to save disk space and 
assure accuracy of the information.
Don't do this, either:



When you design a database system for a relational database manager like Approach, fields numbered in 
sequence tell you that you need to pull those fields out into their own database. 
In this case, that's what you will do for actors: Make Actor a main idea, build records around that main idea, and build 
another database to store those records. Later, you can join the two databases so that you can do finds on them 
together.

Your plan now calls for four groups of fields:

Movies Actors Directors Producers
Title Last name Last name Last name
Release date First name First name First name
Type of film Birth date Birth date Birth date
Description Nationality Nationality Nationality
Available on video? Home town
Color?
Language
Recommended by?

Next topic 



Make connections between the groups

Previous topic
A group of related records forms a database. Each group you created around Movie, Actor, Director, and Producer 
becomes the basis for records in four separate databases.
Approach makes it easy to see the data in one database from inside another database. You can get to the data in 
both databases. This way Approach really helps you cut down on tedious data entry because you don't have to 
duplicate all of the data needed by all groups.
Now it's time to create the connections between the databases so that the information can be shared between them. 
Note, however, that you're still working on paper. Later, in Approach, you can make these same connections with a 
few clicks of the mouse.

Join fields and joined databases
Approach connects databases using joins between fields common to both databases. The join establishes the 
relationship between the two databases. For example, the join tells which director needs to be put with which movies.

Database relationships
Databases can be related in four ways:

• One-to-many: The main idea in one database can be connected to more than one record in another database. At 
first you think that the Movie database and the Actor database are related this way because one movie can have 
more than one actor. This relationship, however, ignores that one actor could be in many movies. A better 
example is the relationship between a customer database and an order database. One customer can have many 
orders.

• One-to-one: The main idea in one database is connected to only one main idea in the other database. You don't 
normally use one-to-one relationships in Approach, because you can put all of the fields in a single database.

• Many-to-one: Many of the records in a database can be connected to only one idea in another database. The 
Movie database is related to the Director database this way: many movies have one director. 

Approach treats this relationship as the reverse of the one-to-many relationship. You don't have to do anything 
special to make a distinction between the two types. For example, the Movie and Director databases are also 
related one-to-many if you express the relationship like this: One director can direct many movies.

• Many-to-many: The main idea in a database can be connected many times to many of the records in another 
database. This is the best way to describe the relationship between the Movie and Actor databases. One actor 
can be in many movies, and one movie can have many actors.

If you look at your database system, you see three relationships:
• Movie to director (many to one)
• Movie to producer (many to one)
• Movie to actors (many to many)

To make the connections between these databases, you need to identify a field that each pair of databases has in 
common. That field will be the join field.

Identify the join field 
So far, there isn't a duplicated field between the databases. You have to create a field to be the join field. 



It's usually best to define one field in each database specifically to be a join field and then enter a unique value, like a 
serial number or an ID, in that field in the records. Define the field in the "one" database.
For the relationships between movies and their directors, the Director database is the "one" database (one director 
directs many movies). If you put a "Director Last Name" field in the movie database, you have a field that joins the 
databases. However, several directors may have the same last name, so this join doesn't identify unique director 
records. There are ways you can make a better connection.

Making the join field unique
The join field or fields must uniquely identify a record in one of the databases--the Director database, in this case. If it 
doesn't, here are some things you can do to make the join field unique:

• Generate another field that is unique for each record; an ID field, for example an order number or a part number.
For example, generate a Director ID just in case two directors in the list have the same name. (For movies this is 
true, too. Remember King Kong? There's one starring Fay Wray and another starring Jessica Lange.)
When you build your database in Approach, you can have Approach automatically fill a field with a unique ID 
number for every record.

• Use more than one field in the join.
You could use First and Last Name fields to make sure you have specified a single director. (For the movie, you 
can use Title and Release Date. The original King Kong came out in 1933. The remake appeared in 1976.)

To apply this idea to the Movie and Director databases:

Both the director Alfred Hitchcock and the movies share the Director ID of 026. This value serves as the connection 
between the two databases.
The same arrangement works for the relationship between the Producer and Movie databases: create the join field in 
the "one" database (Producer) and add that field to the "many" database (Movie).

Building a many-to-many relationship
The Movie and Actor databases have a many-to-many relationship. The Help topic Many-to-many relationships 
describes the nuts and bolts for creating this join in Approach. This relationship always uses a third database 
(Intersection) to act as the "one" database between two "many" databases. The new "one" database contains two join
fields: One for the one-to-many with movies and the other for the one-to-many with actors.

The Intersection database must meet the same requirements that the other databases meet: each field in the 



database must describe the main idea of the database and must appear only one time to describe that main idea. 
There is a record in the Intersection database for each actor and movie combination, each "filming event" for that 
actor. For example, Groucho Marx appears in three movies on your list: A Day at the Races, A Night at the Opera, 
and Duck Soup. So there are three records for Groucho in the Intersection database, one for each movie. Each of 
these records stores only the Movie ID and Groucho's Actor ID.

Looking at the your database system, you now have five databases and four joins between them:

Next topic 



Use SmartMasters

Previous topic
The planning process is crucial. Once you design your database system, however, check to see if Approach has 
already built a database template or an application like the one you planned. Approach provides lots of SmartMaster 
templates and applications that are ready to use. Templates provide the basic structure for creating your own set of 
joined databases. SmartMaster applications provide complete, pre-built solutions for common database systems. You
can use the templates and applications whole or customize them to suit your needs. 

Choose a SmartMaster template or application that is the best match for your data needs.

Next topic 



What kind of data?

Previous topic
Fields: Think of them as building blocks of data, from which you construct meaningful information. Fields are the 
smallest unit of data in a database, and in general, the smaller the better.

How many fields in your database?
Don't worry about the number of fields in a database, but do think carefully about how to break up data into fields. 
Approach looks at fields to find the answers to your questions, and while Approach can search easily and quickly 
across dozens, even hundreds, of fields to find an answer, it is much more difficult to look deeply into a single field 
and pull out the one piece of data you want.
Spread your data out into many fields so it's easier to see.

Names in fields
For example, it's common to think of a person's name as a single unit, like the person. Analyzed into its components, 
however, a name often comprises two or three units; First name, Middle name, Last name. If you're tracking people, 
it's a good idea to break the idea of Name down into its component parts; therefore, you'll need at least two fields, 
First Name and Last Name. 

Addresses in fields
Same with addresses. Besides the name of the person living at the address, an address often comprises at least four
or five pieces of data: street, city, state, postal code, and country. 
If you put all that data into a single field, that may be OK, so long as the only question you'll ever ask is: What's John 
Smith's address? But will you ever ask the question: Who are all the people in my database who live in the 94114 
postal code? If so, your single field won't be the best solution. 
If you divide the address into its logical, usable components, you can ask all kinds of questions and get answers back
quickly and easily.

The key to defining fields is to separate each piece of information that you may use to search through the 
data, to calculate other values, to categorize your data.

Comment field trap
Beware of "comment" or "note" fields, like that "All other data about the movie" field mentioned earlier. Such fields are
great for collecting information that doesn't quite fit into neat little fields; for example, a synopsis of a movie plot. If 
there is specific information that you need to record, however, don't leave it up to chance in a broad category field.
Comment fields work well for elaborating other specified details or recording a log of changes or additions to a record.



More fields for the movie database
You've been thinking of more questions:

• What movies did Orson Welles direct?
• I remember that Mom had recommended a movie. Which one was that?
• When did 20,000 Leagues Under the Sea come out?
• What were the color movies produced when color was first popular, say before 1944?
• What Charlie Chaplin movies are available on video?

The list of fields is taking shape. You continue to pull more and more specific pieces of data out of that single giant 
comment field you started with. Note that these fields are not in any particular order yet.

Title Release date 
Actors (first, last name) Type of film 
Color? Description 
Available on video? Language
Director (first, last name) Recommended by?
Producer (first, last name)

Next topic    



What questions will you ask the database?

Previous topic
The example developed through these topics is a simple one based on a personal hobby, but the thought processes 
are the same that a database administrator would go through to build the databases that store data for a large 
company.

Using what you learn here to design a database
You can apply what you learn here to any database you design. When you finish reading this series of topics, you'll 
be ready to plan your database. Once you've got a plan on paper, you'll be ready to create an Approach file (.APR) 
based on your plan and then enter the data you want the database to store (or import it from another application 
where it already exists).
It's likely that the more you use your Approach database, the more demands you'll make of it. Approach will be able to
meet these demands. Rely on the user assistance provided in the book and in this Help system to reveal the 
many tasks you can accomplish in Approach.
Back to the example. . .

Asking your database the easy questions
Let's say you've built a database. The first task you attempt--or in database parlance, the first find you do--is to look 
for all of the information on the movie Strangers on a Train.
That's easy. If that's the only way you approach movies, you'll be fine with a database containing two units of data 
(called fields): 

• Field: Movie title
• Field: All other data about the movie

Done.

Asking your database more complex questions
But what about all those other, more complex questions you were asking earlier? What would your two-field database
do for you when you ask questions like

• Which of Hitchcock's movies are out on video?
That's a two-part question. You are asking Approach to search every record in the database and come back with a list
of movies that satisfy these two conditions: Hitchcock is in the Director field and Yes is in the field called Available on 
video.
So, if you don't have a field that contains only the director's name and you don't have a field that identifies whether a 
movie is available on video, you can't ask this question.

Adding more fields to answer complex questions
To answer the more complex questions, you've gone from a two-field database to a four-field database:

• Field: Movie title
• Field: Director
• Field: Available on video
• Field: All other data about the movie

See how it works? You're pulling specific pieces of data out of the mass of movie data and creating individual fields to
store those small pieces of data.
If you spend some time thinking about the questions you'll ask--the kind of finds you'll do--you'll discover a lot about 
the fields you'll need to create.

Next topic



What will a database do for you?

Previous topic 

Track all your data 
You don't want to keep all this data in your head, and you now know that keeping it in a static list doesn't help much 
either. You want the database to track all the tiny pieces of data. That's easy; databases you create in Approach can 
accommodate lots of data.
So you want the database to be your memory for all this movie data. The amount of data a database has to store 
won't be a problem, though it will require some work to type the data.

Access all your data
But more important, you want to be able to get information--meaningful data ("just the movies that fit my mood")--out. 
You want to be able to ask a specific question and get a concise answer. The really challenging part is organizing the 
data so that you can combine it in different ways to answer your questions.

Answer your data questions
Approach can deliver answers to your questions in seconds. But in order for a database to answer intelligently, you 
must build some of your own intelligence into the database: Train it to speak your language so that it can respond to 
the questions you ask.

Organize and plan first, let the database work later
Organization and planning are key. If you expend the effort in planning now, Approach will do the all the heavy lifting 
later. Some time spent planning before you create an Approach file pays off in the speed, flexibility, and 
responsiveness of the database when you start pulling information out of it.

Next topic



Why build a database?
The following sequence of topics describes how to build a database that works well in Approach. 

• We recommend that you read the topics in sequence, using the Next topic button at the end of each topic to 
continue.

• To print the entire sequence, click Help Topics at the top of this window, click the Contents tab in the Help 
Browser, double-click the Getting Started book at the top of the list, click the Planning a database book, and click 
Print at the bottom of the Help Browser.

Planning your database

Suppose you're a movie fan who wants to keep track of movies you hear about and want to see. You scan the new 
arrivals at the video store and read the reviews in the paper. 
At first, you accumulate a bunch of notes to yourself about the movies you want to see, and you keep the notes in a 
folder in your desk.
Eventually, the folder becomes a disorganized collection of odd scraps of paper, napkins, and newspaper clippings. 
You continue to gather data, but because trying to find anything in the folder is frustrating, you're losing track of your 
information.

Creating one list of data may not be enough
You decide to put all the data in a list. You fire up the computer, start Word Pro, and start typing. You notice that you 
have more than one note about some movies, but you type in everything because you want to preserve the data 
you've gathered. Word Pro can even put the list in alphabetical order (you never realized how many movie titles 
began with "The"). 
You get about a third of the way through the folder before you get tired. At least it's a start.
One night, you want to rent a comedy. You leaf through the folder, you scan the list. Alphabetical order doesn't help 
you find comedies. Nothing is categorized. Some movies you remembered to label; others not. You wish that instead 
of typing one long list, you had created many lists: one for comedies, one for dramas, one for action movies, and so 
on.

Why dynamic data is useful
The more you think about it, the more lists you wish you had: one for Hitchcock movies, one for movies released after
1960, one for foreign-language movies, one for musicals. But you'd have to put The Trouble with Harry on both the 
list of comedies and the list of Hitchcock movies. Too much typing, you think.
You say to yourself: I wish I had a list with movable entries. I wish I could press a key and the entries would organize 
themselves the way I want to see them--or better yet, I'd press a key and I'd see a list of just the movies that fit my 
mood.



You want dynamic data. You want certain pieces of data pulled out of a large mass and organized into meaningful 
information. You've just discovered you need a database. You choose Approach. Good choice!

Next topic 



Changing the status to single-user
You can temporarily change your network environment so that you can open network databases as a single user. 
This prevents other users from having access to your databases.

For dBASE databases
Deselect "Database sharing" in the dBASE Network Connection dialog box. 

For Paradox databases
Delete the text in the User name and "Network control file path" boxes in the Paradox Network Connection dialog 
box. 

{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;H_SETTING_FILESHARING_O
PTIONS_FOR_PARADOX_FILES_STEPS;',0)} See related topics



Details: Entering passwords

Database file passwords
If a database file was opened in dBASE III, dBASE IV, or FoxPro it can have two types of passwords:

• Read/write password, which gives you complete access to the file
• Read-only password, which allows you to read data, but not modify it

A database can have a read-only, a read/write, or both a read/write and a read-only password.
If a database file has passwords, the Enter Database Password dialog box appears when you try to open Approach 
files that use the database. 

Approach file passwords
If an Approach file (.APR) has a password (which is always defined in TeamSecurity), the Enter Approach File 
Password dialog box appears when you try to open it.

{button ,AL(`H_ENTERING_PASSWORDS_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_NEW_PASSWORD_PRIVILEGES_STEPS;H_DEFINING_PASSWORDS_FOR_A_DATA

BASE_STEPS;H_DELETING_PASSWORD_PRIVILEGES_STEPS;H_EDITING_PASSWORD_PRIVILEGES_STE
PS;H_SETTING_PASSWORD_PRIVILEGES_STEPS;H_TEAMSECURITY_DIALOG_BOX_CS;',0)} See related 
topics



Entering passwords
If you try to open a database file with a password or make design or join changes in an Approach file with a 
password, an Enter Password dialog box appears.
1. Type the password in the text box. 

You must spell a password exactly as it was defined. Passwords are not case-sensitive.
2. Click OK.
If you have joined multiple database files that are password protected with the same password, and you open 
the .APR file, Approach prompts you for a password. 
You can require passwords for each database by choosing File - TeamSecurity, clicking New, Edit, or Copy and 
selecting "Require passwords for each database" in the Database tab.

{button ,AL(`H_ENTERING_PASSWORDS_DETAILS',1)} See details
{button ,AL(`H_CREATING_NEW_PASSWORD_PRIVILEGES_STEPS;H_DEFINING_PASSWORDS_FOR_A_DATA

BASE_STEPS;H_DELETING_PASSWORD_PRIVILEGES_STEPS;H_EDITING_PASSWORD_PRIVILEGES_STE
PS;H_PASSWORDS_OVER;H_SETTING_PASSWORD_PRIVILEGES_STEPS;H_TEAMSECURITY_DIALOG_B
OX_CS',0)} See related topics



Details: Refreshing data from the network onscreen
Refresh Data does the following:

• Updates the data onscreen to match the database on the network 
• Enters changes to the database
• Inserts new records into the found set or sort order, as appropriate

Why refresh data?
As you work in a network database, Approach places a copy of the data you see onscreen in your computer's 
memory. If other users are making changes to the database at the same time you are, their changes do not always 
appear instantly onscreen. Refresh your data when you want to see the current version of it.

Downloading data in Print Preview
When you print data from a network, by default Approach refreshes the data from the network database whenever 
there are changes made to the database. If you preview data before printing and other users make changes to the 
database while you're previewing and preparing to print, the data you print may not be the same as the data you 
previewed. 
To change this setting from the default, open the Preferences dialog box, click the General tab, and select "Download
data before Print Preview." 
When this option is selected, Approach downloads a copy of the current set of network data to your hard disk 
whenever you change to Print Preview to "freeze" the data you see onscreen. This way, you can be sure you're 
looking at the same data that will be printed. Downloading is useful when you preview a report that includes a 
summary, or a data set that many users are working on at once.

{button ,AL(`H_REFRESHING_THE_DATA_NETWORK_ONSCREEN_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;H_SETTING_FILESHARING_O

PTIONS_FOR_PARADOX_FILES_STEPS;',0)} See related topics



Refreshing data from the network onscreen
Approach refreshes the data from a network database when you

• Find or sort data
• Edit data
• Preview or print

You can also refresh the data yourself by choosing Refresh Data on the context menu.

{button ,AL(`H_REFRESHING_THE_DATA_NETWORK_ONSCREEN_DETAILS',1)} See details
{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;H_SETTING_FILESHARING_O

PTIONS_FOR_PARADOX_FILES_STEPS;',0)} See related topics



Details: Saving changes to shared records

Optimistic record locking
With optimistic record locking on, when two users edit the same record, the changes are saved in the database for 
the first user to enter the changes. When the second user tries to save any changes, a message box warns that the 
changes may write over those made by the first user.

Full record locking
If you don't want other users to edit a record at the same time as you, you can turn off optimistic record locking. Using
full record locking, once you click a record, other network users can view the record but not make changes to it until 
you press ENTER and release the record lock. 

{button ,AL(`H_SAVING_CHANGES_TO_SHARED_RECORDS_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;H_SETTING_FILESHARING_O

PTIONS_FOR_PARADOX_FILES_STEPS;H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_
FILES_STEPS;',0)} See related topics



Saving changes to shared records
Optimistic record locking is the default setting for Approach. If you have optimistic record locking set for your network 
environment, other users can edit a record at the same time you do. 
When you try to commit the changes you've made to a shared record that has been modified by another user, a 
message box appears that gives you a choice of either saving or canceling your changes.

Saving your changes
Click Yes to save your changes and write over changes made by other users.
This writes over all changes made to the record since your view of it was last refreshed.

Canceling your changes
Click No to refresh your copy and see changes made to the record by other users. You can then make your changes 
on top of theirs.
Note To turn off optimistic record locking, choose File - User Setup - Approach Preferences and click the General tab.
Deselect "Lock records using optimistic record locking."

{button ,AL(`H_SAVING_CHANGES_TO_SHARED_RECORDS_DETAILS',1)} See details
{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;H_SETTING_FILESHARING_O

PTIONS_FOR_PARADOX_FILES_STEPS;H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_
FILES_STEPS;',0)} See related topics



Details: Setting file-sharing options for dBASE files
• You can have any Approach file active when you open the File - Open dialog box. 
• The dBASE options affect all dBASE files you open.

Database sharing
By default, this setting lets other users open and make changes to a network dBASE file you already have open.
If the setting is off, no one else can open the file until you close it.
If this setting is on, make sure everyone you work with on a network uses the same locking protocol to access dBASE
files.

Local databases are shared
If you're using a peer-to-peer network system such as LANtastic or Windows for Workgroups and the system is set up
for sharing local files, this setting allows other users to open dBASE files already open on your local drive. 
If this setting is off, other users can open a dBASE file on your local drive only if you do not already have the file 
open. This is true only if "Database sharing" is on and your network software allows you to share local files.

Sharing data only with other Approach users
This setting optimizes performance for files that are shared only with other Approach users. 
Turn this setting off if you or other network users plan to use dBASE files with other applications.

{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS',1)} Go to procedure
{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_DBASE_FILES_IN_APPROACH_REF;

H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_FILES_STEPS;',0)} See related topics



Setting file-sharing options for dBASE files
The dBASE file-sharing options let you specify whether or not

• To let other users work with network files you have open
• To make your local files available to other users
• To optimize performance for files used only with Approach

Commands on the File menu: New Database, Open, Save As, Import Data, Export Data, Import Approach File
1. Select dBASE IV or dBASE III+ in the "Files of type" box.
2. Click Setup.

The dBASE Network Connection dialog box appears. 
3. To let other users work with files you have open, select "Database sharing."
4. To make open files on your local drive available to other users, select "Local databases are shared." 

Available on peer-to-peer networks only.
5. To optimize performance for files shared only with other Approach users, select "Sharing data only with other 

Approach users."
6. Click OK to close the dBASE Network Connection dialog box.
7. Click OK.
8. Close and reopen any dBASE files for the changes to affect them.

{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_DBASE_FILES_IN_APPROACH_REF;

H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_FILES_STEPS;',0)} See related topics



Details: Setting file-sharing options for Paradox files
The Paradox options affect all Paradox files you open.

Types of networking
• If you select "Use Paradox 3.5 networking," you can open Paradox 3.5 files but not Paradox 4 files on a network.

 When you create or export a Paradox file (whether or not you are using a network), the file is in the 3.5 file type.
• If you select "Use Paradox 4.x networking," you can open both Paradox 3.5 and Paradox 4 files on a network. 

When you create or export a Paradox file (whether or not you are using a network), the file is in the 4.x file type. 
Paradox 4.x networking includes Paradox for Windows.

• Paradox 4 users cannot share data concurrently with users of Paradox 3.5. 

Paradox control files
Paradox databases use network control files to monitor user count and to control database-sharing on a network. If 
you want to share Paradox files with other users, you need to specify the location of the control files. Check with your 
network administrator for the location of these files.

• Paradox 4.x, including Paradox for Windows: the file is PDOXUSRS.NET. 
• Paradox 3.5: the file is PARADOX.NET.

The control files for Paradox 3.5 and Paradox 4.x should be in the same directory.
If you do not specify a location for the control files, open Paradox databases on a network as a single user.

{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_PARADOX_FILES_STEPS',1)} Go to procedure
{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_CREATING_SECONDARY_INDEXES_

FOR_PARADOX_DATABASES_STEPS;H_PARADOX_FILES_IN_APPROACH_REF;',0)} See related topics



Setting file-sharing options for Paradox files
For Paradox files, you can specify 3.5 or 4.x networking and the location of the Paradox network control files.
Commands on the File menu: New Database, Open, Save As, Import Data, Export Data, Import Approach File
1. Select Paradox in the "Files of type" box.
2. Click Setup.

The Paradox Network Connection dialog box appears.
3. Select the type of networking. 

For Paradox for Windows, select Paradox 4.x networking.
4. Enter your user name in the User name box.
5. Enter the directory location for the control files in the "Network control file path" box. 

Do not include the name of the control files in the path. For example, if the files are in the SHARE directory on the
f drive, type f:\SHARE, not f:\SHARE\PDOXUSRS.NET.

6. Click OK to close the Paradox Network Connection dialog box.
7. Click OK.
8. Close and reopen any Paradox files for the changes to take effect. 

{button ,AL(`H_SETTING_FILESHARING_OPTIONS_FOR_PARADOX_FILES_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_CREATING_SECONDARY_INDEXES_

FOR_PARADOX_DATABASES_STEPS;H_PARADOX_FILES_IN_APPROACH_REF;',0)} See related topics



Details: Specifying locking protocols for shared dBASE files
To maintain the integrity of data, all users who share dBASE files should specify the same locking protocol. The 
locking protocols for dBASE IV and dBASE III+ are not compatible with each other. 

• If all the users in a group are working through a dBASE IV application, change the protocol to dBASE4. 
• If all the users in a group are working through a dBASE III+ application, change the protocol to dBASE3.
• If you have a mixed group of dBASE III+ and dBASE IV users, change the protocol to dBASE3 for all users. 

dBASE III+ users cannot select dBASE4 as their locking protocol. However, dBASE IV users can select dBASE3 
as their locking protocol. 

{button ,AL(`H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_FILES_STEPS',1)} Go to 
procedure

{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_SETTING_DATABASE_OPTIONS_DET
AILS;H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;',0)} See related topics



Specifying locking protocols for shared dBASE files
If you share dBASE files with other users, you must all specify dBASE IV or dBASE III+ as the locking protocol for the
files. The default protocol is dBASE IV.
You must change the locking protocols in the registration database.
1. In the Windows 95 taskbar, click Start.
2. Click Run.

The Run dialog box opens.
3. Type regedit.
4. Click OK.

The Registry Editor appears.
5. Navigate to:

HKEY_USERS
      Software
              Lotus
                      Approach
                                97.0
                                            General

6. Scroll to sdBASEFileSharing and double-click it.
The Edit String dialog box appears.

7. Depending on the locking protocol you use, type one of the following:
• dBASE4
• dBASE3

8. Click OK.
9. Restart Approach for the change to take effect.

{button ,AL(`H_SPECIFYING_LOCKING_PROTOCOLS_FOR_SHARED_DBASE_FILES_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_STATUS_TO_SINGLE_USER_STEPS;H_SETTING_DATABASE_OPTIONS_DET

AILS;H_SETTING_FILESHARING_OPTIONS_FOR_DBASE_FILES_STEPS;',0)} See related topics



Charting a different data set
You can change the set of data a chart displays by specifying a new data source.
1. From the Chart menu, choose Chart Properties.
2. From the Chart Object menu, choose Chart Data Source.

The Chart Data Source Assistant appears, with the current data source highlighted for each field.
3. Select a field to appear on the x-axis.
4. Click the Y-axis tab.
5. Define the calculation for the y-axis.
6. (Optional) Click the Series tab.
7. (Optional) Select a field for the series.
8. Click Done.

{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_CHARTS_FROM_CROSSTABS_STEPS;H_CREATING
_CHARTS_IN_REPORTS_STEPS;H_CREATING_PIE_CHARTS_STEPS;H_DECIDING_WHAT_NEW_CHARTS_
SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;',0)} See related topics



Overview: Charts 
A chart is an Approach view  that shows data in a graphic representation. If you're analyzing data, charts can identify 
trends and relationships. Charts are dynamic; if you change the data the chart is based on, Approach updates the 
chart automatically.
You can create four different chart types, in two-dimensional (2D) or three-dimensional (3D) format. After creating a 
chart, you can change its type and add text and graphics to it. In addition to graphic information, a chart can also 
include a title, a subtitle, a legend, a crosstab    table, and a note. 
Approach gives you two ways to create charts: with the Chart Assistant or directly from a crosstab.
Charts can also be placed in the summary panel    of a report. 

Chart Assistant
The Chart Assistant guides you through creating a chart. In the Chart Assistant, you give the chart a name, layout 
(the chart type), and style (2D or 3D). You also select the fields that appear on the chart axes. If the chart contains a 
series (a set of values plotted along the x-axis), you select the field for grouping the series. The chart legend explains 
the series.
If you create a pie chart, you select the field whose values appear as pie slices.
The Chart Assistant lets you choose from four types of charts: bar, line, area, or pie. In the Chart InfoBox, you can 
change the chart type to another of the 20 types supported by Lotus Chart. 

Chart axes
All charts except pie charts plot data against a horizontal x-axis and a vertical y-axis.

• The x-axis defines    the categories you want to plot, such as years, geographic areas, age ranges, or the names 
of your sales personnel. 

• The y-axis defines the values plotted in the chart that correspond to the x-axis categories. For instance, the y-axis
could show the quantity or dollar amount of units sold by each of your sales personnel. 

You can show tick marks and labels for units of measure with an axis, and you can title each axis to describe the data
plotted against it. 

Creating charts from crosstabs
You can create a chart directly from a crosstab by clicking the Chart icon in the crosstab view. Approach creates a 
vertical bar chart displaying the data in the crosstab. The values in the body of the crosstab are plotted as the chart 
bars. The crosstab rows are charted along the x-axis, and crosstab groups (from the columns) form the series that 
appear in the legend. 

Drill Down to Data
Drill Down to Data lets you display the records that the chart is based on. Select the bar, line, area, or pie portion of a 
chart, and then from the Chart Object menu choose Drill Down to Data. The records that contribute to that portion of 
the chart appear in a worksheet or other view that you specify. 

Modifying charts
The Chart and Chart Object menus are context-sensitive. What you select in a chart determines which menu displays
and which properties you can change in the InfoBox .

• The Chart Object menu displays in the menu bar when you are in a chart in Design and you select a graphic 
object in the chart such as a title, label, bar, line, or pie slice.    Use these commands to modify chart parts, 
including title, legend, axes and grids, series, and series labels. You can also select a different source of data for 
the chart or a different type of chart. 

• The Chart menu displays when you click near the border of the chart. Use these commands to delete or duplicate
the entire chart or pages of a multi-page chart.

Opening the InfoBox for a chart object
From the Chart or Chart Object context menu, choose Chart Properties or click the Show InfoBox icon when you see 
the Chart Object context menu.

Opening the InfoBox for a chart



Click the Show InfoBox icon when you see the Chart context menu, or double-click the margin (between the border 
and the grid) of the chart view.

{button ,AL(`H_CREATING_CHARTS_FROM_CROSSTABS_STEPS;H_DECIDING_WHAT_NEW_CHARTS_SHOUL
D_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FIELD_FOR_THE
_SERIES_STEPS;H_SELECTING_A_FIELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FIELDS_FOR_THE_
Y_AXIS_STEPS;H_CREATING_PIE_CHARTS_STEPS;',0)} See related topics



Creating charts from crosstabs
When you create a chart directly from a crosstab, the values in the crosstab cells are plotted as the chart bars. The 
crosstab rows are charted along the x-axis, and crosstab groups (from columns) form the series that appear in the 
legend. 
Approach uses a preset chart type for a chart created from a crosstab, initially set to bar chart.
1. Make sure that the crosstab contains the data you want to chart. 
2. Choose Crosstab - Chart this Crosstab.

Approach creates the chart and displays it with a default title and default axis titles.

{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_CHARTS_IN_REPORTS_STEPS;H_DECIDING_WHAT
_NEW_CHARTS_SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;',0)} See 
related topics



Creating charts in reports
Enhance your reports and summarize data by creating charts in the summary panels. 
1. Go to or create a report that has summary panels. 
2. Select a summary panel and drag its border to make space for the chart.
3. Choose Create - Control - Chart.

The mouse pointer changes to cross hairs. 
4. Drag to draw the chart area inside the report panel.

The Chart Assistant appears.
5. Enter a name for the chart, and select layouts and styles. 
6. Select a field for the x-axis.
7. Select field(s) for the y-axis.
8. Select a field for the series.
9. Click Done. 

The chart you created becomes part of the report.

{button ,AL(`H_CREATING_CHARTS_FROM_CROSSTABS_STEPS;H_CREATING_PIE_CHARTS_STEPS;H_DRIL
L_DOWN_TO_DATA_FOR_CHARTS_STEPS;',0)} See related topics



Creating pie charts
Command: Create - Chart

Tab: Pie fields
Pie charts let you define the relationships of the various parts to the whole. For example, a pie chart could show you 
each salesperson's orders (using a sum calculation) as a percentage of the total orders of the whole company.
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field for the pie slices in the "Show a new slice for" box.

Pie charts show one pie slice for each different value of this field.
3. Select a calculation in the "Each slice shows the" box.
4. Be sure the database containing the field you want is showing in the "in database" box.
5. Select a field to be calculated in the "of field" box.

Summarizing the values in this field determines the sizes of the pie slices.
6. Click Done.

{button ,AL(`H_CHART_ASSISTANT_OVER;H_DECIDING_WHAT_NEW_CHARTS_SHOULD_LOOK_LIKE_REF;H_
DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FIELD_FOR_THE_SERIES_STEPS;H_S
ELECTING_A_FIELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FIELDS_FOR_THE_Y_AXIS_STEPS;',0)} 
See related topics



Deciding what new charts look like
Approach provides a number of layouts and styles. Select one of each to determine the basic appearance of the 
chart. The Sample Chart previews each combination.
Command: Create - Chart

Tab: Layout

View name & title
The name you enter appears as a default in printed charts, in the title at the top of the chart, and in the view tab. For 
example:

Layout
Approach lets you choose from four chart types in the Chart Assistant. After you create the chart, use the InfoBox to 
select another type for the chart. 

Chart type Description Looks like
Bar chart Each bar represents a single 

value in a series. The height of 
each bar shows a value at a 
point in time. Bar charts are 
useful for comparing individual 
values. 

    

Line chart Each point along a line 
represents a value at a particular
period or point in time, and each 
line represents a category of 
data. Use line charts to trace the
changes in sets of data over 
time. 

    

Area chart Shows trends in data over time 
by emphasizing the area under 
the curve created by each data 
series. Use area charts to see 
relationships between sets of 
data rather than individual data 
points. 

    

Pie chart The relationship of various parts 
to the whole. Each data value is 
represented by a slice of the pie,
and the size of the slice 
corresponds to the percentage 
of the total.

    

Style
Approach lets you select either 2D or 3D chart styles. 

{button ,AL(`H_CREATING_CHARTS_FROM_CROSSTABS_STEPS;H_CREATING_CHARTS_IN_REPORTS_STEP
S;H_CREATING_PIE_CHARTS_STEPS;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A
_FIELD_FOR_THE_SERIES_STEPS;H_SELECTING_A_FIELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FI
ELDS_FOR_THE_Y_AXIS_STEPS;',0)} See related topics



Drilling down to data for charts
You can select a view to display the drill-down data. 
If you do not identify the drill-down view, Approach creates a new worksheet to display the data. The drill-down view 
displays the set of records that corresponds to the selected portion of the chart.

 Are you in Design?
1. To open the Approach Chart InfoBox, double-click the margin (between the border and the grid) of the chart view.
2. Click the Basics tab in the InfoBox.

3. Select the view you want in the "Drill down view" box.
4. (Optional) Move, collapse, or close the InfoBox.
5. Select the graphical representation in the chart (for example, a bar or a pie slice) for which you want the detail 

data.
6. From the Chart Object menu, choose Drill Down to Data.

The selected drill-down view appears, displaying the detail data.
7. To return to the original chart view, click its view tab. 

Approach returns to the chart and displays the original found set.

{button ,AL(`H_DRILL_DOWN_TO_DATA_OVER;H_CHART_ASSISTANT_OVER;H_CHOOSING_DRILLDOWN_VIE
WS_STEPS;H_CREATING_CHARTS_IN_REPORTS_STEPS;H_DECIDING_WHAT_NEW_CHARTS_SHOULD_
LOOK_LIKE_REF;H_SELECTING_A_FIELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FIELDS_FOR_THE_
Y_AXIS_STEPS;',0)} See related topics



Details: Selecting a field for the series (chart legend)
A series lets you plot more than one value for each value on the x-axis. Use the series to further analyze the x-axis 
values.
If you do not select a field in the Series tab, your chart does not contain a legend. To add a series after creating the 
chart, choose Chart - Chart Data Source and specify a new data source. To create a legend in an existing chart, 
select the Legend option in the Chart InfoBox. 

Example
You run a small company that sells three products and has a staff of two sales representatives. 
Suppose you want to create a bar chart comparing the performance of your sales representatives in October. You 
define the x-axis to display the names of your sales reps. You define the y-axis to display their sales for the month of 
October.
If you finished your chart at this point, the chart would display two bars, one for each sales rep. Each bar would 
represent each rep's combined total sales for all three products.

To further analyze the reps' sales performance by each product, in the Series tab of the assistant, select the Product 
field.
Now your chart displays six bars (3 products x 2 reps) in two groups, one group for each sales rep. In each group 
there would be a separate bar for each product sold by the rep.

A legend appears in your chart. It contains three labels identifying your three products. 

{button ,AL(`H_SELECTING_A_FIELD_FOR_THE_SERIES_STEPS',1)} Go to procedure
{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_PIE_CHARTS_STEPS;H_DECIDING_WHAT_NEW_CH

ARTS_SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FI
ELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FIELDS_FOR_THE_Y_AXIS_STEPS;',0)} See related topics



Selecting a field for the series (chart legend)
(Optional) Select a field for the series to create a legend for a chart.
Command: Create - Chart

Tab: Series
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Field" box.
3. Select a custom grouping for the field in the "Group by" box.

The grouping options that display correspond to the type of field you select. When you select a date, the grouping
options for dates appear. When you select a text field, the grouping options for a text field appear. This is also true
for time fields and numeric fields. The default selection creates a group for every unique value of the field. 

4. Click Done.
5. If the Define Main Database dialog box appears, select the database you want to be the main database    for the 

chart and click OK.
This dialog box appears if the chart uses fields from more than one joined database. The first database you select
in the Chart Assistant is preselected as the main database.

{button ,AL(`H_SELECTING_A_FIELD_FOR_THE_SERIES_DETAILS',1)} See details
{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_PIE_CHARTS_STEPS;H_DECIDING_WHAT_NEW_CH

ARTS_SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FI
ELD_FOR_THE_X_AXIS_STEPS;H_SELECTING_FIELDS_FOR_THE_Y_AXIS_STEPS;',0)} See related topics



Selecting a field for the x-axis
You must select a field for the x-axis for all chart types except pie chart.
Command: Create - Chart

Tab: X-Axis
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "X-Axis field" box.
3. Select a custom grouping for the field in the "Group by" box.

The grouping options that display correspond to the type of field you select. When you select a date, the grouping
options for dates appear. When you select a text field, the grouping options for a text field appear. This is also true
for time fields and numeric fields. The default selection creates a group for every unique value of the field. 

4. Click Next.

{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_PIE_CHARTS_STEPS;H_DECIDING_WHAT_NEW_CH
ARTS_SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FI
ELD_FOR_THE_SERIES_STEPS;H_SELECTING_FIELDS_FOR_THE_Y_AXIS_STEPS;',0)} See related topics



Selecting fields for the y-axis
You must select a field for the y-axis for all chart types except pie chart. The field you select for the y-axis should 
perform a summary calculation such as summing a quantity field, counting an ID field, and so on.
You can select additional fields to create as many as five y-axes.
Command: Create - Chart

Tab: Y-Axis
1. Be sure the database containing the field you want is showing in the "Database" box.
2. Select a field in the "Y-Axis field" box.
3. Click Add.
4. Select the calculation type for the field from the "Chart the" box.

Each field you add to the y-axis box must have a calculation type assigned to it. Each calculation type has its own
icon that displays to the left of the selected field name. 
Change the calculation type by clicking the icon to the left of the field name and selecting a different calculation 
type icon from the pop-up box.

5. (Optional) To add additional fields, repeat steps 1 - 4. 
6. Click Next or Done.

{button ,AL(`H_CHART_ASSISTANT_OVER;H_CREATING_PIE_CHARTS_STEPS;H_DECIDING_WHAT_NEW_CH
ARTS_SHOULD_LOOK_LIKE_REF;H_DRILL_DOWN_TO_DATA_FOR_CHARTS_STEPS;H_SELECTING_A_FI
ELD_FOR_THE_SERIES_STEPS;H_SELECTING_A_FIELD_FOR_THE_X_AXIS_STEPS;',0)} See related topics



Creating a custom menu by copying one that exists

 Are you in Design?
1. Choose Create - Custom Menu.
2. Select the menu you want to base your work on.
3. Click Copy.

The Define Custom Menu Bar dialog box appears.
4. Name the menu bar.
5. To create the new menu , redefine menu types, and add, move, and delete top-level commands and menu items.
6. Click OK to close the Define Custom Menu Bar dialog box.
7. Click Done.

{button ,AL(`H_CREATING_CUSTOM_MENUS_STEPS;H_CUSTOM_MENUS_REF;H_DELETING_CUSTOM_MEN
US_STEPS;H_EDITING_CUSTOM_MENUS_STEPS;H_MOVING_AND_DELETING_CUSTOMMENU_COMMAN
DS_STEPS;',0)} See related topics



Creating custom menus
This task builds a menu from scratch.
If it makes more sense for you to create a menu by changing one that already exists, use Create - Custom Menu - 
Copy.

 Are you in Design?

Creating top-level commands for the menu bar
1. Choose Create - Custom Menu.
2. Click New.

The Define Custom Menu Bar dialog box appears.
3. Name the menu bar.
4. Under Menu Type, double-click Standard Menu to open the drop-down box.
5. Select the type of menu you want to base this menu on.
6. Under Menu Name, click Menu and name the top-level command.

This name appears on the menu bar of your custom menu.
7. To add items under this top-level command, go on to the next procedure.

To add another top-level command, click Add Menu and repeat steps 4 - 6.

Creating items under the top-level command 
1. Under Item Action, double-click the cell to open the drop-down box.
2. Select a menu item.
3. To change the name of the menu item, under Item Name, select the cell and edit the name.
4. To add another item to the menu, click Add Item and repeat steps 1 - 3.

When you finish
1. Click OK to close the Define Custom Menu Bar dialog box.
2. Click Done.
3. Attach the menu to a view using the Basics tab of the view InfoBox.
A custom menu is visible only in the view you attach it to, and only in Browse.

{button ,AL(`H_CREATING_A_CUSTOM_MENU_BY_COPYING_ONE_THAT_EXISTS_STEPS;H_CUSTOM_MENU
S_REF;H_DELETING_CUSTOM_MENUS_STEPS;H_EDITING_CUSTOM_MENUS_STEPS;H_MOVING_AND_
DELETING_CUSTOMMENU_COMMANDS_STEPS;',0)} See related topics



Custom menus
Custom menus are visible only in views you attach them to, and only in Browse.

Menu types
To display a menu with a list of Select
Commands. Standard Menu
Commands, followed by the names of the last 
five Approach files opened.

Menu + Files

Commands, followed by the names of each 
open Approach file and its current view.

Window Menu

Commands specific to the kind of view, for 
example, the Browse or Worksheet commands.
You cannot alter this menu.

Context Menu

Available macros. You cannot add items to this 
menu.

Macro List

All the views in the Approach file. You cannot 
add items to this menu.

View List

NotesFlow Action commands. NotesFlow Actions

Keyboard shortcuts
Keyboard shortcuts let you choose commands by pressing ALT and a letter underlined in the menu name.
To identify this letter, type & (ampersand) right before the letter you want to underline in the Menu Name or Item 
Name cell. For example:
Calculation &Macro List
Underlines the letter M in Macro, so you can open the menu in Browse by pressing ALT+M.
Note To show an ampersand in a name, type &&. For example:
&Add && Delete
Places the ampersand between Add and Delete and also underlines the letter A in Add.

Item Action drop-down box
The Item Action drop-down box shows

• All the commands you can add to a custom menu
• The names of all views and macros in the Approach file
• A blank line
• A menu divider (a line of hyphens)

{button ,AL(`H_CREATING_A_CUSTOM_MENU_BY_COPYING_ONE_THAT_EXISTS_STEPS;H_CREATING_CUS
TOM_MENUS_STEPS;H_DELETING_CUSTOM_MENUS_STEPS;H_EDITING_CUSTOM_MENUS_STEPS;H_M
OVING_AND_DELETING_CUSTOMMENU_COMMANDS_STEPS;',0)} See related topics



Custom Menu dialog box
Choose a task

Creating custom menus 
Creating a custom menu by copying one that exists
Editing custom menus 
Moving and deleting commands on custom menus 
Deleting custom menus 

 

{button ,AL(`H_CUSTOM_MENUS_REF;',0)} See related topics



Defining passwords for a database
Approach can set database passwords for dBASE, FoxPro, and Paradox databases only.
Set two passwords:

• One for users who need complete access to the database
• Another for users who need only to look at the data

If you're trying to set a password for the Approach file, click TeamSecurity.
1. From the File menu, choose User Setup, and then choose Approach Preferences.

2. Click the Password tab.
3. Be sure the database you want to protect is showing in the "Database" box.
4. Enter the password in the "Read/write password" box.
5. Click Save Default.

The Confirm Password dialog box appears.
6. Confirm the password by entering it in the Confirm Password box and click OK.

The "Read-only password" box becomes available.
7. (Optional) Enter another password in the "Read-only password" box.
8. Confirm the read-only password and click OK.
9. Click OK.

{button ,AL(`H_PASSWORDS_OVER;',0)} See related topics



Deleting custom menus
If you delete a menu that is attached to a view, Approach replaces it with the default menu for the view.

 Are you in Design?
1. Choose Create - Custom Menu.
2. Select the custom menu.
3. Click Delete.

A message box appears to confirm your choice.
4. Click Yes.
5. Click Done.

{button ,AL(`H_CREATING_A_CUSTOM_MENU_BY_COPYING_ONE_THAT_EXISTS_STEPS;H_CREATING_CUS
TOM_MENUS_STEPS;H_CUSTOM_MENUS_REF;H_EDITING_CUSTOM_MENUS_STEPS;H_MOVING_AND_
DELETING_CUSTOMMENU_COMMANDS_STEPS;',0)} See related topics



Displaying the contents of drop-down lists automatically
Command: File - User Setup - Approach Preferences

Tab: General
Under Navigation, select "Expand drop-down lists automatically."
When users tab into a field that is a drop-down box or a field box and list, it immediately expands to display the items 
on the list.
If this setting is off: Users must click the box or its arrow to display the list.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Downloading data before previewing
Command: File - User Setup - Approach Preferences

Tab: General
Under Data, select "Download data before Print Preview."
This option copies the current data set from the network database to your hard disk. Copying the data can take time, 
so do it when network activity is low.
The data set you print is the version on your hard disk rather than the one in the network database. That way, you 
can be sure what you're printing is what you previewed.
If this setting is off: When you print from the data on the network, you may not always print the data set you 
preview. This can happen because other people working in the network database may change the data between the 
time you preview it and the time you print. Most of the time this is not a problem, and leaving this setting off saves a 
lot of time.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Editing custom menus

 Are you in Design?
1. Choose Create - Custom Menu.
2. Select the custom menu.
3. Click Edit.

The Define Custom Menu Bar dialog box appears.
4. To edit the menu, redefine menu types, and add, move, and delete top-level commands and menu items.
5. Click OK to close the Define Custom Menu Bar dialog box.
6. Click Done.

{button ,AL(`H_CUSTOM_MENUS_REF;H_DELETING_CUSTOM_MENUS_STEPS;H_MOVING_AND_DELETING_
CUSTOMMENU_COMMANDS_STEPS;',0)} See related topics



Entering data using optimistic record locking
Command: File - User Setup - Approach Preferences

Tab: General
Under Data, select "Lock records using optimistic record locking."
This option allows two users to edit a record at the same time.

• When two users edit the same record, the changes are saved in the database for the first user to enter them. 
Then when the second user tries to enter changes, Approach asks the user whether to save and write over the 
changes of the first user, or cancel. 

• Approach runs faster with optimistic record locking on because it does not have to check whether to lock a record 
when a user tries to view it.

If this setting is off: You're using full record locking. This means that two users can view a record at the same time, 
but only the first user to begin editing the record can save changes.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Identifying default directories
Command: File - User Setup - Approach Preferences

Tab: General
Click Default Directories.
The Default Directories dialog box appears, where you identify the following directories:

The path you enter for Tells Approach where to
Default working 
directory

Save newly created files.

SmartMaster directory Store Approach files that you 
save as SmartMaster 
applications (.MPR).

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Making calculated fields available for joins
Command: File - User Setup - Approach Preferences

Tab: General
Under Show, select "Calculated fields in the Join dialog."
Showing calculated fields in the Join dialog box lets you join databases on fields of this type.
Calculated fields appear in italics at the bottom of the field lists in the Join dialog box.
If this setting is off: You cannot join databases on calculated fields.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.

{button ,AL(`H_JOINED_DATABASES_OVER;H_JOIN_DIALOG_BOX_CS;',0)} See related topics



Moving and deleting commands on custom menus
Moving menus or items
1. In the Define Custom Menu Bar dialog box, click the left margin next to the top-level menu or item you want to 

move.
To select more than one menu or item, drag in the left margin. 
Both cells are highlighted, and the mouse pointer changes to a hand.

2. Drag the command or item to another location.

Deleting menus or items
1. Select the top-level menu or item to delete.
2. Click Delete Menu or Delete Item.

{button ,AL(`H_CREATING_A_CUSTOM_MENU_BY_COPYING_ONE_THAT_EXISTS_STEPS;H_CREATING_CUS
TOM_MENUS_STEPS;H_CUSTOM_MENUS_REF;H_DELETING_CUSTOM_MENUS_STEPS;H_EDITING_CUS
TOM_MENUS_STEPS;',0)} See related topics



Moving between fields using ENTER
Command: File - User Setup - Approach Preferences

Tab: General
Under Navigation, select    "Use Enter key to move between fields."
When you select this option, pressing ENTER on a form in Browse acts exactly like pressing TAB: it moves you to the 
next field in the tab order. It does not add data to the database.
To add data to the database, you must press CTRL+ENTER or click.

If this setting is off: Pressing ENTER enters the data in the database, but does not move you to the next field.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.

{button ,AL(`H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_
CHANGING_THE_TAB_ORDER_ON_VIEWS_STEPS;',0)} See related topics



Overview: Passwords

Defining passwords
To define

• Approach file passwords, choose File - TeamSecurity.

• Database passwords, choose File - User Setup - Approach Preferences and click the Password tab.

Entering passwords
A password is a sequence of characters you must enter before you can work in an Approach file.

• Passwords are not case-sensitive.
• They can have up to 16 characters.

Approach file password
A file can have more than one password. Different passwords for the same file can give you different privileges in that
file. 
For example, one password can give you complete access to edit and enter data in the associated databases as well 
as change the design of the views. Another password for the same file might let you do nothing except look at data. 
This is useful for files on networks; such files often must be available to many users, not all of whom should be able 
to change the file.

Database passwords
Database passwords can be set for dBASE, Paradox, and FoxPro databases only.
This password grants you read-only access or read/write access to the database(s) associated with the file.

• A read-write password gives users complete access to the data in the database file.
• A read-only password allows users to read data in a database, but not modify it.

You can give users access to password-protected databases even if they don't know the database password. Choose
File - TeamSecurity and create an Approach file password that allows users access to the databases.

{button ,AL(`H_DEFINING_PASSWORDS_FOR_A_DATABASE_STEPS;H_TEAMSECURITY_DIALOG_BOX_CS;',0
)} See related topics



Placing calls from Approach files

Why place calls from Approach?
Suppose your company is offering a special price on a product for a limited time. You want to call your customers to 
let them know as soon as possible, but you don't like the idea of having to punch in all those numbers.
By using the phone numbers that you have in your customer database, you can automate the dialing of phone 
numbers and make the task as efficient, error-free, and speedy as possible.

Preparing to place calls
1. Connect a modem to your computer.
2. Open the Approach file for the database containing the phone numbers.
3. (Optional) If you want to call only certain customers, do a find and work with the found set of phone numbers.
4. Choose File - User Setup - Approach Preferences.

5. Click the Dialer tab and enter the information required.

Placing the calls

Are you in Browse?
1. Click the phone number field.
2. Choose Browse - Dial.

The Dialing dialog box appears, and Approach dials the number.
Note If you don't select a field containing phone numbers, the Dial Number dialog box appears. Enter a number 
and click OK.

3. Conduct your business on the phone, and then hang up.
4. Go to the next record.
5. Repeat steps 1 - 4. 



Preferences dialog box: Display tab
Choose a task

Setting display preferences for the Approach window
Setting preferences for the Design environment
Adding custom controls to the Tools palette 

{button ,AL(`H_Setting_a_default_sort_order_for_looking_at_records_in_Browse_steps;H_PREFERENCES_DIALO
G_BOX_INDEX_TAB_CS;H_PREFERENCES_DIALOG_BOX_GENERAL_TAB_CS;H_PREFERENCES_DIALOG
_BOX_DATABASE_TAB_CS;H_DEFINING_PASSWORDS_FOR_A_DATABASE_STEPS;H_SETTING_DIALING_
PREFERENCES_REF;',0)} See related topics



Preferences dialog box: General tab
Choose a task

Making calculated fields available for joins 
Showing the Add Field dialog box after creating new fields
Showing the Cancel Macro dialog box while running macros
Moving between fields using ENTER
Displaying the contents of drop-down lists automatically
Identifying default directories
Downloading data before previewing
Entering data using optimistic record locking

{button ,AL(`H_PREFERENCES_DIALOG_BOX_DISPLAY_TAB_CS;H_Setting_a_default_sort_order_for_looking_at
_records_in_Browse_steps;H_PREFERENCES_DIALOG_BOX_INDEX_TAB_CS;H_PREFERENCES_DIALOG_
BOX_DATABASE_TAB_CS;H_DEFINING_PASSWORDS_FOR_A_DATABASE_STEPS;H_SETTING_DIALING_P
REFERENCES_REF;',0)} See related topics



Details: Setting a default sort order for looking at records in Browse
The sort order you set here does not affect the order of records in the database, only the order in which they appear 
by default when you display them in Browse.    (Databases generally store records in the order that you entered 
them.)

The primary sort field
The first field in the "Fields to sort on" box is the primary sort field.    Approach sorts records based on the data in this 
field. 
For example, Last Name is a common primary sort field to display the records in an employee database in 
alphabetical order.

Subsequent sort fields
The second sort field, and any others you select, give Approach a way to settle conflicts when more than one record 
has the same data in the primary sort field.    
For example, an employee database has 12 records containing the name Smith in the primary sort field, Last_Name. 
You select First_Name as the second sort field. Approach then sorts the record for Jane Smith before the record for 
John Smith.

{button ,AL(`H_SETTING_A_DEFAULT_SORT_ORDER_FOR_RECORDS_IN_BROWSE_STEPS',1)} Go to 
procedure



Setting a default sort order for looking at records in Browse
For each Approach file, you can set a sort order to move through records in that order in Browse. 
Caution When you create a default sort order it could slow performance on a large database, since Approach has to 
sort the database before displaying the records.
1. Open the Approach file (.APR).
2. Choose File - User Setup - Approach Preferences.

3. Click the Order tab.
4. Be sure the database showing in the "Maintain default sort for" box is the one you want.
5. Select a field in the "Fields" box.
6. Click Add.
7. Select an ascending or descending sort order for the field.
8. To add additional fields, repeat steps 4 - 7.
9. (Optional) To use this sort order when you open this file in the future, click Save Default.
10. Click OK.

{button ,AL(`H_SETTING_A_DEFAULT_SORT_ORDER_FOR_RECORDS_IN_BROWSE_DETAILS',1)} See details



Setting dialing preferences
These preferences associate a modem with an Approach file and record information about the phone you use with 
Approach. While setting preferences, have the documentation for your modem at hand.
Command: File - User Setup - Approach Preferences

Tab: Dialer
Save Default: Saves your preferences for future work sessions in Approach.

Modem settings
Option Description
Modem port Specifies the computer communication port 

that the modem is connected to.
Baud rate Specifies the baud rate of the modem.
Dial prefix
Dial suffix

Some modems need prefix and suffix codes 
to dial. For example, you may need to dial a 
credit card number after dialing the phone 
number. Store such codes here rather than 
with each phone number.

Hang-up Consult your modem documentation for the 
command string used to hang up.

Initialize Consult your modem documentation for the 
command string to initialize the modem.

Dialing settings
Option Description
Access code Specifies the number(s) for accessing an 

exchange or phone system, and if 
necessary, a comma for a pause. For 
example, to dial 9 for an outside line, type 9,.
The comma inserts a pause to wait for the 
outside line.

Do not dial Specifies numbers to omit when dialing. For 
example, use this option to remove the area 
code or international dialing code when you 
are dialing within that area code or country.

Dial Type Most telephones use tone dialing. Rotary 
phones use pulse dialing.

{button ,AL(`H_PLACING_CALLS_FROM_APPROACH_FILES_STEPS;',0)} See related topics



Setting display preferences for the Approach window
Command: File - User Setup - Approach Preferences

Tab: Display

To display Select
Buttons at the top of the window providing 
shortcuts for common tasks.

SmartIcons

Buttons at the bottom of the window for 
switching views, switching environments, 
and displaying information about the current 
view.

Status bar

Buttons at the top of window for switching 
environments, doing finds, entering new 
records, and when you choose View - Show 
Tab Order, changing the tab order.

Action bar

Tabs showing view names. Click a tab to go 
to the view. When off, use status bar to 
switch views.

View tabs

Command descriptions in the title bar when 
you highlight a menu command.

Title bar Help

A dialog box for opening and creating files 
when you start Approach or close a file.

Welcome dialog

Showing summaries in reports
Select "Report summaries" to ensure that you see summaries whenever you go to a report. With this option, 
Approach displays the report in either the Print Preview or Design environment.
Note To see summaries, you must also turn on View - Show Data.

Changing the default style
Click Default Style to display the Define Style dialog box, where you edit the default style.
The default style is a collection of style properties that Approach uses to create new views and objects, including the 
following:

• Font and attributes for field data
• Color and borders of field boxes
• Font and attributes for labels
• Attributes for PicturePlus fields
• Color and borders of views

Like any other named style, you can change the default style so that new views and objects have properties you 
prefer.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.

{button ,AL(`H_SETTING_PREFERENCES_FOR_THE_DESIGN_ENVIRONMENT_REF;',0)} See related topics



Setting preferences for database files
Command: File - User Setup - Approach Preferences

Tab: Database

For dBASE and FoxPro files
You should periodically compress the file.
When you delete records in dBASE or FoxPro databases, the records are only marked for deletion; they are not 
actually deleted until you compress the file. Approach file compression removes unused space left by deleted records
and rebuilds the index. 
Compressing the file can help improve performance, ensure the integrity of the index, and use disk space more 
efficiently.

For dBASE, FoxPro, and Paradox files
You can do the following:

• Select read-only access to the database file.
• Select either the DOS or Windows character set. 

The character set determines how you enter special characters that are not on the keyboard.    For example, if 
you are using the DOS set and want to type the symbol for Yen (¥), press ALT and type 157 on the numeric 
keypad. Using the Windows set, press ALT and type 165 on the numeric keypad.

For Paradox 4.0 files
You can change the case-sensitivity for doing finds in Paradox 4.0 database files. In Paradox 4.0 files, finds are 
initially not case-sensitive, but you can change them to be case-sensitive in Approach.
Finds in Paradox 3.5 files are always case-sensitive.

For Lotus Notes, SQL, Access, and ODBC tables
The options for these tables affect all of the tables you create or open in Approach, not just the table selected in the 
Preferences dialog box.

• For Lotus Notes, SQL, Access,    and ODBC: Select read-only access to the database file.
• For SQL, Access, and ODBC: Display SQL system tables in the list of file names in dialog boxes.

Save Default 
Saves your preferences for future work sessions in Approach.
Options available on the Database tab vary according to the file type of the database you select.



Setting preferences for the Design environment
Command: File - User Setup - Approach Preferences

Tab: Display

Settings for the Design environment
To display Select
Data from a record instead of field names. Data
Rulers to help you design a view. Rulers
Add Field dialog box. Add Field dialog
A floating palette of buttons for creating drawn 
objects, fields, and macro buttons.

Tools palette

Settings for the grid
To Select
Show a grid to help you see the alignment of 
objects.

Show grid

Force objects to line up along the grid when 
you draw, move, or resize them.

Snap to grid

Specify inches or centimeters as the unit of 
measurement for the grid.

Units

Specify a width for the increments on the grid. Width

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.

{button ,AL(`H_SETTING_DISPLAY_PREFERENCES_FOR_THE_APPROACH_WINDOW_REF;',0)} See related 
topics



Showing the Add Field dialog box after creating new fields
Command: File - User Setup - Approach Preferences

Tab: General
Under Show, select "Add Field dialog after creating new fields."
To simplify adding new fields to a view, have Approach automatically display the Add Field dialog box, which lists the 
fields you just created using the Field Definition box.    With this option, expect the following:

• The Add Field box appears when you close the Field Definition dialog box, if you have added new fields to the 
database.

• Add Field shows only the fields you just defined or edited. To see all fields of the database, click    Show All Fields 
at the bottom of the Add Field dialog box.

If this setting is off: Add fields by choosing Add Field on the context menu.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Showing the Cancel Macro dialog box while running macros
Command: File - User Setup - Approach Preferences

Tab: General
Under Show, select "Cancel Macro dialog when running macros."
To let users cancel a macro while it is running, have Approach display the Cancel Macro dialog box.
If this setting is off: Users have no visual clues for canceling a macro. They must press ESC.

Saving preferences
To save your preferences for future work sessions in Approach:

• If an Approach file is open: click Save Default, and then click OK.
• If an Approach file is not open: click OK.



Using the Index to get Help
If Help is not available in the current context, use the Index to get Help.
1. In the Help window, click Help Topics.
2. Click Index.
3. Enter the task or term you want information on.
4. Select the index entry you want, and then click Display.



dBASE files in Approach
Approach creates and uses these files: dBASE III+ and dBASE IV
File extension: .DBF
Network: You can share Approach dBASE files on a network.

Viewing dBASE files in Approach
These are the main differences between viewing dBASE files in Approach and in other dBASE applications:

• In a dBASE file created in Approach, you can use field names with any characters, up to 32 characters long. If 
you view the file in other dBASE applications, you may see a modified version of your field names.

• Memo fields greater than 5,000 characters cannot be viewed in the internal memo editor for dBASE III+.
• Memo fields greater than 64,000 characters cannot be viewed in the internal memo editor for dBASE IV.
• Approach PicturePlus fields cannot be viewed in other dBASE applications.

Restrictions on field names
Maximum length of field names: 32 characters
Permitted characters: Any, including letters, whole numbers, spaces, commas, periods, arithmetic signs
Other dBASE applications have more restrictions on the length of field names and on the characters you can use. For
field names that do not satisfy other applications, Approach saves both the name you give the field and a modified 
name that other applications can read. If you open the database in another dBASE application, you see the modified 
field names.

Restrictions on field lengths
You must specify a field length for text and numeric fields. Other fields are fixed in length or do not require a specified
length.
Maximum length for text fields: 254
Maximum length for numeric fields: 19. You can specify up to 15 decimal places, but the total cannot exceed 19.

Index files
Approach uses its own indexes for keeping track of records in a dBASE file. 

Limits on files, records, and fields
Item Limit
File size 2 gigabytes
Database files open Up to 30, depending on 

memory
Records per database 1,000,000,000
Record size 4,000 bytes
Fields per record 128 (dBASE III+)

255 (dBASE IV)
Fields used in a sort 255
Size of a memo file Limited by disk space 
Size of a PicturePlus file Limited by disk space
Indexes per database 255

{button ,AL(`H_OPENING_DATABASES_CREATED_IN_OTHER_APPLICATIONS_STEPS;H_SETTING_FILESHARI
NG_OPTIONS_FOR_DBASE_FILES_STEPS;',0)} See related topics



Files created or used by Approach
The file extensions most often used in Approach:

• .DBF for dBASE and FoxPro files
• .DB for Paradox files
• .APR for Approach files

Files created or used by Approach
The following table gives the extensions for Approach files and data-related files that Approach creates or uses.
You may see other extensions for files that another database application has created. For information about those 
extensions, see the documentation for the application.
When n appears in an extension, it stands for a variable number. For example, the extension .Xnn might appear in a 
file name as .X24.

Extensio
n

File type

.ADX Approach dBASE index

.APR Approach file, for storing views

.APT Consolidated Approach data 
and views, created when you 
attach an .APR file to 
aTeamMail message

.APX Approach-specific Paradox 
information file

.CDX FoxPro compound index

.DB Paradox database file

.DBF dBASE or FoxPro database file

.DBQ Paradox memo file

.DBT dBASE memo file

.FPT FoxPro memo file

.IDX FoxPro 2.0 index

.LCK Paradox lock file

.MB Paradox 4.0/Windows memo file

.MDB Microsoft Access database file

.MDX Maintained dBASE index

.MPR Approach SmartMaster 
Application

.NDX Nonmaintained dBASE index

.NRP Notes Reporter file

.NSF Notes database file

.OYZ Approach alternate dBASE 
index

.QRY Approach query file, for SQL 
tables

.SMI Lotus SmartIcon file

.VEW Approach file, for storing views; 
versions earlier than 3.0

.Xnn Paradox single secondary index

.Ynn Paradox single secondary index

.XGn Paradox composite secondary 
index



.YGn Paradox composite secondary 
index

Approach creates an .OYZ file only if it needs to create an index and an .ADX file already exists for another 
application.

Text and spreadsheet files
You can use the following text and spreadsheet files for creating database files and for importing and exporting data.

Extension File type
.TXT Delimited or fixed-length text
.WKS Lotus 1-2-3 Release 1A
.WK1 Lotus 1-2-3 Release 2
.WK3 Lotus 1-2-3 Release 3
.WK4 Lotus 1-2-3 Release 4 or 5
.WRK Symphony Release 1 or 1.01
.WR1 Symphony Release 1.1, 1.2, or 2
.XLS Excel 3.0 or 4.0

Graphic files
You can use graphic files for importing images into a PicturePlus field and for putting an object on a view as a design 
element. These are the filename extensions for supported file types:

Extension File type
.BMP Windows bitmap
.EPS Encapsulated Postscript
.GIF Graphics interchange
.JPG JPEG (Joint Photographic 

Experts Group)
.PCX Windows Paintbrush
.TGA Targa
.TIF TIFF (Tagged Image File 

Format)
.WMF Windows metafile

LotusScript files
These are the filename extensions for supported LotusScript file types:

Extension File type
.LSS ASCII text files containing 

LotusScript code
.LSO Compiled LotusScript files

Approach files
Approach files (.APR) store views, and all their style and layout information, calculated fields, variable fields, macros, 
and scripts.
The Approach file does not store any data. Instead, you do all your work in the Approach files, including entering and 
editing data, finding and sorting records, and organizing and printing information. 
When you create a new database file in Approach (or open and existing database file, spreadsheet, or text file from 
another application), Approach automatically creates or opens a new Approach file for it.    

Index files
Database applications create index files that list all the values for a field and records in a database file. An index is 
created when you use a field in a find, list, or join. Approach uses its own index file (.ADX) for dBASE and FoxPro 



databases, and the Paradox index (.X*, .Y*) for Paradox databases.
Approach creates an .OYZ file only if it needs to create an index and an .ADX file already exists for another 
application.

Memo files
When you define a field as the memo field type, Approach creates a corresponding memo (.DBT) file to store the 
field's information. Memo files allocate space in 4K sections and can contain a maximum 64K of information.      

LotusScript files
These are the file extensions for supported LotusScript file types:

Extension File type
.LSS ASCII text files containing 

LotusScript code
.LSO Compiled LotusScript files

Text and spreadsheet files
You can use the following text and spreadsheet files for creating database files and for importing and exporting data.

Extension File type
.TXT Delimited or fixed-length text
.WKS Lotus 1-2-3 Release 1A
.WK1 Lotus 1-2-3 Release 2
.WK3 Lotus 1-2-3 Release 3
.WK4 Lotus 1-2-3 Release 4 or 5
*.123 Lotus 1-2-3 97
.WRK Symphony Release 1 or 1.01
.WR1 Symphony Release 1.1, 1.2, or 2
.XLS Excel 3.0 or 4.0

Graphic files
You can use graphic files for importing images into a PicturePlus field and for putting an object in a view as a design 
element. These are the file extensions for supported file types:

Extension File type
.BMP Windows bitmap
.EPS Encapsulated Postscript
.GIF Graphics interchange
.JPG JPEG (Joint Photographic Experts 

Group)
.PCX Windows Paintbrush
.TGA Targa
.TIF TIFF (Tagged Image File Format)
.WMF Windows metafile



FoxPro files in Approach
Approach creates and uses these files: FoxPro 2.1
File extension: .DBF
Network: You cannot share FoxPro files on a network in Approach. You can open a FoxPro file on a network, but 
other users will not be able to open it at the same time.

Viewing FoxPro files in Approach
These are the main differences between viewing FoxPro files in Approach and in other FoxPro applications:

• In a FoxPro file created in Approach, you can use field names with any characters, up to 32 characters long. If 
you view the file in other FoxPro applications, you may see a modified version of your field names.

• Approach PicturePlus fields cannot be viewed in other FoxPro applications.

Restrictions on field names
Maximum length of field names: 32 characters
Permitted characters: Any, including letters, whole numbers, spaces, commas, periods, arithmetic signs
Other FoxPro applications have more restrictions on the length of field names and on the characters you can use. For
field names that do not satisfy other applications, Approach saves both the name you give the field and a modified 
name that other applications can read. If you open the database in another FoxPro application, you see the modified 
field names.

Restrictions on field lengths
You must specify a field length for text and numeric fields. Other fields are fixed in length or do not require a specified
length.
Maximum length for text fields: 254
Maximum length for numeric fields: 19. You can specify up to 15 decimal places, but the total cannot exceed 19.

Index files
Approach uses its own indexes for keeping track of records in a FoxPro file. 

Limits on files, records, and fields
Item Limit
File size 2 gigabytes
Database files open Up to 30, depending on 

memory
Records per database 1,000,000,000
Record size 4,000 bytes
Fields per record 255
Fields used in a sort 255
Size of a memo file Limited by disk space
Size of a PicturePlus file Limited by disk space
Indexes per database 255

{button ,AL(`H_OPENING_DATABASES_CREATED_IN_OTHER_APPLICATIONS_STEPS;',0)} See related topics



IBM DB2 tables in Approach
Approach can open these files:

• IBM DB2/2, DB2/6000, and DB2/HP-UX tables, opened directly in Approach, through ODBC support
• IBM DB2, DB2/400, and SQL/DS tables, via the IBM Distributed Database Connection Services (DDCS), through 

ODBC support
• IBM DB2 tables, through the Micro Decisionware Database Gateway (MDI), version 2.0 or later

Viewing DB2 tables in Approach
These are the main differences between viewing DB2 tables in Approach and in other DB2 applications:

• Date fields in DB2 include both a date and a time. In Approach, these fields appear as two fields: a date field and 
a time field. The extension "_Time" is added to the time field.
For example, suppose the DB2 date field Shipped has the value "5/10/94 10:35PM." Approach displays a date 
field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM."

• You can create memo and PicturePlus fields in a DB2 table you open through ODBC, but not in a DB2 table you 
open through MDI. Approach PicturePlus fields cannot be viewed in other DB2 applications.

If you read a DB2 table without a unique index, Approach opens a read-only copy of the table.
After you connect to a DB2 server, all the user names appear in the list view. Double-click your user name to display 
the tables that belong to you in the list view.

Restrictions on field names for tables opened through ODBC
Data type Maximum length of field names
PicturePlus 12 characters
Boolean 11 characters
All others 18 characters

Permitted characters: The first character in a field name must be a letter. After that, the name can have letters and 
whole numbers.
Characters not to use: Spaces and ODBC keywords are not allowed.

Restrictions on field names for tables opened through MDI
Data type Maximum length of field names
Boolean 11 characters
All others 18 characters

Permitted characters: The first character in a field name must be a letter. After that, the name can have letters, 
whole numbers, and the underscore character (_).

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length of text fields: 254

Limits on tables, records, and fields
Item Limit
Table size Limited only by disk space
Tables open at a time 255
Records per table Limited only by disk space
Record size 2,000 or 4,000 bytes
Fields per record 300
Fields used in a sort As many fields as are in the table
Memo and picture fields per 
table

Limited only by disk space 
(available only for DB2 tables you 
open through ODBC)





Lotus Notes files in Approach
Approach creates and uses these files: Approach only creates forms within .NSF files. Approach does not create 
the .NSF files.
File extension: .NSF
Network: You can share .NSF files on a Notes server but not on a local network file server.

Viewing Lotus Notes files in Approach
Approach has transparent access to Notes database files. All of Approach's reporting, forms, and updating 
capabilities can be used with data stored in Notes. 
Approach and Notes can pass information back and forth via global variables using Notes/FX .
Approach users can distribute forms, reports, worksheets, charts, mailing labels, and crosstabs via Notes mail.

Restrictions on field names
Maximum length of field names: 32
Permitted characters: Field names must begin with a letter and may contain up to 32 bytes. The field name can 
include letters, numbers, and the symbols _ and $.

Restrictions on field lengths
Maximum length for text fields: 254
Maximum length for numeric fields: Fixed

Index files
No maximum

Limits on files, records, and fields
Item Limit
File size No limits
Database files open Limited by Approach
Records per database No limits
Record size Limited by Approach
Fields per record Limited by Approach

Fields used in a sort 32
Size of a memo file No limit
Size of a PicturePlus file No limit
Indexes per database No limit (50 maximum in VSE)



Microsoft Access tables in Approach 
Approach works with these files: Microsoft Access database tables. To open an Access table in Approach, the 
table must be part of an Access database that has been set up using the 32-BIT ODBC Admin. You can use ODBC 
Admin to create a data source that either links to an existing Access database or creates a new Access database. 
To open a table in an Access database from Approach: 
1. Choose File - Open.
2. Select Microsoft Access Driver (*.MDB) from the "Files of type" box.
3. Select the database.
4. Specify the table to open.
5. Click Open.
You can also add tables to the Access database. The new tables can be from another Access database or any other 
file type. Choose File - Export Data to export them to the Access database.      
File extension: .MDB
Network: You can share Access tables on a network in Approach. The connection to Access is through the ODBC 
driver.

Viewing Access tables in Approach
These are the main differences between viewing Access tables in Approach and in the Microsoft Access application:

• Approach PicturePlus fields cannot be viewed in Access.
• In Approach, fields in the Access currency field type are converted to numeric fields.
• Timestamp fields in Access include both a date and a time. In Approach, these fields appear as two fields: a date 

field and a time field. The extension "_Time" is added to the time field.
For example, suppose the Access timestamp field Shipped has the value "5/10/94 10:35PM." Approach displays a
date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM."

If you read an Access table without a unique index, Approach opens a read-only copy of the file.

Restrictions on field names in Microsoft Access
Data type Maximum length of field names
Text, memo, Boolean 
(bit), numeric 
(numeric/currency)

32 characters

Date, time 26 characters
Permitted characters: The first character in a field name must be a letter. After that, the name can have letters and 
whole numbers.
Characters not to use: Spaces and ODBC keywords

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length for text fields: 255

Limits on tables, records, and fields in Microsoft Access
Item Limit
Table size 1 gigabyte (versions 1.1 and 2.0)

128 megabytes (version 1.0)
Tables open at a time Up to 255, depending on memory
Records per database Limited by the size of the database
Record size Limited by the number of fields
Fields per record 255
Fields used in a sort 10
Size of a memo field 32,000 bytes



Size of a PicturePlus file 1 gigabyte (versions 1.1 and 2.0)
128 megabytes (version 1.0)

Indexes per database 32



ODBC data sources in Approach
Approach is fully compatible with the Open Database Connectivity standard (ODBC). You can use only 32-bit drivers.
Approach supports the following ODBC drivers:
Informix 
Oracle 
SQL Server
Sybase

Viewing ODBC data sources in Approach
These are the main differences between viewing ODBC data in Approach and in other applications:

• You can add PicturePlus fields to an ODBC data source in Approach only if the driver supports the Long Var 
Binary field type. You can add memo fields only if the driver supports the Long Var Char field type.

• You cannot view Approach PicturePlus fields in other ODBC applications. 
• In Approach, fields in the ODBC field types Big Int, Tiny Int, Small Int, Real, Numeric, Decimal, Integer, Double, 

and Float are converted to numeric fields.
• Timestamp fields in ODBC include both a date and a time. In Approach, these fields appear as two fields: a date 

field and a time field. The extension "_Time" is added to the time field.
For example, suppose the ODBC Timestamp field Shipped has the value "5/10/94 10:35PM." Approach displays a
date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM."

If you read an ODBC data source without a unique index or timestamp, Approach opens a read-only copy of the view 
file or table.

Restrictions on field names
The maximum length of a field name depends on whether the ODBC driver supports the data type of the field:

Data type (ODBC 
data types in 
parentheses

If the driver 
supports the data 
type

If the driver does 
not support the 
data type

Text (Char or Var 
Char)

30 or limit of driver (Always supported)

Numeric (Bit Int, 
Tiny Int, Small Int, 
Real, Numeric, 
Decimal, Integer, 
Double, or Float)

30 or limit of driver 30 or limit of driver; 
stored as text

Memo (Long Var 
Char)

30 or limit of driver Field is disabled

Boolean (Bit) 30 or limit of driver (30 or limit of driver)
- 7; stored as text

Date (Date) 30 or limit of driver (30 or limit of driver)
- 6; stored as 
timestamp (if 
supported) or as 
text

Time (Time) 30 or limit of driver (30 or limit of driver)
- 6; stored as 
timestamp (if 
supported) or as 
text

PicturePlus (Long 
Var Binary)

(30 or limit of 
driver) - 6

Field is disabled

If two lengths are given for a field name (such as "30 or limit of driver"), the maximum can only be the shorter of the 
two lengths.
Permitted characters: The first character in a field name must be a letter. After that, the name can have letters and 



whole numbers.
Characters not to use: Spaces and ODBC keywords

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length of text fields: The limit of the ODBC driver. Most drivers have a limit of 255.

Limits on tables, records, and fields
In an ODBC data source, the size of the table and the number of records in it are limited only by disk space. You can 
have up to 255 tables open at a time.
The limits on record size, fields per record, fields in a sort, and memo and picture fields are determined by the 
database application for the ODBC data source. For more information, consult the documentation for the ODBC 
driver or for the database application.



Oracle SQL tables in Approach
Approach can work with these files: Tables in Oracle SQL, version 7
Network: You can work with an Oracle table on a server or on your local drive.

Viewing Oracle SQL tables in Approach
These are the main differences between viewing tables in Approach and in other Oracle SQL applications:

• Approach PicturePlus fields cannot be viewed in other Oracle SQL applications.
• In Oracle SQL, null and blank field values sort greater than nonblank field values.
• Date fields in Oracle SQL include both a date and a time. In Approach, these fields appear as two fields: a date 

field and a time field. The extension "_Time" is added to the time field.
For example, suppose the Oracle SQL date field Shipped has the value "5/10/94 10:35PM." Approach displays a 
date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM."

• When reading Oracle SQL 7 tables, Approach treats varchar2 fields with more than 255 characters as memo 
fields.

If you read an Oracle view file based on more than one Oracle table, Approach opens a read-only copy of the view 
file.
After you connect to an Oracle 7 server, all the user names appear in the list view. Double-click your user name to 
display the tables that belong to you in the list view.

Restrictions on field names
If an Oracle table is created with lowercase field names, you must enclose the field names in double quotation marks 
(" ") to access the fields.

Data type Maximum length of field names
Text, memo, numeric 30 characters
Date, time, Boolean, 
PicturePlus

23 characters

Permitted characters: All, except the double quotation mark (")
Characters not to use: Double quotation mark (")
Oracle field names in formulas: Enclose the field name in double quotation marks (" ") if you want the field name in 
lowercase or if it contains a space, period, comma, or any of the following characters:

/      *      +      -      <      >      ( 

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length for text fields: 255.
In Oracle 7, a text field can be up to 2,000 characters. If you create a text field that is longer than 255 characters, 
Approach treats it as a memo field.

Limits on tables, records, and fields
Item Limit
Table size Limited only by disk space
Tables open at a time 255
Records per table Limited only by disk space
Record size Limited by the number of fields 

and the size of the field type
Fields per record 254
Fields used in a sort As many fields as are in the 

table
Size of a memo or picture 
field

2 gigabytes (Oracle 7)

Memo and picture fields per 1 memo field or 1 picture field 



table (but varchar2 fields already in 
an Oracle 7 table are treated 
as memo fields in Approach)



Paradox files in Approach
Approach creates and uses these files: Paradox 3.5 and Paradox 4.0. All characteristics of Paradox 4.0 described 
in this topic also apply to Paradox for Windows.
File extension: .DB
Network: You can share Approach Paradox files on a network.
Paradox files require a key field. When you create a Paradox database in Approach or try to use one that does not 
have a key field, the Choose Key Field dialog box appears automatically. You can either add a new field to be the key
or select an existing one or a combination of fields.

Viewing Paradox files in Approach
Because Paradox 3.5 does not support memo or PicturePlus fields, you cannot view them using Paradox 3.5. 
You can view memo and PicturePlus fields in Paradox 4.0, unless the database was created in the Paradox 3.5 file 
type. However, Paradox 4.0 PicturePlus fields are read-only in Approach. 

Restrictions on field names
Data type Maximum length of field names
Text, numeric, date 25 characters
Time, memo, Boolean, 
PicturePlus

18 characters

Permitted characters: Letters, whole numbers, spaces, commas, periods, arithmetic signs
Paradox field names in formulas: Enclose the field name in double quotation marks (" ") if it contains a space, 
period, comma, or any of the following characters:

/      *      +      -      <      >

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length for text fields: 255

Index files
A primary index for a Paradox file is built on the key field specified when you create the file. Indexes in Paradox 3.5 
are case-sensitive and in Paradox 4.0 are case-insensitive.

Limits on files, records, and fields
Item Limit
File size 4 gigabytes
Database files open 2 to 10, depending on the 

number of secondary index 
files open

Records per database 2,000,000,000
Record size 1,350 bytes
Fields per record 255
Fields used in a sort 255
Size of a memo file Limited by disk space
Size of a PicturePlus file Limited by disk space
Indexes per database 255

{button ,AL(`H_CREATING_SECONDARY_INDEXES_FOR_PARADOX_DATABASES_STEPS;H_SETTING_FILESH
ARING_OPTIONS_FOR_PARADOX_FILES_STEPS;H_SPECIFYING_A_KEY_FIELD_FOR_A_PARADOX_DATA
BASE_STEPS;',0)} See related topics





QMF files in Approach
Approach can open these files:

• QMF Query - When you select a QMF Query, the query is run on the QMF server. The results appear in an 
Approach form and worksheet. This data is read-only. 

• QMF Procedure - When you select a QMF Procedure, the procedure is run on the QMF server. The last data set 
used by the procedure appears in an Approach form and worksheet. This data is read-only.

QMF files opened in Approach cannot be updated, edited, or saved.
To access QMF files on the server, you must use SRPI or APPC connections.
Approach can import these files:

• QMF Form - When you select a QMF Form to import, the form is downloaded from the QMF server. It does not 
contain any data, but its attributes are used to create a new Approach report or crosstab view.

• QMF Query - If you have the DB2 data source defined, you can import a QMF Query using the SQL Assistant. 
The SQL statement of the QMF Query is downloaded from the QMF server. Use the DB2 data source to connect 
to DB2 and submit the SQL statement to DB2 directly. 

Viewing QMF tables in Approach
• Timestamp fields in QMF include both a date and a time. In Approach, these fields appear as two fields: a date 

field and a time field. The extension "_TIME" is added to the time field.
For example, suppose the QMF timestamp field SHIPPED has the value "5/10/94 10:35PM." Approach displays a 
date field SHIPPED with the value "5/10/94" and a time field SHIPPED_TIME with the value "10:35PM."

• After you connect to a QMF server, all the user names appear in the list view. Double-click your user name to 
display the QMF objects that belong to you in the list view.

Limits on tables, records, and fields

Item Limit
Table size Limited only    by disk space
Tables open at a time Limited only by disk space
Records per table Limited only by disk space
Record size Limited only by the QMF 

export facility
Fields per record Limited by the database QMF 

uses
Fields used in a sort As many fields as are in the 

table 
Field name 18 characters



Query files in Approach
Query files allow you to quickly connect to a server and gain access to specific information in either SQL or non-SQL 
databases (such as dBASE, FoxPro, and Paradox).
File extension: .QRY
Create or edit a query file using any text editor. These are the commands you can use:
Type=Oracle or SQLServer or DB2-MDI or Notes or ODBC type
Network=protocol letter (for Oracle SQL*NET1.x only)
Path=name of the database server
User=your name
Password=your password
Database=name of the database (for SQL Server only)
Select valid SELECT statement
The commands for a query file are case-insensitive. They can appear in any order with the exception    of the 
SELECT statement, which must be the last command. 
All of the commands except for Type and Select are optional. If the query file does not contain enough log-on 
information, a Connect dialog box appears when you open the file so that you can fill in the remaining information.
If you include spaces or nonalphanumeric characters in a parameter, the parameter must be enclosed in    double 
quotation marks (" "). 
This is an example of an Oracle query file:

Type=Oracle
Network=X (for Oracle SQL*NET1.x only)
Path=ORASRV
User=Rich
Password=sequoia
Select Name,Address,City From Employee

This is an example of a dBASE query file:
Type=dBASE
Select firstname, lastname from "c:\temp\emp.dbf"

Creating a query file
You can also create a query file by either saving or exporting, as long as there is an SQL table active in Approach.



SQL Server 4.x tables in Approach
Approach can work with these files: Tables in Microsoft SQL Server (any version under 5.0) and Sybase SQL 
Server (version 4.x).

Viewing SQL Server tables in Approach
These are the main differences between viewing tables in Approach and in other SQL Server applications:

• Approach PicturePlus fields cannot be viewed in other SQL Server applications.
• SQL Server has a field type specifically for currency. In Approach, this is converted to a numeric field.
• Date fields in SQL Server include both a date and a time. In Approach, these fields appear as two fields: a date 

field and a time field. The extension "_Time" is added to the time field.
For example, suppose the SQL Server date field Shipped has the value "5/10/94 10:35PM." Approach displays a 
date field Shipped with the value "5/10/94" and a time field Shipped_Time with the value "10:35PM."

If you read an SQL Server view file or an SQL Server table without a unique index or timestamp, Approach opens a 
read-only copy of the view file or table.
After you connect to the SQL Server, all the active databases appear in the list view. When you double-click the 
database to which you have access, all the tables belonging to that database appear in the list view.

Restrictions on field names
Data type Maximum length of field names
Text, memo, numeric, 
Boolean

30 characters

Date, time, PicturePlus 24 characters
Permitted characters: The first character in a field name must be a letter, the number sign (#), or the underscore 
character (_). After that, the name can have letters, whole numbers, and the following characters:    #      _      $
Characters not to use: Spaces

Restrictions on table names
A table name beginning with a number sign (#) denotes a temporary table. Other object names cannot begin with a #.
Table names have the same restrictions as field names.

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length for text fields: 255

Limits on tables, records, and fields
Item Limit
Table size Limited only by disk space
Tables open at a time 255
Records per table Limited only by disk space
Record size 1,962 bytes, not including 

picture and memo fields
Fields per record 250
Fields used in a sort 16
Size of a memo or picture field 2 gigabytes
Memo and picture fields per table Limited only by disk space



Troubleshooting IBM DB2 using CAE
In order to connect to IBM DB2 using IBM CAE's ODBC Driver, you must first:

• Install the DB2 server
• Install IBM's 32-bit CAE 2.1.2 or greater
• Install Lotus Approach on the client machine
• Install the ODBC driver support (this icon is in the "IBM DB2 Database" group for Windows NT or the "DB2 Client 

for Windows 95" folder for Windows 95) 
• Correctly Catalog a node and then the Database using the named node at the DB2> prompt
• Update the Database Manager Configuration File at the DB2> prompt to make sure the NNAME entry is not 

empty
• Be able to connect to the Database at a DB2> prompt
• Configure the ODBC Data Source using the ODBC 32-bit or CLI/ODBC Administrator
• Have a proper ID and Password    and adequate rights

Error messages
In any multi-component setup it's easy to forget a step, but sometimes hard to determine which step was missed. 
Error messages associated with the most common problems that might arise (and their possible solutions) are shown
below.

• Couldn't open the database, return code -35
The most likely cause of this message is that the server is not operational, or the communication link is not up, or has
not been properly configured. If Approach and DB2 are running on the same machine, start DB2. Otherwise, inform 
the person responsible for the DB2 server of the problem.

• Couldn't open the database, return code -1038
The DB2 table contains a BLOB or CLOB column. Lotus Approach cannot open these tables. The EMP_PHOTO and 
EMP_RESUME tables include such columns. 

• The file (database) is read-only
The most common reason for this message is that you do not have appropriate privileges for the table. If you do have
privileges for the table, the table may not have a primary key. Lotus Approach requires a primary key if the table is to 
be updated. The EMP_ACT table in the Sample database, for example, does not have a primary key.

• Server is not available
If you get this message when opening a database (and you know there are no server problems) you probably 
neglected to bind the database to the ODBC driver manager.
Another possible reason is that you may not have catalogued the database as an ODBC data source. Correct this 
problem by using the ODBCAD32.EXE program.

Help
Specific help on individual error messages and more detailed help on specific clients is available from the Lotus 
KnowledgeBase on the Lotus Home Page at www.lotus.com and from Approach Customer Support.



Troubleshooting Microsoft SQL Server
Approach uses a 32-bit ODBC driver to connect to Microsoft SQL Server. Standard ODBC troubleshooting 
procedures apply to connections of this data type. The following information applies to Microsoft SQL Server versions
4.x and 6.x.      
In order to connect to Microsoft SQL Server, you must also have:

• The Net Library and dB Library 
• A properly configured client (or the settings manually updated in the registry)

It is not necessary (though it may be more convenient for some users) to install the client for Microsoft SQL Server as
long as the Net Library and db Library (NTWDBLIB.DLL) are installed. Approach will install NTWDBLIB.DLL and 
DBNMPNTW.DLL if you want to use Named Pipes as your default protocol. However, to use a different protocol you 
must install the proper 32-bit Net Lib .DLL's. 
The following table shows a list of the .DLL's needed for each protocol:

Protocol Microsoft
NWLINK IPX/SPX DBMSSPXN.DLL

TCP/IP DBMSSOCN.DLL

DEC NET N/A
MuliProtocol DBMSRPCN.DLL
Named Pipes DBNMPNTW.DLL

If you have installed the Microsoft clients, they have utilities that will test your connection without using the ODBC 
driver. The recommended utility for Microsft SQL Server is ISQLW. 

Help
Specific help on individual error messages and more detailed help on specific clients is available from the Lotus 
KnowledgeBase on the Lotus Home Page at www.lotus.com and from Approach Technical Support.



Troubleshooting Oracle Server
Approach uses a 32-bit ODBC driver to connect to Oracle Server. Standard ODBC troubleshooting procedures apply 
to connections of this data type. Approach cannot connect to Oracle 6 and below because these versions do not 
support a 32-bit SQL*Net 2.1 client. 
In order to connect to Oracle Server you must:

• Install a 32-bit Oracle client supporting SQL*Net 2.1
• Configure the client (i.e. update the SQLNET.ORA and TNSNAMES.ORA in the ORANT\NETWORK\ADMIN 

directory)
• Add \ORANT\BIN to your search path
• Be able to connect through the Oracle client (i.e. through SQLDBA)

Be sure the Oracle 7 Client is installed before setting up the corresponding ODBC data sources.

Help 
Specific help on individual error messages and more detailed help on specific clients is available from the Lotus 
KnowledgeBase on the Lotus Home Page at www.lotus.com and from Approach Technical Support.



Troubleshooting Sybase SQL Server 4.x
Approach uses a 32-bit ODBC driver to connect to Sybase SQL Server. Standard ODBC troubleshooting procedures 
apply to connections of this data type. The following information applies to Sybase SQL Server versions 4.x.
In order to connect to Sybase SQL Server, you must also have:

• The Net Library and dBLibrary
• A properly configured client (or the settings manually updated in the registry)

It is not necessary (though it may be more convenient for some users) to install the client for Sybase SQL Server as 
long as the Net Library and dBLibrary are installed. Approach will install NTWDBLIB.DLL and DBNMPNTW.DLL if you
want to use Named Pipes as your default protocol. However, to use a different protocol you must install the proper 
32-bit Net Lib .DLL's. 
The following table shows a list of the .DLL's needed for each protocol:

Protocol Microsoft
NWLINK IPX/SPX DBMSSPXN.DLL

TCP/IP DBMSSOCN.DLL

DEC NET N/A
MuliProtocol DBMSRPCN.DLL
Named Pipes DBNMPNTW.DLL

If you have installed the Sybase clients, they will have utilities to test your connection. The recommended utility for 
Sybase SQL Server is SybPing. 

Help
Specific help on individual error messages and more detailed help on specific clients is available from the Lotus 
KnowledgeBase on the Lotus Home Page at www.lotus.com and from Approach Technical Support.



Troubleshooting Sybase System 10 and 11
Approach uses a 32-bit ODBC driver to connect to Sybase System 10 and 11. Standard ODBC troubleshooting 
procedures apply to connections of this data type.
In order to connect to Sybase System 10 and 11, you must also have:

• The Net Library
• A properly configured client (or the settings manually updated in the registry)

It is necessary to install the Sybase Open Client for Sybase System 10 and 11.
The following table shows a list of the .DLL's needed for each protocol:

Protocol Sybase
NWLINK IPX/SPX NLNWLINK.DLL
TCP/IP NLWNSCK.DLL
DEC NET NLDECNET.DLL
MultiProtocol N/A
Named Pipes NLMSNMP.DLL

If you have installed the Sybase System 10 or 11 clients, they will have utilities to configure the appropriate protocols 
for your databases and to test your connection. The recommended utilities for Sybase System 10 and 11 are SQLEdit
and SybPing. 

Help
Specific help on individual error messages and more detailed help on specific clients is available from the Lotus 
KnowledgeBase on the Lotus Home Page at www.lotus.com and from Approach Technical Support.



Overview: Installing additional language versions of Approach
SmartSuite lets you access your Lotus applications in multiple languages. The first language you install becomes 
your default language. To add a second or third language version of Approach, you must run the Install again. The 
Install program informs you that you already have an existing copy of the product in a different language and 
preserves the directory structure of the default language. 
The Install program adds icons for the additional languages to the Windows Start menu. These icons are identified by
the two-character ISO language tag. 
For example, the icon for the French version of Approach is labeled Approach - FR.

Choosing another language version
If you installed additional language versions of Approach, you can choose another language version by right-clicking:

• The Approach application icon in the Lotus Applications folder in SmartCenter 
• A SuiteStart icon 



What's new in Approach?
Lotus Approach Release 9 for Windows 95 and Windows NT includes new functionality that helps you easily migrate 
Approach documents to the Internet.

Publishing Approach views and named finds to the Internet: 
You can publish the current view, a specified view, or a specified named find to an Internet site.

Building Web sites that integrate Approach documents:    
Using Lotus FastSite, you can build a Web site that combines Approach views and named finds with other SmartSuite
product documents.



Keyboard shortcuts
To use keyboard shortcuts, do the following.
1. Press ALT.
2. Press the letter of the command in the main menu.

For example, to select all records in a worksheet, press ALT + E A (Edit - Select All).
You can also use the following shortcuts for many common commands.

Command Shortcut Context
Browse CTRL+B All
Copy CTRL+C or 

CTRL+INS
All

Cut CTRL+X or 
SHIFT+DEL

All

Delete Record CTRL+DEL Browse
Design CTRL+D All
Fast Format(On/Off) CTRL+M Design
Find CTRL+F Browse
Find All CTRL+A Browse
Find/Sort Assistant CTRL+I All
First Record CTRL+HOME Browse
Go To Record CTRL+W Browse
Group CTRL+G Design
Hide Record CTRL+H Browse
Insert Current Time CTRL+SHIFT+T All
Insert Previous Value CTRL+SHIFT+P All
Insert Today's Date CTRL+SHIFT+D All
Last Record CTRL+END Browse
New Record CTRL+N Browse
Next Record PG DN Browse
Next View CTRL +PG DN All
Open CTRL+O All
Paste CTRL+V or 

SHIFT+INS
All

Previous Record PG UP Browse
Previous View CTRL +PG UP All
Print CTRL+P All
Print Preview(On/Off) CTRL+SHIFT+B All
Properties (InfoBox) CTRL+E or 

ALT+ENTER
Design

Refresh Data CTRL+R All
Save Approach File CTRL+S All
Show/Hide Tools 
Palette

CTRL+L Design

Show/Hide Rulers CTRL+J Design
Snap to Grid(On/Off) CTRL+Y Design
Sort CTRL+T Browse
Spell Check CTRL+F2 All
Undo CTRL+Z or All



ALT+BACKSPACE

Ungroup CTRL+U Design
Zoom In CTRL+ All
Zoom Out CTRL+¯ All
Zoom To 100% CTRL +1 All

{button ,AL(`H_CUSTOM_MENUS_REF;H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_WITHIN_FIELDS_REF
;H_SELECTING_WITHIN_FIELDS_REF;H_SELECTING_REPEATING_PANELS_STEPS;H_SELECTING_OBJE
CTS_STEPS;H_SELECTING_TEXT_IN_A_TEXT_BLOCK_STEPS;',0)} See related topics



Moving between fields
Forms, reports, and mailing labels

To move to Press
The next field in the tab order TAB

The previous field in the tab 
order

SHIFT+TAB

You can set your preferences    to use ENTER to move between fields.    If you do, TAB continues to behave as 
described above.

Worksheets and crosstabs
To move to Press
The next field in a row ® or TAB

The previous field in a row ¬ or SHIFT+TAB

The next cell in a column ¯

The previous cell in a column
The next cell in a column of 
selected cells

ENTER

The previous cell in a column 
of selected cells

SHIFT+ENTER

{button ,AL(`H_KEYBOARD_SHORTCUTS_REF;H_MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MO
VING_ONE_RECORD_AT_A_TIME_STEPS;H_MOVING_WITHIN_FIELDS_REF;H_SELECTING_WITHIN_FIEL
DS_REF;H_SETTING_GENERAL_WORKING_PREFERENCES_REF',0)} See related topics



Moving within fields and text blocks
To move Press
Down one line ¯

Left one character ¬

Left one word CTRL+ ¬

Right one character ®

Right one word CTRL+ ®

To start of line HOME

To end of line END

Up one line

{button ,AL(`H_KEYBOARD_SHORTCUTS_REF;H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_BETWEEN_FI
ELDS_USING_ENTER_STEPS;H_MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MOVING_ONE_
RECORD_AT_A_TIME_STEPS;H_SELECTING_WITHIN_FIELDS_REF;',0)} See related topics



Selecting within fields and text blocks
To select Press
Down one line SHIFT+¯

Left one character SHIFT+¬

Left one word CTRL+SHIFT+¬
Right one character SHIFT+ ®
Right one word CTRL+SHIFT+ ®

Up one line SHIFT+

{button ,AL(`H_KEYBOARD_SHORTCUTS_REF;H_MOVING_BETWEEN_FIELDS_REF;H_MOVING_BETWEEN_FI
ELDS_USING_ENTER_STEPS;H_MOVING_FROM_PAGE_TO_PAGE_IN_FORMS_STEPS;H_MOVING_ONE_
RECORD_AT_A_TIME_STEPS;H_SELECTING_WITHIN_FIELDS_REF;',0)} See related topics



Details: Previewing views
Data

• All data from Browse appears in Print Preview.
• You can move through records in Print Preview as you can in Browse.
• You cannot click in the fields, edit data, or edit design objects.

• Go to Browse if you need to change data.
• Go to Design if you need to make style or layout changes, including changes to drawn objects and text 

blocks.

Non-printing objects
To make a non-printing object appear in Preview, go to Design and select "Show in Print Preview" in the Basics tab of
the InfoBox. This is useful when you're in Preview and you want to run a macro attached to a button that you don't 
want to print.

Summary data
If Approach has any fields that summarize data from multiple records, Approach calculates the summary in Preview 
and shows the results.

Closing up space between objects
If a view has fields or other objects that need to slide up or left, the fields slide into position in Preview, if those 
options are set in the InfoBox.

Zooming with the mouse
To Click
Zoom in (magnify) Left mouse button
Zoom out (bird's-eye view) Right mouse button
See the view at 100% The percentage in the status 

bar and select 100%

{button ,AL(`H_PREVIEWING_VIEWS_STEPS',1)} Go to procedure
{button ,AL(`H_DOWNLOADING_DATA_BEFORE_PREVIEWING_STEPS;H_PREVENTING_OBJECTS_AND_FIEL

DS_FROM_PRINTING_STEPS;H_PRINTING_VIEWS_STEPS;H_REFRESHING_THE_DATA_NETWORK_ONS
CREEN_STEPS;H_SELECT_PRINT_PREVIEW_TO_SEE_REPORT_SUMMARIES_REF;H_SPECIFYING_THE_
PRINTER_PAPER_AND_ORIENTATION_STEPS;H_ZOOMING_IN_AND_OUT_STEPS;',0)} See related topics



Previewing views
The Preview environment shows what a view looks like when you print it.
Choose File - Print Preview.

• You see the view at 85%.
• The mouse pointer changes to the zoom cursor.

To turn Preview off, choose File - Print Preview.
You can zoom in and out while looking at a view in Preview; zooming doesn't affect the way Approach prints the view.

{button ,AL(`H_PREVIEWING_VIEWS_DETAILS',1)} See details
{button ,AL(`H_PRINTING_VIEWS_STEPS;H_REFRESHING_THE_DATA_NETWORK_ONSCREEN_STEPS;H_SE

LECT_PRINT_PREVIEW_TO_SEE_REPORT_SUMMARIES_REF;H_SPECIFYING_THE_PRINTER_PAPER_AN
D_ORIENTATION_STEPS;H_ZOOMING_IN_AND_OUT_STEPS;H_DOWNLOADING_DATA_BEFORE_PREVIE
WING_STEPS;',0)} See related topics



Overview: Printing Approach views
• You can print all the records in a database or a found set.
• You can print from any view.
• To print a single record, print from a form.

Printing forms
When you print records from a form, Approach starts a new page for each record and for each form page.
To show more records per page, print from a report or worksheet view.

Non-printing objects
To prevent objects in a view from printing--for example, buttons that run macros--go to Design and define those 
objects as non-printing in the Basics tab of the InfoBox.
To see non-printing objects in Preview, select "Show in Print Preview" in the Basics tab of the InfoBox. This is useful 
when you're in Preview and you want to run a macro attached to a button that you don't want to print.

Summary data on reports
Approach calculates summaries that apply to a range of records when you print. To see summary data right before 
you print, choose File - Print Preview. If you want to be sure that the summary data you see on the screen is the 
same as what is printed, select "Download on Preview."
See Downloading data before previewing.

Closing up space between objects
If a view has fields or other objects that are designated to slide up or left, the fields slide when you print.    To see the 
spacing between objects right before you print, choose File - Print Preview.

{button ,AL(`H_CLOSING_EXTRA_SPACE_BETWEEN_FIELDS_STEPS;H_DOWNLOADING_DATA_BEFORE_PR
EVIEWING_STEPS;H_FORMATTING_WORKSHEETS_OR_CROSSTABS_FOR_PRINTING_STEPS;H_PREVE
NTING_OBJECTS_AND_FIELDS_FROM_PRINTING_STEPS;H_PREVIEWING_VIEWS_STEPS;H_PRINTING_
A_DIAGRAM_OF_JOIN_RELATIONSHIPS_STEPS;H_PRINTING_A_LIST_OF_DATABASE_FIELDS_STEPS;H_
PRINTING_REPORTS_STEPS;H_PRINTING_VIEWS_STEPS;H_SPECIFYING_THE_PAPER_ORIENTATION_A
ND_MARGINS_STEPS;',0)} See related topics



Details: Printing views
Print range

To print Select
All records in the database All records
The current record when 
you're using a form

Current record

A range of records Record, and specify from 
where to where

Print to file
Printing to a file is useful if you do not have a printer connected to your computer and would like to print to a disk.

Collate copies
If you print more than one copy of the print job, select Collate copies to have Approach print one copy of the whole 
print job before printing another.
Otherwise, all copies of page 1 are printed, and then all copies of page 2, and so on.

{button ,AL(`H_PRINTING_VIEWS_STEPS',1)} Go to procedure
{button ,AL(`H_FORMATTING_WORKSHEETS_OR_CROSSTABS_FOR_PRINTING_STEPS;H_PREVENTING_OB

JECTS_AND_FIELDS_FROM_PRINTING_STEPS;H_PREVIEWING_VIEWS_STEPS;H_PRINTING_APPROACH
_VIEWS_OVER;H_PRINTING_REPORTS_STEPS;H_SPECIFYING_THE_PRINTER_PAPER_AND_ORIENTATI
ON_DETAILS;',0)} See related topics



Printing views
1. Check the status bar to be sure you're using the set of records you want to print.

Note Even when printing a form, which shows only one record at a time, you can print the entire set of records 
Approach is working with at the moment.

2. (Optional) Choose Sort from the context menu to sort the records.
3. (Optional) Choose File - Print Preview to see how the view looks when you print it.
4. Choose File - Print.

The Print dialog box appears.
5. Make printing adjustments in the Print dialog box.

Note If you change the printer, you may notice a difference in your layout, especially if the printer you select does 
not support the fonts you chose for the view you want to print.

6. (Optional) To change the paper size, paper source, or page orientation, click Properties.
7. Click Print.

Canceling a print job
To cancel a print job, press ESC.

{button ,AL(`H_PRINTING_VIEWS_DETAILS',1)} See details
{button ,AL(`H_FORMATTING_WORKSHEETS_OR_CROSSTABS_FOR_PRINTING_STEPS;H_PREVENTING_OB

JECTS_AND_FIELDS_FROM_PRINTING_STEPS;H_PREVIEWING_VIEWS_STEPS;H_PRINTING_APPROACH
_VIEWS_OVER;H_PRINTING_REPORTS_STEPS;H_SPECIFYING_THE_PRINTER_PAPER_AND_ORIENTATI
ON_DETAILS;H_CLOSING_EXTRA_SPACE_BETWEEN_FIELDS_STEPS;H_PAGINATING_REPORTS_STEPS;
H_PRINTING_A_DIAGRAM_OF_JOIN_RELATIONSHIPS_STEPS;H_PRINTING_A_LIST_OF_DATABASE_FIEL
DS_STEPS;H_PRINTING_MACRO_COMMANDS_STEPS;',0)} See related topics



Properties of printers
Command: File - Page Setup - Printer - Properties
The most frequently used printing options appear in the Page Setup dialog box. The settings under Paper and 
Orientation are the same in Page Setup as in the Properties dialog box.
All other options available for the printer you're using appear in the Properties dialog box.
These options vary from printer to printer, but generally they include options for

• Paper size, orientation, and source
• Graphics resolution, dithering, and mode
• Fonts
• Device options

Changes made to printer properties
Changes you make in the Properties dialog box remain as the settings for the printer until you change them again.
To restore the original settings of the printer, click Restore Defaults.

{button ,AL(`H_PRINTING_APPROACH_VIEWS_OVER;H_SPECIFYING_THE_PAPER_ORIENTATION_AND_MAR
GINS_STEPS;H_SPECIFYING_THE_PRINTER_PAPER_AND_ORIENTATION_STEPS;',0)} See related topics



Specifying the paper, orientation, and margins for printing

Are you in Design?
1. Choose File - Page Setup.
2. Under Paper, select a paper size and, if necessary, a paper source.
3. Under Orientation, select "Portrait" or "Landscape."
4. (Optional) To specify a printer, click Printer.

Note If you change the printer, you may notice a difference in your layout, especially if the printer you select does 
not support the fonts you chose for the view you want to print.

5. (Optional) To change other settings for the printer, click Properties
6. Click OK.

{button ,AL(`H_PREVIEWING_VIEWS_STEPS;H_PRINTING_APPROACH_VIEWS_OVER;H_PRINTING_VIEWS_S
TEPS;H_SELECTING_PRINT_SETTINGS_FOR_ENVELOPES_STEPS;H_PROPERTIES_OF_PRINTERS_REF;'
,0)} See related topics



Details: Specifying the printer, paper, and orientation
Orientation
If you see that the view won't fit on a page in Print Preview, adjusting the page orientation may help.

• Portrait prints the view with its top along the short edge of the paper.
• Landscape prints the view with its top along the long edge of the paper.

Printer
Change the printer you use for this print job from the default printer to any other that is connected to your computer.
The default printer is determined by the operating system. To select another printer as the default printer, make this 
change in the print settings for the operating system.

{button ,AL(`H_SPECIFYING_THE_PRINTER_PAPER_AND_ORIENTATION_STEPS',1)} Go to procedure
{button ,AL(`H_FORMATTING_WORKSHEETS_OR_CROSSTABS_FOR_PRINTING_STEPS;H_PREVIEWING_VIE

WS_STEPS;H_PRINTING_APPROACH_VIEWS_OVER;H_PRINTING_VIEWS_STEPS;H_SELECTING_PRINT_
SETTINGS_FOR_ENVELOPES_STEPS;H_PROPERTIES_OF_PRINTERS_REF;',0)} See related topics



Specifying the printer, paper, and orientation
1. Choose File - Print, and click Properties.
2. Under Printer, select a printer.
3. (Optional) To change other settings for the printer, click Properties.

See Properties of printers 
4. Under Paper, select a paper size and, if necessary, a paper source.
5. Under Orientation, select Portrait or Landscape.
6. Click OK.

{button ,AL(`H_SPECIFYING_THE_PRINTER_PAPER_AND_ORIENTATION_DETAILS',1)} See details
{button ,AL(`H_FORMATTING_WORKSHEETS_OR_CROSSTABS_FOR_PRINTING_STEPS;H_PREVIEWING_VIE

WS_STEPS;H_PRINTING_APPROACH_VIEWS_OVER;H_PRINTING_VIEWS_STEPS;H_SELECTING_PRINT_
SETTINGS_FOR_ENVELOPES_STEPS;H_PROPERTIES_OF_PRINTERS_REF;',0)} See related topics




